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Notices

This information was developed for products and services offered in the U.S.A. 

IBM may not offer the products, services, or features discussed in this document in other countries. Consult 
your local IBM representative for information on the products and services currently available in your area. Any 
reference to an IBM product, program, or service is not intended to state or imply that only that IBM product, 
program, or service may be used. Any functionally equivalent product, program, or service that does not 
infringe any IBM intellectual property right may be used instead. However, it is the user's responsibility to 
evaluate and verify the operation of any non-IBM product, program, or service. 

IBM may have patents or pending patent applications covering subject matter described in this document. The 
furnishing of this document does not give you any license to these patents. You can send license inquiries, in 
writing, to: 
IBM Director of Licensing, IBM Corporation, North Castle Drive, Armonk, NY 10504-1785 U.S.A.

The following paragraph does not apply to the United Kingdom or any other country where such 
provisions are inconsistent with local law: INTERNATIONAL BUSINESS MACHINES CORPORATION 
PROVIDES THIS PUBLICATION "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR 
IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF NON-INFRINGEMENT, 
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer of 
express or implied warranties in certain transactions, therefore, this statement may not apply to you. 

This information could include technical inaccuracies or typographical errors. Changes are periodically made 
to the information herein; these changes will be incorporated in new editions of the publication. IBM may make 
improvements and/or changes in the product(s) and/or the program(s) described in this publication at any time 
without notice. 

Any references in this information to non-IBM Web sites are provided for convenience only and do not in any 
manner serve as an endorsement of those Web sites. The materials at those Web sites are not part of the 
materials for this IBM product and use of those Web sites is at your own risk. 

IBM may use or distribute any of the information you supply in any way it believes appropriate without incurring 
any obligation to you.

Information concerning non-IBM products was obtained from the suppliers of those products, their published 
announcements or other publicly available sources. IBM has not tested those products and cannot confirm the 
accuracy of performance, compatibility or any other claims related to non-IBM products. Questions on the 
capabilities of non-IBM products should be addressed to the suppliers of those products.

This information contains examples of data and reports used in daily business operations. To illustrate them 
as completely as possible, the examples include the names of individuals, companies, brands, and products. 
All of these names are fictitious and any similarity to the names and addresses used by an actual business 
enterprise is entirely coincidental. 

COPYRIGHT LICENSE:

This information contains sample application programs in source language, which illustrate programming 
techniques on various operating platforms. You may copy, modify, and distribute these sample programs in 
any form without payment to IBM, for the purposes of developing, using, marketing or distributing application 
programs conforming to the application programming interface for the operating platform for which the sample 
programs are written. These examples have not been thoroughly tested under all conditions. IBM, therefore, 
cannot guarantee or imply reliability, serviceability, or function of these programs. 
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Chapter 1. Channel Subsystem overview

In this chapter we present an overview of the Channel Subsystem, including the following 
topics:

� Channel Subsystem

� Logical partitions

� Subchannel sets

� Channels

� The definition for Multiple CSS

� Activation

1
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1.1  Channel Subsystem

The channels in the Channel Subsystem (CSS) permit the transfer of data between main 
storage and I/O devices or other servers under the control of a channel program. Through 
these channel connections, the CSS enables communication from server memory to 
peripherals. 

The CSS allows channel I/O operations to continue independently of other operations within 
the server. This allows other functions to resume after an I/O operation has been initiated. 
Brief descriptions of some key entities that comprise the CSS follow.

Channel: The communication path from the Channel Subsystem to the connected control 
units and I/O devices. The channel subsystem communicates with I/O devices by means of 
channel paths between the channel subsystem and control units.

Channel Path Identifier (CHPID): A value assigned to each channel path of the system that 
uniquely identifies that path. A total of 256 CHPIDs are supported by one CSS. On a z10 EC, 
a CHPID number is assigned to a physical location by the user via HCD or IOCP.

Subchannel: Provides the logical appearance of a device to the program, and it contains the 
information required for sustaining a single I/O operation. A subchannel is assigned for each 
device defined to the logical partition. 

Control unit: Provides the logical capabilities necessary to operate and control an I/O device, 
and it adapts the characteristics of each device so that it can respond to the standard form of 
control provided by the CSS. A control unit can be housed separately, or it can be physically 
and logically integrated with the I/O device, the channel subsystem, or within the server itself.

Input/output (I/O) device: Provides external storage, which is a means of communication 
between data processing systems, or a means of communication between a system and its 
environment. In the simplest case, an I/O device is attached to one control unit and is 
accessible through one channel path.

Figure 1-1 depicts the relationship between the Channel Subsystem, the channels, the 
control units, and the I/O devices.
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Figure 1-1   Channel Subsystem relationship to channels, control units, and I/O devices

Multiple Channel Subsystem
The multiple Channel Subsystem (CSS) concept implemented in the System z servers is 
designed to offer considerable increases in processing power, memory size, and I/O 
connectivity over previous servers. 

Table 1-1 shows a summary of CSS features available on various System z models.

Table 1-1   CSS features per System z  model

On the z10 EC all channel subsystem images are defined within a single I/O Configuration 
Data Set that is loaded into the server Hardware System Area (HSA) and initialized during 
power-on reset. 

z10 EC, z9 EC z9 BC z990 z890

Number of CSS 4 per server 2 per server 4 per server 2 per server

Devices in 
subchannel set-0

63.75 K per CSS
255 K per server

63.75 K per CSS
255 K per server

63 K per CSS
252 K per 
server

63 K per CSS
126 K per 
server

Devices in 
subchannel set-1

64 K-1 per CSS
256 K-4 per server

64 K-1 per CSS
256 K-4 per server

0 0

Partitions 15 per CSS
60 per server

15 per CSS
30 per server

15 per CSS
30 per server

15 per CSS
30 per server

CHPIDs 256 per CSS
1024 per server

256 per CSS
512 per server

256 per CSS
1024 per server

256 per CSS
512 per server

Processor

Channels

Subchannels

Partitions

CSS

CU CU CU
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Figure 1-2 shows a logical view of these relationships. The z10 EC supports four Channel 
Subsystems per server. CSSs are numbered from 0 to 3; these designations are sometimes 
referred to as the “CSS Image ID” or “CSSID” (CSSID 0, 1, 2, or 3 for z10 EC, z9 EC and 
z990, and CSSID 0 and 1 for z9 BC and z890).

Each channel subsystem may have from 1 to 256 channels, and may in turn be configured 
with 1 to 15 logical partitions, with a maximum of 60 logical partitions.

Figure 1-2   Logical view of multiple CSSs in z10 EC server

MIF 
Multiple Image Facility (MIF) enables resource sharing across logical partitions within a single 
CSS. When a channel is shared across logical partitions in multiple CSSs, this is known as 
“spanning.” See “Spanned channels” on page 8 for more information. 

1.2  Logical partitions

A logical partition (LPAR) supports the running of an operating system, such as z/OS, and 
provides Central Processors (CPs), memory, subchannels, and access to channels. The z10 
EC server does not support basic mode. Only LPAR mode can be defined.

The following definitions apply on System z servers: 

� Logical partition name: Defined by the user through HCD or IOCP. It is the name in the 
RESOURCE statement in the IOCP. The logical partition names must be unique across all 
CSSs in the server.

� Logical partition identifier: A number in the range of 00 to 3F; it is assigned in the image 
profile through the Support Element or the Hardware Management Console. It is unique 
across the server and may also be referred to as the “User Logical Partition ID (UPID).”

We suggest that you establish a numbering convention for the logical partition identifiers. 
We use the CSS number concatenated to the MIF Image ID, which means logical partition 

Memory (min 16 GB, max 1520 GB)

Available Processing Units (min 1, max 64)

Up to 2  Subchannel Sets per CSS 

Physical Channels (PCHIDs)

Single LIC (server-wide)

IFB-C, and IFB-O cables

Single HSA with one active IOCDS 

Up to 4 Logical Channel Subsystems 

I/O Cage with features

HSA

1-16 IFB C/O

Up to 15 Logical Partitions per LCSS
Up to 60 Logical Partitions per CEC

IOCDS

0-26 PUs 0-40 PUs 0-64 PUs

Driver

E26
E40

E56/64

16 -352 GB 16 - 752 GB 16 -1136 
GB

16 -1520 GB

E12

Logical Partitions

CSS 0 
up to 256  
CHPIDs 

CSS 1 
up to 256  
CHPIDs 

CSS 2 
up to 256  
CHPIDs 

CSS 3 
up to 256  
CHPIDs 

SS 0 
SS 1

SS 0 
SS 1

SS 0 
SS 1

SS 0 
SS 1

1-12 PUsA

1-32 IFB C/O 1-40 IFB C/O 1-48 IFB C/O

Up to four books per server
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ID “3A” would be in CSS “3” with MIFID “A”. This fits within the allowed range of logical 
partition IDs and conveys useful information. 

� MIF ID: Defined via HCD, or via IOCP in the RESOURCE statement. It is in the range of 
x'1’ to x'F' and is unique within a CSS, but not unique across multiple CSSs. 

Multiple CSSs can specify the same MIF ID. The MIF ID is also known as “Image ID (IID).” 

Figure 1-3 illustrates the relationship between CSSs, logical partitions, and associated 
MIFIDs. TST1, PROD1, and PROD2 are defined to CSS 0. TST2, PROD3, and PROD4 are 
defined to CSS 1. TST3 is defined to CSS 2. TST4 and PROD5 are defined to CSS 3. Notice 
that PROD2 and PROD5 have the same MIFID, although logical partition IDs are different for 
them. Users should understand that HCD and HCM panel refers to the definition of a “MIF ID” 
in each CSSID.

Figure 1-3    CSS and logical partition definition of z10 EC

I/O operations for a logical partition are identified as originating from a Channel Image (CI). 
The Channel Image is defined as CI = CSSID + MIFID

For FICON® I/O operations, addressing is CI (+ CHPID) + S_ID + D_ID + CUI + UA, where 
the terms are defined as:

S_ID Source ID 
D_ID Destination ID
CUI Control Unit ID
UA Unit Address

The FICON control unit logical addressing for CTCs is CSSID.MIFID

1.3  Subchannel sets

In z/Architecture®, each I/O device is represented by a separate set of controls for each 
logical partition, called a subchannel, which is used by the operating system to pass an I/O 
request from the SCP to the channel subsystem. To a program, the subchannel would appear 
as a device. In the channel subsystem, the primary control block for an I/O is the 

CSS0 CSS3 Specified in 
HCD / IOCPCSS1 CSS2

Specified in HMC
Image Profile

Specified in
 HCD / IOCPTST1 PROD1 PROD2 TST3 TST4 PROD5

02 04 0A 22 35 3A

Logical  Partition  Name Logical  
Partition  Name

Logical  Partition  ID

Specified in 
HCD / IOCP

TST2 PROD3 PROD4

14 16 1D

MIF ID
2

MIF ID
4

MIF ID
A

MIF ID
2

MIF ID
5

MIF ID
A

MIF ID
4

MIF ID
6

MIF ID
D

Logical  Partition  Name

Logical  Partition  ID Logical  
Partition  ID

Log Part  
Name

Log Part  
ID
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“Subchannel” represented by a control block called the Unit Control Word (UCW). UCWs are 
part of the Hardware System Area (HSA).

Multiple subchannel sets
The number of devices that can be addressed by a logical partition can be a limitation for 
some installations. The concept of multiple subchannel sets (MSS) provides relief for this 
problem.

Usually, a subchannel represents an addressable I/O device. A disk control unit with 30 
drives uses 30 subchannels (for base addresses), and so forth. An addressable device is 
associated with a device number and the device number is commonly, but incorrectly, known 
as the “device address.”

Subchannel numbers are limited to four hexadecimal digits by hardware and software 
architectures. Four hexadecimal digits provides up to 64 K addresses, known as a set. IBM 
reserved 256 subchannels, leaving 63.75 K subchannels for general use. 

The advent of Parallel Access to Volumes (PAV) has made this 63.75 K subchannels 
limitation a problem for larger installations. One solution is to have multiple sets of 
subchannels, with a current implementation of two sets. Each set provides 64 K-1 addresses. 
Subchannel set 0 still reserves 256 subchannels for IBM use. Subchannel set 1 provides to 
the installation the full range of 64 K addresses.

Figure 1-4   Multiple Subchannel Sets

Each CSS has two subchannel sets, as shown in Figure 1-4. The two subchannel sets enable 
a total of 63.75 K subchannels in set 0 and an additional 64 K subchannels in set 1. 

The current implementation in z/OS limits the use of subchannel set 1 to disk alias devices. 
Subchannel set 0 can be used for base and for alias addresses.

The appropriate subchannel set number must be included in IOCP definitions or in the HCD 
definitions that produce the IOCDS. The subchannel set number defaults to zero.

z10 EC

Channels Channels

Partitions Partitions Partitions Partitions

Logical Channel 
Subsystem 0

Logical Channel 
Subsystem 1

Logical Channel 
Subsystem 2

Logical Channel 
Subsystem 3

Up to 15
Logical Partitions

Up to 15
Logical Partitions

Up to 15
Logical Partitions

Up to 15
Logical Partitions

CSS-3 Subchannels

SS-1SS-0

CSS-2 Subchannels

SS-1SS-0

CSS-1 Subchannels

SS-1SS-0

CSS-0 Subchannels

SS-1SS-0

63.75K63.75K 63.75K 63.75K64K64K 64K64K

Multiple Subchannel Sets MSS

Subchannels

ChannelsChannels

Subchannels Subchannels Subchannels
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With the availability of HyperPAV, the requirement for PAV devices is greatly reduced. 
HyperPAV allows an alias address to be used to access any base on the same control unit 
image per I/O base. It also allows different HyperPAV hosts to use one alias to access 
different bases, which reduces the number of alias addresses required. HyperPAV is 
designed to enable applications to achieve equal or better performance than is possible with 
the original PAV feature alone, while also using the same or fewer z/OS resources. 
HyperPAV is an optional feature on the IBM DS8000™ series. 

1.4  Channels

The channel subsystem communicates with I/O devices by means of channel paths between 
the channel subsystem and control units. A channel is the communication path from the 
Channel Subsystem to the connected control units and I/O devices. 

Channel Path ID (CHPID)
A Channel Path Identifier (CHPID) is a value assigned to each channel path of the system 
that uniquely identifies that path. A total of 256 CHPIDs are supported by each CSS. A 
CHPID number is assigned to a physical channel by the user via HCD or IOCP.

Physical Channel ID (PCHID)
A Physical Channel ID (PCHID) reflects the physical location of a channel-type interface. A 
PCHID number is based on the I/O cage location, the channel feature slot number, and the 
port number of the channel feature. A CHPID no longer directly corresponds to a hardware 
channel port, but is assigned to a PCHID using HCD or IOCP. 

You can address 256 CHPIDs within a single channel subsystem. That gives a maximum of 
1024 CHPIDs when four CSSs are defined. Each CHPID within a CSS is associated with a 
single channel. The physical channel, which uniquely identifies a connector jack on a channel 
feature, is known by its PCHID number.

PCHIDs identify the physical ports on cards located in I/O cages and follows the numbering 
scheme defined for the processor model. PCHID values are shown in Table 1-4 on page 13 
and Table 1-5 on page 14.

Adapter ID (AID)
The Adapter ID assigned to each InfiniBand® link on a Host Channel Adapter used for 
coupling initially reflects the physical location of the HCA. 

The Adapter ID specifies the adapter identifier associated with the host channel adapter 
(HCA) on which this channel path is defined. It is determined from the PCHID Report when a 
host channel adapter is ordered. An AID is assigned for HCA2-O adapters and is required for 
all CIB channel path definitions. The AID is a two-digit hexadecimal number between x"00" 
and x"1F". A maximum of 16 CIB channel paths can be defined for the same AID. 

For more information about InfiniBand, see Getting Started with InfiniBand on System z10 
and System z9, SG24-7539.

Control unit
A control unit provides the capabilities necessary to operate and control an I/O device. The 
control unit acts as an interface between the Channel Subsystem and the I/O device, 
masking the uniqueness of the I/O device from the CSS. A control unit can be housed 
separately, or it can be physically and logically integrated with the I/O device, the Channel 
Subsystem, or within the server itself.
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I/O device
An input/output (I/O) device is the end-point in the “conduit” between a server and a 
peripheral. Although the channel does not communicate directly with I/O devices (it 
communicates with control units), it is useful to mention them here because we previously 
discussed subchannels, which appear as I/O devices to programs. 

An I/O device has the characteristics of the peripheral that it represents. It could provide 
external storage, a means of communication between data-processing systems, or a means 
of communication between a system and its environment. In the simplest case, an I/O device 
is attached to one control unit and is accessible through one channel path.

 I/O sharing
There are now two possibilities for I/O device sharing: 

� MIF

This enables channel sharing among logical partitions running in one channel subsystem. 

� Spanning

This extends the MIF concept of sharing channels across logical partitions in a single CSS 
to sharing channels across logical partitions and multiple channel subsystems. 

Spanning is the ability for the channel to be configured to multiple channel subsystems. 
When defined that way, the channels can be transparently shared by any or all of the 
configured logical partitions, regardless of the channel subsystem to which the logical 
partition is configured. 

MIF-shared channels
PR/SM™ allows sharing of resources across logical partitions. MIF enables channel sharing 
among logical partitions, but sharing is limited to partitions defined to one channel subsystem. 

MIF enables channel sharing among logical partitions running in one channel subsystem. It is 
important to understand qualifiers that apply to a logical partition definition. The following 
definitions for z10 EC, z9 EC, z9 BC, z990, and z890 are described in “Logical partitions” on 
page 4: 

� Logical partition name
� Logical partition identifier
� MIF ID

Spanned channels
Spanning is the ability of channels to be configured to multiple CSSs, and be transparently 
shared by any or all of the configured logical partitions configured in these CSSs. 

Figure 1-5 on page 9 shows an example with two CSSs using spanned channels. There are 
spanned external channels (with associated PCHIDs) and spanned internal channels (no 
associated PCHIDs).
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Figure 1-5   MIF-Shared and Spanned channels

It should be noted that there are certain channels commonly used on earlier servers that 
cannot be spanned. For example, ESCON® channels can be MIF-shared within one CSS, 
but cannot be spanned across multiple CSSs. Table 1-2 shows channels that can be shared 
and spanned by CHPID type. 

Table 1-2   Spanned and shared channels

Channel type CHPID definition MIF-shared 
channels

Spanned 
channels

FICON Express4 External FC, FCP Yes Yes

FICON Express2a

a. Available if carried over during an upgrade 

External FC, FCP Yes Yes

FICON Expressa External
FC, FCP Yes Yes

FCV Yes No

ESCON External
CNC, CTC Yes No

CVC, CBY No No

OSA-Express3 10 GbE External OSD Yes Yes

OSA-Express2 External OSD, OSE, OSC, OSN Yes Yes

ICB-4 External CBP Yes Yes

ISC-3 External CFP Yes Yes

InfiniBand Coupling External CIB Yes Yes

IC Internal ICP Yes Yes

HiperSockets™ Internal IQD Yes Yes

LCSS0 LCSS1

Partition
1

Partition
2

Partition
15

Partition
14

Partition
16

Partition
17

Partition
18

Partition
60

MIF-1 MIF-2 MIF-F MIF-1 MIF-2 MIF-3 MIF-F

CHPID
00

CHPID
02

CHPID
01

CHPID
FF

PCHID
10B

PCHID
10D

PCHID
10C

PCHID
20A

CHPID
04

SPAN
PCHID

20E
PCHID

145
PCHID

147
PCHID

146
PCHID

158
PCHID

159

CHPID
03

Share
CHPID

06
SPAN

PCHID
120

CHPID
00

CHPID
01

CHPID
22

CHPID
FF

CHPID
05

Share

internal external
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The example shown in Figure 1-6 shows a server with four CSSs:

� The logical CHPID numbers 50, 54, 5A, and 5E are shared channels between the logical 
partitions except for A0D, A0E, and A0F in CSS0, and A1D, 1D, and A1F in CSS1, which 
are defined with NOTPART parameters. These CHPIDs are defined as spanned channel 
for each physical ficon (TYPE=FC) channels, PCHID numbers 1F1, 571, 160, and 561.

� All logical partitions in each CSSs are using the subchannel sets SS0 and SS1 to address 
the same DASD. They use SS0 to address the base addresses C400-C431, and they use 
SS1 to address the alias addresses C432-C4FF.

Figure 1-6   Configuration example with CSSs, MSSs, and PCHIDs

The IOCP statements in Example 1-1 are not intended to represent a real server, but are just 
used to illustrate the new elements involved.

Example 1-1   IOCP Statement

ID    MSG2='SYS6.IODF42 - 2007-12-07 09:12',SYSTEM=(2097,1),  *
      LSYSTEM=SCZP201,                                        *
      TOK=('SCZP201',00800006991E2094091203920107341F00000000,*
      00000000,'07-12-07','09:12:03','SYS6','IODF42')          
RESOURCE PARTITION=((CSS(0),(A0A,A),(A0B,B),(A0C,C),(A0D,D),(A*
      0E,E),(A0F,F),(A01,1),(A02,2),(A03,3),(A04,4),(A05,5),(A*
      06,6),(A07,7),(A08,8),(A09,9)),(CSS(1),(A1A,A),(A1B,B),(*

LPs

1F1 571 160 561

CHPIDs

PCHIDs

50 54 5A 5E

subchannel
sets

CSSs

z10 EC server

Switches 62 63

IBM DS8000 (emulated 3390s) addresses C400-C431 = bases
addresses C432-C4FF = aliases

261C

Disk 
addresses

64

26

61

1C

CSS0
A01 A0C

0 1

50 54 5A 5E

C432-C4FF
C400-C431 C400-C431

C432-C4FF

.....
CSS1

A11 A1C

0 1

.....

50 54 5A 5E

CSS2
A21 A25

0 1

.....

50 54 5A 5E

CSS3
A31 A33

0 1

.....

C4xx C4xx C4xx C4xx C4xx C4xx
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      A1C,C),(A1D,D),(A1E,E),(A1F,F),(A11,1),(A12,2),(A13,3),(*
      A14,4),(A15,5),(A16,6),(A17,7),(A18,8),(A19,9)),(CSS(2),*
      (A21,1),(A22,2),(A23,3),(A24,4),(A25,5),(*,6),(*,7),(*,8*
      ),(*,9),(*,A),(*,B),(*,C),(*,D),(*,E),(*,F)),(CSS(3),(A3*
      1,1),(A32,2),(A33,3),(*,4),(*,5),(*,6),(*,7),(*,8),(*,9)*
      ,(*,A),(*,B),(*,C),(*,D),(*,E),(*,F)))                   
CHPID PATH=(CSS(0,1,2,3),50),SHARED,                          *
      NOTPART=((CSS(0),(A0D,A0E,A0F),(=)),(CSS(1),(A1D,A1E,A1F*
      ),(=))),SWITCH=61,PCHID=1F1,TYPE=FC                      
CHPID PATH=(CSS(0,1,2,3),54),SHARED,                          *
      NOTPART=((CSS(0),(A0D,A0E,A0F),(=)),(CSS(1),(A1D,A1E,A1F*
      ),(=))),SWITCH=62,PCHID=571,TYPE=FC                      
CHPID PATH=(CSS(0,1,2,3),5A),SHARED,                          *
      NOTPART=((CSS(0),(A0D,A0E,A0F),(=)),(CSS(1),(A1D,A1E,A1F*
      ),(=))),SWITCH=63,PCHID=160,TYPE=FC                      
CHPID PATH=(CSS(0,1,2,3),5E),SHARED,                          *
      NOTPART=((CSS(0),(A0D,A0E,A0F),(=)),(CSS(1),(A1D,A1E,A1F*
      ),(=))),SWITCH=64,PCHID=561,TYPE=FC                      
CNTLUNIT CUNUMBR=C400,                                        *
      PATH=((CSS(0),50,54,5A,5E),(CSS(1),50,54,5A,5E)),       *
      UNITADD=((00,256)),                                     *
      LINK=((CSS(0),1C,1C,26,26),(CSS(1),1C,1C,26,26)),       *
      CUADD=4,UNIT=2105                                        
IODEVICE ADDRESS=(C400,050),CUNUMBR=(C400),STADET=Y,UNIT=3390B 
IODEVICE ADDRESS=(C432,206),CUNUMBR=(C400),STADET=Y,SCHSET=1, *
      UNIT=3390A 

Channel Program (CP)
A Channel Program (CP) is a set of Channel Command Words (CCW). Channel programs 
are built by the requester of the I/O and then control is passed to the next phase of the I/O, 
which is performed by the System Assist Processor (SAP®). 

System Assist Processor (SAP)
A System Assist Processor (SAP) is a special-purpose PU responsible for handling I/O. SAPs 
are sometimes referred to as “I/O Processors” or “IOPs”.

Hardware System Area (HSA)
The Hardware System Area (HSA) is an area of memory in the processor central storage 
used by the hardware. It is established during power-on reset (POR) using the configuration 
information from the IOCDS. A fixed amount of 16 GB is reserved for HSA storage size and is 
fenced off from customer purchased memory.

The HSA contains the subchannels (UCWs). HSA Storage is allocated based on the size of 
the IOCDS (partitions, channels, control units and devices). Additional storage is reserved for 
Dynamic I/O reconfiguration, if enabled. 

Fanout card and adapters
A fanout card is designed to provide the path for data between memory and I/O using feature 
cards and cables. The z10 EC server can have one to four books installed in the CPC. Each 
book includes up to eight fanout slots, with a maximum of 24 fanout cards for a four-book 
structure. Each fanout has two ports to connect an ICB or IFB cable, depending on the type of 
fanout. There are two types of Host channel adapters (HCA): one uses an optical interface 
(HCA2-O) for coupling, the other uses copper cable (HCA2-C) to connect to an I/O cage.
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Each slot can hold one of the following fanouts:

� Host Channel Adapter (copper), HCA2-C - provides connectivity to the IFB-MP card in the 
I/O cage.

� Host Channel Adapter (optical), HCA2-O - provides coupling links connectivity to other 
z10 EC (HCA2-O) or z9 servers (HCA1-O).

� Memory Bus Adapter, MBA - is used for copper cable ICB-4 links only.

The HCA2-O fanout used for coupling links has an assigned Adapter ID number (AID), which 
must be used for definitions in IOCDS to have a relation between the physical adapter 
location and the CHPID number.

I/O cage
The z10 EC server holds a minimum of one I/O cage at the bottom of frame A and two 
optional I/O cages in the Z frame.

Each cage supports up to seven I/O domains and a total of 28 I/O card slots. Each I/O domain 
supports four I/O card slots as shown in Figure 1-7 on page 13.

Each I/O domain uses an IFB-MP card in the I/O cage and a copper cable connected to a 
Host Channel Adapter (HCA) fanout in the CEC cage. An I/O cage has seven domains, but in 
order to have the redundant I/O interconnect function available to all domains, an eighth 
domain connection is required for a z10 EC server I/O cage in which all seven domains are 
used. The eighth domain connection is only used if the primary IFB-MP for the last domain is 
disabled.

Figure 1-7 on page 13 shows the physical layout of the I/O cage, with the I/O slots and the I/O 
domains. The assignment of slots to domains in each I/O cage is identified in Table 1-6.

Table 1-3   I/O domains

I/O slots 5, 14, 23, and 28 contain the IFB-MP cards used for STI or IFB connections. 
Assuming a fully-loaded I/O cage, there are two IFBs in each of these slots.

One IFB-MP card in slot 28 serves only I/O domain 6 in slots 29 to 32. Two IFB connections 
are still provided to allow redundant I/O interconnect.

I/O Domain I/O slots in domain

0 (A) 1, 3, 6, 8

1 (B) 2, 4, 7, 9

2 (C) 10, 12, 15, 17

3 (D) 11, 13, 16, 18

4 (E) 19, 21, 24, 26

5 (F) 20, 22, 25, 27

6 (G) 29, 30, 31, 32
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Figure 1-7   z10 EC I/O Cage

The address of each PCHID is determined by the physical location of the card in the I/O cage. 
Each slot in an I/O cage supports up to 16 PCHID addresses. Table 1-4 lists the PCHID 
addresses used for the front locations in each I/O cage. 

Table 1-4    PCHIDs address range per I/O cage and I/O slot (Front)

 I/O slot # I/O 
Domain

PCHID 
I/O cage 1 Front 

PCHID 
I/O cage 2 Front 

PCHID 
I/O cage 3 Front 

1 A 100-10F 300-30F 500-50F

2 B 110-11F 310-31F 510-51F

3 A 120-12F 320-32F 520-52F

4 B 130-13F 330-33F 530-53F

5 IFB-MP

6 A 140-14F 340-34F 540-54F

7 B 150-15F 350-35F 550-55F

8 A 160-16F 360-36F 560-56F

9 B 170-17F 370-37F 570-57F

10 C 180-18F 380-38F 580-58F

11 D 190-19F 390-39F 590-59F

I/O  A

I/O  B

I/O  A

I/O  B

I/O  A

I/O  B

I/O  A

I/O  B

I/O  C

I/O  D

I/O  C

I/O  D

I/O  C

I/O  D

I/O  C

I/O  D

C
D

top
bottom

I/O  G

I/O  G

I/O  G

I/O  G

I/O  F

I/O  E

I/O  F

I/O  E

I/O  F

I/O  E

I/O  F

I/O  E

G top

E
F

top
bottom

DCA / CC

DCA / CC
6 GB IFB 
I/O connect
6 GB IFB 
I/O connect

1

2

3

4

5

6

7

8

9

10

11

12

13

14

15

16

17

18

36

35

34

33

32

31

30

29

28

27

26

25

24

23

22

21

20

19front rear

A
B  

top
bottomIFB-MP

6 GB IFB 
I/O connect
6 GB IFB 
I/O connect

6 GB IFB 
I/O connect
6 GB IFB 
I/O connect

IFB-MP

IFB-MP

IFB-MP

6 GB IFB 
I/O connect

6 GB IFB 
I/O connect
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Table 1-5 lists the PCHID addresses used for the rear locations in each I/O cage.   

Table 1-5    PCHIDs address range per cage and I/O slot (Rear)

12 C 1A0-1AF 3A0-3AF 5A0-5AF

13 D 1B0-1BF 3B0-3BF 5B0-5BF

14 IFB-MP

15 C 1C0-1CF 3C03CF 5C0-5CF

16 D 1D0-1DF 3D0-3DF 5D0-5DF

17 C 1E0-1DF 3E0-3EF 5E0-5EF

18 D 1F0-1FF 3F0-3FF 5F0-5FF

 I/O slot # I/O 
Domain

PCHID 
I/O cage 1 Rear 

PCHID 
I/O cage 2 Rear 

PCHID 
I/O cage 3 Rear 

19 E 200-20F 400-40F 600-60F

20 F 210-21F 410-41F 610-61F

21 E 220-22F 420-42F 620-62F

22 F 230-23F 430-43F 630-63F

23 IFB-MP

24 E 240-24F 440-44F 640-64F

25 F 250-25F 450-45F 650-65F

26 E 260-26F 460-46F 660-66F

27 F 270-27F 470-47F 670-67F

28 IFB-MP

29 G 280-28F 480-48F 680-68F

30 G 290-29F 490-49F 690-69F

31 G 2A0-2AF 4A0-4AF 6A0-6AF

32 G 2B0-2BF 4B0-4BF 6B0-6BF

33
DCAs

34

35
DCAs

36

 I/O slot # I/O 
Domain

PCHID 
I/O cage 1 Front 

PCHID 
I/O cage 2 Front 

PCHID 
I/O cage 3 Front 
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1.5  The definition for Multiple CSS

This section explains the new IODF definition for the z10 EC processor. For more information, 
see the manuals Hardware Configuration Definition Planning (GA22-7525), and Input/Output 
Configuration Program User’s Guide for ICP IOCP (SB10-7037).

When the definition of a new processor with 2097 type is added by HCD, the maximum 
number of logical partitions is automatically generated in IODF; see the message in 
Figure 1-8.

Figure 1-8   HCD - Add a new z10 EC processor

Figure 1-9 on page 16 is the channel subsystem list after a new 2097 processor is defined. 
The z10 EC supports the maximum four CSSs in a processor. You will notice that two 
subchannel sets are defined in each channel subsystem, which is the maximum number 
supported, as follows:

� The maximum number of devices is 65280 per CSS for subchannel set 0. 

� The maximum number of devices is 65535 per CSS for subchannel set 1.

 Processor List        Row 1 of 9 More:       > 
 Command ===> _______________________________________________ Scroll ===> CSR   
                                                                                
 Select one or more processors, then press Enter. To add, use F11.              

 / Proc. ID Type +   Model +  Mode+ Serial-# + Description                      
 _ ISGSYN   2064     1C7      LPAR  __________ ________________________________ 
 _ ISGS11   2064     1C7      LPAR  __________ ________________________________ 
 _ NEWPROC  2097     E12      LPAR  __________ ________________________________ 
 _ P000STP1 2084     C24      LPAR  01534A2084 ________________________________ 
 _ P000STP2 2094     S08      LPAR  0BAD4E2094 ________________________________ 
 _ SCZP101  2094     S18      LPAR  02991E2094 ________________________________ 
 _ SCZP201  2097     E26      LPAR  01DE502097 ________________________________ 
 _ SCZP801  2064     1C7      LPAR  010ECB2064 ________________________________ 
 _ SCZP901  2084     C24      LPAR  026A3A2084 ________________________________ 
 ******************************* Bottom of data ********************************
+------------------------------------------------------------------+            
| Definition of processor NEWPROC has been extended to its maximum |            
| configuration.                                                   |            
+------------------------------------------------------------------+
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Figure 1-9   Channel Subsystem List after defining a new z10 EC processor

Each CSS can have a maximum of 15 logical partitions defined, so a z10 EC system can 
have up to 60 logical partitions, including reserved logical partitions. 

Figure 1-10 is the partition list in a channel subsystem. Note that the logical partition names 
have not been assigned yet. This means that all numbers (between x'1' and x'F') of the 
partition in each channel subsystem are already defined as “reserved.” This is indicated by an 
asterisk(*) in the partition name field. This asterisk ensures that the CSS treats this logical 
partition as a reserved logical partition. 

The partition usage is also defined at this point as CF/OS. This means that these reserved 
logical partitions can be used as an operating system, Coupling Facility, or Linux® logical 
partition. This partition usage can be changed with a dynamic activate.

During the initial configuration setup (the definition of the new z10 EC processor) in HCD, 
change only definitions for the number of partitions that you want to work with.

Figure 1-10   Partition list after defining a new z10 EC processor

 Channel Subsystem List                  Row 1 of 4 
 Command ===> _______________________________________________ Scroll ===> CSR   
                                                                                
 Select one or more channel subsystems, then press Enter.  To add, use F11.     
                                                                                
 Processor ID . . . : NEWPROC                                                   
                                                                                
   CSS Devices in SS0    Devices in SS1                                         
 / ID  Maximum + Actual  Maximum + Actual  Description                          
 _ 0   65280     0       65535     0       ________________________________     
 _ 1   65280     0       65535     0       ________________________________     
 _ 2   65280     0       65535     0       ________________________________     
 _ 3   65280     0       65535     0       ________________________________ 

                              Partition List 
   Goto  Backup  Query  Help                                               
 -----------------------------------------------------------------------   
                                                              Row 1 of 15  
 Command ===> ________________________________________ Scroll ===> CSR     
                                                                           
 Select one or more partitions, then press Enter. To add, use F11.         
                                                                           
 Processor ID  . . . . : NEWPROC                                           
 Configuration mode  . : LPAR                                              
 Channel Subsystem ID  : 0                                                 
                                                                           
 / Partition Name   Number Usage + Description                             
 _ *                1      CF/OS   ________________________________        
 _ *                2      CF/OS   ________________________________        
 _ *                3      CF/OS   ________________________________        
 _ *                4      CF/OS   ________________________________        
 _ *                5      CF/OS   ________________________________        
 _ *                7      CF/OS   ________________________________ 
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The reserved logical partitions can only be seen as definitions in HCD or HCM, or in the IOCP 
deck produced by HCD. The Resource Partition statement in IOCP shows the reserved 
partitions with * in the name field. At this time, they are just place holders and no resources 
are assigned and allocated to them. Of course, the reserved logical partition isn’t visible yet 
on the Contents of CPC in the HMC.

Notes that in the IOCP deck produced by HCD, the RESOURCE PARTITION statement 
shows the reserved partitions with * in the name field, as shown in Figure 1-11.

Figure 1-11   Sample extract of IOCP deck

1.6  Activation

No single component or single part of the CPC completely defines the channel subsystem on 
the z10 EC. It should be seen more like an architected construct that comprises many CPC 
resources, both hardware or LIC. These resources work together to support I/O operations 
across the CPC: I/O queuing, de-queuing, priority management, and identification of all I/O 
operations performed by logical partitions.

During initialization of the server, Channel Subsystem rules are enforced. Initialization of the 
server includes definition and activation of the logical partitions. The activation steps are as 
follows:

1. Reset profile to activate the z10 EC CPC.

– Build the CSS HSA contents based on the I/O configuration definition in the selected 
IOCDS.

– Initialize all defined channel types.
– Initialize FICON and ESCON links.

2. Activate the required logical partitions (Image Profile).

– Initialize the logical partition per the logical partition image profile.
– Assign storage to the logical partition; the storage is never shared with other logical 

partitions.
– For FICON and ESCON channels, establish logical paths.

ID    MSG2='MASAYAN.IODF41 - 2007-12-05 15:21',               *
      SYSTEM=(2097,1),                                        *
      TOK=('NEWPROC',00800001991E2094152132040107339F00000000,*
      00000000,'07-12-05','15:21:32','MASAYAN','IODF41')       
RESOURCE PARTITION=((CSS(0),(TEST,1),(*,2),(*,3),(*,4),(*,5),(*
      *,6),(*,7),(*,8),(*,9),(*,A),(*,B),(*,C),(*,D),(*,E),(*,*
      F)),(CSS(1),(*,1),(*,2),(*,3),(*,4),(*,5),(*,6),(*,7),(**
      ,8),(*,9),(*,A),(*,B),(*,C),(*,D),(*,E),(*,F)),(CSS(2),(*
      *,1),(*,2),(*,3),(*,4),(*,5),(*,6),(*,7),(*,8),(*,9),(*,*
      A),(*,B),(*,C),(*,D),(*,E),(*,F)),(CSS(3),(*,1),(*,2),(**
      ,3),(*,4),(*,5),(*,6),(*,7),(*,8),(*,9),(*,A),(*,B),(*,C*
      ),(*,D),(*,E),(*,F))) 

Note: IOCP ignores the MAXDEV keyword on the RESOURCE statement and always 
reserves the maximum number of logical partitions.
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3. IPL/Load (Load Profile or Manual Load).

– Perform an I/O system reset for the logical partition for all defined channel paths. The 
IPLed operating system starts the required I/O operations.

Dynamic addition or deletion of a logical partition 
With high availability requirements, if we expect that we may need a logical partition at some 
future date, we reserve all logical partitions within an CSS in the IOCDS used for power-on 
reset of a z10 EC™. 

The HSA for the z10 EC server is now a separately reserved area of memory outside of 
customer purchased memory. It is no longer required to plan for reserving space for future 
additional definitions in the Input/Output Configuration Data Set (IOCDS) or to do a 
Power-On-Reset (POR) to support these HSA activities.

When the definition of a new processor with 2097 type is added by HCD, the maximum 
number of logical partitions, channel subsystems and subchannel sets is automatically 
generated in the IODF. A detailed example of reserved logical partitions is provided in 
Chapter 9, “Reserved logical partitions” on page 369.
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Chapter 2. Configuration planning

In this chapter we describe the planning steps to take when you install a z10 EC. These steps 
apply whether you are upgrading from an existing server or installing a new z10 EC. 

We discuss the following topics:

� Tools

– “IBM Configurator for e-business (e-Config)” on page 21
– “Resource Link” on page 21
– “Hardware Configuration Definition (HCD)” on page 21
– “Hardware Configuration Manager (HCM)” on page 22
– “Input/Output Configuration Program” on page 23
– “CHPID Mapping Tool” on page 24

� Hardware Management Console (HMC)

– “Hardware Management Console Application V2.10.0” on page 30
– “Remote Support Facility (RSF)” on page 34 
– “SNMP APIs” on page 45
– “Connectivity for HMC and Support Element” on page 47

� Channel considerations

– “Parallel channels” on page 49
– “ESCON channels” on page 50
– “FICON channels” on page 50
– “Open Systems Adapter (OSA)” on page 52
– “HiperSockets” on page 53
– “PSIFB links” on page 54
– “Coupling links” on page 58
– “Configuration rules” on page 63

2
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2.1  Tools

This section summarizes the various tools available for the IBM System z platforms. Table 2-2 
provides references to more detailed descriptions of the tools.

The examples in this document use tools, such as HCD and CMT, which refer to the Machine 
type as opposed to server names. Table 2-1 lists the Machine types for current IBM System z 
platforms.

Table 2-1   IBM System z platforms and machine type

Coupling Facility Structure Sizer (CFS)
The Coupling Facility Structure Sizer tool is used to monitor various aspects of Coupling 
Facility partitions. It is useful for gathering information about structure sizes, usage, potential 
bottlenecks and coupling link availability.

Using the Coupling Facility Structure Sizer enables you to plan the amount of storage that 
needs to be allocated for Coupling Facility partitions more accurately. 

Open System Adapter/Support Facility (OSA/SF)
The Open Systems Adapter Support Facility (OSA/SF) is an application that helps you 
customize and manage your OSA-Express features. It also allows you to obtain status and 
operational information about the HCD-defined OSA-Express features and assists in problem 
determination. OSA/SF is required to configure the OSA-Express features for non-QDIO 
mode and can be used to configure MAC addresses and speeds for QDIO mode.

Processor Capacity Reference (zPCR)
zPCR is a PC-based productivity tool that runs under Windows®. It is designed to provide 
capacity planning insight for IBM System z processors running various workload 
environments under z/OS, z/VM®, and Linux. Capacity results are based on IBM's LSPR 
data supporting all IBM System z processors as well as legacy LSPR data.

Power Estimation Tool
This tool estimates the power consumption for the specified configuration. The object of the 
tool is to produce an estimate of the power requirements to aid you in planning for your 
machine installation. 

Table 2-2   Tools and references

Server Abbreviated name Machine type

IBM System z10 Enterprise Class z10 EC 2097

IBM System z9 Enterprise Class z9 BC 2096

IBM System z9 Business Class z9 EC 2094

IBM eServer zSeries 990 z990 2084

IBM eServer zSeries 890 z890 2086

Tool Interneta address for more information

HCD HCD and HCM Web page 
http://www.ibm.com/servers/eserver/zseries/zos/hcm/

HCM
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2.1.1  IBM Configurator for e-business (e-Config)

The e-Config tool is available to your IBM representative. It is used to design and generate 
new configurations (CFReports) or upgrades to an existing configuration. It also maintains 
information about installed features for those configurations. 

Reports generated from e-CONFIG are helpful in understanding what changes are being 
made for a system upgrade, what PCHIDs have been ordered (PCHID reports), and what the 
final configuration looks like.

2.1.2  Resource Link

The first step in planning for installation of the z10 EC is accessing Resource Link. You need 
to register with a client site number, ID, and a valid e-mail address. Your IBM representative 
can assist you with this registration process. 

Once you can access Resource Link, you will have access to a number of resources and 
tools that are needed in the installation process, as well as information regarding the z10 EC. 
A number of tools are available to simplify the installation process of a z10 EC. Even if you 
have worked with most of them before, be sure to check for the latest versions that are 
relevant to z10 EC. The tools include the CHPID Mapping Tool and the Coupling Facility 
Structure Sizer Tool. 

Under the Education tab, you will find information about the new HMC application, as well as 
an online tutorial. There is also an education module for the CHPID Mapping Tool. 

The IBM Resource Link Web site provides a number of additional tools and resources.

An IBM Registration ID is required to sign onto the Resource Link Web site. It only takes a 
few minutes to register to obtain an IBM Registration ID.

After you have an IBM ID, you can customize your profile to the servers that you are 
responsible for. The address for Resource Link is:

http://www.ibm.com/servers/resourcelink

2.1.3  Hardware Configuration Definition (HCD)

Hardware Configuration Definition (HCD) is a tool that supplies an interactive dialog to 
generate the I/O Definition File (IODF) and subsequently the Input/Output Configuration Data 

CMT https://www.ibm.com/servers/resourcelink/hom03010.nsf/pages/chpidmain?O
pendocument

CFS http://www.ibm.com/systems/z/cfsizer/

z/PCR Getting Started with zPCR at 
http://www.ibm.com/support/techdocs/atsmastr.nsf/WebIndex/PRS1381

OSA/SF http://www.ibm.com/servers/eserver/zseries/zos/bkserv/r4pdf/osasf.html

Power 
Estimation Tool

https://www.ibm.com/servers/resourcelink/hom03010.nsf/pages/powerestima
tionmain?OpenDocument

a. For the CMT and the Power Estimation Tool you need an ID to the Resource Link™ site.

Tool Interneta address for more information 
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Set (IOCDS). We strongly recommend that you use HCD or HCM to generate the I/O 
configuration, as opposed to writing your own IOCP statements. The validation checking that 
HCD performs as you enter data helps minimize the risk of errors.

HCD support for the z10 is available on all supported z/OS levels with 2097DEVICE PSP and 
z/VM beginning with V5.2 and V5.3. HCD provides the capability to make both dynamic 
hardware and software I/O configuration changes. For z/OS, HCD is required for Dynamic I/O 
reconfiguration.

z/OS V1.7 HCD with 2094DEVICE PSP or higher is required to support InfiniBand coupling 
technology. This is required to be able to define CIB type CHPIDs.

2.1.4  Hardware Configuration Manager (HCM)

Hardware Configuration Manager (HCM) provides a graphical user interface to HCD and its 
IODF. It also has the ability to define and store more information about the physical hardware 
that the IODF is defined to.

If this is something that your installation requires, or if you prefer to build and maintain the 
IODFs using this interface, then you will find HCM to be a useful tool.

Note that HCM does not replace HCD, but instead is used in conjunction with HCD and its 
selected IODF. However, HCM can be used “stand alone” once an IODF is built and the 
configuration files (IODF##.HCM or IODF##.HCR) are created on your HCM workstation.

HCM V1.9 SL2 is now available; it introduces some support for the CHPID Mapping tool, 
which is described in more detail in the following section. 

CHPID Mapping Tool support
HCM for z/OS V1.9 has an interface into the CHPID Mapping Tool, which assists in the 
process of exporting and importing an IODF, and launching the CHPID Mapping Tool. It also 
creates an IOCP statements file and transfers the file to your workstation and from your 
workstation back to the host.

You need to be logged on to HCM and using the “work” IODF that contains the server 
requiring processing by the CMT. You also need to have the CHPID Mapping Tool installed 
on the same workstation. 

To use the tool, select: Utilities → CHPID Mapping Tool Support

Figure 2-1 shows the following options:

� Export IOCP File for the CHPID Mapping Tool (CMT)

� Launch the CHPID Mapping Tool (CMT)

� Import IOCP File from the CHPID Mapping Tool (CMT)

Note: Always check IBM Resource Link Web site to verify that you have the latest version 
of the CHPID Mapping Tool installed.
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Figure 2-1   HCM - CHPID Mapping Tool Support

2.1.5  Input/Output Configuration Program

ICP IOCP Version 2 Release 1.0 is required to support 2097 model CPCs and coupling over 
InfiniBand channel paths TYPE=CIB. 

Using ICP IOCP, it is possible to write an IOCDS in preparation for a CPC upgrade. You can 
write an IOCDS to a z9 EC or z9 BC, regardless of whether the operating system supports 
z10 EC: 

� In z/OS or VSE, specify keyword CHECKCPC=NO in the PARM field of the EXEC 
statement.

� In CMS, use option NOCHKCPC. 

The IOCDS cannot be used to power-on reset the CPC until it is upgraded to a 2097.

You can also write an IOCDS when preparing to upgrade to a z10 EC from a z9 EC or a z990.

Note: Though it is possible to define the z10 EC configuration using only IOCP, we 
strongly recommend that you use HCD because of its error detection and management 
features.

Note: IOCP can write an IOCDS in preparation for an upgrade to a CPC for which IBM 
does not offer an upgrade path. The IOCDS will be unusable on the earlier CPC.
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Stand-alone IOCP
Stand-alone IOCP programs now run in a logical partition (LPAR mode). If you are moving 
from a z9 or previous server to a z10 EC server and you are running an earlier operating 
system version not supported on a z10 EC server, you may have to create a stand-alone 
IOCP to start up the new environment. 

Note that z10 EC Support Elements do not have diskette drives and HMCs running Ver 2.10 
do not support diskette drives. To import the IOCP statements using stand-alone IOCP, you 
must copy the IOCP source statements to a USB Flash Memory Drive or FTP it from another 
system on the LAN.

For more details about the changes and requirements for ICP IOCP, refer to Input/Output 
Configuration Program User’s Guide, SB10-7037.

2.1.6  CHPID Mapping Tool 

The CHPID Mapping Tool (CMT) provides a mechanism to map CHPIDs to PCHIDs as 
required on a z10 EC. The CHPID Mapping Tool is optional but we strongly recommend that 
you use the CMT, as opposed to manually mapping the CHPIDs onto PCHIDs. Using the 
CMT provides the best availability recommendations for a particular configuration.

The process flow for a new z10 EC installation is illustrated in Figure 2-2. 

Figure 2-2   z10 EC I/O configuration definition flow for a new install 

To access the CHPID Mapping Tool you must be logged into the Resource Link site:

� Select CHPID Mapping Tool under the Servers column on the Tools page. 

Note: Figure 2-2 illustrates a new build process. When doing an upgrade from a System 
z9, the PCHID values from the System z9 must be retained in the IOCP input to the CHPID 
Mapping Tool.
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Alternatively, you can access it by using the following URL:

https://www-01.ibm.com/servers/resourcelink/hom03010.nsf/pages/chpidmain?Opendocument

For reference, you can also download a PDF version of CHPID Mapping Tool Users Guide, 
GC28-6825.

At the Resource Link site, do the following: 

1. Under Downloads, click CHPID Mapping Tool. You are then given the option of 
downloading either the complete CMT program or a file that upgrades an existing CMT 
program you may already have installed on your workstation.

2. Click the appropriate link and install/upgrade the CHPID Mapping Tool program.

I/O Configuration Data (Customer Control Number - CCN)
The Customer Control Number (CCN) is generated by your IBM Customer Representative 
when building your configuration order. This number is entered into Resource Link in order to 
download a CFReport file, which is used as input into the CHPID Mapping Tool. Ensure that 
you have the most current CCN that incorporates any change that may have been made to 
your z10 EC order.

To enter the CCN and download the CFReport, under Servers in the Tools panel:

1. Select CHPID Mapping Tool. Alternatively, you can use the following URL:

https://www-1.ibm.com/servers/resourcelink/hom03010.nsf/pages/chpidmain?Opendocument

2. Under Downloads, click I/O Configuration Data (CCN). This takes you to the CFReport 
download page, where you can enter your Customer Control Number. 

At the CFReport download page, do the following:

1. Enter your 8-digit CCN in the panel, then click Submit.

You are prompted to save the nnnnnnnn.CFR file to your workstation.

2. Save the nnnnnnnn.CFR file for later input into the CHPID Mapping Tool.

If you have any problems or require more information, click Help about CFReport 
download.

Availability Mapping
When planning and configuring the z10 EC server, you must plan for maximum server and 
device availability in the event of a channel failure or multiple channel failures. 

To help you configure z10 EC to ensure maximum availability based on the characteristics of 
the server, the CHPID Mapping Tool has an Availability Mapping option that assigns channel 
paths to avoid a single point of failure. You also have the option of switching to manual 
mapping if desired. In addition, you can map CHPIDs with the availability option and manually 
make changes afterwards.

When using the availability option, you must first provide a copy of the system’s IOCP source. 
Then, via the CHPID Mapping Tool, define priorities for the control units. The CMT can assign 
CHPIDs to the I/O ports and produce a new CHPID report that has maximum availability. This 

Note: Always verify that you have the latest version of the CHPID Mapping Tool installed 
on your PC. 
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is achieved by distributing channel paths across different channel cards and different Host 
Channel Adapters (HCAs) or on previous servers, the STI links.

The PCHIDs are fixed on the z10 EC and CHPIDs are mapped by the CMT and assigned in 
the IOCP deck. The output from the CMT consists of tailored reports for your reference and 
for the IBM service representative. 

There is also an IOCP deck with PCHIDs mapped to CHPIDs by CSS. This IOCP is migrated 
back into HCD and a production IODF can be built.

Machine information
To access any of the machine information, you need to have your IBM ID authorized. This 
can be done under the line Register for machine information on the Machine information Web 
page, as follows:

� Under Servers in the Tools panel, click Machine information. Alternatively, you can use 
the following URL:

https://www-01.ibm.com/servers/resourcelink/hom03010.nsf/pages/machineinformation?OpenDo
cument

� Click View all machines.

If none of your servers are accessible, then you need to request access via your IBM 
Customer Representative. Profiling is done against your Customer Number, so ensure you 
have it available before you register for Machine information.

If your IBM ID is registered with your Customer Name and Number, then you are presented 
with a list of servers that have been profiled against your Customer Number. Do the following: 

� Click the Serial Number of the server you are inquiring about.

Reports that are available include information about Customer data, System status, RC/MCL, 
CHPIDs, and MES. 

2.2  Hardware Management Console (HMC)

The Hardware Management Console communicates with each Central Processor Complex 
(CPC) through the CPC’s Support Element (SE). When tasks are performed at the Hardware 
Management Console, the commands are sent to one or more support elements, which then 
issue commands to their CPCs. CPCs can be grouped at the Hardware Management 
Console so that a single command can be passed along to as many as all of the CPCs 
defined to the Hardware Management Console. One Hardware Management Console can 
control up to 100 support elements and one support element can be controlled by 32 
Hardware Management Consoles.

Note: The IOCP deck that is produced from the CHPID Mapping Tool must be migrated 
back into HCD. It cannot be used directly by IOCP. Any attempt to use the IOCP source 
created by the CHPID Mapping Tool in the IOCP program will fail. 
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Figure 2-3   HMC workplace - CPC details

Starting with HMC Version 2.9.0 the Hardware Management Console application offers only 
one type of access, called full function remote access. This single type of access provides the 
full complement of tasks and functions to all users. Using an HTML-based user interface and 
a supported Web browser, a remote user operates in exactly the same manner as a local 
user working at the HMC itself.

Note that even though the same user interface is used locally and remotely, the sets of tasks 
available to local and remote users are not completely identical. For example, the Format 
Media task is only available to a local user since it involves inserting the media into a physical 
HMC drive. 

While global enablement of remote access is controlled through the Customize Console 
Services task as shown in Figure 2-4, individual user level remote access enablement is 
managed using the user profiles console actions task.

Figure 2-4   Enablement of remote operation

The console services can be customized as follows:

Remote operation: Use this service to control whether this Hardware Management Console 
can be operated from a remote workstation.

LIC change: This must be enabled to allow this console to change IBM Licensed Internal 
Code (LIC) on its defined Central Processor Complexes (CPCs) and their support elements.
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Optical error analysis: Use this service to control whether this Hardware Management 
Console analyzes and reports optical problems for its defined objects.

CIM management interface: Controls whether this Hardware Management Console can be 
remotely managed using the Common Information Model (CIM) interface.

Individual user remote access enablement is accomplished by selecting the Allow remote 
access via the web check box on the User Properties panel, as shown in Figure 2-5. For a 
new user profile this box is unchecked by default.

Figure 2-5   User Properties panel

Lightweight Directory Access Protocol (LDAP) support (see Figure 2-6) for Hardware 
Management Console user authentication allows a Hardware Management Console to be 
configured to use an LDAP server to perform user ID and password authentication at logon. 
The user ID is defined on the Hardware Management Console along with the roles to be 
given to the user ID. Hardware Management Console settings related to the user ID will 
continue to reside on the Hardware Management Console, and the LDAP directory will be 
used to authenticate the user, thus eliminating the need to store the user ID’s password 
locally. Both SSL and non-SSL connections to the LDAP server are supported. 
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Figure 2-6   LDAP server authentication

Network security
Network security is an important concern. To help meet this challenge, the HMC is configured 
with a firewall to limit network access in and out of the system. By default, no external 
connections are allowed through the firewall, although modifications to the configuration can 
be made.

The Customize Network Settings allows a user to alter the firewall setup for a specific set of 
applications defined by HMC. This is one of the Hardware Management Console Settings 
tasks, and it is not available to all users without permission.

As can be seen in Figure 2-7, there are four tabs on the Customize Network Settings panel. 
The tabs and customizable settings are as follows:

� Identification: The console name (the short host name), domain name (an entry here, 
together with the console name value, yields the long host name), and a console 
description.

� LAN Adapters: Contains a summarized list of all LAN adapters. From there, you can view 
and change addressing, routing, and other characteristics of this LAN to be changed.

� Name Services: Contains DNS and Domain Suffix values, which you can remove and 
add.

� Routing: Contains routing and default gateway information, which you can modify.

 

 

 

Chapter 2. Configuration planning 29



 

Figure 2-7   Customize Network Settings

Since access to the HMC is provided via an HTML-based user interface, current 
browser-based encryption mechanisms are employed for enhanced security. All remote 
browser access to HMC must use Secure Sockets Layer (SSL) encryption. Only the local 
user interface can use non-encrypted access, since that is inherently a secure environment.

With SSL encryption required for all remote access to the HMC, a certificate is required to 
provide the keys used for this encryption. As shipped, the HMC provides a self-signed 
certificate that allows this encryption to occur.

Customers wishing to manage the certificates used on their HMCs can do so through the 
Certificate Management task, shown in Figure 2-8. This task provides the capability of getting 
information about the certificates used on the console, and it allows you to create a new 
certificate for the console, change the property values of the certificate, and work with existing 
and archived certificates or signing certificates.

Figure 2-8   Certificate management panel

2.2.1  Hardware Management Console Application V2.10.0 

The z10 EC server comes with a new version of Hardware Management Console (HMC). 

New features include:

� Support for USB flash memory drive, due to the removal of the diskette drive.
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� Additional help information can be viewed from the file descriptor area for each task 
window.

� The tree-style user interface is now the default user interface for all user IDs except the 
default SERVICE user ID or any user IDs assigned service roles.

� IPv6 support, providing additional support for the following tasks:

a. Customize API settings

b. Customize network settings

c. CPC details

� The details window includes a Busy status tab specifying why an object is busy.

There are two ways to access the new HMC application. Both methods access the HMC via a 
Web browser.

The first method is from the HMC workstation itself. When the HMC is initialized, a Web 
browser automatically starts up and displays a welcome panel and a link to the logon 
panel (Figure 2-9). The second method is via a Web browser on any workstation that has 
connectivity to the operations LAN where the HMC is installed. In the browser address bar, 
you point to the IP address or URL of the HMC. 

Figure 2-9   HMC Welcome panel

Click Log on and launch the Hardware Management Console web application. A valid 
user ID and password are needed to proceed with the logon. There is no difference whether 
you log on via the local HMC or via a Web browser from a remote workstation; the same 
logon panel is displayed in both cases (Figure 2-10).

Note: The Support Element shipped with the z10 EC runs Support Element Console 
application V2.10.0 which allows for the tree style user interface.
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Figure 2-10   HMC application Web browser logon window

After successfully logging on, you can enter the HMC application. Depending on the access 
level granted to your user ID, you can perform all functions that were available to you on 
previous HMCs. 

The main difference is that you can now access the HMC application from a workstation with 
a Web browser, and do not have to go to the HMC workstation to access the HMC 
application. 

Two options are available for the user interface: the classic view and the tree style, with the 
tree style user interface being the default view.

In this book we used the tree style view for all HMC window examples. This interface provides 
“drill down” and “launch in context” capabilities, as shown in Figure 2-11 and Figure 2-12.

Figure 2-11   HMC - Tree view (example 1)
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Figure 2-12   HMC - Tree view (example 2)

HMC application 
There is no direct interface to the HMC application except for the Web browser. Even when 
working from the local HMC workstation, you only access the HMC application via a Web 
browser. The HMC embedded operating system contains an HTTP server that enables 
access to the HMC application V2.10.0 through a Web browser. 

To access the HMC from a remote workstation, the workstation needs to have TCP/IP 
connectivity to the operations LAN where the HMC is installed. At least one workstation with 
the HMC application V2.10.0 is required to control and operate a z10 EC server. 

Multiple users can access the HMC concurrently from remote workstations. Users need only 
a supported Web browser installed on their workstations. Supported Web browsers include:

� Internet Explorer® 6.0 or later
� Mozilla 1.6 or later
� Firefox 1.0 or later
� Netscape 7.1 or later
� Opera 8.0 or later

HMC Application V2.10.0 uses pop-up windows, so ensure that you have pop-ups enabled in 
your Web browser. Otherwise, the HMC application will not function correctly. 

Each time you perform a task or display, the result is presented to you in a new window.

Note: A connection to the HMC Web server uses SSL encryption. A user public key 
certificate must be supplied with a new HMC installation. All browser connections to an 
HMC require a user ID and password. 
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Previously, when displaying hardware messages, you had to “scroll through” using the scroll 
buttons on the bottom right-hand side of the HMC panel. After you found the option, you 
would highlight the CPC by clicking it once, then double-clicking the Hardware Messages 
icon. Alternatively, you could “drag and drop” the CPC image on hardware messages. Those 
options still work, but now you have a new way to perform such tasks.

As previously mentioned, the HMC runs as a closed application. No other applications (such 
as the Sysplex Timer® console software) can be installed on the HMC. Also, the formatting 
capabilities of the underlying operating platform that make use of removable media are not 
available to the user. A new console actions task, Format Media, is provided. It is available to 
a local user only.

Figure 2-13   HMC, Format media

Refer to the Hardware Management Console Operations Guide Version 2.10.0, SC28-6867 
for a complete description of the functions available. The Resource Link Web site also 
provides an online tutorial for the HMC application. Select the Education tab and follow the 
links to the HMC tutorial.

2.2.2  Remote Support Facility (RSF)

The Hardware Management Console Remote Support Facility (RSF) provides 
communication to a centralized IBM support network for hardware problem reporting and 
service. The types of communication provided include:

� Problem reporting and repair data 
� Fix delivery to the service processor and Hardware Management Console 
� Hardware inventory data 
� On Demand enablement (optional) 

You can configure the Hardware Management Console to send hardware service related 
information to IBM using a dialup connection over a modem or using an Internet-based 
connection. The advantages of using an Internet connection include: 

� Significantly faster transmission speed

� Ability to send more data on an initial problem request, potentially resulting in more rapid 
problem resolution 

� Reduced customer expense (for example, the cost of a dedicated analog telephone line)

� Greater reliability

Unless your enterprise’s security policy prohibits any connectivity from the Hardware 
Management Console over the Internet, an Internet connection is recommended.
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The following security characteristics are in effect regardless of the connectivity method 
chosen:

� Remote Support Facility requests are always initiated from the Hardware Management 
Console to IBM. An inbound connection is never initiated from the IBM Service Support 
System.

� All data transferred between the Hardware Management Console and the IBM Service 
Support System is encrypted in a high-grade Secure Sockets Layer (SSL) encryption.

� When initializing the SSL encrypted connection the Hardware Management Console 
validates the trusted host by its digital signature issued for the IBM Service Support 
System. 

� Data sent to the IBM Service Support System consists solely of hardware problems and 
configuration data. No application or customer data is transmitted to IBM.

If both types of connections are configured, the Internet will first be tried, and if this fails, then 
the modem is used.

Internet connectivity
When an internet connection is used, the Hardware Management Console can be configured 
to use a second network card to physically separate a private LAN connection from the 
Internet-enabled network. The Hardware Management Console can be enabled to connect 
directly to the Internet (Figure 2-14) or to connect indirectly from a customer-provided proxy 
server (Figure 2-15 on page 36). The decision about which of these approaches works best 
for your installation depends on the security and networking requirements of your enterprise. 

All the communications are handled through TCP sockets initiated by the Hardware 
Management Console and use a high-grade SSL to encrypt the data that is transmitted. The 
destination TCP/IP addresses are listed in Table 2-3.

Table 2-3   IBM Support Center server address list

Figure 2-14   Direct Internet connection

America Non-America

129.42.160.48 129.42.160.48

129.42.160.49 129.42.160.50

207.25.252.200 207.25.252.200

207.25.252.204 207.25.252.205

Note: HTTPS port 443 is used for all communications.
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If your Hardware Management Console can be connected to the Internet, and the external 
firewall can be set up to allow established TCP packets to flow outbound to the destination 
addresses, you can use a direct Internet connection. The use of Source Network Address 
Translation (SNAT) and masquerading rules to mask the Hardware Management Console’s 
source IP address are both acceptable. 

Figure 2-15   Indirect Internet Connection with a proxy server

If your installation requires the Hardware Management Console to be on a private network, 
you may be able to use an indirect Internet connection using an SSL proxy, which can 
forward requests to the Internet. One of the other potential advantages of using an SSL proxy 
is that the proxy may support logging and audit facilities. To forward SSL sockets, the proxy 
server must support the basic proxy header functions (as described in RFC 2616) and the 
CONNECT method. Optionally, basic proxy authentication (RFC 2617) can be configured so 
that the Hardware Management Console authenticates before attempting to forward sockets 
through the proxy server.

Configuring outbound connections
At a high level, the following procedures are used to configure outbound connections:

1. Customize customer information

2. Configure remote services

3. Customize outbound connectivity

4. Customize network settings

5. Customize console services

Details for these procedures are provided in the following section.

Step by step procedures for configuring RSF connection 
The procedures detailed in this section enable the HMC to connect to the RSF with a direct 
Internet connection as well as a dial out modem connection, used for backup purposes. The 
Internet connection will be used as the default.

Note: All of the steps needed to configure outbound connectivity require customer 
approval.
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Configuring dial out modem connection
Begin at the Hardware Management Console Settings panel, and perform the following steps:

1. Select Customize Customer Information. 

– Enter Administrator information.
– Enter System information.
– Enter Account information.

Close the pop-up window.

Completing these entry fields for each managed system allows your service structure to 
record necessary contact information.

2. Select Configure Remote Services.

Remote service is two-way communication between the console and the IBM Service 
Support System (commonly known as RETAIN®) for the purpose of conducting 
automated service operations. Using remote service reduces the operator interaction 
needed to complete some service operations and provides some console tasks with 
another source or destination for sending or receiving service information.

In the pop-up window (Figure 2-16), select:

– Enable remote service requests. If it is not selected remote service is disabled. 
Disabling remote service does not prevent the console from detecting and analyzing 
problems. The console will still issue hardware messages to notify console operators of 
problems. 

– Authorize automatic service call reporting. If this feature is selected the console 
automatically reports problems and requests service.

If service is required to correct a problem, its hardware message will include instructions 
for calling a customer service center to report the problem and request service.

Figure 2-16   Customize Remote Service

Click OK to close the window.

3. Select Customize Outbound Connectivity.

In the pop-up window (Figure 2-17), select:

– Enable local system as a call-home server. This allows the local Hardware 
Management Console to connect to your service provider’s remote support facility for 
call-home requests.

– Click Allow dialing using the local modem.
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Figure 2-17   Dial out connectivity

4. Click Modem Configuration. Select the options to configure your modem (Figure 2-18).

Figure 2-18   Modem settings

– Specify dial type by selecting Tone or Pulse.

– In the Other Settings area, click Wait for a dial tone and Enable speaker. Add a dial 
prefix if required.

– Click OK.

5. Click Add on the Customize Outbound Connectivity window (Figure 2-19).

Figure 2-19   Modem configuration
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6. The Add Telephone Number window is opened (Figure 2-20).

Figure 2-20   Add Telephone Number for outbound dial out

Make the following entries and selections:

– Select a Country or region. 
– Select a State or province.
– Select a local phone number if available.
– Add toll-free numbers if available.
– Add toll numbers last.

Use the Up and Down buttons to move the local number to the top of the list, move the 
toll-free numbers to below the local numbers and place the toll numbers at the bottom of 
the list.

Select a phone number from the table list. Edit the phone number to enable it as a local 
call, if required. Click Add.

7. Test the modem connection (Figure 2-21).
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Figure 2-21   Modem connection completed

– Click Test.

– Click Start in the returned Test Telephone Number panel (Figure 2-22).

Figure 2-22   Test modem connectivity

– When the test is completed successfully, click Cancel.

The outbound modem configuration is now complete. This procedure was done as a backup 
for the preferred method – Internet connection – which is configured using the following 
steps.
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Configuring Internet connection
The first two steps are the same as those for dial out connection; perform steps 1 and 2 as 
described on page 37. Continue with the following steps:
1.

2.

3. Select Customize Outbound Connectivity and click the Internet tab (Figure 2-23).

Figure 2-23   Internet connection tab

Click the Allow use of an existing Internet connection check box; click Test. 

4. The Test Internet panel is displayed (Figure 2-24). Click Start and wait for the results.

Figure 2-24   Test for Internet connection
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If the test completes successfully, click Cancel.

If the test was not successful, or if an SSL Proxy is used, further network settings have to 
be considered. 

5. Select Customize Network Setting, then the Identification tab in HMC Management 
(Figure 2-25). 

Figure 2-25   Customize Network Settings, Identification

Enter the Console name, Domain name, and a brief description.

6. Select the LAN Adapters tab (Figure 2-26). Select one of the adapters.

Figure 2-26   Customize Network Settings, LAN Adapters

7. Click Details to open the LAN Adapter Details panel (Figure 2-27).

Note: To get access to the Customize Network Settings panel you must be logged on 
with an Access Administrator role.

 

 

 

42 IBM System z10 Enterprise Class Configuration Setup



 

Figure 2-27   LAN Adapter Details

Select the IPv4 or IPv6 setting, make the required entries, and click OK. Repeat this 
procedure for the second LAN Adapter if necessary.

8. Select the Name Services tab in the Customize Network Settings panel (Figure 2-28).

Figure 2-28   Customize Network Settings, Name Services

– Click the DNS enabled check box, if required.
– Enter the DNS Server Search Order IP address, if required, and click Add.
– Enter the Domain Suffix Search Order, if required, and click Add.

9. Select the Routing tab in the Customize Network Setting panel (Figure 2-29).
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Figure 2-29   Customize Network Settings, Routing

This information is needed for connecting to RETAIN through the internet. Select the 
Enable ‘routed’ check box only when there is a request. Click New to add routing 
information.

10.Make the appropriate selections and entries on the Route Entry panel (Figure 2-30):

– Route Entry Position
– Route Type
– Destination, Gateway and Subnet mask to match your network requirements
– Adapter

Click OK.

Figure 2-30   Route Entry

11.That opens the Customize Network Settings again. Fill in the Gateway information and 
click OK.
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Figure 2-31   Network Settings Updated

The message SET00001 informs you that the network settings have been successfully 
updated.

Go back to step 8 to check your changed network settings. Remember you have to leave the 
Access Administrator role to go back to the Customize Outbound Connectivity function.

2.2.3  SNMP APIs

SNMP describes management data and the protocols for exchanging that data between 
heterogeneous systems. The protocols include both the description of the management data, 
defined in the Management Information Base (MIB), and the operations for exchanging or 
changing that information. By implementing common protocols, management data can be 
exchanged between different platforms with relative ease.

SNMP defines an architecture that consists of:

�     Network management applications

�     Network management agents and subagents

�     Network elements, such as hosts and gateways

The SNMP application can ask agents for specific information about network elements. 
Conversely, agents can tell the network management application when something happens 
to one or more network elements. The protocol used between the network management 
application and agents is SNMP. 

An SNMP agent can be configured for an HMC to allow other system management 
applications to use Management APIs to the Hardware Management Console Application. 
Enablement of the SNMP APIs is required to support z10 EC features such as the z/OS 
Capacity Provisioning Manager (CPM) or the Active Energy Manager (AEM), to monitor the 
power and thermal data of a z10 EC.

To configure the SNMP agent you must log on to the HMC using the Access Administrator 
role. To enable the SNMP APIs and customize the SNMP agent settings, select HMC 
Management → Customize API Settings. Figure 2-32 shows the Customize API Settings 
dialog, which is used to add SNMP information.

 

 

 

Chapter 2. Configuration planning 45



 

Figure 2-32   Customize API Settings

To allow applications to request information from the HMC a community name must be 
added. Click Add under the Community Names section to specify one or more community 
names to use. 

Figure 2-33 shows the Community Name Information panel that is displayed once you click 
the Add button. The following information is required:

Name: Specifies the community name used to verify that a request for SNMP 
information is valid when a manager makes an SNMP request. 

Address: Specifies the IPv4 or IPv6 internet address. 

Network mask: Specifies a network mask that is logically ANDed with the IP address 
of the manager making an SNMP request. 

Access Type: Specifies the access, read or write, you want to allow SNMP requests. 

Figure 2-33   Community Name Information

Community names and access type are specified by the application. For example, z/OS 
Capacity Provisioning Manager requires a defined community name and read/write access. 
System Director's Active Energy Manager (AEM) requires a defined community name, but 
read access is sufficient.

To allow applications to use SNMP APIs, click Enable SNMP APIs as shown in Figure 2-34. 
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Figure 2-34   Enable SNMP APIs

After the SNMP APIs are enabled, the HMC must be restarted, as indicated by message 
ACT03092, shown in Figure 2-35.

Figure 2-35   ACT03092 message

2.2.4  Connectivity for HMC and Support Element

When planning the HMC and SE connectivity, you have the following elements:

� Four Ethernet cables (about 15 m). These connect to each Ethernet adapter in each SE. 

� An Ethernet switch, automatically ordered.

� An HMC workstation with two Ethernet adapters and an HMC display. 

� An optional modem interface.

The HMC and SE can be used to connect to an external time source (ETS) to maintain time 
accuracy for the connected server if the server time protocol (STP) is used. Details about the 
setup of the STP can be found in Chapter 7.1, “External Time Source setup” on page 306.

A modern view of the connections for the SE and HMC is shown in Figure 2-36.

Note: HMC is not restarted automatically; it must be done manually. It is not possible to 
restart HMC remotely; it must be done directly from the console.
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Figure 2-36   HMC connection System z10 EC and System z9 server to NTP and RSF

HMC Application V2.10.0 also supports the System z9, zSeries, and S/390® servers 
identified in Table 2-4 when at the correct driver and MCL level. 

Table 2-4   HMC back level system support

HMCs and SEs can now communicate using TCP/IP Version 4 (IPv4), TCP/IP Version 6 
(IPv6), or both. It is no longer necessary to assign a static IP address to an SE if it only needs 
to communicate with HMCs on the same subnet. An HMC and SE can use IPv6 link-local 
addresses to communicate with each other. Every IPv6 network interface is assigned a 

Server family Server type  Driver level SE version

z10 EC 2097 73 2.10.0

z9 BC 2096 67 2.9.2

z9 EC 2094 67 2.9.2

z890 2086 55 1.8.2

z990 2084 55 1.8.2

z800 2066 3G 1.7.3

z900 2064 3G 1.7.3

9672 G6 9672/9674 26 1.6.2

9672 G5 9672/9674 26 1.6.2
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link-local IP address. This link-local address is for use on a single link (subnet) and is never 
routed. Two IPv6-capable hosts on a subnet can communicate using link-local addresses, 
without having any other IP addresses assigned. 

2.3  Channel considerations

With the introduction of InfiniBand connectivity for coupling links at the z10 EC, new 
definitions and rules must be considered. The planning necessary to implement them is 
covered in 2.3.7, “Coupling links” on page 58.

There are certain types of channels that are no longer supported on the z10 EC. Some 
feature codes can only be carried over to the z10 EC, but are no longer orderable features. If 
you have critical devices on a channel type that is no longer supported, you must plan to 
make alternative arrangements for connectivity before upgrading to the z10 EC.

This section introduces the connectivity options available on z10 EC. Table 2-5 lists the 
channel types and definitions that are supported on a z10 EC. The system-relevant rules for 
z10 EC are described in detail in subsequent paragraphs.

Table 2-5   Supported channel types and definitions

2.3.1  Parallel channels

The z10 EC does not support the attachment of parallel channels. Using a converter that 
converts ESCON connections to the parallel protocol enables devices with a parallel 
attachment to be used.

Parallel attached devices are connected to a converter, and the converter is connected to an 
ESCON channel defined as CVC or CBY. These channel types have to be defined as 
dedicated or reconfigurable. They cannot be defined as shared or spanned. 

Channel type CHPID definition MIF shared Spanned 

ESCON
CNC, CTC Yes No

CVC, CBY No No

FICON Expressa

a. Feature is only available if carried over by an upgrade from previous server.

FC, FCP Yes Yes

FCV Yes No

FICON Express2a

FICON Express4
FC, FCP Yes Yes

OSA Express2 OSD, OSE, OSC, OSN Yes Yes

OSA Express3 OSD Yes Yes

ICB-4 CBP Yes Yes

ISC-3 CFP Yes Yes

PSIFB CIB Yes Yes

IC (Internal CHPID) ICP Yes Yes

HiperSockets 
(Internal CHPID)

IQD Yes Yes
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2.3.2  ESCON channels

ESCON channel support on a z10 EC is in the form of a 16-port ESCON card (feature code 
2323). The card has 15 ports available for use, while the sixteenth is a spare port for use if 
one of the other ports fails. All ESCON ports in the z10 EC use the industry standard MT-RJ 
connector.

ESCON channels cannot be defined as spanned. They can be defined as MIF-shared in a 
CSS, but can only be configured to one CSS at a time. Within a CSS, they can be defined as 
MIF-shared, reconfigurable, or dedicated (SHR, REC, DED). 

If you have devices like a 2074 console controller, and you plan to use multiple CSSs that 
access the same 2074, then you need to configure an ESCON PCHID in each CSS to access 
the 2074 via an ESCON Director. 

ESCON channels can be configured in one of three ways:

� Point-to-point: In this configuration, an ESCON channel is connected directly to the control 
unit.

� Switched point-to-point: In this configuration, an ESCON channel is connected to multiple 
control units via an ESCON director.

� Switched point-to-point via maximum 2 chained ESCON directors, where at least one 
connection at one ESCON director has to be dedicated. This configuration allows for 
connections over extended distances. 

2.3.3  FICON channels

A z10 EC allows FICON channels to be defined in three ways:

� FICON native mode (FC) 

This type of channel allows for connectivity to control units that have native FICON 
interfaces. This can be done by point-to-point (direct connection), switched point-to-point 
(through a Fibre Channel Director), or cascaded FICON Directors (through two Fibre 
Channel Directors). FC channels can be defined as MIF-shared and spanned; refer to 
Figure 2-37 on page 51.
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Figure 2-37   Supported FICON topologies

� FICON conversion mode (FCV)

This mode allows ESCON devices to be accessed via a FICON Bridge port feature in a 
IBM 9032 model 5 ESCON Director. 

On FICON Express2 or FICON Express4, you cannot define FCV channels. If you wish to 
still use FCV channels, the FICON Express LX cards must be carried over to the z10 EC. 
FCV channels can only be defined as MIF-shared. They cannot be spanned.

� Fibre Channel Protocol mode (FCP) 

This channel type allows for access to FCP devices via a Fibre switch or multiple Fibre 
switches to FCP devices, or via a Fibre switch or multiple Fibre switches to a Fibre 
Channel-to-SCSI bridge. 

The FICON Express4, FICON Express2, and FICON Express provide support for Fibre 
channel and SCSI interfaces in Linux environments. FCP channels can be defined as 
MIF-shared and spanned; see Figure 2-38 on page 52.

Note: The IBM 9032 model 5 director has been withdrawn from marketing, and no 
replacement is available.

Note: IBM intends for System z10 EC to be the last server to support FICON Express 
LX and CHPID type FCV. 
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Figure 2-38   FCP connectivity topologies

2.3.4  Open Systems Adapter (OSA)

The z10 EC supports the OSA Express3 and OSA Express2 features. Depending on the 
specific feature, OSA Express2 can be carried over from a previous server during an upgrade 
or ordered as new features, while the OSA Express3 features are ordered as new features.

The following OSA features are not supported on the z10 EC:

� OSA-2

Can be replaced by the equivalent OSA Express2 feature. This may require a new 
connector. All LAN Channel Stations (LCS) functions are available, that is, you can use 
the OSA Express2 feature in non-QDIO mode and have TCP/IP pass-thru and SNA on the 
same port.

� OSA-2 FDDI 

Can be replaced by a multiprotocol router. The OSA Express3 Gigabit Ethernet or OSA 
Express2 1000BASE-T Ethernet would have an Ethernet connection to the router, and the 
router would perform the FDDI conversion.

� OSA-Express 155 ATM

Can be replaced by an OSA Express2 1000BASE-T Ethernet or OSA Express3 Gigabit 
Ethernet and a multiprotocol router with the appropriate network interfaces.

� OSA-Express Token Ring 

Can be replaced by a OSA Express2 1000BASE-T Ethernet or OSA Express3 Gigabit 
Ethernet and a multiprotocol router with the appropriate network interfaces.
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A typical OSA network could appear as illustrated in Figure 2-39, which shows all the current 
supported OSA connectivity across System z servers.

Figure 2-39   OSA supported connectivity across z Series servers

The OSA Express2 1000BASE-T Ethernet feature can also be used for OSA-Express 
Integrated Console Controller (OSA-ICC). The OSA-ICC provides a system console function 
at IPL time and operating systems support for multiple logical partitions. These can be used 
as a replacement for the 3174 or other console controller or as an additional console 
controller to the 3174 or 2074. The OSA-ICC is a standard feature on the Express2 
1000BASE-T Ethernet feature. It can be used by coding the channel type as OSC in HCD.

The OSA-Express2 Gigabit Ethernet and 1000BASE-T Ethernet features have the capability 
to provide direct (LPAR-to-LPAR) connectivity to the Communication Controller for 
Linux(CCL) on z10 EC with the introduction of the Open Systems Adapter for Network 
Control Program (OSN) CHPID type. When the channel is defined as OSN (OSA-NCP) it can 
be used to replace IBM 3745 control units running NCP. As with OSA-ICC, OSA-NCP is a 
standard feature. In order to exploit this feature for OSA-NCP, you must use a Linux logical 
partition running the appropriate application.

2.3.5  HiperSockets

HiperSockets provide the fastest TCP/IP communications between z/OS, zVM, VSE/VSA, 
and Linux logical partitions on a z10 EC. HiperSockets provide internal “virtual” local area 
networks that act like TCP/IP networks inside a z10 EC. This is achieved by the Licensed 
Internal Code (LIC) and supporting device drivers on the operating systems. It establishes a 
network with higher availability, security, simplicity, performance, and cost effectiveness than 
could be achieved using a external TCP/IP network.

The HiperSockets function, also known as Internal Queued Direct Input/Output (iQDIO), uses 
no physical cabling or external networking connections. Data access is performed at memory 
speeds, bypassing external network overheads and delays.

The HiperSocket is defined as a channel type IQD. It is assigned a CHPID value, but no 
PCHID. When defining an IQD channel, you have to set the maximum frame size in HCD. 
The default is 16 KB, but you can use 24 KB, 40 KB, or 64 KB.

HiperSockets can be defined as MIF-shared in a CSS and as spanned channels across 
multiple CSSs. A HiperSocket CHPID can be seen as an “internal LAN” to the server, and the 
level of sharing is determined by the logical partitions you wish to grant access to that LAN.
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HiperSockets supported functions on a z10 EC include the following: 

� HiperSockets Broadcast support on Internet Protocol version 4 (IPv4) for applications

Applications using the broadcast function can propagate the broadcast frames to all 
TCP/IP applications that are using the HiperSockets.

� VLAN support for HiperSockets in a Linux environment

VLANs can reduce overhead by allowing networks to be organized by traffic patterns and 
not physical locations. This allows for traffic flow over HiperSockets and between 
HiperSockets and OSA Express features.

� IP version 6 support on HiperSockets

2.3.6  PSIFB links

IBM System z10 Enterprise Class  servers benefit from the high speed and low latency 
offered by InfiniBand technology. It provides improved reliability, scalability, and performance, 
which is important for both Parallel Sysplex and I/O interconnectivity.

InfiniBand is a point-to-point interconnect architecture developed to satisfy contemporary 
requirements for higher bandwidth and ability to scale with increasing bandwidth demand. 
Each individual link is based on a two-fiber 2.5 Gbps bidirectional connection for an optical 
(fiber cable) implementation or a four wire 2.5 Gbps bidirectional connection for an electrical 
(copper cable) implementation, called a physical lane. Each lane supports multiple transport 
services for reliability and multiple prioritized virtual communication channels. Physical lanes 
are grouped together in support of a single physical lane (1X), 4 physical lanes (4X), 8 
physical lanes (8X), or 12 physical lanes (12X).

InfiniBand currently defines several link speeds at the physical layer. It negotiates the use of:

� Single Data Rate (SDR) delivering 2.5 Gbps per physical lane

� Double Data Rate (DDR) delivering 5.0 Gbps per physical lane

� Quadruple Data Rate (QDR) delivering 10.0 Gbps per physical lane

Combining the link speeds with the interface widths gives the link or signalling rates as shown 
in Table 2-6.

Table 2-6   Interface width and link ratings

I/O interconnectivity on z10 EC 
The connectivity to the I/O cages (I/O domains) in the IBM System z10 Enterprise Class  is 
supported by InfiniBand technology, which provides a data rate of 6 GBps.

For the IBM System z10 Enterprise Class  an HCA2-C fanout in the front of a book connects 
via an IFB copper cable to the IFB-MP card in the I/O cage. As shown in Figure 2-40, there is 
a passive connection in the IFB-MP to provide the redundancy for the I/O interface. This 
allows for concurrent repairs against the cabling, the HCA-2C fanout, or the book. The use of 

Width Single Data Rate Double Data Rate Quadruple Data Rate

1X 2.5 Gbps 5.0 Gbps 10 Gbps (1 GBps)

4X 10.0 Gbps (1 GBps) 20.0 Gbps (2 GBps) 40 Gbps (4 GBps)

8X 20.0 Gbps (2 GBps) 40.0 Gbps (4 GBps) 80 Gbps (8 GBps)

12X 30.0 Gbps (3 GBps) 60.0 Gbps (6 GBps) 120 Gbps (12 Gbps)
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InfiniBand for the I/O interconnectivity is entirely internal to the z10 EC and requires no further 
planning or actions.

Figure 2-40   Dataflow for a disconnected I/O interface link

InfiniBand coupling links 
On the IBM System z10 Enterprise Class  2x IB-DDR is the high-speed link used to connect 
either two IBM System z10 Enterprise Class  units together, or a System z10 EC to a System 
z9, in a point-to-point coupling link. The HCA2-O fanout is installed in a fanout slot in the front 
of the book. The fanout has two optical MPO ports and the order increment for the HCA2-O 
fanout is always one complete fanout with both links enabled.

The connection is realized by connecting the HCA2-O to the other systems’ IFB fanouts 
(either an HCA1-O for a System z9 or an HCA2-O for a z10 EC) via a 50 micron OM3 (2000 
MHz-km) multimode fiber. In the cable are 12 lanes (two fibers per lane, one each for transmit 
and receive) which yields 24 fibers in total. The maximum supported length for these 
connections is 150 meters (see Figure 2-41).
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Figure 2-41   InfiniBand coupling link connectivity for z10 

A System z9 with PSIFB feature installed can only be a standalone Coupling Facility. 

Adapter ID (AID) assignment 
The AID is a number between 00 and 1F assigned to every PSIFB fanout at installation time. 
It is unique for the system. There is only one AID per fanout assigned so that both ports on 
the fanout share the same AID. In the IOCP the AID must be used to connect the physical 
location of the fanout with the logical assigned CHPID. For assignment and handling, the AID 
is bound to the serial number of the fanout. If the fanout is moved, the AID moves with it, so it 
is not necessary to readjust the IOCDS. For new system builds or newly installed books, the 
AID can be determined from Table 2-7.

Table 2-7   Initial AID number assignment

Note: IBM has announced a Statement of Direction to support PSIFB links on general 
purpose System z9 EC and BC servers. When that support is made available, System z9 
servers with general purpose processors, IFLs, zAAPs, or zIIPs will be able to utilize 
12x IB-SDR links. Currently, 12x IB-SDR links are available on System z9 servers that 
have only ICF processors.
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Depending on the System z10 model the plugging rules for fanouts vary, but the IBM 
configuration tool takes care of the allocation. The assignments of the AIDs are found in the 
PCHID Report for new servers or MES upgrades, as well as in HMC/SE panels after 
installation. Refer to “Sample PCHID REPORT showing AID assignments” on page 62 for an 
example of a PCHID Report.

A maximum of 16 HCA2-O fanouts are supported on a IBM System z10 Enterprise Class , 
which provide a total of 32 ports. Nevertheless, the maximum value of 64 coupling link 
CHPIDs per system is still valid – including IC, ICB-4, active ISC-3, and PSIFB types. It is 
possible to define up to 16 CHPIDs per fanout, which can be freely distributed across both 
links. Note that the PSIFB CHPIDs can be shared or spanned across logical partitions on z10 
servers. However, the number of coupling CHPIDs must not exceed the maximum of 64.

PSIFB links and STP 
PSIFB links are also valid to pass time synchronization signals using Server Time Protocol. 
Therefore the same coupling links can be used to exchange timekeeping information and 
Coupling Facility messages in a Parallel Sysplex.

STP provides a coordinated time source for systems connected via coupling links. It replaces 
the Sysplex Timer as a time source for interconnected systems. STP utilizes coupling links to 
transmit time signals between interconnected systems. PSIFB links are supported for STP 
timing signals between systems that support PSIFB, including timing-only links where 
required. Coexistence with other types of coupling links used for STP is also supported. For 
additional information refer to Server Time Protocol Planning Guide, SG24-7280.

Prerequisites 
The implementation of PSIFB links requires a z10 EC system on at least one end of the 
connection. The hardware prerequisites for PSIFB are satisfied by the System z10 EC 
ordering process. Prerequisites for PSIFB links on System z9 are also resolved by the IBM 
ordering process, with the HCA1-O fanout feature (FC0167). Additional HSA will be allocated 
to support the HCA1-O fanout on System z9. After the feature is installed, a POR is required 
to enable the PSIFB links.

PSIFB links are supported by z/OS 1.7 and later releases. At the time of writing, all currently 
available and supported releases will require additional PTFs. The information necessary to 

D7 04 0C 14 1C

D8 05 0D 15 1D

D9 06 0E 16 1E

DA 07 0F 17 1F

Note: The fanout positions D3 and D4 are reserved for FSP cards (Functional Service 
Processor) and cannot be used for fanouts. Also the positions D1 and D2 are not available 
in the books in slots 10 and 15 of an E40 model, and all books of an E56 and E64 model.

Note: It is strongly recommended that between any two servers exchanging STP 
messages, at least two physical coupling links are in use to prevent a single point of failure.
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identify the required service is available in the Preventive Service Planning (PSP) buckets 
named 2094DEVICE and 2097DEVICE for System z10 and z9 respectively. The PSP 
information should be thoroughly reviewed early in the planning process to allow time for 
ordering and installing any necessary software maintenance.

One of the necessary software updates will include changes to Hardware Configuration 
Dialog (HCD). This support is necessary to define the configuration for z10 EC. In addition, if 
PSIFB links are defined between z10 EC and z9 BC or EC systems, a new selection has to 
be made for the processor type defined for the z9. A new support level selection that includes 
the 2094 basic support and CIB is available, see Figure 2-42. Select the option with CIB 
support to enable definition of PSIFB links which require a CHPID type of CIB.

Figure 2-42   HCD processor type support levels for PSIFB

Cable requirements 
The PSIFB link utilizes an industry standard optical fiber cable. However, this cable is new to 
the z10 EC and System z9 environment. The cable for 12x IB-DDR is a 12 fiber pair cable 
(total of 24 optical fibers) of 50 micron multimode optical fiber. You are responsible to provide 
the cable because it is not included with the HCA feature. The maximum cable length for 
PSIFB is 150 meters, which provides more flexibility for physical placement of servers.

The IBM System z10 Enterprise Class  and System z9 environment uses an InfiniBand MPO 
50 micron fiber cable for PSIFB connectivity. It is a 50 micron OM3 (2000 MHz-km) 
multimode fiber cable with MPO connectors. It has one pair of fibers per lane, which yields 24 
fibers in total for a cable used in a 12x connection. Optical cables of different length are only 
used to realize coupling links. The sender and receiver are clearly marked with either RX or 
TX and the connectors are keyed. Also on all FRUs using IFB optical modules the keys are 
facing upward and the Transmitter module (TX) is on the left side and the Receiver module 
(RX) is on the right side.

2.3.7  Coupling links

The z10 EC server supports three types of external coupling links: Parallel Sysplex over 
InfinBand (PSIFB) coupling links, Integrated Cluster Bus-4 (ICB-4) links, and InterSystem 
Channel-3 (ISC-3) links. There is one model-related exception: the 2097-E64 supports only 
PSIFB and ISC-3 (if an ICB-4 feature is required in a four book server model, RPQ 8P2334 
must be ordered). All the supported coupling link types can coexist on a single server and 
between two servers. There are no restrictions on intermixing supported link types.

                          Available Support Levels 
                                                   Row 1 of 3 More:       > 
 Command ===> ___________________________________________________________   
                                                                            
 Select the processor support level which provides the processor            
 capabilities you want to use.                                              
                                                                            
                                                                            
   Support Level                                                            
   XMP, Basic 2094 support                                                  
 / XMP, 2094 support, CIB 

Note: IBM System z10 Enterprise Class  will be the last server to support ICB-4 links.

 

 

 

58 IBM System z10 Enterprise Class Configuration Setup



 

Coexistence 
When implementing PSIFB links the requirements for z10 EC server coexistence must be 
considered. The z10 EC can only coexist with System z9 (EC or BC), z990, and z890 servers 
in a parallel sysplex. Any earlier servers (such as z800 or z900) in the parallel sysplex 
environment must be removed or replaced by a supported server before the z10 EC can be 
added. Figure 2-43 illustrates the supported coexistence environments as well as the types of 
supported coupling links on z10 EC servers. Note that a z10 EC server will support ICB-4 and 
ISC-3 connections, except for the z10 EC E64 model.

PSIFB links are available on z10 EC and System z9 servers. They are used to connect 
z10 EC servers to other z10 EC servers or to connect z10 EC servers to System z9 
stand-alone coupling facility servers. In other words, for a System z9 to have PSIFB features 
installed it can have only Internal Coupling Facility (ICF) processors. If a System z9 has any 
general purpose processors, Integrated Facility for Linux (IFL) processors, System z9 
Application Assist Processors (zAAPs), or IBM System z9 Integrated Information Processors 
(zIIPs) then it is not eligible for the PSIFB features.

When configuring a z10 EC in a Parallel Sysplex configuration, you need to ensure that the 
other servers have the correct channel type and definition to connect to a z10 EC. 

Figure 2-43   Coupling link configuration options and supported coexistence for z10 EC

Note: IBM has announced a Statement of Direction to support PSIFB links on general 
purpose System z9 EC and BC servers. When that support is made available, System z9 
servers with general purpose processors, IFLs, zAAPs, or zIIPs will be able to utilize 
12x IB-SDR links. Currently, 12x IB-SDR links are available on System z9 servers that 
have only ICF processors.
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The channel types that can be defined for coupling links are: 

� ISC-3 in peer mode (CFP): Inter System Channel links are used for data sharing between 
the Coupling Facility and the operating systems connected to the Coupling Facility. They 
are connected point-to-point. ISC-3 coupling links must be defined in peer mode (CFP). 

� ICB-4 in peer mode (CBP): Integrated Cluster Bus channels are used to connect servers 
over short distances, to a maximum of 10 meters (33 feet). 

� PSIFB (CIB): This is a new CHPID type to identify a coupling over IB (CIB) channel path. 
The CHPID can be DED, REC, SHR or SPAN. The link supports point-to-point to up to 
150m.

� Internal Coupling links in peer mode (ICP): Internal Coupling channels are linkless 
connections (controlled by Licensed Internal Code) that do not need any cabling. They 
provide connectivity between a Coupling Facility and logical partitions running on the 
same CPC.

Some high-level configuration guidelines for CIB CHPIDs are as follows: 

� No PCHID can be specified for a CIB channel path. An Adapter ID (AID) and PORT are 
used. 

� A spanned CIB CHPID requires the same AID and PORT to be specified for all channel 
subsystems where it is defined.

� Up to 16 CIB CHPIDs can be defined to the same AID. This is verified at the HCA level, 
meaning all 16 could be defined on one port.

� A combination of CIB, CBP, CFP and ICP CHPIDs are allowed to the same control unit 
(CF image) up to the maximum of eight paths per CU.

� All CIB CHPIDs on a single control unit must have the same connecting system 
(CSYSTEM). This is checked by HCD.

� A CIB CHPID can only be connected to another CIB CHPID.

� All CIB CHPIDs must be connected within HCD/HCM before a production IODF can be 
built.

� A processor that has a connected CIB channel path must have an established local 
system name (LSYSTEM). This is handled by HCD.

� Only CF-capable partitions may be specified in the access or candidate list of a CF peer 
channel path. 

Support for multiple CHPIDs per port 
An important change from previous coupling link technology is the ability to define multiple 
CHPIDs on a single PSIFB port. Each PSIFB fanout has two ports, and 16 CHPIDs can be 
defined across those two ports in any combination. This allows configurations that were not 
possible with previous coupling link implementations. There are multiple reasons for utilizing 
this new support, such as:

� PSIFB links can be shared by multiple sysplexes. If a single System z9 with two z/OS 
logical partitions, each a member of a different parallel sysplex, is connected to another 
System z9 with two CF logical partitions, one for each sysplex, at least two coupling links 
are required. Without PSIFB the two sysplexes cannot share a coupling link. With PSIFB, 
multiple CHPIDs can be assigned to a single physical link, allowing each sysplex to own 

Note: A configuration connecting two CIB CHPIDs within the same system using the 
same AID and port is not supported. The current versions of IOCP/HCD will allow this 
type of configuration, but future versions of IOCP/HCD will prevent such a definition.

 

 

 

60 IBM System z10 Enterprise Class Configuration Setup



 

separate logical coupling links across a single physical PSIFB link. Depending on the 
exact configuration, this may provide for a significant reduction in the number of coupling 
links required. 

For ICB-3, ICB-4, and ISC-3 coupling links, each coupling link CHPID requires a physical 
link (Figure 2-44).

Figure 2-44   Coupling links using ICB-3, ICB-4, ISC-3

For PSIFB links, multiple CHPIDs can share a physical link (up to 16 per adapter). Refer 
to Figure 2-45.

Figure 2-45   Coupling links using PSIFB

� Defining more coupling link CHPIDs provides additional subchannels for CF 
communication. Each peer-mode coupling link CHPID defines seven subchannels 
supporting seven concurrent I/O operations to the coupling facility. If the volume and 
duration of CF accesses is high enough to cause subchannel busy conditions, then 
defining additional CHPIDs may improve CF communication performance. This may also 
provide significant relief when multiple z/OS images on a single machine are sharing a 
coupling link CHPID via Multiple Image Facility (MIF). For heavily utilized systems this is 
often a source of subchannel busy conditions. 

Note: Defining multiple CHPIDs on a single physical PSIFB link does not satisfy the 
recommendation that there be multiple coupling links between coupled systems. 
Multiple physical links, on different HCAs, should be configured to avoid single points of 
failure.
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Adapter ID (AID) and port assignments 
Unlike channels installed in an I/O cage, which are identified by a PCHID number related to 
their physical location, PSIFB fanouts and ports are identified by an Adapter ID (AID). The 
AID is used to define CHPIDs for PSIFB links just as PCHIDs are used to define CHPIDs for 
other types of coupling links. The assignment of AIDs is covered in “Adapter ID (AID) 
assignment” on page 56. 

The AID assigned to an adapter can be found in the PCHID report provided for a new server 
or for MES upgrades on existing servers. This is the same report that provides the PCHID 
information for other types of coupling links. Example 2-1 shows part of a PCHID report for a 
z10 EC model E26. In this example two adapters are installed, one in the first book (location 
06) and the other in the second book (location 15). The adapters are installed in location D6 
in each case. The assigned AID to the adapter in the first book is 0B and the AID assigned to 
the adapter in the second is 1B.

Example 2-1   Sample PCHID REPORT showing AID assignments

CHPIDSTART
  19756694                      PCHID REPORT                       Dec 16,2007
  Machine: 2097-E26  SNxxxxxxx
  - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - 
  Source           Cage  Slot  F/C    PCHID/Ports or AID              Comment   
  06/D6            A25B  D606  0163   AID=0B                                    

  15/D6            A25B  D615  0163   AID=1B                                    

LSYSTEM, CSYSTEM and CPATH 
A local system name (LSYSTEM in the IOCP) is required on every server that will use PSIFB 
links. The LSYSTEM unique keyword is on the ID statement. The local system name is used 
by the CPC to identify itself when establishing a coupling facility connection using CIB 
channel paths. When the local system name is not present, it will default to the CPC name. 
We recommend using the same CPC name specified for the processor on the Hardware 
Management Console. This will help to avoid naming conflicts. 

CSYSTEM is on the CHPID statement. This is the name of the system with which this CHPID 
is going to connect. That is, the name given the attached system by the just mentioned 
LSYSTEM value in the IOCP. 

The CPATH is also defined on the CHPID statement. The value of this keyword, similar to 
ICP, identifies the CSS and CHPID on the connecting system (CSYSTEM) to which this 
channel path is to communicate. The CPATH keyword is valid only for ICP and CIB channel 
paths and is required for all ICP and CIB definitions. An ICP or CIB channel path must 
connect to another channel path of the same type and can connect to only one path. A 
channel path cannot connect to itself. The CPATH keyword has extra syntax rules when the 
connected channel paths belong to the same CPC (that is, they are internal connections). 
Channel paths cannot connect to each other if they both have candidate lists with the same, 
single logical partition. Note that this prevents the definition of ICP and CIB channels in a 
configuration with only one logical partition. 

Note: When a PSIFB HCA is moved from one slot location on a processor book to another, 
the AID moves as well (the AID is retained). 
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PSIFB link 
A PSIFB link connects a port on a host channel adapter (HCA) via a physical cable to the 
equivalent one on a different server. The z10 EC supports up to 64 coupling link CHPIDs. The 
maximum number of coupling links allowed for each type is summarized in Table 2-8. 

Table 2-8   Maximum number of coupling links supported 

The maximum number of coupling links in a particular server is affected by factors including 
the number of I/O cages and books installed.

It is important to note that the maximum number of coupling links and the maximum number 
of CHPIDs defined are both 64. Defining IC links, and defining multiple CHPIDs over the 
installed PSIFB ports, may cause the limit on the number of CHPIDs to be reached well 
before the maximum number of physical links. While these maximums have not changed, 
they must be considered when planning to utilize the flexibility allowed by the PSIFB links.

CIB CHPIDs can be shared or spanned across logical partitions and channel subsystems on 
z10 EC and System z9 servers.

2.3.8  Configuration rules

Table 2-9 summarizes the maximum number of CHPID types supported on System IBM 
System z10 Enterprise Class .

Table 2-9   IBM System z10 Enterprise Class  maximum number of supported channels

Coupling link type Order Increment z10 EC Maximuma

a. Maximum combined coupling link types and defined CHPIDs is 64.

IC n/a 32

ICB-4 1 port 16

ISC-3 1 link 48

PSIFB 2 ports (1 HCA) 32 (16 HCAs)

Maximum channel paths (CHPID type) z10 EC

Channel paths (total) 1024a

CVC, CBY, CNC, CTC 1024a

a. Model E12 supports a total of 960 channel paths only.

FCVb, FC, FCP

b. Only available if FICON Express is carried over on an upgrade (max. CHPID 120).

336

OSDc, OSE,OSC, OSN

c. If OSA Express2 10 GbE LR is carried over on an upgrade the max. CHPID is 24.

48

CFP, CBP, ICP, CIB combined 64

CFP 48

CBP 16

ICP 32

CIB 32

IQD 16
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The following configuration rules are implemented and enforced using the Hardware 
Configuration Definition (HCD) and Input Output Configuration Program (IOCP).

All control units and I/O devices that attach to the server must be defined to the channel 
subsystem. When defining the I/O configuration for the server CSS via HCD/IOCP, you need 
to specify:

� For logical partitions, the logical partition name, CSS ID, and MIF ID

� Channel paths and their assignment to CSSs and logical partitions

� ESCON or FICON Director, where appropriate

� Control units attached to the channel paths

� I/O devices assigned to the control units

Table 2-10   IBM System z10 Enterprise Class  server attributes

When assigning channels, you must consider if you want to have certain types of channels 
defined as spanned. This means that some channels can access multiple CSSs. This takes 

Attributes z10 EC

Maximum configurable
Physical Control Units
(PCUs)

per CVC, CBY 48

per OSD 16

per OSE, OSC, OSN 1

per CFP, CBP, ICP, CIB 1

PCUs or link addresses per CNC, CTC 120

PCUs or link addresses per FCVa, FC

a. FCV channel paths can have link addresses in the range 01 - FE, and therefore have a 
maximum of 254 link addresses.

256

per FCP 1

per IQD 64

Maximum 
configurable
devices

per CFP, CBP, ICP, CIB 256

per CNC 1024

per CTC 512

per OSE 255b

b. 240 valid subchannels can be used 

per OSC 254c

c. 120 valid subchannels can be used

per OSD channel path with priority specification disabled 1920

per OSD channel path with priority specification enabled 480

per OSN (UNIT=OSN devices or subchannels) 480

per OSN (UNIT=3745 devices or subchannels) 180

per FCP 480

per FCV, FC 16K

for all IQD channel paths 12K
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the MIF concept of sharing channels across logical partitions to sharing channels across 
logical partitions and CSSs. 

A channel is considered spanned when its CHPID number in all CSSs is the same, and it is 
assigned to the same PCHID or AID. A spanned channel is defined with OPERATION 
MODE=SPAN in HCD; see Figure 2-46.

Figure 2-46   HCD - Define spanned channels

_____________________________ Add Channel Path ______________________________
e Specify or revise the following values.                                    
Processor ID . . . . : SCZP201                                               
Configuration mode . : LPAR                                                  
Channel Subsystem ID : 1                                                     
Channel path ID  . . . . 80    +            PCHID . . . 1B0                  
Number of CHPIDs . . . . 1                                                   
Channel path type  . . . FC    +                                             
Operation mode . . . . . SPAN  +                                             
Managed  . . . . . . . . No   (Yes or No)   I/O Cluster ________  +          
Description  . . . . . . ________________________________                    
Specify the following values only if connected to a switch:                  
Dynamic entry switch ID  __  + (00 - FF)                                     
Entry switch ID  . . . . __  +                                               
Entry port . . . . . . . __  +                                               
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Chapter 3. MES upgrade from System z9 EC 
to z10 EC

In this chapter we describe how to upgrade an existing System z9 EC to a z10 EC.

You can also upgrade from a z990 to a z10 EC; however, only examples of upgrading or 
replacing a System z9 EC are shown in this book. An upgrade includes all frames, cages, 
support cards and new I/O features.

Because a wide variety of environments exist, the results achieved in your environment may 
differ from those described here. Nevertheless, the step-by-step process we explain in this 
chapter should provide enough information for you to replicate the approach in your own 
environment. 

We discuss the following topics:

� Scenario overview

� HCD - Migrate the existing 2094 IODF

� Save configuration files

� Validate the 2097 work IODF

� CHPID Mapping Tool actions

� HCD - Update the 2097 work IODF with PCHIDs

� HCD - Build the 2097 production IODF

� Load the 2097 processor IOCDS

� HMC steps for activation profiles

3
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3.1  Scenario overview

We begin by providing an overall description of this scenario.

3.1.1  The configuration process
Figure 3-1 illustrates the general process flow that we follow in our example. The numbered 
steps are described following the figure.

Figure 3-1   CMT - Overall process flow

1. When planning to migrate to a z10 EC, the IBM Technical Support team can help you to 
define a configuration design that meets your needs. The configuration then gets passed 
to the ordering step.

2. The IBM order for the configuration is created and passed to the manufacturing process.

3. The manufacturing process creates a configuration file that is stored on the IBM Resource 
Link Web site. This configuration file describes the hardware being ordered. This data is 
available for download by the client installation team.

4. The existing System z9 EC I/O configuration is used as a starting point into HCD. The 
System z9 EC production IODF is used as input to HCD to create a work IODF that will be 
the base to define the new z10 EC configuration. 
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5. When the new z10 EC configuration has been added and the obsolete hardware has been 
deleted, a validated version of the configuration is saved in a 2097 validated work IODF. 

6. From the validated work IODF, create a file containing the z10 EC IOCP statements. This 
IOCP statements file is transferred to the workstation used for the CHPID Mapping Tool 
(CMT). HCM may also be used here to transfer the IOCP deck to and from the CMT.

7. The configuration file created by the IBM Manufacturing process in step 3 is downloaded 
from Resource Link to the CMT workstation.

8. The CHPID Mapping Tool uses the input data from files to map logical channels to 
physical ones on the new z10 EC hardware. 

You might have to make decisions in response to situations that might arise, such as:

a. Resolving situations in which the limitations on the purchased hardware cause a single 
point of failure (SPoF). You may need to purchase additional hardware in order to 
resolve some SPoF situations.

b. Prioritizing certain hardware items over others.

After processing by the CHPID Mapping Tool, the IOCP statements contain the physical 
channels assignment to logical channels, based on the actual purchased hardware 
configuration. 

The CHPID Mapping Tool also creates configuration reports to be used by the IBM service 
representative and the installation team. 

9. The file containing the updated IOCP statements created by the CHPID Mapping Tool,   
which now contains the physical channels assignment, is transferred to the host system.

10.Using HCD again, and using the validated work IODF file created in step 5 and the IOCP 
statements updated by the CHPID Mapping Tool, apply the physical channel assignments 
done by the CMT to the configuration data in the work IODF. 

After the physical channel data has been migrated into the work IODF, a 2097 production 
IODF is created and the final IOCP statements can be generated. The installation team 
uses the configuration data from the 2097 production IODF when the final power-on reset 
is done, yielding a z10 EC with an I/O configuration ready to be used. 

If you are upgrading an existing 2094, you may be able to use HCD to write an IOCDS to your 
current 2094 in preparation for the upgrade. If you can write an IOCDS to your current 2094 in 
preparation for upgrading it to a 2097, do so and let the IBM service representative know 
which IOCDS to use. 

If the 2094 is not connected using a LAN to the CPC where HCD is running, or if you are not 
upgrading or cannot write an IOCDS in preparation for the upgrade, use HCD to produce an 
IOCP input file and download the input file to diskette. If the file is too big to fit on a diskette, 
compress it using a zip-compatible program. 

The migration path from a System z9 EC to a z10 EC can be either in the form of a field 
upgrade to the existing System z9 EC, or a replacement (push/pull) of an existing System z9 
EC with a new z10 EC. Note the following points:

1. A field upgrade means that the existing System z9 EC processor serial number is retained 
during the upgrade. 

Note: Using the HCD option Write IOCDS in preparation of an upgrade is the preferred 
method for writing the initial IOCDS when upgrading from a 2094 to a 2097. This scenario 
will use the HCD option Write IOCDS process.
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2. A replacement of the existing System z9 EC by a new z10 EC implies physically removing 
(push) the System z9 EC and bringing in a new z10 EC (pull) to take its place. The 
replacement z10 EC has a new serial number which is different from that of the existing 
System z9 EC.

In this chapter, we document the field upgrade scenario.

3.1.2  Planning considerations
Table 3-1 lists the channel types as described in an IOCDS that are used with the System z10 
EC.

Table 3-1   Channels, links, and adapters with CHPID type

Keep the following considerations in mind when planning your configuration.

Coupling links
Only the following Coupling Facility CHPIDs are supported:

� CHPID Type=CFP - ISC-3 links in peer mode

� CHPID Type=CBP - ICB-4 links

� CHPID Type=CIB - PSIFB links connecting to a HCA2-O (Optical) card

� CHPID Type=ICP - Internal Coupling links.

Channels
CHPID 
Type

May be 
defined as 

Shared

May be 
defined as 
Spanned

ESCON channels:
Connection Channel (ESCON architecture)
Channel to Channel (connects to CNC)

CNC
CTC

yes
ye

no
no

FICON bridge. A FICON channel that attaches to an ESCON Director 
Model 5

FCV yes no

FICON native channels that attach to FICON directors or directly to 
FICON control units

FC yes yes

FICON channels that attach to Fibre channel devices, switches, 
directors, or Fibre-Channel-to-SCSI bridges

FCP yes yes

ISC-3 peer mode channels (connects to another CFP) CFP yes yes

ICB-4 peer channels (connects to another ICB-4) CBP yes yes

IC peer channels (connects to another ICP) ICP yes yes

InfiniBand host channel adapters (HCA) CIB yes yes

HiperSocket (IQDIO) channels IQD yes yes

OSA adapters using QDIO architecture OSD yes yes

OSA adapters using non-QDIO architecture OSE yes yes

OSA 1000Base-T adapters for OSA-ICC OCE yes yes

OSA-Express2 adapters for NCP OSN yes yes

Note: Coupling links can be defined as both Coupling and STP links or STP-only links.
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HMC
The System z10 EC requires HMC Application Ver 2.10.0 or higher and only uses Ethernet 
for its network connection. The HMC and also the Service Elements do not contain a floppy 
disc drive, requiring the use of a USB Flash Memory Drive to input and back up customer 
configuration data.

Software support
HCD V1.9 or HCD V1.7 and later with 2097DEVICE PSP Bucket and PTFs is required to 
define and support some of the new features of the System z10 EC. 

Open Systems Adapter - Integrated Console Controller (OSA-ICC)
You might consider using OSA Express2 1000Base-T CHPIDs defined as TYPE=OSC. 
These OSA cards allow you to set up console function supported by a configuration file 
defined on the Support Element for that processor.

Fibre Channel Protocol (FCP)
When using CHPIDs defined as TYPE=FCP, you may wish to consider NPIV.

CPC name versus Processor ID
HCD allows you to define different Processors (Logical) to the same CPC (Physical). The 
Processor ID needs to be unique within the same IODF, but the CPC name does not. 
Therefore, the CPC name does not need to match the Processor ID. This is useful where you 
may have several Processor/logical partition/control unit setups that share the same physical 
CPC within the same IODF. Furthermore, the Processor ID is what is defined for the 
HWNAME parameter in the LOAD member in SYS1.IPLPARM.

The CPC name is coded in HCD option 1.3 under View Processor Definition in the CPC name 
field under SNA address, along with a Network name. It is the CPC name, and not the 
Processor ID, that appears on the HMC. 

When you view the Network information for a CPC via the HMC, note that the SNA address is 
made up of a Network name and CPC name separated by a dot (for example, 
USIBMSC.SCZP201). These values are defined in the Support Element for the CPC and they 
need to match the values set in the IODF so that HCD option 2.11 can find the CPC to write 
an IOCDS in the S/390 Microprocessor Cluster List.

Local System Name
An additional system name LSYSTEM is used to identify the local system name of a server 
when defining PSIFB type=CIB coupling links.

This data field can be found when changing a CIB-capable processor under HCD Option 1.3.

The LSYSTEM field can be set or changed to any 1-8 alphanumeric characters and also can 
begin with either an alpha or numeric character. All characters are upper case.

Here are the rules that will determine whether, and where, HCD will set the LSYSTEM 
keyword automatically:

1. If a CIB-capable processor is defined and the CPC name is set but the local system name 
is not set, HCD defaults the local system name to the CPC name. 

2. If a CIB-capable processor that has not yet defined a CPC name will be changed to get a 
CPC name but no local system name, HCD defaults the CPC name to the local system 
name.
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3. If a non-CIB capable processor is changed to a support level that is CIB capable, and the 
processor has a CPC name set but no local system name, the local system name is 
defaulted to the CPC name. 

4. If the processor definition is changed such that the local system name is explicitly 
removed, HCD does not do any defaulting.

5. If a processor has a local system name set (whether it has a CPC name or not), any 
change to the local system name has to be done explicitly. There will be no implicit name if 
the CPC name or the support level is changed.

6. During Build Production IODF it is verified that a local system name has to be set for the 
processor if the processor has a CIB channel path defined. If this verification fails, an error 
message is given and the production IODF is not built.

We do, however, recommend that the local system name be the same as the CPC name.

Additional keywords on the ID statement in an IOCP deck include:

AID: Adapter ID

Port: HCA port

CPATH: Specifies the CCSID and CHPID on the connecting system

3.1.3  MES upgrade scenario
This scenario describes the configuration steps to upgrade an existing 2094 to a 2097. Key 
factors are as follows:

� HCD requires a new Processor ID for the 2097.

� We recommend keeping the same CPC name for the 2097.

� The 2097 processor channels connect to the same switch ports and access the same 
control unit interfaces.

� The control unit interfaces connect to the same switch ports.

� The starting IODF is the current 2094 production IODF.

� The target IODF is a new 2097 work IODF.

The example here uses a 2094-S18 with a Processor ID of SCZP101 and three CSSs (CSS 
ID=0, CSS ID=1 and CSS ID=2) and is being upgraded to a 2097-E26 with a Processor ID of 
SCZP202. The CPC name SCZP101 and serial number 000101 are not changed. 

The following CHPID types are migrated:

� OSD, OSE, OSC, OSN
� CTC, CNC, FC, FCP
� CFP, CBP, ICP 
� IQD

The following Hardware/CHPID types are not supported and not migrated to the 2097:

� PCIXCC and PCICA
� ICB-3 links
� ICB-2 links
� ISC-3 links in compatibility mode (CHPID types CFS and CFR)
� OSA-Express Token Ring

Table 3-2 summarizes the migration options and tool requirements. The step-by-step process 
is documented later in this chapter.
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Table 3-2   2094 I/O configuration migrated to a 2097

3.2  HCD - Migrate the existing 2094 IODF
The following steps explain how to define the existing I/O configuration to the new 2097 
server using HCD, and then migrate the channel subsystem and logical partitions from the 
2094 to the 2097 server. Using HCD, the sequence of operations is as follows:

1. Create a work IODF from the current 2094 production IODF.

2. Repeat the 2094 processor being upgraded.

3. Observe CF link messages for later reference.

4. Delete unsupported items for the repeated 2094.

5. Change the repeated 2094 to a 2097 and delete the 2094.

6. Redefine all CF connections to other processors and any Internal CF required 
connections.

7. Define any additional CHPIDs, control units, and devices you may want to add during the 
upgrade.

8. Possibly, over-define channel paths.

9. Save OSA configuration information.

10.Build a 2097 validated work IODF.

11.Create an IOCP statements file and file transfer to your workstation. This step may be 
performed with HCM.

12.Import CFReport and IOCP statements into the CMT.

13.Perform hardware resolution and PCHID/CHPID availability.

14.Create configuration reports for yourself and the IBM service representative.

15.Import IOCP statements updated with PCHIDs back into validated work IODF.

2094 to 2097 Upgrade an existing 2094 to a 2097 
(MES upgrade)

Processor ID Require to change 2094 to new ID

CPC name Recommend to be the same name

Channel to switch port connections Same ports

Control Unit to switch port connections Same ports

Starting IODF Current active production IODF

Target IODF Create a new work IODF

HCD action Repeat and Change (see below)

CHPID Mapping Tool (CMT) Program Optional, but recommended 

CFReport File (CCN) Required

IOCP (import from validated work IODF) Yes

CHPID Mapping Tool actions (PCHID reset) Yes

CHPID Mapping Tool IOCP Output Yes

CHPID Mapping Tool Reports Yes, CHPID and CHPID to CU Report
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16.Build Production IODF and remote write the IOCP to an IOCDS on the processor.

17.Build Reset, Image and Load Profile.

18.Perform Power-on Reset (Activate) of 2097.

In the following sections, we describe these steps in more detail. 

Create work IODF from current 2094 production IODF
Use HCD to select the current production IODF that contains the 2094 processor you are 
upgrading (for example, SYS6.IODF38).

Repeat the 2094 processor being upgraded
1. From the main HCD panel, select option 1.3, Processor List. Type r (for repeat) next to 

the 2094 you want to upgrade, then press Enter (see Figure 3-2).

Figure 3-2   HCD - Processor List (repeating processor)

2. You are presented with the Identify Target IODF panel. Do one of the following:

– To retain all the other processor definitions in the IODF, press Enter. 

– Otherwise, type in a Target IODF data set name. In this case, only the processor you 
are repeating is retained in the Target IODF.

3. The Create Work I/O Definition File panel now prompts you to enter the data set name of 
the Target IODF (for example, SYS6.IODF39.WORK).

4. You are presented with the Repeat Processor panel, as shown in Figure 3-3. Enter the 
Processor ID of the new 2097 (in this example, SCZP202) and leave all other fields 
unchanged, then press Enter to continue.

 Processor List        Row 1 of 8 More:       > 
Command ===> _______________________________________________ Scroll ===> CSR   
                                                                               
Select one or more processors, then press Enter. To add, use F11.              
                                                                               
                                                                               
/ Proc. ID Type +   Model +  Mode+ Serial-# + Description                      
_ ISGSYN   2064     1C7      LPAR  __________ ________________________________ 
_ ISGS11   2064     1C7      LPAR  __________ ________________________________ 
_ P000STP1 2084     C24      LPAR  01534A2084 ________________________________ 
_ P000STP2 2094     S08      LPAR  0BAD4E2094 ________________________________ 
r SCZP101  2094     S18      LPAR  02991E2094 ________________________________ 
_ SCZP801  2064     1C7      LPAR  010ECB2064 ________________________________ 
_ SCZP901  2084     C24      LPAR  026A3A2084 ________________________________ 
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Figure 3-3   HCD - Repeat Processor 

CF Link Information messages
At this point, you may be presented with Severity E, I, or W messages. As shown in 
Figure 3-4, in our example CBDG441I Severity I messages were mentioned in the 
introduction; these were received due to the CF Link CHPIDs not being copied over to the 
2097 definition.

Figure 3-4   HCD - Message List (CBDG441I)

--------------------------- Repeat Processor ------------------------------

Specify or revise the following values.                                    

Processor ID . . . . . . . . . SCZP202_                                    

Processor type . . . . . . . : 2094                                        
Processor model  . . . . . . : S18                                         
Configuration mode . . . . . : LPAR                                        

Serial number  . . . . . . . . 02991E2094                                  
Description  . . . . . . . . . ________________________________            

Specify SNA address only if part of an S/390 microprocessor cluster:       

Network name . . . . . . . . . USIBMSC   +                                 
CPC name . . . . . . . . . . . SCZP101   +                                 

Local system name  . . . . . . ________                                    

+-----------------------------------------+
|New IODF SYS6.IODF39.WORK defined. |
+-----------------------------------------+

 ----------------------------- Message List -------------------------------- 
Save  Query  Help                                                         

                                                                 Row 1 of 239
 Command ===> ___________________________________________ Scroll ===> CSR    
                                                                             
 Messages are sorted by severity. Select one or more, then press Enter.      
                                                                             
 / Sev Msg. ID  Message Text                                                 
 _ W   CBDG441I The coupling facility connection between channel path BE     
 #              of processor SCZP101 and channel path 66 of processor        
 #              P000STP1 is not copied.                                      
 _ W   CBDG441I The coupling facility connection between channel path BF     
 #              of processor SCZP101 and channel path 54 of processor        
 #              P000STP2 is not copied.                                      
 _ W   CBDG441I The coupling facility connection between channel path C0     
 #              of processor SCZP101 and channel path C5 of processor        
 #              SCZP901 is not copied.                                       
_ I   CBDG271I Requested action on object SCZP101 successfully    
#              processed. 
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Scroll down until you reach the end of the messages and notice message CBDG271I 
requested action on object SCZP101 successfully processed 

Press PF3 or PF12 to continue. As shown in Figure 3-5, there is now an additional 2094 
processor named SCZP202. 

Figure 3-5   HCD - Processor List (repeated processor)

Change the 2094 to a 2097 and delete the 2094
At this point you can either leave the original copy of the 2094 (SCZP101), or delete it from 
the IODF. In our example, we kept it in the IODF for a few more steps.

Do the following:

1. Type c (for change) next to SCZP202 to change the 2094 to a 2097, then press Enter; see 
Figure 3-6. 

2. Make the following updates, then press Enter:

– Update Processor type to 2097.

– Update Processor Model to E26.

– Update the 2094 part of the serial number to 2097 (that is, 0001012094 to 0001012097).

 Processor List        Row 1 of 8 More:       > 
Command ===> _______________________________________________ Scroll ===> CSR  
                                                                              
Select one or more processors, then press Enter. To add, use F11.             
                                                                              
                                                                              
/ Proc. ID Type +   Model +  Mode+ Serial-# + Description                     
_ ISGSYN   2064     1C7      LPAR  __________ ________________________________
_ ISGS11   2064     1C7      LPAR  __________ ________________________________
_ P000STP1 2084     C24      LPAR  01534A2084 ________________________________
_ P000STP2 2094     S08      LPAR  0BAD4E2094 ________________________________
_ SCZP101  2094     S18      LPAR  02991E2094 ________________________________
_ SCZP202  2094     S18      LPAR  02991E2094 ________________________________
_ SCZP801  2064     1C7      LPAR  010ECB2064 ________________________________
_ SCZP901  2084     C24      LPAR  026A3A2084 ________________________________
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Figure 3-6   HCD - Change Processor Definition (changing repeated processor)

3. Press Enter. The Update Channel Path Identifiers panel displays (Figure 3-7). We are not 
making any changes in our example.

Figure 3-7   HCD - Update Channel Path Identifiers (not changed)

4. Press Enter for each of the Channel Subsystem IDs. 

Now the repeated 2094 processor is successfully changed to a 2097-E26; see Figure 3-8 on 
page 78.

 -------------------- Change Processor Definition ------------------- 

Specify or revise the following values.                               
                                                                      
Processor ID . . . . . . . . : SCZP202                                
Support level:                                                        
XMP, Basic 2094 support                                               
Processor type . . . . . . . . 2097      +                            
Processor model  . . . . . . . E26       +                            
Configuration mode . . . . . . LPAR      +                            
                                                                      
Serial number  . . . . . . . . 02991E2097  +                          
Description  . . . . . . . . . ________________________________       
                                                                      
Specify SNA address only if part of an S/390 microprocessor cluster:  
                                                                      
Network name . . . . . . . . . USIBMSC   +                            
CPC name . . . . . . . . . . . SCZP101   +                            
                                                                      
Local system name  . . . . . . ________ 

+--------------------- Update Channel Path Identifiers ----------------------+
|                                                               Row 1 of 125 |
| Command ===> __________________________________________ Scroll ===> CSR    |
|                                                                            |
| Specify any changes to the channel path identifiers in the list below.     |
|                                                                            |
| Processor ID . . . . : SCZP202                                             |
| Channel Subsystem ID : 0                                                   |
|                                                                            |
| CHPID  Type  Side  Until CHPID   New CHPID +                               |
| 00     OSD         __            00                                        |
| 01     OSD         __            01                                        |
| 02     OSD         __            02                                        |
| 03     OSD         __            03                                        |
| 04     OSD         __            04                                        |
| 05     OSD         __            05                                        |
| 07     OSC         __            07                                        |
| 08     OSD         __            08                                        |
| 09     OSE         __            09                                        |
| 0A     OSC         __            0A                                        |
| 0B     OSD         __            0B                                        |
|  F1=Help        F2=Split       F3=Exit        F4=Prompt      F5=Reset      |
|  F7=Backward    F8=Forward     F9=Swap       F12=Cancel     F22=Command    |
+----------------------------------------------------------------------------+
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Figure 3-8   HCD - Processor List (changed processor)

Observe the message displayed at the bottom of the panel indicating that the processor 
definition has been extended to its maximum configuration. This is because part of the 
Central Storage is allocated as a fixed-size Hardware System Area that is not addressable by 
application programs. In HCD when you define as new or redefine a processor as 2097, HCD 
automatically defines the maximum configuration of four CSSs and 60 logical partitions.

Delete the 2094 processor definition
Now that the 2094 has been repeated and changed to become a 2097, the original 2094 
definition (SCZP101) must be deleted so that the required CF Links can be restored.

1. Type d (for delete) next to processor SCZP101 in the Processor List (Figure 3-9).

Figure 3-9   HCD - Processor List (deleting processor)

 Processor List        Row 1 of 8 More:       >
Command ===> _______________________________________________ Scroll ===> CSR  
                                                                               
 Select one or more processors, then press Enter. To add, use F11.             
                                                                               
                                                                               
 / Proc. ID Type +   Model +  Mode+ Serial-# + Description                     
 _ ISGSYN   2064     1C7      LPAR  __________ ________________________________
 _ ISGS11   2064     1C7      LPAR  __________ ________________________________
 _ P000STP1 2084     C24      LPAR  01534A2084 ________________________________
 _ P000STP2 2094     S08      LPAR  0BAD4E2094 ________________________________
 _ SCZP101  2094     S18      LPAR  02991E2094 ________________________________
_ SCZP202  2097     E26      LPAR  02991E2097 ________________________________
 _ SCZP801  2064     1C7      LPAR  010ECB2064 ________________________________
 _ SCZP901  2084     C24      LPAR  026A3A2084 ________________________________
 ******************************* Bottom of data *******************************
                                                                               

                                                                               
+------------------------------------------------------------------+
| Definition of processor SCZP202 has been extended to its maximum |
| configuration.                                                   |
1+------------------------------------------------------------------+

Processor List        Row 1 of 8 More:       >
Command ===> _______________________________________________ Scroll ===> CSR  

Select one or more processors, then press Enter. To add, use F11.             
                                                                              
                                                                              
/ Proc. ID Type +   Model +  Mode+ Serial-# + Description                      
_ ISGSYN   2064     1C7      LPAR  __________ ________________________________ 
_ ISGS11   2064     1C7      LPAR  __________ ________________________________ 
_ P000STP1 2084     C24      LPAR  01534A2084 ________________________________ 
_ P000STP2 2094     S08      LPAR  0BAD4E2094 ________________________________ 
d SCZP101  2094     S18      LPAR  02991E2094 ________________________________ 
_ SCZP202  2097     E26      LPAR  02991E2097 ________________________________ 
_ SCZP801  2064     1C7      LPAR  010ECB2064 ________________________________ 
_ SCZP901  2084     C24      LPAR  026A3A2084 ________________________________ 
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2. Press Enter to “Confirm Delete Processor”.

Figure 3-10   HCD - Processor List (processor deleted)

Reconnect the CF channel paths not migrated
Manually redefine the CF Links you want from the SCZP202 processor to any other 
processor, along with any Internal CF Links desired. To help this effort, you can get a CF 
connection report from the previous production IODF containing the 2094. Alternatively, you 
can make a note of all CBDG441I error messages received in the previous step.

Define additional I/O
Define any additional CHPIDs, control units and devices, CTCs, and so on that you may be 
adding into the 2097 during the upgrade.

Over-define channel paths on an XMP processor
Sometimes you may need to define a channel path that is not physically installed on the 
processor. This may be useful if you are planning to add additional channel cards to the 
processor in the future and want to have the definitions in the IODF before the hardware is 
installed.

HCD allows you to over-define CHPIDs by using an asterisk (*) for the PCHID value. An 
over-defined CHPID must adhere to all validation rules, but it is not taken into account by an 
IOCDS download. Also it is not included in the IOCP statements, in a CONFIGxx member, or 
during dynamic activation.

If a control unit contains only CHPIDs with a PCHID value of an asterisk (*), then the whole 
control unit (including any attached devices) is omitted from the configuration to be activated.

When installing the channel path later, you must edit the CHPID and replace the * with its 
valid PCHID.

Processor List        Row 1 of 7 More:       >
Command ===> _______________________________________________ Scroll ===> CSR  
                                                                              
Select one or more processors, then press Enter. To add, use F11.             
                                                                              
                                                                              
/ Proc. ID Type +   Model +  Mode+ Serial-# + Description                     
_ ISGSYN   2064     1C7      LPAR  __________ ________________________________
_ ISGS11   2064     1C7      LPAR  __________ ________________________________
_ P000STP1 2084     C24      LPAR  01534A2084 ________________________________
_ P000STP2 2094     S08      LPAR  0BAD4E2094 ________________________________
_ SCZP202  2097     E26      LPAR  02991E2097 ________________________________
_ SCZP801  2064     1C7      LPAR  010ECB2064 ________________________________
_ SCZP901  2084     C24      LPAR  026A3A2084 ________________________________

Note: This is not the case for CFP and CBP type CHPIDs, where these CHPIDs have 
connections to other CFP and CBP type CHPIDs. 

Therefore, HCD only allows you to define CFP and CBP type CHPIDS as over-defined if 
they are unconnected.

If you define a CIB type CHPID, it must also be defined with an HCA Adapter ID (AID) and 
an HCA Port ID, represented in the AID/P column in the Channel Path List. HCD does not 
allow a CIB type CHPID to be defined as over-defined.
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The 2097 production IODF can then be activated dynamically and the PCHID/CHPID/control 
unit definitions become available to the operating system.

� Figure 3-11 illustrates what the CHPID/PCHID definitions look like before being defined as 
over-defined. Press PF20 (right) in the Channel Path List.

Figure 3-11   HCD - Channel Path List (Reserving CHPIDs)

� Figure 3-12 shows what the CHPID / PCHID definitions look like after being defined as 
over-defined.

Figure 3-12   HCD - Channel Path List (over-defined CHPIDs)

3.3  Save configuration files
On the System z9 EC, and z9 BC, customization information for certain channel types is 
stored in files on the Support Element (SE). The files are called configuration files, and they 
are named based on the physical location (PCHID value) of the feature. 

Table 3-3 lists CHPID types that have configuration files on a System z9 EC, and System z9 
BC. 

 Channel Path List     Filter Mode. More: <     >
Command ===> _______________________________________________ Scroll ===> CSR  
                                                                              
Select one or more channel paths, then press Enter. To add, use F11.          
                                                                              
Channel Subsystem ID : 0                                                      
1=A01       2=A02       3=A03       4=A04       5=A05                         
6=A06       7=A07       8=A08       9=A09       A=A0A                         
B=A0B       C=A0C       D=A0D       E=A0E       F=A0F                         
                          I/O Cluster  --------- Partitions 0x -----   PCHID  
/ CHPID Type+ Mode+ Mngd  Name +       1 2 3 4 5 6 7 8 9 A B C D E F   AID/P  
_ BE    CFP   SHR   No    ________     _ _ _ _ _ _ _ _ _ _ _ _ a _ _   3D8    
_ BF    CFP   SHR   No    ________     _ _ _ _ _ _ _ _ _ _ _ _ a _ _   3D9    
_ CE    CFP   SPAN  No    ________     _ _ a _ _ _ _ _ _ _ _ _ _ _ _   181    
_ CF    CFP   SPAN  No    ________     _ _ a _ _ _ _ _ _ _ _ _ _ _ _   111    
_ EC    CFP   SPAN  No    ________     _ _ a _ _ _ _ _ _ _ _ _ _ _ _   3C0    
_ EE    CFP   SPAN  No    ________     _ _ a _ _ _ _ _ _ _ _ _ _ _ _   3D0 

 Channel Path List     Filter Mode. More: <     >
Command ===> _______________________________________________ Scroll ===> CSR  
                                                                              
Select one or more channel paths, then press Enter. To add, use F11.          
                                                                              
Channel Subsystem ID : 0                                                      
1=A01       2=A02       3=A03       4=A04       5=A05                         
6=A06       7=A07       8=A08       9=A09       A=A0A                         
B=A0B       C=A0C       D=A0D       E=A0E       F=A0F                         
                          I/O Cluster  --------- Partitions 0x -----   PCHID  
/ CHPID Type+ Mode+ Mngd  Name +       1 2 3 4 5 6 7 8 9 A B C D E F   AID/P  
_ BE    CFP   SHR   No    ________     _ _ _ _ _ _ _ _ _ _ _ _ a _ _   *      
_ BF    CFP   SHR   No    ________     _ _ _ _ _ _ _ _ _ _ _ _ a _ _   *      
_ CE    CFP   SPAN  No    ________     _ _ a _ _ _ _ _ _ _ _ _ _ _ _   *      
_ CF    CFP   SPAN  No    ________     _ _ a _ _ _ _ _ _ _ _ _ _ _ _   *      
_ EC    CFP   SPAN  No    ________     _ _ a _ _ _ _ _ _ _ _ _ _ _ _   *      
_ EE    CFP   SPAN  No    ________     _ _ a _ _ _ _ _ _ _ _ _ _ _ _   * 
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Table 3-3   Channel or CHPID type information in configuration files

If channels or CHPIDs have associated configuration files, the CHPID Mapping Tool can 
assign PCHIDs to the logical CHPID definitions or move a CHPID definition to a new location. 
This can occur regardless of whether channels are moving. 

The CHPID Mapping Tool can override PCHID assignments for:

� FICON channels supporting FCP
� OSA Express2 and channels supporting OSC

The MES upgrade process preserves configuration files on an upgrade from a z9 EC to a 
System z10 EC. However, it is your responsibility to keep a backup of the customization data 
stored in the configuration files. 

During an MES upgrade, the following occurs:

� The channel cards will be moved as part of the normal rebalance of all I/Os. 

� The configuration files will be copied from your old system, restored to the new System 
z10 EC, and renamed to match their new PCHIDs of the new physical locations of the 
channel cards. 

� The CHPID Mapping Tool will force the logical CHPID previously assigned to the old 
PCHID location to be now assigned to the new PCHID location. 

The CHPID Mapping Tool can only perform this function if the initial IOCP input contains 
the PCHID assignments from the old system. 

For more information about configuration files, refer to Appendix A, “An explanation of 
configuration files” in CHPID Mapping Tool Users Guide, GC28-6825.

In this book, we show examples of backing up the configuration data with OSA/SF for OSA 
Express2 features, and with the HMC for OSA-ICC.

3.3.1  Save OSA configuration information with OSA/SF
The Open Systems Adapter Support Facility (OSA/SF) is an application that helps you to 
customize and manage your OSA-Express and OSA-Express2 features. It also allows you to 
obtain status and operational information. 

OSA/SF includes a graphical user interface (GUI) and a REXX™ interface. The OSA/SF GUI 
runs on Windows and Linux software that have graphics and Java™ 1.4 support. From a 
single OSA/SF GUI, you can establish connections to all server images that have OSA/SF 
running. This potentially allows you to have centralized control of OSA-Express2 features that 
span server boundaries, as shown in Figure 3-14 on page 82.

Feature or CHPID type Information stored in configuration files

OSA-Express2 types OSD/OSE Any user-specified MAC addresses and OAT tables

1000Base-T channel 
defined as CHPID type OSC

Console session information
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Figure 3-13   OSA/SF

Using OSA/SF, you can save the OSA Express2 definitions for user-specified MAC addresses 
and OAT tables. For information about setting up OSA/SF, refer to Open Systems 
Adapter-Express Customer’s Guide and Reference, SA22-7935, and OSA-Express 
Implementation Guide, SG24-5948.

To customize and manage the OSA/SF feature, perform the following steps:

1. From a Windows workstation, start a DOS session and issue the command java ioajava 
to start the OSA/SF GUI. Log on to OSA/SF as shown in Figure 3-14. 

Figure 3-14   OSA/SF Workstation Interface - Logon

The OSA/SF main panels are displayed; see Figure 3-15 on page 83.
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Figure 3-15   OSA/SF Workstation Interface 

2. From the OSA/SF Commands panel, click CHPID View. The CHPID View panel is 
displayed; it lists all OSA features in the configuration; see Figure 3-17. 

Figure 3-16   OSA/SF Workstation Interface - CHPID view

3. From the CHPID list displayed in the CHPID View panel, select the CHPID you want to 
work with. Click Selected → Configurations → Configuration..., as shown in 
Figure 3-17. 
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Figure 3-17   OSA/SF Workstation Interface - Selected Configurations 

4. A CHPID configuration panel is displayed, with only blank information. From this panel, 
click File → Get current configuration; see Figure 3-18.

Figure 3-18   OSA/SF Workstation Interface - get current configuration

5. The CHPID configuration panel is displayed again, now with the current OSA CHPID 
configuration information. Fill in the Configuration name (Figure 3-19). 
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Figure 3-19   OSA/SF Workstation Interface - Current configuration

6. Click File → Save configuration... (Figure 3-20). The configuration file is saved by 
OSA/SF and can be reused later. 

Figure 3-20   OSA/SF Workstation Interface - Save current configuration

You can use OSA/SF to install previously saved configuration information using the install and 
activate functions. Note that in order to use the GUI, you need to manually install and activate 
at least one OSA feature to enable communication between the GUI and the OSA/SF 
application.

1. From the OSA/SF main view, initialize the CHPID view. Select Configurations → 
Planning configurations... (Figure 3-21). 

 

 

 

Chapter 3. MES upgrade from System z9 EC to z10 EC 85



 

Figure 3-21   OSA/SF Workstation Interface - Planning configurations

2. The Configure OSA CHPID panel displays (Figure 3-22). Select the CHPID number and 
the CHPID Type that you want to define, and click OK. 

Figure 3-22   OSA/SF Workstation Interface - Configure OSA CHPID

3. OSA/SF displays a default panel for the type of feature selected. Click File → Open 
saved configuration... (Figure 3-23).
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Figure 3-23   OSA/SF Workstation Interface - Open saved configuration

OSA/SF displays a Host Configuration List panel containing the names of previously 
saved configuration files that match the feature type (Figure 3-24). 

Note that the Host Configuration List being displayed will vary with the OSA Express2 
feature type selected in Figure 3-22. For example, a request for OSD 1000Base-T 
Ethernet displays the list shown in Figure 3-24.

Figure 3-24   OSA/SF Workstation Interface - Host configuration list (OSD 1000Base-T Ethernet)

4. From the list, select the saved configuration name and click Load. Configuration 
information previously saved is now displayed on the OSA configuration panel. Any 
changes that may be needed can be done for this configuration with OSA/SF as shown in 
Figure 3-25.
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Figure 3-25   OSA/SF Workstation Interface - Change Configuration

5. Select Activate → Activate with install to restore the OSA feature configuration; see 
Figure 3-26 on page 89. 
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Figure 3-26   OSA/SF Workstation Interface - Install

3.3.2  OSA-ICC, CHPID=OSC
If the 2094 being upgraded contains any TYPE=OSC CHPIDs, then the operator console, 
TN3270, and Printer definitions are stored and managed on the Support Element and their 
definitions only are associated with a PCHID, not a CHPID. Therefore it is good practice to 
have a backup copy of these definitions. 

Export the configuration data for OSA-ICC using HMC Ver 2.9.2
To export the configuration data, follow these steps: 

1. Log on using SYSPROG authority to the HMC workstation supplied with the 2094 (as 
opposed to a remote Web browser) and select the CPC that contains the OSC CHPIDs 
that you want to export the configuration data for (for example, SCZP101).

2. In the Defined CPCs Work Area, select the CPC that contains the OSC CHPIDs that you 
want to export the configuration data for (for example, SCZP101).

3. Under Operational Customization, double-click OSA Advanced Facilities.

4. Select the radio button for the Channel ID card that you want to export, then click OK 
(Figure 3-27 on page 90).
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Figure 3-27   HMC - OSA Advanced Facilities (OSC Channel)

5. Select the radio button Card specific advanced facilities... and click OK (Figure 3-28).

Figure 3-28   HMC - OSA Advanced Facilities (Card specific)

6. Select the radio button Manual configuration options..., and click OK (Figure 3-29 on 
page 91).
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Figure 3-29   HMC - OSA Advanced Facilities (Manual config)

7. Select the radio button Export source file and click OK (Figure 3-30).

Figure 3-30   HMC - OSA Advanced Facilities (Export source)

8. The task requests a file name to be written onto the diskette. In our example we entered 
OSC-ICC_0121; see Figure 3-31 on page 92. Click OK.
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Figure 3-31   HMC - OSA Advanced Facilities (Export filename)

9. You are prompted to insert a diskette into the drive on the HMC workstation that you are 
logged on to (Figure 3-32). Insert the diskette and click OK.

Figure 3-32   HMC - OSA Advanced Facilities (Export insert diskette)

10.The HMC task writes the configuration data for the Channel ID that was selected onto the 
diskette and displays a message panel when it has completed (Figure 3-33). Click OK.

Figure 3-33   HMC - OSA Advanced Facilities (Export completed)

11.Remove the diskette from the drive as instructed by the message displayed in Figure 3-34 
on page 93; click OK. You can now click Cancel to exit all OSA Advanced Facilities panels. 
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Figure 3-34   HMC - OSA Advanced Facilities (Remove diskette)

Figure 3-35 shows a sample of the configuration data downloaded on the diskette.

Figure 3-35   OSC configuration sample (OSC-0121)

Export the configuration data for OSA-ICC using HMC Ver 2.10.0
To export the configuration data, follow these steps: 

1. Log on using SYSPROG authority to the HMC workstation supplied with the 2094 (as 
opposed to a remote Web browser) and select the CPC that contains the OSC CHPIDs 
that you want to export the configuration data for (for example, SCZP101).

<OSC_SERVER>
  HOST_IP= 9.12.4.165
  DEFAULT_GATEWAY= 9.12.4.1
  SUBNET_MASK= 255.255.252.0
  PORT= 3270
  ETHERNET_FRAME= DIX
  MTU= 576
  NAME= OSAF080
</OSC_SERVER>
  
  
<CONFIG_SESSION>
<SESSION1>
  CSS= 00 IID= 07 DEVICE= F080
  GROUP=  "SCZCF080"
  CONSOLE_TYPE= 1    RESPONSE= OFF    READ_TIMEOUT= 60
</SESSION1>

<SESSION2>
  CSS= 01 IID= 07 DEVICE= F081
  GROUP=  "SCZCF081"
  CONSOLE_TYPE= 1    RESPONSE= OFF    READ_TIMEOUT= 60
</SESSION2>
..................................
......................................
<SESSION71>
  CSS= 00 IID= 01 DEVICE= F0BA
  GROUP=  "WTSC74"
  CONSOLE_TYPE= 1    RESPONSE= OFF    READ_TIMEOUT= 0
</SESSION71>

</CONFIG_SESSION>
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2. Under Systems Management, click Servers to expand the list.

a. On the right-hand pane you will see listed all servers defined to this HMC. Click the 
radio button for the server you wish to access (in this example SCZP101)

b. Click the small pop-up menu arrow just after the CPC name and use this to expand to 
and select the OSA Advanced Facilities menu (Figure 3-36).

Figure 3-36   HMC - OSA Advanced Facilities (Popup Menu)

3. Alternatively, you can access the OSA options the following way:

a. Under Systems Management, click Servers to expand the list.

b. Under Servers, click the server to select it (in this example SCZP101).

c. On the Tasks pad, click Operational Customization to expand it, and select OSA 
Advanced Facilities (Figure 3-37 on page 95).

Note: An HMC upgraded from Ver 2.9.2 to Ver 2.10.0 may contain a usable floppy disk 
drive. A new HMC installed along with a z10 EC with Ver 2.10.0 will not contain a floppy 
disk drive.
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Figure 3-37   HMC - OSA Advanced Facilities (Task Menu)

4. Click the radio button for the Channel ID card that you want to export, then click OK 
(Figure 3-38).

Figure 3-38   HMC - OSA Advanced Facilities (OSC Channel)
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5. Select the radio button Card specific advanced facilities... and click OK (Figure 3-39).

Figure 3-39   HMC - OSA Advanced Facilities (Card specific)

6. Select the radio button Manual configuration options... and click OK (Figure 3-40).

Figure 3-40   HMC - OSA Advanced Facilities (Manual config)
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7. Select the radio button Export source file and click OK (Figure 3-41).

Figure 3-41   HMC - OSA Advanced Facilities (Export source)

8. The task requests a file name to be written onto the installed Media device. In our example 
we entered OSC-ICC_0220 (Figure 3-42). Click OK.

Figure 3-42   HMC - OSA Advanced Facilities (Export filename)

9. HMC displays panel ACT20430 with the following prompts:

– Please insert the following removable media:

– The removable media to export data to:

– Click Cancel to cancel operation.

10.HMC detects the installed media.

11.HMC displays the panel Select Media Device - SCZP101.

This task supports the following devices:

– USB Flash Memory Drive, Diskette
– Radio button - USB Flash Memory Drive
– Radio button - Diskette Drive

12.Click the radio button for USB Flash Memory Drive, then click OK.

Note: A suitable USB Flash Memory Drive must be inserted into the USB port prior to 
the next step so that it can be detected and be provided as an option for selection.
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13.The HMC task writes the configuration data for the Channel ID that was selected onto the 
media device and displays a message panel when it has completed (Figure 3-33). Click 
OK.

Figure 3-43   HMC - OSA Advanced Facilities (Export completed)

14.You can remove the USB Flash Memory Drive at any time, then click OK. Click Cancel to 
exit all OSA Advanced Facilities panels. 

Figure 3-35 shows a sample of the configuration data downloaded on the diskette.

Figure 3-44   OSC configuration sample (OSC-0121)

<OSC_SERVER>
  HOST_IP= 9.12.4.165
  DEFAULT_GATEWAY= 9.12.4.1
  SUBNET_MASK= 255.255.252.0
  PORT= 3270
  ETHERNET_FRAME= DIX
  MTU= 576
  NAME= OSAF080
</OSC_SERVER>
  
  
<CONFIG_SESSION>
<SESSION1>
  CSS= 00 IID= 07 DEVICE= F080
  GROUP=  "SCZCF080"
  CONSOLE_TYPE= 1    RESPONSE= OFF    READ_TIMEOUT= 60
</SESSION1>

<SESSION2>
  CSS= 01 IID= 07 DEVICE= F081
  GROUP=  "SCZCF081"
  CONSOLE_TYPE= 1    RESPONSE= OFF    READ_TIMEOUT= 60
</SESSION2>
..................................
......................................
<SESSION71>
  CSS= 00 IID= 01 DEVICE= F0BA
  GROUP=  "WTSC74"
  CONSOLE_TYPE= 1    RESPONSE= OFF    READ_TIMEOUT= 0
</SESSION71>

</CONFIG_SESSION>
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3.4  Validate the 2097 work IODF

Validate the work IODF
1. Select HCD option 2.12, Build validated work I/O definition file. Review the Message 

List and correct any errors. 

2. Press PF3 to continue; the message Requested action successfully processed is 
displayed. 

3. Go to HCD option 6.4,View I/O Definition File Information and notice that the IODF type 
is now Work - Validated; see Figure 3-45.

Figure 3-45   HCD - View I/O Definition File Information (validated work IODF)

Creating the IOCP for the CHPID Mapping Tool

1. Select HCD option 2.3, Build IOCP input data set, and press Enter; see Figure 3-46 on 
page 100.

+---------------- View I/O Definition File Information -----------------+

IODF name  . . . . . . : 'SYS6.IODF39.WORK'                
IODF type  . . . . . . : Work - Validated                    
IODF version . . . . . : 5                                   
                                                             
Creation date  . . . . : 2007-11-29       
Last update  . . . . . : 2007-11-30  17:27

Volume serial number . : IODFWK                              
Allocated space  . . . : 2000    (Number of 4K blocks)       
Used space . . . . . . : 1582    (Number of 4K blocks)       
   thereof utilized (%)  90 
                                                             
Activity logging . . . : No                                  
Backup IODF name . . . :                                     
                                                             
Description  . . . . . :                                     
                                                             
                                                             
                                                             
 F1=Help    F2=Split   F3=Exit    F9=Swap   F12=Cancel 

Note: If you are an HCM user, you may prefer to use HCM to create the IOCP statements 
file and transfer the file to your PC. You can then launch the CHPID Mapping Tool, create 
an updated IOCP statements file, and transfer the file back to the host.
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Figure 3-46   HCD - Activate or Process Configuration Data (Build IOCP for SCZP202)

2. HCD displays the list of available processors to chose from. Select the processor 
SCZP202 by typing a forward slash mark (/) and then press Enter (Figure 3-47).

Figure 3-47   HCD - Available Processors (select processor for IOCP file)\

3. HCD displays a panel on which you enter information regarding the IOCP input data set to 
be created. Fill in the following fields:

– Title1
– IOCP input data set
– Enter Yes in the field Input to Stand-alone IOCP.
– Fill in the Job statement information for your installation.

4. Press Enter; HCD submits a batch job to create the data set.

---- Activate or Process Configuration Data ------  

Select one of the following tasks.               
                                                  
 3_  1.  Build production I/O definition file     
     2.  Build IOCDS                              
     3.  Build IOCP input data set                
     4.  Create JES3 initialization stream data   
     5.  View active configuration                
     6.  Activate or verify configuration         
         dynamically                              
     7.  Activate configuration sysplex-wide      
     8.  Activate switch configuration            
     9.  Save switch configuration                
     10. Build I/O configuration statements       
     11. Build and manage S/390 microprocessor    
         IOCDSs and IPL attributes                
     12. Build validated work I/O definition file 

 -------------------------- Available Processors --------------------------- 
                                                                  Row 1 of 7 
   Command ===> __________________________________________________________   
                                                                             
Select one.                                                              
                                                                         
  Processor ID  Type     Model    Mode  Description                      
  ISGSYN        2064     1C7      LPAR                                   
  ISGS11        2064     1C7      LPAR                                   
  P000STP1      2084     C24      LPAR                                   
  P000STP2      2094     S08      LPAR                                   
/ SCZP202       2097     E26      LPAR                                   
  SCZP801       2064     1C7      LPAR                                   
  SCZP901       2084     C24      LPAR                                   
**************************** Bottom of data *****************************
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Figure 3-48   HCD - Build IOCP Input Data Set

5. In TSO, verify that the data set just created exists, and that it contains IOCP statements; 
see Figure 3-49.

The data set is used as input into the CHPID Mapping Tool.

Figure 3-49   HCD - IOCP input data set contents (truncated)

Also note that part of the TOK statement has been blanked out with dots (Example 3-1). 

Example 3-1   HCD - IOCP file (TOK statement)

TOK=('SCZP202',00800001991E2094172730040107334F00000000,*
00000000,'07-11-30','17:27:30','........','........') 

 ------------------------- Build IOCP Input Data Set -------------------------- 
                                                                                
   Specify or revise the following values.                                      
                                                                                
IODF name . . . . . . . . . : 'SYS6.IODF39.WORK'                       
Processor ID  . . . . . . . : SCZP202                                    
Title1 . IODF39__________________________________________________________
Title2 : SYS6.IODF39.WORK - 2007-11-30 17:27 
                                                                         
IOCP input data set                                                      
'SYS6.IODF39.IOCPIN.SCZP202'___________________                        
Input to Stand-alone IOCP?  Yes  (Yes or No)                             
                                                                         
Job statement information                                                
//WIOCDS  JOB (ACCOUNT),'NAME'                                               
//*                                                                          
//*                                                                          

ID    MSG1='IODF39',                                          
      MSG2='SYS6.IODF39.WORK - 2007-11-30 17:27',           
      SYSTEM=(2097,1),                                        
      TOK=('SCZP202',00800001991E2094172730040107334F00000000,
      00000000,'07-11-30','17:27:30','........','........')   
RESOURCE PARTITION=((CSS(0),(A0A,A),(A0B,B),(A0C,C),(A0D,D),(A
      0E,E),(A0F,F),(A01,1),(A02,2),(A03,3),(A04,4),(A05,5),(A
      06,6),(A07,7),(A08,8),(A09,9)),(CSS(1),(A1A,A),(A1B,B),(
      A1C,C),(A1D,D),(A1E,E),(A1F,F),(A11,1),(A12,2),(A13,3),(
      A14,4),(A15,5),(A16,6),(A17,7),(A18,8),(A19,9)),(CSS(2),
      (A2A,A),(A2B,B),(A2C,C),(A2D,D),(A2E,E),(A2F,F),(A21,1),
      (A22,2),(A23,3),(A24,4),(A25,5),(A26,6),(A27,7),(A28,8),
      (A29,9)),(CSS(3),(*,1),(*,2),(*,3),(*,4),(*,5),(*,6),(*,
      7),(*,8),(*,9),(*,A),(*,B),(*,C),(*,D),(*,E),(*,F)))    
CHPID PATH=(CSS(0,1,2),00),SHARED,                            
      NOTPART=((CSS(0),(A0B,A0C,A0D,A0E,A0F),(=)),(CSS(1),(A1B
      ,A1C,A1D,A1E,A1F),(=)),(CSS(2),(A2B,A2C,A2D,A2E,A2F),(=)
      )),PCHID=340,TYPE=OSD                                   
CHPID PATH=(CSS(0,1,2),01),SHARED,                            
      NOTPART=((CSS(0),(A0B,A0C,A0D,A0E,A0F),(=)),(CSS(1),(A1B
      ,A1C,A1D,A1E,A1F),(=)),(CSS(2),(A2B,A2C,A2D,A2E,A2F),(=)
      )),PCHID=1C0,TYPE=OSD 
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This is a safeguard to ensure that this IOCP file cannot be written to a processor and used 
for a power-on reset, because this IOCP file was created from a validated work IODF and 
not a Production IODF – which is something that can be done only for processors that 
contain PCHID definitions.

6. Download this IOCP file from TSO to the CMT workstation. Use a workstation file transfer 
facility such as the one in the IBM Personal Communications Workstation Program, or any 
equivalent 3270 emulation program. Be sure to use TEXT as the transfer type. In this 
example, we named the file SCZP202in.iocp.

3.5  CHPID Mapping Tool actions
In the following steps we take the output from the previous set of HCD steps (IOCP), and the 
output from the 2097 order process (CFReport). Using the CHPID Mapping Tool, we assign 
PCHIDs to each of the CHPIDs for the 2097.

For this process, the CHPID Mapping Tool (CMT) must be downloaded. Refer to “CHPID 
Mapping Tool” on page 24, for information about downloading and installing the CMT. If you 
already have CMT installed, then verify that you have the latest updates installed.

Using the CHPID Mapping Tool, follow these steps:

1. Import the IOCP statements file and the CFReport file into the CHPID Mapping Tool. 
Getting the IOCP statements may be performed with HCM.

2. Resolve CHPIDs with a PCHID conflict.

3. Resolve CHPIDs without associated hardware.

4. Resolve Hardware resolution.

5. Set the priority for single-path control units and other control units that would override the 
CHPID Mapping Tool default priorities.

6. Run the CHPID Mapping Tool availability function.

7. Create CHPID Mapping Tool reports.

8. Create an updated IOCP statements file and file transfer back to the host z/OS image. 
This step may be performed with HCM. 

Import the CFReport file into the CHPID Mapping Tool
1. Start the CHPID Mapping Tool on your workstation.

2. Import the CFReport file into the CHPID Mapping Tool. 

3. Click File → Import CFReport file (Figure 3-50). 

Important: When an IOCP statement file is exported from a Validated Work IODF 
using HCD, it must be imported back to HCD in order for the process to be valid. The 
IOCP file cannot be used directly by the IOCP program.

Note: When upgrading from a 2094 to a 2097, it is mandatory to use the CHPID Mapping 
Tool level that supports the 2097. The internal availability characteristics of the 2097 are 
different from previous System z processors.
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Figure 3-50   CMT - Import CFReport Order file

4. Select the CFReport file to import and click Open (Figure 3-51). Information from the 
CFReport is displayed on the left-hand side of the window (Figure 3-52 on page 104).

Figure 3-51   CMT - Open CFReport file
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Figure 3-52   CMT - Imported CFReport Order file

Import the 2094 IOCP file into the CHPID Mapping Tool
1. To import the IOCP file, click Tool → Import IOCP File (Figure 3-53).

Figure 3-53   CMT - Import IOCP file
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2. Select the IOCP file on your workstation to import into the CHPID Mapping Tool and click 
Open. 

In our example, the CHPID Mapping Tool issued the following: 

� Matching CHPID - This window lists all CHPIDs that are assigned with PCHIDs that have 
been moved during MES upgrade. This is for informational purposes only.

� Invalid CHPID - This window lists all the CHPIDs that have been found with Invalid 
PCHID values assigned in the IOCP Input file. PCHID may represent hardware that is not 
compatible with a given CHPID type, or there may be no hardware present at a given 
PCHID.

� HW Resolution - A few CHPIDs support more than one available channel type. Users 
should select the preferred channel type for any given CHPID. CHPIDs are grouped and 
displayed per CHPID type.

� CHPID Reset - Availability considers only CHPIDs that are not assigned with a PCHID. 
CHPIDs that already have PCHIDs assigned can be reset using this panel. 

� Reset CHPIDs assigned by Availability - Checking this option resets all CHPIDs that 
were processed by prior availability runs in this session. 

By default, this option is checked. 

� Reset CHPIDs assigned by Manual Remap - Checking this option resets CHPIDs that 
were assigned a PCHID in the Manual panel. If this option is not checked, then availability 
PCHIDs for these CHPIDs are not reset. 

By default, this option is unchecked. 

� Reset CHPIDs assigned by the CHPID Mapping Tool for config files - The CFReport 
indicates that you are doing an MES/upgrade, and you have channels or CHPIDs (or both) 
that may have configuration files currently associated with them. The MES/upgrade may 
be moving some of those channel cards. 

Regardless of whether the channels are moving or not, the CHPID Mapping Tool either 
has assigned PCHIDs to the logical CHPID definitions to keep the CHPID definition 
associated with its current configuration file, or has moved the definition to the new 
location where the channel is moving. 

If you reset the CHPID Mapping Tool assignments, it is your responsibility to have a 
backup of the configuration file data prior to the MES, and to restore that data to the new 
location (the PCHID where the affected CHPIDs are assigned) before you can use the 
CHPIDs. 

By default, this option is unchecked. 

� Reset CHPIDs assigned by IOCP - If some of the CHPIDs were assigned in the IOCP 
Input file, then checking this option resets the CHPIDs. Checking this option may require 
recabling after availability assignments. 

This option should be checked. 

If none of the options is checked, availability only works on CHPIDs that do not have PCHIDs 
assigned.

In order to give the CHPID Mapping Tool the most choices when using the availability option, 
we recommend that you choose Reset all IOCP assigned PCHIDs. 

However, if you choose Reset only the PCHID/hardware mismatch, then review the 
intersects from availability processing carefully to ensure that preserving the prior 
CHPID-to-PCHID relationship is not causing unacceptable availability. 
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If you choose to run Availability mapping, this will reset any previously mapped CHPID 
assignments and could result in recabling of the server.

CHPIDs that may have configuration files associated
As shown in Figure 3-54, here you can see any PCHIDs that could potentially have 
configuration files associated with them. Click OK.

Figure 3-54   CMT - CHPIDs assigned by CMT
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Resolve CHPIDs with PCHID conflict
Now the CMT displays the CHPIDs with PCHID conflicts; see Figure 3-55.

Figure 3-55   CMT - CHPIDs with PCHID conflicts

In our example we selected Reset only the PCHID/hardware conflicts.

Resolve CHPIDs without associated hardware
The CHPID Mapping Tool now displays messages about any CHPID types that were imported 
from the IOCP input file (IODF) into the CMT that do not have any associated hardware 
support in the CFReport file (Figure 3-56). Click OK.

Figure 3-56   CMT - Required Hardware unavailable

The following message is issued:

CHPIDs with invalid/incompatible hardware found.
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We left excessive numbers of CHPID types CBP in our IODF to show how the CHPID 
Mapping Tool would handle this condition and to give an opportunity to explain how you can 
resolve this situation. Refer to “Over-define channel paths on an XMP processor” on page 79.

This is an example of where you can use this option to change the PCHID value to an asterisk 
(*) in the IODF, if you should still want to retain the CBP/CFP CHPID definitions in the IODF 
and expect to have CBP/CFP CHPIDs installed in the processor at a later date.

Alternatively, you could remove the CBP/CFP CHPID definitions from the IODF.

To continue with this example, follow these steps:

1. Go back into the IODF and change the PCHID values for the CBP/CFP CHPIDs (or any 
other CHPIDs that have no supporting hardware in the CFReport) to an asterisk (*).

2. Re-validate the IODF; use HCD option 2.12.

3. Recreate the IOCP statements file and file transfer to your PC.

4. Import the IOCP file; click Tool → Import IOCP File.

Now when you click Reset only the PCHID/hardware conflicts, the CHPID Mapping Tool 
asks you to resolve some hardware.

Hardware resolution
The CHPID Mapping Tool may prompt you to resolve issues that may arise from importing the 
IOCP file. In our example, the CHPID Mapping Tool wanted clarification on the TYPE=OSD, 
TYPE=OSE and TYPE=FC channels. 

In each case, we must check off what each of the channels is used for; see Figure 3-57. The 
image in the lower right-hand side shows what we had selected for the FC channels.

Note: Other CHPID types can also be over-defined by entering an asterisk (*) for the 
PCHID value, with the exception of CIB type CHPID definitions.

Note: If you look at the IOCP statements file now, notice that the CBP/CFP CHPIDs 
have been omitted from the file, but are still defined in the IODF.
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Figure 3-57   CMT - Hardware resolution after IOCP import

� Select one tab at a time. In one of our examples, the CHPID Mapping Tool needs to know 
which channel type the FC and FCP CHPID definitions use between the FICON Express2 
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and FICON Express4 hardware. Select the desired box and move to the next tab until all 
CHPID definitions have hardware selected.

The CHPID Mapping Tool displays all of the information that it currently knows.

Figure 3-58   CMT - Manual tab

Process CU Priority
If you are importing an IOCP statements file from a 2094 that had CU Priority values defined, 
you may want to review the CU Priority beforehand. The CHPID Mapping Tool can then 
perform the availability functions appropriately for a 2097. Follow these steps:

1. Under the File menu, click the Availability tab.

2. Click Process CU Priority and a window pops up. 

The Reset CHPID Assignment window allows you to reset previously assigned PCHIDs, 
as follows:

– Reset CHPIDs assigned by Availability
– Reset CHPIDs assigned by Manual Remap
– Reset CHPIDs assigned by IOCP

In our example, we selected Reset CHPIDs assigned by Availability and Reset CHPIDs 
assigned by IOCP; see Figure 3-59 on page 111.

 

 

 

110 IBM System z10 Enterprise Class Configuration Setup



 

Figure 3-59   CMT - Reset CHPID Assignments 

The 2097 has different availability rules than the 2094, so we need to remove all PCHIDs 
assignments that were still in the IOCP.

3. Click Process. After the CHPID Mapping Tool has reset the CHPIDs, it displays a 
message indicating the results of the process (Figure 3-60).

Figure 3-60   CMT - Process CU Priority completion message

The following list defines the possible intersects:

C Two or more assigned channels use the same channel card.
S More than half the assigned channels use the same STI.
M All assigned channels are supported by the same MBA group.
B More than half the assigned channels are supported by the same book.
D Assigned channels are on the same daughter card.

Our example returned the “B” intersect.

4. Click OK. You can now display the results of the channel mapping. You can also sort the 
report in different ways. For example, to see how the CHPID Mapping Tool ranked the 
control units, select Sorts → By CU Priority.

Note: Intersect messages inform you of a potential availability problem detected by the 
CMT, but do not necessarily indicate an error.

It is your responsibility to evaluate whether the condition should be corrected.
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Our example does not contain any CU Priority values, but this illustrates how CU Priority 
values are represented in the IOCP file.

5. You need to check and set values for items such as OSA-ICC CHPIDs and CTC CHPIDs, 
to ensure that the CHPID Mapping Tool allocates these CHPIDs with high PCHID 
availability.

Page through the listing and search through the column CU Number for any control units 
you want to set priority for. In our example, we set the OSC type CU Numbers to priority 
333; see Figure 3-61.

Figure 3-61   CMT Set CU Priority

If there are coupling links used by a CF image, you should group these links.

Each set of CHPIDs going to a different CPC should be grouped with a common priority. 
For example, suppose the CF image has four links (CHPIDs 40, 41, 42, and 43) and that 
40 and 41 go to one CPC, and 42 and 43 go to a different CPC. In this case you should 
give CHPIDs 40 and 41 one priority and CHPIDs 42 and 43 a different priority. The 
concept is the same regardless of the number of connecting CPCs or the number of links 
to each CPC.

Note: The control unit priorities are stored in the IOCP output file created by the CMT 
that gets migrated back into HCD. HCD maintains these priorities and outputs them 
when creating another IOCP deck. 

They are in the form of commented lines at the end of the IOCP deck, as shown here: 

*CMT* VERSION=000
*CMT* CCN=27132026(CFR from ResourceLink)
*CMT* 8000.0=0010,8000.1=0010,8000.2=0010,8100.0=0010,8100.1=0010
*CMT* 8100.2=0010,8200.0=0010,8200.1=0010,8200.2=0010,8300.0=0010
*CMT* 8300.1=0010,8300.2=0010,8400.0=0010,8400.1=0010,8400.2=0010
*CMT* 8500.0=0010,8500.1=0010,8500.2=0010,8600.0=0010,8600.1=0010
*CMT* 8600.2=0010,8700.0=0010,8700.1=0010,8700.2=0010,C400.0=0020
*CMT* C400.1=0020,C400.2=0020,C500.0=0020,C500.1=0020,C500.2=0020
*CMT* C600.0=0020,C600.1=0020,C600.2=0020,C700.0=0020,C700.1=0020
*CMT* C700.2=0020
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6. Under the File menu, click the Availability tab again.

7. Click Process CU Priority and a window pops up. 

The Reset CHPID Assignment window allows you to change the CHPID values:

– Reset CHPIDs assigned by Availability
– Reset CHPIDs assigned by Manual Remap
– Reset CHPIDs assigned by IOCP

In our example, we selected Reset CHPIDs assigned by Availability. 

8. Click Process. Then click Sorts → By CU Priority; notice that the OSC type control units 
with priority of 333 have sorted to the top of the list. 

9. Select the Manual tab; Figure 3-62 shows the results of mapping the CHPIDs.

Figure 3-62   CMT - Manual (CHPIDs assigned)

As you can see, the CHPID and CHPID Origin columns are no longer blank. The CMT has 
assigned CHPIDs to PCHIDs and it has placed the value Avail in the CHPID Origin column, 
indicating that the CHPID values were assigned based on availability.

CHPIDs not connected to Control Units
Under the Availability tab, click Sorts → By Control Unit. The CHPID Mapping Tool 
displays at the end of the list all CHPIDs defined in the IOCP input that are not connected to 
control units. All coupling CHPIDs in this list are preceded with an “S” in the CU Number 
column (not shown in the following figure). All non-coupling CHPIDs are preceded with a “P,” 
see Figure 3-63.
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Figure 3-63   CMT - Sort by Control Unit

You should review the list because:

� You may have forgotten to add a CHPID to a control unit and may need to update the 
IOCP source before continuing in the CHPID Mapping Tool.

� The unconnected CHPIDs may be extra channels you are ordering in anticipation of new 
control units.

� The unconnected CHPIDs may be coupling links that are being used in coupling facility 
(CF) images (these do not require control units).

If there are extra CHPIDs for anticipated new control units, you may want to group these 
CHPIDs with a common priority. This will allow the availability mapping function to pick 
PCHIDs that will afford your new control unit good availability.

Create reports 
The CHPID Mapping Tool offers built-in reports, which are available from the Reports 
pull-down menu. You can also print the information on the Availability tab or the Manual tab by 
clicking Print. When in the Availability tab, you can enter information in the comments column 
that might be useful at a later date.

For simplicity, we only describe how to print three reports in this example (the CHPID Report, 
the Port Report, Sorted by location, and the CHPID to Control Unit Report). However, all 
built-in reports are printed in the same way, as explained here.

The person who will install the I/O cables during system installation needs one of these 
reports. The Port Report, sorted by location, is recommended. The installer can use this to 
help with labelling the cables. The labels must include the PCHID or cage/slot/port 
information before system delivery.
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CHPID Report
1. Click Reports → CHPID Report (Figure 3-64). 

Figure 3-64   CMT - Select CHPID Report

2. Enter the Report File Name (or accept the default name offered by CMT) and click Save 
(Figure 3-65).

Figure 3-65   CMT - Report File Name

3. The CHPID Mapping Tool opens a browser window with the CHPID report; see 
Figure 3-66. You may be prompted to accept active content; accept the active content to 
display the report in your browser.
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Figure 3-66   CMT - CHPID Report

At the end of this CHPID report there is a list of CHPIDs with modified PCHID/AID 
assignments (Figure 3-67). This report is valuable for moving cables. 

Figure 3-67   List of CHPIDs having modified PCHID assignment
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Port Report - Sorted by Location
1. Click Reports → Port Report → Sorted by Location, and then click Save (assuming 

that you accept the CHPID Mapping Tool report name).

The CHPID Mapping Tool opens a browser window with the CHPID to Port Report 
(Figure 3-68). 

2. You may be prompted to accept active content. Accept the active content in order to 
display the report in your browser. 

Figure 3-68   CMT - CHPID to Port Report

Create the CHPID to Control Unit Report
These reports are created in a similar way to the CHPID Report:

1. Click Reports → CHPID to Control Unit Report.

2. Click Save.

3. The CHPID Mapping Tool opens a browser window with the CHPID to Control Unit Report; 
see Figure 3-70 on page 118. You may be prompted to accept active content; accept the 
active content to display the report in your browser. 
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Figure 3-69   CMT - CHPID to CU Report

Create updated IOCP

Create an IOCP statements file for input back into the IODF via HCD. This IOCP statements 
file now has the CHPIDs assigned to PCHIDs. 

1. Click Tool → Create Updated IOCP File (Figure 3-70).

Figure 3-70   CMT - Create Updated IOCP File

Note: You may prefer to use HCM to transfer the updated IOCP statements file back to the 
host. Before doing so, however, first run the next step in the CHPID Mapping Tool to create 
the updated IOCP file.
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2. Enter the File name and location for the IOCP output file and click Save (Figure 3-71).

Figure 3-71   CMT - Save IOCP output file 

3. The CMT displays an informational message, shown in Figure 3-72, regarding what to do 
for the final execution of the tool.

Figure 3-72   CMT - Informational message 

Note: This file needs to be uploaded to the z/OS image on which you have the work 
IODF used previously to create the IOCP input data set. 
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4. The CHPID Mapping Tool program can be shut down now. Click File → Exit (Figure 3-73).

Figure 3-73   CMT - Exit program

3.6  HCD - Update the 2097 work IODF with PCHIDs
After mapping the CHPIDs to PCHIDs using the CHPID Mapping Tool, the information needs 
to be transferred back into HCD, as follows: 

1. Upload the IOCP file created by the CMT (sczp202out.iocp, in our example) to the z/OS 
image. Use a file transfer facility such as the one in IBM Personal Communications or an 
equivalent FTP program. Be sure to use TEXT as the transfer type.

Looking at the updated IOCP statements file, you will notice that the CMT has left a 
reference to the CCN. Also notice the CU Priority values added for the OSC control units.

Example 3-2   HCD - Updated IOCP statements file (with CMT statements)

.  PATH=((CSS(0),D0,D2,DA),(CSS(1),D0,D2,DA)),UNIT=CFP              
         IODEVICE ADDRESS=(FF07,007),CUNUMBR=(FFF6),UNIT=CFP                    
         IODEVICE ADDRESS=(FF82,007),CUNUMBR=(FFF6),UNIT=CFP                    
         IODEVICE ADDRESS=(FFB3,007),CUNUMBR=(FFF6),UNIT=CFP                    
*CMT* VERSION=000                                                               
*CMT* CCN=33334885(CFR)                                                         
*CMT* E200.0=0333,E200.1=0333,E200.2=0333,E300.0=0333,E300.1=0333               
*CMT* E300.2=0333,EF00.0=0333,EF00.1=0333,EF00.2=0333,F000.0=0333               
*CMT* F000.1=0333,F000.2=0333,F080.0=0333,F080.1=0333,F080.2=0333               
******************************** Bottom of Data ********************************

2. From the HCD main panel shown in Figure 3-74, enter the work IODF name used. Select 
option 5, Migrate configuration data.

Note: Control unit priorities are stored in the IOCP output file created by CMT that gets 
migrated back into HCD. HCD maintains these priorities and outputs them when 
creating another IOCP deck. They are in the form of commented lines at the end of the 
IOCP deck; see Example 3-2.

 

 

 

120 IBM System z10 Enterprise Class Configuration Setup



 

Figure 3-74   HCD - main menu, select Migrate configuration data

3. From the Migrate Configuration Data panel shown in Figure 3-75, select option 1, Migrate 
IOCP/OS data, then press Enter.

Figure 3-75   HCD - Migrate Configuration Data

4. On the Migrate IOCP Data panel shown in Figure 3-76, fill in the following fields and then 
press Enter:

Processor ID Use the same one used to create the IOCP input deck.

OS configuration ID This is the OS configuration associated with the processor.

IOCP only input data set This is the data set name specified when the iocpout.txt file 
was uploaded to TSO (see 3.7, “HCD - Build the 2097 
production IODF” on page 123).

Processing mode Select option 2 to save the results of the migration. (Prior to 
using 2, however, try to migrate using option 1, in order to 
validate the operation.)

Migrate options Select option 3 for PCHIDS. Only the PCHIDs are migrated 
into the work IODF.

 z/OS V1.9 HCD
 Command ===> ________________________________________________________________ 
                                                                               
                            Hardware Configuration                             
                                                                               
 Select one of the following.                                                  
                                                                               
 5_  1.  Define, modify, or view configuration data                            
     2.  Activate or process configuration data                                
     3.  Print or compare configuration data                                   
     4.  Create or view graphical configuration report                         
     5.  Migrate configuration data                                            
     6.  Maintain I/O definition files                                         
     7.  Query supported hardware and installed UIMs                           
     8.  Getting started with this dialog                                      
     9.  What's new in this release                                            
                                                                               
 For options 1 to 5, specify the name of the IODF to be used.                  
                                                                               
 I/O definition file . . . 'SYS6.IODF39.WORK'                                + 

 ----------- Migrate Configuration Data -------------  
                                                       
                                                       
   Select one of the following tasks.                  
                                                       
   1   1.  Migrate IOCP/OS data                        
       2.  Migrate switch configuration data           
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Figure 3-76   HCD - Migrate IOCP / MVSCP / HCPRIO Data

5. HCD displays any errors or warning messages as a result of the migration action. In our 
example, we did not receive any messages other than the one indicating that the migration 
was successful (Figure 3-77). This is the message that you should get. 

At this point, the work IODF contains both the CHPID definitions and the mapping to 
PCHIDs that was done using the CHPID Mapping Tool. 

Figure 3-77   HCD - Migration Message List

6. Press PF3 and you should receive the following message:

IOCP/Operating system deck migration processing complete, return code = 0.

7. Press PF3 again to continue.

-------------------- Migrate IOCP / MVSCP / HCPRIO Data --------------------
                                                                            
                                                                            
 Specify or revise the following values.                                    
                                                                            
 Processor ID . . . . . . . . . . . . SCZP202   +   CSS ID . . . . . . _  + 
 OS configuration ID  . . . . . . . . TEST2097 +                           
                                                                            
 Combined IOCP/MVSCP input data set . _____________________________________ 
 IOCP only input data set . . . . . . 'SYS6.IODF39.IOCPOUT.SCZP202'         
 MVSCP only or HCPRIO input data set  _____________________________________ 
            Associated with processor ________  +                           
                            partition ________  +                           
 Processing mode  . . . . . . . . . . 2   1.  Validate                      
                                          2.  Save                          
                                                                            
 Migrate options  . . . . . . . . . . 3   1.  Complete                      
                                          2.  Incremental                   
                                          3.  PCHIDs                        
 MACLIB used  . . . . . . . 'SYS1.MACLIB'                                   
 Volume serial number . . . ______  + (if not cataloged) 

 -------------------------- Migration Message List --------------------------- 
    Query Help                                                                
  --------------------------------------------------------------------------   
                                                                   Row 1 of 2  
  Command ===> ___________________________________________ Scroll ===> PAGE    
                                                                               
  Messages are sorted by severity. Select one or more, then press Enter.       
                                                                               
  / Statement  Orig Sev Message Text                                           
  _                 I   I/O configuration successfully written to the IODF     
  #                     SYS6.IODF39.WORK.                                      
  ***************************** Bottom of data ******************************  
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3.7  HCD - Build the 2097 production IODF
To make use of the definitions that we updated in HCD, we need to create a 2097 production 
IODF from our work IODF and remotely or locally write the IODF to the 2094 IOCDS using 
Write IOCDS in preparation of upgrade, as follows:

1. From the HCD main panel, select option 2, Activate or process configuration data 
(Figure 3-78).

Figure 3-78   HCD - Main menu, select activate or process configuration data

2. HCD displays the Activate or Process Configuration Data panel. Select option 1, Build 
production I/O definition file, and press Enter (Figure 3-79).

Figure 3-79   HCD - Activate or Process Configuration Data, select Build production IODF

 z/OS V1.9 HCD                                          
 Command ===> ________________________________________________________________ 
                                                                               
                            Hardware Configuration                             
                                                                               
 Select one of the following.                                                  
                                                                               
 2   1.  Define, modify, or view configuration data                            
     2.  Activate or process configuration data                                
     3.  Print or compare configuration data                                   
     4.  Create or view graphical configuration report                         
     5.  Migrate configuration data                                            
     6.  Maintain I/O definition files                                         
     7.  Query supported hardware and installed UIMs                           
     8.  Getting started with this dialog                                      
     9.  What's new in this release                                            
                                                                               
 For options 1 to 5, specify the name of the IODF to be used.                  
                                                                               
 I/O definition file . . . 'SYS6.IODF39.WORK'                                + 

 ----- Activate or Process Configuration Data -------  
                                                       
                                                       
   Select one of the following tasks.                  
                                                       
   1_  1.  Build production I/O definition file        
       2.  Build IOCDS                                 
       3.  Build IOCP input data set                   
       4.  Create JES3 initialization stream data      
       5.  View active configuration                   
       6.  Activate or verify configuration            
           dynamically                                 
       7.  Activate configuration sysplex-wide         
       8.  Activate switch configuration               
       9.  Save switch configuration                   
       10. Build I/O configuration statements          
       11. Build and manage S/390 microprocessor       
           IOCDSs and IPL attributes                   
       12. Build validated work I/O definition file    
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3. HCD displays the Message List panel (Figure 3-80). Verify that you have only Severity W 
warning messages and that they are normal for the configuration. Correct any messages 
that should not occur and try to build the production IODF again. Continue this process 
until you have no messages that indicate problems.

Figure 3-80   HCD - Message List (building Production IODF)

4. Press PF3 to continue.

5. HCD displays the Build Production I/O Definition File panel. Fill in the fields Production 
IODF name and Volume serial number, and then press Enter (Figure 3-81).

Figure 3-81   HCD - Build Production I/O Definition File

6. HCD displays the Define Descriptor Fields panel (Figure 3-82). Press Enter to accept the 
descriptor fields selected by HCD, or enter your selection and then press Enter.

 ------------------------------- Message List -------------------------------- 
    Save  Query  Help                                                          
  --------------------------------------------------------------------------   
                                                                 Row 1 of 139  
                                                                               
  Messages are sorted by severity. Select one or more, then press Enter.       
                                                                               
  / Sev Msg. ID  Message Text                                                  
  _ W   CBDG092I Maximum number of 256 logical paths on link 61.0C to          
  #              control unit 8000 exceeded. Actually defined: 312             
  _ W   CBDG092I Maximum number of 256 logical paths on link 61.10 to          
  #              control unit 8000 exceeded. Actually defined: 424             
  _ W   CBDG092I Maximum number of 256 logical paths on link 61.14 to          
  #              control unit 8000 exceeded. Actually defined: 424             
  _ W   CBDG092I Maximum number of 256 logical paths on link 62.08 to          
  #              control unit 8000 exceeded. Actually defined: 312             
  _ W   CBDG092I Maximum number of 256 logical paths on link 62.0C to          
  #              control unit 8000 exceeded. Actually defined: 312             
  _ W   CBDG092I Maximum number of 256 logical paths on link 62.10 to          
  #              control unit 8000 exceeded. Actually defined: 312             

 -------------- Build Production I/O Definition File ---------------  
                                                                       
                                                                       
   Specify the following values, and choose how to continue.           
                                                                       
   Work IODF name . . . : 'SYS6.IODF39.WORK'                           
                                                                       
   Production IODF name . 'SYS6.IODF39'                                
   Volume serial number . IODFPK  +                                    
                                                                       
   Continue using as current IODF:                                     
   2   1.  The work IODF in use at present                             
       2.  The new production IODF specified above                     
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Figure 3-82   HCD - Define Descriptor Fields

7. HCD displays the following message, indicating that the production IODF was successfully 
created:

Production IODF SYS6.IODF39 created.

Proceed to the next section to implement the configuration on the 2097.

3.8  Load the 2097 processor IOCDS
At this point, we have a production IODF, which is SYS6.IODF39. Now we need to update the 
IOCDS on the server that will be upgraded (for example, SCZP101 → SCZP202). The 
IOCDS will be available to power-on reset after the processor has been upgraded.

Update the IOCDS
1. From the HCD main panel, select option 2, Activate or process configuration data 

(Figure 3-83). Verify that the IODF is the production one created in the previous step, then 
press Enter.

Figure 3-83   HCD - main menu, select Activate or process configuration data

 -------------------- Define Descriptor Fields -------------------- 
                                                                     
                                                                     
   Specify or revise the following values.                           
                                                                     
   Production IODF name  . : 'SYS6.IODF39'                           
                                                                     
   Descriptor field 1  . . . SYS6                                    
   Descriptor field 2  . . . IODF39 

 z/OS V1.9 HCD                                                                 
 Command ===> ________________________________________________________________ 
                                                                               
                            Hardware Configuration                             
                                                                               
 Select one of the following.                                                  
                                                                               
 2   1.  Define, modify, or view configuration data                            
     2.  Activate or process configuration data                                
     3.  Print or compare configuration data                                   
     4.  Create or view graphical configuration report                         
     5.  Migrate configuration data                                            
     6.  Maintain I/O definition files                                         
     7.  Query supported hardware and installed UIMs                           
     8.  Getting started with this dialog                                      
     9.  What's new in this release                                            
                                                                               
 For options 1 to 5, specify the name of the IODF to be used.                  
                                                                               
 I/O definition file . . . 'SYS6.IODF39'                                       
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2. The Activate or Process Configuration Data panel displays (Figure 3-84). Select option 11, 
Build and manage S/390 microprocessor IOCDSs and IPL attributes, then press 
Enter.

Note: In this example, we are assuming that we have connectivity to the 2094 that is being 
upgraded via the HMC local network in order to create an IOCDS. 

In the case where the server being upgraded is not accessible from the HMC LAN, we 
would need to create an IOCP file from HCD and then do a stand-alone IOCP. This is done 
using the same process as used to create an IOCP file for the CHPID Mapping Tool.

Figure 3-84   HCD - Activate or Process Configuration Data - Select Build IOCDSs

3. The S/390 Microprocessor Cluster List panel displays (Figure 3-85). Select the 2094 being 
upgraded from the list by typing a forward slash (/) to update one of its IOCDSs, then press 
Enter.

Tip: The Support Element can now read an IOCP file that has been written in ZIP 
format.

 ----- Activate or Process Configuration Data ------- 
                                                      
                                                      
   Select one of the following tasks.                 
                                                      
   11  1.  Build production I/O definition file       
       2.  Build IOCDS                                
       3.  Build IOCP input data set                  
       4.  Create JES3 initialization stream data     
       5.  View active configuration                  
       6.  Activate or verify configuration           
           dynamically                                
       7.  Activate configuration sysplex-wide        
       8.  Activate switch configuration              
       9.  Save switch configuration                  
       10. Build I/O configuration statements         
       11. Build and manage S/390 microprocessor      
           IOCDSs and IPL attributes                  
       12. Build validated work I/O definition file   
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Figure 3-85   HCD - S/390 Microprocessor Cluster List

4. The Actions on selected CPCs panel displays (Figure 3-86). Select option 1, Work with 
IOCDSs, and then press Enter.

Figure 3-86   HCD - Actions on selected CPCs, Work with IOCDSs

5. The IOCDS List panel displays (Figure 3-87). Select the IOCDS that you wish to update 
for the 2097 upgrade by typing a forward slash (/), then press Enter.

Figure 3-87   HCD - IOCDS List

 Goto  Query  Help                                                              
 ------------------------------------------------------------------------------ 
                       S/390 Microprocessor Cluster List             Row 1 of 4 
 Command ===> _______________________________________________ Scroll ===> PAGE  
                                                                                
 Select one or more CPCs, then press Enter.                                     
                                                                                
   --------------CPC--------------   IODF                                       
 / SNA Address        Type   Model   Processor ID                               
 / USIBMSC.SCZP101    2094   S18     SCZP101                                    
 _ USIBMSC.SCZP701    9672   XX7     SCZP701                                    
 _ USIBMSC.SCZP801    2064   1C7     SCZP801                                    
 _ USIBMSC.SCZP901    2084   C24     SCZP102                                    
 ******************************* Bottom of data ********************************

 ----------------- Actions on selected CPCs ------------------ 
                                                                
                                                                
   Select by number or action code and press Enter.             
                                                                
   1_  1.  Work with IOCDSs . . . . . . . . . . (s)             
       2.  Work with IPL attributes . . . . . . (i)             
       3.  Select other processor configuration (p)             

 . Goto  Query  Help                                                            
 ------------------------------------------------------------------------------ 
                                   IOCDS List          Row 1 of 4 More:       > 
 Command ===> _______________________________________________ Scroll ===> PAGE  
                                                                                
 Select one or a group of IOCDSs, then press Enter.                             
                                                                                
                                          -----Token Match----- Write           
 / IOCDS       Name     Type   Status     IOCDS/HSA IOCDS/Proc. Protect         
 / A0.SCZP202  IODF35  LPAR   Alternate  No  No          No
 _ A1.SCZP202  IODF36   LPAR   POR Yes No  Yes-POR
 _ A2.SCZP202  IODF33   LPAR   Alternate  No        No          No              
 _ A3.SCZP202  IODF34   LPAR   Alternate  No        No          No              
 ******************************* Bottom of data ********************************
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6. The Actions on selected IOCDSs panel displays (Figure 3-88). Select option 1, Update 
IOCDS, then press Enter.

Figure 3-88   HCD - Actions on selected IOCDSs

7. The Build IOCDSs panel displays (Figure 3-89). Verify that all the information is correct. 
Fill in the field Title1, then press Enter.

Figure 3-89   HCD - Build IOCDSs

8. Because YES was specified for the field Write IOCDS in preparation of upgrade, HCD now 
displays a confirmation panel (Figure 3-90). Press Enter to continue. 

 ---------------- Actions on selected IOCDSs ----------------- 
                                                                
                                                                
   Select by number or action code and press Enter.             
                                                                
   1_  1.  Update IOCDS . . . . . . . . . . . . (u)             
       2.  Switch IOCDS . . . . . . . . . . . . (s)             
       3.  Enable write protection  . . . . . . (e)             
       4.  Disable write protection . . . . . . (w)             

Note: Specifying YES in the Write IOCDS in preparation of upgrade field is only 
required when you are upgrading the existing hardware and you wish to write the 
IOCDS for a 2097 from the existing hardware. The yes value permits the writing of 
an IOCDS that contains information that the current hardware does not recognize.

 ------------------------------- Build IOCDSs --------------------------------- 
                                                                    Row 1 of 1  
   Command ===> ___________________________________________ Scroll ===> PAGE    
                                                                                
   Specify or revise the following values.                                      
                                                                                
   IODF name . . . . . . . . . : 'SYS6.IODF39'                                  
                                                                                
   Title1 . TEST39 _________________________________________________________    
   Title2 : SYS6.IODF39 - 2007-11-30 18:33 
                                                                                
                              Write IOCDS in                                    
   IOCDS        Switch IOCDS  preparation of upgrade                            
   A0.SCZP102   No            YES                                               
   ***************************** Bottom of data ******************************  
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Figure 3-90   HCD - Build IOCDS (Confirm Write IOCDS)

9. The Job Statement Information panel displays (Figure 3-91). Fill in the job statements as 
required by the installation, then press Enter. HCD submits the job to update the IOCDS. 

Figure 3-91   HCD - Job Statement Information

10.Verify the job output to ensure that the IOCDS was written without error and to the correct 
IOCDS. You should receive the following message:

ICP057I IOCP JOB WIOCDS SUCCESSFUL. LEVEL A0 IOCDS REPLACED.

Now if you return to HCD option 2.11 and view the IOCDS, you will note that the SNA 
Address remains at USIBMSC.SCZP101 (Figure 3-92 on page 130).

------------------------------- Build IOCDSs --------------------------------
                                                                             
---------- Confirm Write IOCDS in preparation of processor upgrade ----------
                                                                  Row 1 of 1 
 Command ===> ___________________________________________ Scroll ===> CSR    
                                                                             
 Scroll forward to view the complete list of IOCDSs which will be written    
 regardless of processor type in preparation of a processor upgrade. Press   
 F3 or F12 to cancel, press ENTER to confirm the write request.              
                                                                             
 The processor receiving the IOCDS(s) must be a CMOS processor.              
                                                                             
 You will not be able to perform a POR using the new IOCDS until your        
 processor has been upgraded. Do not make the new IOCDS the active one on    
 your processor. Do not activate any I/O configuration changes in the IODF   
 until your processor has been upgraded. Keep the old processor definition   
 in an IODF until after the upgrade.                                         
                                                                             
 IOCDS                                                                       
 A0.SCZP202                                                                  
 ***************************** Bottom of data ****************************** 

Note: Route the job to execute on the image you are logged on to. In that way, you 
know that the image can “see” the new 2097 in order to update its IOCDS.

 ------------------------- Job Statement Information -------------------------- 
                                                                                
   Specify or revise the job statement information.                             
                                                                                  
   Job statement information                                                    
   //WIOCDS  JOB (ACCOUNT),'NAME'                                               
   //*                                                                          
   //*                                                                          
   //*                                                                          
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Figure 3-92   HCD - IOCDS with upgrade IODF

Also, when you select USIBMSC.SCZP101, notice that IOCDS A0 (which we wrote the 
upgrade IODF to) has a status of Invalid Status (Figure 3-93). This occurs because we 
specified YES for Write IOCDS in preparation for upgrade, and the IOCDS contains IOCP 
statements and code relevant only for a 2097 processor.

The status will switch when this processor is upgraded to a 2097. The 2097 IOCDS status 
will change to Alternate and the 2094 IOCDSs will change to Invalid. 

Figure 3-93   HCD - IOCDS showing Invalid Status

3.9  HMC steps for activation profiles

Building the Reset Profile and pointing to required IOCDS
Now that the IODF has been written to an IOCDS, a Reset (power-on reset) Profile needs to 
be built to point to that IOCDS. This Reset Profile is used to power-on reset the 2097 after it 
has been upgraded.

Goto  Query  Help                                                              
 ------------------------------------------------------------------------------ 
                       S/390 Microprocessor Cluster List             Row 1 of 4 
 Command ===> _______________________________________________ Scroll ===> PAGE  
                                                                                
 Select one or more CPCs, then press Enter.                                     
                                                                                
   --------------CPC--------------   IODF                                       
 / SNA Address        Type   Model   Processor ID                               
 s USIBMSC.SCZP101    2094   S18     SCZP101                                    
 _ USIBMSC.SCZP701    9672   XX7     SCZP701                                    
 _ USIBMSC.SCZP801    2064   1C7     SCZP801                                    
 _ USIBMSC.SCZP901    2084   C24     SCZP102                                    
 ******************************* Bottom of data ********************************

Note: We recommend that the IOCDS written in preparation for the upgrade be 
rewritten normally at your earliest convenience. Subsequent MESs may cause an 
IOCDS written in preparation for an upgrade to become invalid. 

 Goto  Query  Help                                                            
 ------------------------------------------------------------------------------ 
                                   IOCDS List          Row 1 of 4 More:       > 
 Command ===> _______________________________________________ Scroll ===> PAGE  
                                                                                
 Select one or a group of IOCDSs, then press Enter.                             
                                                                                
                                          -----Token Match----- Write           
 / IOCDS       Name     Type   Status     IOCDS/HSA IOCDS/Proc. Protect         
_ A0.SCZP202  TEST39  LPAR   Invalid    No        No          No 
_ A1.SCZP202  IODF36 LPAR   POR        Yes       No          Yes-POR         
 _ A2.SCZP202  IODF33 LPAR   Alternate  No        No          No              
 _ A3.SCZP202  IODF34 LPAR   Alternate  No        No          No              
******************************* Bottom of data ********************************
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Do the following:

1. Log on to the HMC and select the 2094 that you are upgrading in Defined CPCs Work 
Area.

2. Under Operational Customization, select Customize/Delete Activation Profiles.

3. Select the “Last Used” Reset Profile and choose Customize.

4. Save this “Last Used” profile with a new Profile name to be referred to when the power-on 
reset is required (for example, SCZP101T).

5. Select the new Profile and click Customize.

6. Click the IOCDS that you just updated in the previous step (for example, IOCDS-A0). The 
message shown in Figure 3-94 displays.

Figure 3-94   HMC - Activation Profiles, message ACTB0PDL

Depending on circumstances, you may wish to select Yes or No. At this point, you may 
want to review the Partition Activation List.

7. Click Yes and notice the warning message that is displayed (Figure 3-95 on page 132).

Note: We will be using Ver 2.9.2 HMC because it is presumed that this is the HMC you 
will have with the 2094 when performing an upgrade to 2097.
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Figure 3-95   HMC - Activation Profiles (IOCDS not valid warning message)

8. When you click Yes the following warning message will be displayed (Figure 3-96).

Figure 3-96   HMC - Activation Profiles (IOCDS Not Valid warning message)

Build/Verify Image Profiles
While still in the Reset Profile, you can now review the Image Profile attributes. If you are 
adding additional resources (that is, storage or CPs) to the 2097 during the upgrade, you may 
not be able to add these to the Image Profile at this time.
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Build/Verify Load Profiles
Go through the Load (IPL) Profiles for this 2094 and verify that you are satisfied with all the 
IPL and LOADPARM parameters that have been defined for the Images.

Build/Verify Load Members in SYS#.IPLPARM
You may require additional Load Members defined in SYS#.IPLPARM after the processor has 
been upgraded to the 2097.

Additionally, if you used the HWNAME parameter to point to the Processor ID, then this 
should be updated to point to the new Processor ID (in this example, from SCZP101 to 
SCZP202).

STP configuration
STP configuration should be reviewed to ensure that the correct External Time Source has 
been configured and that you are connected to the correct Coordinated Time Network. 

Refer to Chapter 7, “Server Time Protocol setup” on page 305 for details. 

Performing a power-on reset (POR) of the 2097
When the 2094 processor has been upgraded to a 2097, the IBM service representative 
performs a power-on reset with a Diagnostic IOCDS. 

After this has been completed and the IBM service representative is satisfied with the state of 
the processor, the service representative will hand over the processor to you. You perform 
another power-on reset using the Reset Profile created in the previous step.
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Chapter 4. Replace a System z9 EC with a 
z10 EC

In this chapter we describe how to replace an existing System z9 EC with a z10 EC. 

You can also upgrade from a z990 to a System z10 EC; however, only examples of upgrading 
or replacing a System z9 EC are shown in this book. An upgrade includes all frames, cages, 
support cards and new I/O features.

Because a wide variety of different environments exist, the results achieved in your 
environment may differ from those described here. Nevertheless, the step-by-step process 
we explain in this chapter should provide enough information for you to replicate the approach 
in your own environment. 

We discuss the following topics:

� Scenario overview

� HCD - Migrate the existing 2094 IODF

� Save and restore configuration files

� Validate the 2097 work IODF

� CMT - Assign CHPIDs to PCHIDs

� HCD - Migrate PCHIDs back into work IODF

� Build the production IODF

� Implementing the processor configuration on a 2097

� HMC steps for activation profiles

4
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4.1  Scenario overview
We begin by providing an overall description of this scenario.

4.1.1  The configuration process
Figure 4-1 illustrates the general process flow that we follow in our example. The numbered 
steps are described following the figure.

Figure 4-1   CMT - Overall process flow

1. When you are planning to migrate to a System z10 EC, the IBM Technical Support team 
can help you to define a configuration design that meets your needs. The configuration 
then gets passed to the ordering step.

2. The IBM order for the configuration is created and passed to the manufacturing process.

3. The manufacturing process creates a configuration file that is stored on the IBM Resource 
Link Web site. The configuration file describes the hardware being ordered. This data is 
available for download by the client installation team.

4. The existing System z9 EC I/O configuration is used as a starting point into HCD. The 
System z9 EC production IODF is used as input to HCD to create a work IODF that will be 
the base to define the new System z10 EC configuration. 

5. When the new System z10 EC configuration has been added and the obsolete hardware 
has been deleted, a validated version of the configuration is saved in a 2097 validated 
work IODF. 
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6. From the validated work IODF, create a file containing the z10 EC IOCP statements. This 
IOCP statements file is transferred to the workstation used for the CHPID Mapping Tool 
(CMT). HCM may also be used here to transfer the IOCP deck to and from the CMT.

7. The configuration file created by the IBM Manufacturing process in step 3 is downloaded 
from Resource Link to the CMT workstation.

8. The CHPID Mapping Tool uses the input data from files to map logical channels to 
physical ones on the new System z10 EC hardware. 

You may have to make decisions in response to situations that may arise, such as:

a. Resolving situations in which the limitations on the purchased hardware cause a single 
point of failure (SPoF). You may need to purchase additional hardware in order to 
resolve some SPoF situations.

b. Prioritizing certain hardware items over others. 

After processing by the CHPID Mapping Tool, the IOCP statements contain the physical 
channels assignment to logical channels, based on the actual purchased hardware 
configuration. 

The CHPID Mapping Tool also creates configuration reports to be used by the IBM service 
representative and the installation team. 

9. The file containing the updated IOCP statements created by the CHPID Mapping Tool,   
which now contains the physical channels assignment, is transferred to the host system. 

10.Using HCD again, and taking as input the validated work IODF file created in step 5 and 
the IOCP statements updated by the CHPID Mapping Tool, apply the physical channel 
assignments done by the CMT to the configuration data in the work IODF. 

After the physical channel data has been migrated into the work IODF, a 2097 production 
IODF is created and the final IOCP statements can be generated. 

The installation team uses the configuration data from the 2097 production IODF when the 
final power-on reset is done, yielding a z10 EC with an I/O configuration ready to be used. 

If you are upgrading an existing 2094, you may be able to use HCD to write an IOCDS to your 
current 2094 in preparation for the upgrade. If you can write an IOCDS to your current 2094 in 
preparation for upgrading it to a 2097, do so and inform the IBM service representative which 
IOCDS to use. 

If the new 2097 is not connected using a LAN to the CPC where HCD is running, or you are 
not upgrading or cannot write an IOCDS using HCD in preparation for the upgrade, then use 
HCD to produce an IOCP input file and download the input file to a USB Flash Memory Drive. 

The IOCP input file will then need to be loaded into the 2097 Support Element IOCDS using 
the Stand-Alone Input/Output Configuration Program. Refer to Technical Manual SB10-7152 
for details.

The migration path from a System z9 EC to a z10 EC can be either in the form of a field 
upgrade to the existing System z9 EC, or a replacement (push/pull) of an existing System z9 
EC with a new z10 EC. Note the following points:

1. A field upgrade means that the existing System z9 EC processor serial number is retained 
during the upgrade. 

Note: Using the HCD option Write IOCDS in preparation of an upgrade is the preferred 
method for writing the initial IOCDS when installing a new 2097. This scenario uses the 
HCD option Write IOCDS process. 
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2. A replacement of the existing System z9 EC by a new System z10 EC implies physically 
removing (push) the System z9 EC and bringing in a new System z10 EC (pull) to take its 
place. The replacement z10 EC has a new serial number, different from the existing 
System z9 EC.

In this chapter, we document the push/pull scenario. 

4.1.2  Planning considerations
The follow table lists the channel types as described in an IOCDS that are used with the 
System z10 EC.

Table 4-1   Channels, links, and adapters with CHPID type.

Keep the following considerations in mind when planning your configuration.

Coupling links
Only the following Coupling Facility CHPIDs are supported:

� CHPID Type=CFP - ISC-3 links in peer mode

� CHPID Type=CBP - ICB-4 links

� CHPID Type=CIB - PSIFB links connecting to a HCA2-O (Optical) card

� CHPID Type=ICP - Internal Coupling links

Channels
CHPID 
Type

May be 
defined as 

Shared

May be 
defined as 
Spanned

ESCON channels:
Connection Channel (ESCON architecture)
Channel to Channel (connects to CNC)

CNC
CTC

yes
ye

no
no

FICON bridge. A FICON channel that attaches to an ESCON Director 
Model 5

FCV yes no

FICON native channels that attach to FICON directors or directly to 
FICON control units

FC yes yes

FICON channels that attach to Fibre channel devices, switches, 
directors, or Fibre-Channel-to-SCSI bridges

FCP yes yes

ISC-3 peer mode channels (connects to another CFP) CFP yes yes

ICB-4 peer channels (connects to another ICB-4) CBP yes yes

IC peer channels (connects to another ICP) ICP yes yes

InfiniBand host channel adapters (HCA) CIB yes yes

HiperSocket (IQDIO) channels IQD yes yes

OSA adapters using QDIO architecture OSD yes yes

OSA adapters using non-QDIO architecture OSE yes yes

OSA 1000Base-T adapters for OSA-ICC OCE yes yes

OSA-Express2 adapters for NCP OSN yes yes

Note: Coupling links can be defined as both Coupling and STP links or STP only links.
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HMC
The System z10 EC requires HMC Application Ver 2.10.0 or higher and only uses Ethernet 
for its network connection. The HMC and also the Service Elements do not contain a floppy 
disc drive, thus requiring the use of a USB Flash Memory Drive to input and back up 
customer configuration data.

Software support
HCD V1.9 or HCD V1.7 and later with 2097DEVICE PSP Bucket and PTFs is required to 
define and support some of the new features of the System z10 EC. 

Open Systems Adapter - Integrated Console Controller (OSA-ICC)
You might consider using OSA Express2 1000BaseT CHPIDs defined as TYPE=OSC. These 
OSA cards allow you to set up console function supported by a configuration file defined on 
the Support Element for that processor.

Fibre Channel Protocol (FCP)
When using CHPIDs defined as TYPE=FCP, you may wish to consider NPIV.

CPC name versus Processor ID
HCD allows you to define different Processors (Logical) to the same CPC (Physical). The 
Processor ID needs to be unique within the same IODF, but the CPC name does not. 
Therefore, the CPC name does not need to match the Processor ID. This is useful where you 
may have several Processor/logical partition/control unit setups that share the same physical 
CPC within the same IODF. Furthermore, the Processor ID is what is defined for the 
HWNAME parameter in the LOAD member in SYS1.IPLPARM.

The CPC name is coded in HCD option 1.3 under View Processor Definition in the CPC name 
field under SNA address, along with a Network name. It is the CPC name, and not the 
Processor ID, that appears on the HMC. 

When you view the Network information for a CPC via the HMC, note that the SNA address is 
made up of a Network name and CPC name separated by a dot (for example, 
USIBMSC.SCZP201). These values are defined in the Support Element for the CPC and they 
need to match the values set in the IODF so that HCD option 2.11 can find the CPC to write 
an IOCDS in the S/390 Microprocessor Cluster List.

Local System Name
An additional system name “LSYSTEM” is used to identify the local system name of a server 
when defining PSIFB type=CIB coupling links.

This data field can be found when changing a CIB-capable processor under HCD option 1.3

The LSYSTEM field can be set or changed to any 1-8 alphanumeric characters and also can 
begin with either an alpha or numeric character. All characters are upper case.

Here are the rules that determine whether, and where, HCD will set the LSYSTEM keyword 
automatically:

1. If a CIB-capable processor is defined and the CPC name is set but the local system name 
is not set, HCD defaults the local system name to the CPC name. 

2. If a CIB-capable processor that has not yet defined a CPC name will be changed to get a 
CPC name but no local system name, HCD defaults the CPC name to the local system 
name.
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3. If a non-CIB capable processor is changed to a support level that is CIB capable, and the 
processor has a CPC name set but no local system name, the local system name is 
defaulted to the CPC name. 

4. If the processor definition is changed such that the local system name is explicitly 
removed, HCD does not do any defaulting.

5. If a processor has a local system name set (whether it has a CPC name or not), any 
change to the local system name has to be done explicitly. There will be no implicit name if 
the CPC name or the support level is changed.

6. During Build Production IODF it is verified that a local system name has to be set for the 
processor if the processor has a CIB channel path defined. If this verification fails, an error 
message is given and the production IODF is not built.

We do, however, recommend that the local system name be the same as the CPC name.

Additional keywords on the ID statement in an IOCP deck include:

AID: Adapter ID
Port: HCA port
CPATH: Specifies the CCSID and CHPID on the connecting system

4.1.3  Replace scenario (push/pull)
This scenario describes the configuration steps needed to replace an existing 2094 processor 
with a new 2097 processor. Key factors and procedures are as follows:

� HCD requires a new Processor ID for the 2097.

� HCD requires a new CPC name for the 2097.

� The 2097 processor channels connect to the same switch ports and access the same 
control unit interfaces.

� The control unit interfaces connect to the same switch ports.

� The starting IODF is the current 2094 production IODF.

� The target IODF is a new 2097 work IODF.

� HCD actions:

– Migrate updated IOCP statements
– Build production IODF
– Remote write IODF to IOCDS

� HMC actions:

– Build Reset Profile and point to required IOCDS
– Build/verify Image Profiles
– Build/verify Load Profiles
– Performing a power-on reset

The example here uses a 2094-S18 with a Processor ID of SCZP101 and three CSSs (CSS 
ID=0, CSS ID=1 and CSS ID=2) and replaces it with a 2097-E26 with a Processor ID of 
SCZP202.

The CPC name SCZP101 and serial number 000101 change to the CPC name of SCZP202 
and serial number of 000202. 

The following CHPID types are migrated:

� OSD, OSE, OSC, OSN
� CTC, CNC, FC, FCP
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� CBP, CFP, ICP 
� IQD

The following Hardware/CHPID types are not supported and not migrated to the 2097:

� PCIXCC and PCICA
� ICB-3 links
� ICB-2 links
� ISC-3 links in compatibility mode (CHPID types CFS and CFR)
� OSA-Express Token Ring

Table 4-2 summarizes the migration options and tool requirements. The step-by-step process 
is documented later in this chapter.

Table 4-2   2094 I/O configuration migrated to a 2097

4.2  HCD - Migrate the existing 2094 IODF
The following steps explain how to define the existing I/O configuration to the new 2097 IODF, 
and then migrate the channel subsystem and logical partitions from the 2094 to the 2097 
server. Using HCD, the sequence of operations is as follows:

1. Create a 2097 work IODF from the current 2094 production IODF.

2. Repeat the 2094 processor being replaced.

3. Observe Coupling Link messages for later reference. 

4. Delete unsupported items from the repeated 2094.

5. Change the repeated 2094 to a 2097, then delete the 2094.

6. Redefine all required CF connections to other processors and any Internal CF 
connections required.

2094 to 2097 Replace existing 2094 with a 2097 
(push/pull)

Processor.id Require to change 2094 to new ID

CPC name New name

Channel to switch port connections Same ports

Control Unit to switch port connections Same ports

Starting IODF Current active production IODF

Target IODF Create a new work IODF

HCD action Repeat and Change (see below)

CHPID Mapping Tool Program (CMT)
(needed or not)

Optional, but recommended

CFReport File (CCN)
(needed or not)

Required

IOCP (import from validated work IODF) Yes

CMT PCHID reset Yes

CMT IOCP Output Yes

CMT Reports Yes, CHPID and CHPID to CU Report
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7. Define any additional CHPIDs, control units and devices you may be adding in the 
replacement.

8. Over-define channel paths.

9. Save OSA configuration information.

10.Build a validated 2097 work IODF.

11.Create an IOCP statements file and file transfer to the workstation running the CHPID 
Mapping Tool. This step can also be performed with HCM.

12.Create an IOCP statements file and file transfer to your workstation. This step can be 
performed with HCM.

13.Import CFReport and IOCP statements into the CMT.

14.Perform hardware resolution and PCHID/CHPID availability.

15.Create configuration reports for yourself and the IBM service representative.

16.Import IOCP statements updated with PCHIDs back into validated work IODF.

17.Build Production IODF and remote write the IOCP to an IOCDS on the processor; if not 
possible, copy the IOCP statements to a USB Memory Flash Drive.

18.Run Stand-Alone Input/Output Configuration Program to load the IOCP statements onto 
the 2097 Service Element IOCDS.

19.Build Reset, Image, and Load Profile.

20.Perform Power-on Reset (Activate) of 2097.

In the following sections, we describe these steps in more detail.

Create 2097 work IODF from current 2094 production IODF
In HCD, select the current production IODF that contains the 2094 processor that you are 
replacing (for example, SYS6.IODF38).

Repeat the 2094 processor being replaced
1. From the main HCD panel, select option 1.3, Processor List. Type r (for repeat) next to 

the 2094 you wish to replace, then press Enter (Figure 4-2).

Figure 4-2   HCD - Processor List (repeating processor)

 Processor List        Row 1 of 8 More:       >
Command ===> _______________________________________________ Scroll ===> CSR  
                                                                              
Select one or more processors, then press Enter. To add, use F11.             
                                                                              
                                                                              
/ Proc. ID Type +   Model +  Mode+ Serial-# + Description                     
_ ISGSYN   2064     1C7      LPAR  __________ ________________________________
_ ISGS11   2064     1C7      LPAR  __________ ________________________________
_ P000STP1 2084     C24      LPAR  01534A2084 ________________________________
_ P000STP2 2094     S08      LPAR  0BAD4E2094 ________________________________
r SCZP101  2094     S18      LPAR  02991E2094 ________________________________
_ SCZP201  2097     E26      LPAR  01DE502097 ________________________________
_ SCZP801  2064     1C7      LPAR  010ECB2064 ________________________________
_ SCZP901  2084     C24      LPAR  026A3A2084 ________________________________
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2. You are presented with the Identify Target IODF panel. Do one of the following:

– To retain all the other processor definitions in the IODF, press Enter. 

– Otherwise, type in a Target IODF data set name. In this case, only the processor you 
are repeating is retained in the target IODF.

3. The Create Work I/O Definition File panel prompts you to enter the data set name of the 
target IODF (for example, SYS6.IODF49.WORK).

4. You are presented with the Repeat Processor panel, as shown in Figure 4-3. Enter the 
Processor ID of the new 2097 (in this example, SCZP202) and leave all other fields 
unchanged, then press Enter to continue.

Figure 4-3   HCD - Repeat Processor (defining new processor ID)

Coupling Link Information messages
At this point, you may be presented with Severity E, I, or W messages. As shown in 
Figure 4-4, in our example CBDG441I messages were mentioned in the introduction; these 
were received due to the Coupling Link CHPIDs not being copied over to the 2094 definition.

 ---------------------------- Repeat Processor -------------------------

 Specify or revise the following values.                                
                                                                        
 Processor ID . . . . . . . . . SCZP202_                                
                                                                        
 Processor type . . . . . . . : 2094                                    
 Processor model  . . . . . . : S18                                     
 Configuration mode . . . . . : LPAR                                    
                                                                        
 Serial number  . . . . . . . . 02991E2094                              
 Description  . . . . . . . . . ________________________________        
                                                                        
 Specify SNA address only if part of an S/390 microprocessor cluster:   
                                                                        
 Network name . . . . . . . . . USIBMSC   +                             
 CPC name . . . . . . . . . . . SCZP101   +                             
                                                                        
 Local system name  . . . . . . ________                                
                                                                        
+------------------------------------------+
| New IODF SYS6.IODF49.WORK defined. | 
+------------------------------------------+
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Figure 4-4   HCD - Message List (CBDG441I)

Press PF3 or PF12 to continue. As shown in Figure 4-5 on page 144, there is now an 
additional 2094 processor named SCZP202.

Figure 4-5   HCD - Processor List (repeated processor)

Change the 2094 to a 2097 and delete the 2094
At this point you can either leave the original copy of the 2094 (SCZP101), or delete it from 
the IODF. In our example, we left it in the IODF for a few more steps.

Do the following:

1. Type c (change) next to SCZP202 to change the 2094 to a 2097, then press Enter. The 
Change Processor Definition panel is displayed (Figure 4-6). 

2. Make the following updates, then press Enter:

– Update Processor type to 2097.

– Update Processor Model to E26.

 ----------------------------- Message List -------------------------------- 
Save  Query  Help                                                         

                                                                 Row 1 of 239
 Command ===> ___________________________________________ Scroll ===> CSR    
                                                                             
 Messages are sorted by severity. Select one or more, then press Enter.      
                                                                             
 / Sev Msg. ID  Message Text                                                 
 _ W   CBDG441I The coupling facility connection between channel path BE     
 #              of processor SCZP101 and channel path 66 of processor        
 #              P000STP1 is not copied.                                      
 _ W   CBDG441I The coupling facility connection between channel path BF     
 #              of processor SCZP101 and channel path 54 of processor        
 #              P000STP2 is not copied.                                      
 _ W   CBDG441I The coupling facility connection between channel path C0     
 #              of processor SCZP101 and channel path C5 of processor        
 #              SCZP901 is not copied.                                       
_ I   CBDG271I Requested action on object SCZP101 successfully    
#              processed. 

 Processor List        Row 1 of 8 More:       > 
Command ===> _______________________________________________ Scroll ===> CSR  
                                                                              
Select one or more processors, then press Enter. To add, use F11.             
                                                                              
                                                                              
/ Proc. ID Type +   Model +  Mode+ Serial-# + Description                     
_ ISGSYN   2064     1C7      LPAR  __________ ________________________________
_ ISGS11   2064     1C7      LPAR  __________ ________________________________
_ P000STP1 2084     C24      LPAR  01534A2084 ________________________________
_ P000STP2 2094     S08      LPAR  0BAD4E2094 ________________________________
_ SCZP202  2094     S18      LPAR  02991E2094 ________________________________
_ SCZP801  2064     1C7      LPAR  010ECB2064 ________________________________
_ SCZP901  2084     C24      LPAR  026A3A2084 ________________________________
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– Update Serial Number to 0002022097.

– Update CPC name to SCZP202.

Figure 4-6   HCD - Change Processor Definition (changing repeated processor)

3. Press Enter. The Update Channel Path Identifiers panel displays (Figure 4-7). In our 
example we made no changes.

Figure 4-7   HCD - Update Channel Path Identifiers (not changed)

4. Press Enter “for each of the Channel Subsystem IDs.”

Now the repeated 2094 processor has been successfully changed to a 2097-E26; see 
Figure 4-8 on page 146.

----------------------- Change Processor Definition ----------------------
                                                                          
                                                                          
Specify or revise the following values.                                   
                                                                          
Processor ID . . . . . . . . : SCZP202                                    
Support level:                                                            
XMP, Basic 2094 support                                                   
Processor type . . . . . . . . 2097      +                                
Processor model  . . . . . . . E26       +                                
Configuration mode . . . . . . LPAR      +                                
                                                                          
Serial number  . . . . . . . . 0002022097  +                              
Description  . . . . . . . . . ________________________________           
                                                                          
Specify SNA address only if part of an S/390 microprocessor cluster:      
                                                                          
Network name . . . . . . . . . USIBMSC   +                                
CPC name . . . . . . . . . . . SCZP202   +                                
                                                                          
Local system name  . . . . . . ________ 

--------------------- Update Channel Path Identifiers ----------------------
                                                               Row 1 of 125 
 Command ===> __________________________________________ Scroll ===> CSR    
                                                                            
 Specify any changes to the channel path identifiers in the list below.     
                                                                            
 Processor ID . . . . : SCZP202                                             
 Channel Subsystem ID : 0                                                   
                                                                            
 CHPID  Type  Side  Until CHPID   New CHPID +                               
 00     OSD         __            00                                        
 01     OSD         __            01                                        
 02     OSD         __            02                                        
 03     OSD         __            03                                        
 04     OSD         __            04                                        
 05     OSD         __            05                                        
 07     OSC         __            07                                        
 08     OSD         __            08                                        
 09     OSE         __            09                                        
 0A     OSC         __            0A                                        
 0B     OSD         __            0B                                        
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Figure 4-8   HCD - Processor List (changed processor)

Observe the message displayed at the bottom of the panel indicating that the processor 
definition has been extended to its maximum configuration. This is because part of the 
Central Storage is allocated as a fixed-sized Hardware System Area that is not addressable 
by application programs. In HCD when you define as new or redefine a processor as 2097, 
HCD automatically defines the maximum configuration of four CSSs and 60 logical partitions.

Delete the 2094 processor definition
Now that the 2094 has been repeated and changed to become a 2097, the original 2094 
definition (SCZP101) must now be deleted so that the required Coupling Links can be 
restored.

1. Type d (for delete) next to the processor SCZP101 in the Processor List (Figure 4-9 on 
page 147).

 Processor List        Row 1 of 8 More:       >
Command ===> _______________________________________________ Scroll ===> CSR  
                                                                               
 Select one or more processors, then press Enter. To add, use F11.             
                                                                               
                                                                               
 / Proc. ID Type +   Model +  Mode+ Serial-# + Description                     
 _ ISGSYN   2064     1C7      LPAR  __________ ________________________________
 _ ISGS11   2064     1C7      LPAR  __________ ________________________________
 _ P000STP1 2084     C24      LPAR  01534A2084 ________________________________
 _ P000STP2 2094     S08      LPAR  0BAD4E2094 ________________________________
 _ SCZP101  2094     S18      LPAR  02991E2094 ________________________________
_ SCZP202  2097     E26      LPAR  02991E2097 ________________________________
 _ SCZP801  2064     1C7      LPAR  010ECB2064 ________________________________
 _ SCZP901  2084     C24      LPAR  026A3A2084 ________________________________
 ******************************* Bottom of data *******************************
                                                                               

                                                                               
+------------------------------------------------------------------+
| Definition of processor SCZP202 has been extended to its maximum |
| configuration.                                                   |
1+------------------------------------------------------------------+
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Figure 4-9   HCD - Processor List (Deleting processor)

2. Press Enter to “Confirm Delete Processor”.

Figure 4-10   HCD - Processor List (Processor deleted)

Reconnect the Coupling Link channel paths not migrated
Next, you need to manually redefine the Coupling Links you want from the SCZP202 
processor to any other processor, along with any Internal Coupling Links desired. To help this 
effort, you can get a CF connection report from the previous production IODF containing the 
2094. Alternatively, you can make a note of all CBDG441I error messages received in the 
previous step.

Define additional I/O
At this point, define any additional CHPIDs, control units and devices, CTCs, and so on that 
you may be adding into the 2097 during the upgrade.

Over-define channel paths on an XMP processor
Sometimes you may need to define a channel path that is not physically installed on the 
processor. This may be useful if you are planning to add additional channel cards to the 
processor in the future and want to have the definitions in the IODF before the hardware is 
installed.

Processor List        Row 1 of 8 More:       >
Command ===> _______________________________________________ Scroll ===> CSR  

Select one or more processors, then press Enter. To add, use F11.             
                                                                              
                                                                              
/ Proc. ID Type +   Model +  Mode+ Serial-# + Description                      
_ ISGSYN   2064     1C7      LPAR  __________ ________________________________ 
_ ISGS11   2064     1C7      LPAR  __________ ________________________________ 
_ P000STP1 2084     C24      LPAR  01534A2084 ________________________________ 
_ P000STP2 2094     S08      LPAR  0BAD4E2094 ________________________________ 
d SCZP101  2094     S18      LPAR  02991E2094 ________________________________ 
_ SCZP202  2097     E26      LPAR  0002022097 ________________________________ 
_ SCZP801  2064     1C7      LPAR  010ECB2064 ________________________________ 
_ SCZP901  2084     C24      LPAR  026A3A2084 ________________________________ 

Processor List        Row 1 of 7 More:       >
Command ===> _______________________________________________ Scroll ===> CSR  
 
Select one or more processors, then press Enter. To add, use F11.             
 
 
/ Proc. ID Type +   Model +  Mode+ Serial-# + Description                      
_ ISGSYN   2064     1C7      LPAR  __________ ________________________________ 
_ ISGS11   2064     1C7      LPAR  __________ ________________________________ 
_ P000STP1 2084     C24      LPAR  01534A2084 ________________________________ 
_ P000STP2 2094     S08      LPAR  0BAD4E2094 ________________________________ 
_ SCZP202  2097     E26      LPAR  0002022097 ________________________________ 
_ SCZP801  2064     1C7      LPAR  010ECB2064 ________________________________ 
_ SCZP901  2084     C24      LPAR  026A3A2084 ________________________________ 
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HCD allows you to over-define CHPIDs by using an asterisk (*) for the PCHID value. An 
over-defined CHPID must adhere to all validation rules, but it is not taken into account by an 
IOCDS download. Also it is not included in the IOCP statements, in a CONFIGxx member, or 
during dynamic activation.

If a control unit contains only CHPIDs with a PCHID value of an asterisk (*), then the whole 
control unit (including any attached devices) is omitted from the configuration to be activated.

When installing the channel path later, you must edit the CHPID and replace the * by its valid 
PCHID.

The 2097 production IODF can then be activated dynamically and the PCHID/CHPID/control 
unit definitions become available to the operating system.

� Figure 4-11 illustrates what the CHPID/PCHID definitions look like before being defined as 
over-defined. Press PF20 (right) in the Channel Path List.

Figure 4-11   HCD - Channel Path List (Reserving CHPIDs)

Note: This is not the case for CFP and CBP type CHPIDs, where these CHPIDs have 
connections to other CFP and CBP type CHPIDs. 

Therefore, HCD only allows you to define CFP and CBP type CHPIDS as over-defined if 
they are unconnected.

If you define a CIB type CHPID, it must also be defined with an HCA Adapter ID (AID) and 
an HCA Port ID, represented in the AID/P column in the Channel Path List. HCD does not 
allow a CIB type CHPID to be defined as over-defined.

 Channel Path List     Filter Mode. More: <     >
Command ===> _______________________________________________ Scroll ===> CSR  
                                                                              
Select one or more channel paths, then press Enter. To add, use F11.          
                                                                              
Channel Subsystem ID : 0                                                      
1=A01       2=A02       3=A03       4=A04       5=A05                         
6=A06       7=A07       8=A08       9=A09       A=A0A                         
B=A0B       C=A0C       D=A0D       E=A0E       F=A0F                         
                          I/O Cluster  --------- Partitions 0x -----   PCHID  
/ CHPID Type+ Mode+ Mngd  Name +       1 2 3 4 5 6 7 8 9 A B C D E F   AID/P  
_ BE    CFP   SHR   No    ________     _ _ _ _ _ _ _ _ _ _ _ _ a _ _   3D8    
_ BF    CFP   SHR   No    ________     _ _ _ _ _ _ _ _ _ _ _ _ a _ _   3D9    
_ CE    CFP   SPAN  No    ________     _ _ a _ _ _ _ _ _ _ _ _ _ _ _   181    
_ CF    CFP   SPAN  No    ________     _ _ a _ _ _ _ _ _ _ _ _ _ _ _   111    
_ EC    CFP   SPAN  No    ________     _ _ a _ _ _ _ _ _ _ _ _ _ _ _   3C0    
_ EE    CFP   SPAN  No    ________     _ _ a _ _ _ _ _ _ _ _ _ _ _ _   3D0 
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� Figure 4-12 shows what the CHPID/PCHID definitions look like after being defined as 
over-defined.

Figure 4-12   HCD - Channel Path List (over-defined CHPIDs)

4.3  Save and restore configuration files 
On the System z9 EC, and System z9 BC, customization information for certain channel 
types is stored in files on the Support Element (SE). The files are called configuration files, 
and they are named based on the physical location (PCHID value) of the feature. 

Table 4-3 lists CHPID types that have configuration files on a System z9 EC, and System z9 
BC. 

Table 4-3   Channel or CHPID type information in configuration files

If channels or CHPIDs have associated configuration files, the CHPID Mapping Tool can 
assign PCHIDs to the logical CHPID definitions or move a CHPID definition to a new location. 
This can occur regardless of whether channels are moving. 

The CHPID Mapping Tool can override PCHID assignments for:

� FICON channels supporting FCP

� OSA Express2 and channels supporting OSC

During an MES upgrade, the following occurs:

� The channel cards are moved as part of the normal rebalance of all I/Os. 

� The configuration files are copied from your old system, restored to the new System z10 
EC, and renamed to match their new PCHIDs of the new physical locations of the channel 
cards. 

 Channel Path List     Filter Mode. More: <     >
Command ===> _______________________________________________ Scroll ===> CSR  
                                                                              
Select one or more channel paths, then press Enter. To add, use F11.          
                                                                              
Channel Subsystem ID : 0                                                      
1=A01       2=A02       3=A03       4=A04       5=A05                         
6=A06       7=A07       8=A08       9=A09       A=A0A                         
B=A0B       C=A0C       D=A0D       E=A0E       F=A0F                         
                          I/O Cluster  --------- Partitions 0x -----   PCHID  
/ CHPID Type+ Mode+ Mngd  Name +       1 2 3 4 5 6 7 8 9 A B C D E F   AID/P  
_ BE    CFP   SHR   No    ________     _ _ _ _ _ _ _ _ _ _ _ _ a _ _   *      
_ BF    CFP   SHR   No    ________     _ _ _ _ _ _ _ _ _ _ _ _ a _ _   *      
_ CE    CFP   SPAN  No    ________     _ _ a _ _ _ _ _ _ _ _ _ _ _ _   *      
_ CF    CFP   SPAN  No    ________     _ _ a _ _ _ _ _ _ _ _ _ _ _ _   *      
_ EC    CFP   SPAN  No    ________     _ _ a _ _ _ _ _ _ _ _ _ _ _ _   *      
_ EE    CFP   SPAN  No    ________     _ _ a _ _ _ _ _ _ _ _ _ _ _ _   * 

Feature or CHPID type Information stored in configuration files

OSA-Express2 types OSD/OSE Any user-specified MAC addresses and OAT tables

1000BaseT channel 
defined as CHPID type OSC

Console session information
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� The CHPID Mapping Tool will force the logical CHPID previously assigned to the old 
PCHID location to be now assigned to the new PCHID location. 

The CHPID Mapping Tool can only perform this function if the initial IOCP input contains 
the PCHID assignments from the old system. 

Although the MES upgrade process preserves configuration files on an upgrade from a 
System z9 EC to a z10 EC, it is your responsibility to keep a backup of the customization data 
stored in the configuration files.

For a push/pull upgrade, it is your responsibility to export the configuration files from the 
existing 2094 and import them on the new 2097, as described here:

� For OSA-Express2 channels, export user-assigned MAC addresses using the Display or 
alter MAC address function in card-specific advanced facilities or user-specified OSA 
Address Tables (OATs). 

Another method is to use OSA/SF to back up and restore the configuration information for 
the OSA-Express2 channels.

� For CHPIDs defined as OSC (OSA-ICC), use the Export source file function in Manual 
configuration options.

For more information about configuration files, refer to Appendix A, “An explanation of 
configuration files” in CHPID Mapping Tool Users Guide, GC28-6825.

In this book, we show examples of backing up the configuration data with OSA/SF for OSA 
Express2 features, and with the HMC for OSA-ICC.

4.3.1  Save and restore OSA configuration information with OSA/SF
The Open Systems Adapter Support Facility (OSA/SF) is an application that helps you to 
customize and manage your OSA-Express and OSA-Express2 features. It also allows you to 
obtain status and operational information. 

OSA/SF includes a graphical user interface (GUI) and a REXX interface. The OSA/SF GUI 
runs on Windows and Linux software that has graphics and Java 1.4 support. From a single 
OSA/SF GUI, you can establish connections to all server images that have OSA/SF running. 
This potentially allows you to have centralized control of OSA-Express2 features that span 
server boundaries, as shown in Figure 4-13 on page 151.

 

 

 

150 IBM System z10 Enterprise Class Configuration Setup



 

Figure 4-13   OSA/SF

Using OSA/SF, you can save the OSA Express2 definitions for user-specified MAC addresses 
and OAT tables. For information about setting up OSA/SF, refer to Open Systems 
Adapter-Express Customer’s Guide and Reference, SA22-7935, and OSA-Express 
Implementation Guide, SG24-5948.

1. From a Windows workstation, start a DOS session and issue the command java ioajava 
to start the OSA/SF GUI. 

2. Log on to OSA/SF, as shown in Figure 4-14. 

Figure 4-14   OSA/SF Workstation Interface - Logon

The OSA/SF main panels are displayed; see Figure 4-15 on page 152. 
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Figure 4-15   OSA/SF Workstation Interface 

3. From the OSA/SF Commands panel, click CHPID View. The CHPID View panel is 
displayed; it lists all OSA features in the configuration (Figure 4-16). 

Figure 4-16   OSA/SF Workstation Interface - CHPID view
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4. Select the CHPID you want to work with from the list. Click Selected → 
Configurations → Configuration..., as shown in Figure 4-17. 

Figure 4-17   OSA/SF Workstation Interface - Selected Configurations 

5. A CHPID configuration panel is displayed, with information fields left blank. From this 
panel, click File → Get current configuration (Figure 4-18).

Figure 4-18   OSA/SF Workstation Interface - get current configuration
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6. The CHPID configuration panel is displayed again, now with the current OSA CHPID 
configuration information. Fill in the Configuration name (Figure 4-19). 

Figure 4-19   OSA/SF Workstation Interface - Current configuration

7. Click File → Save configuration... (Figure 4-20). The configuration file is saved by 
OSA/SF and can be reused later. 

Figure 4-20   OSA/SF Workstation Interface - Save current configuration

You can use OSA/SF to install previously saved configuration information using the install and 
activate functions. Note that in order to be able to use the GUI, you need to manually install 
and activate at least one OSA feature to enable communication between the GUI and the 
OSA/SF application. 

1. From the OSA/SF main view, initialize the CHPID view. Select Configurations → 
Planning configurations... (Figure 4-21). 
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Figure 4-21   OSA/SF Workstation Interface - Planning configurations

2. The Configure OSA CHPID panel displays (Figure 4-22). Select the CHPID number and 
the CHPID Type that you want to define, then click OK. 

Figure 4-22   OSA/SF Workstation Interface - Configure OSA CHPID

3. OSA/SF displays a default panel for the type of feature selected. Click File → Open 
saved configuration... (Figure 4-23 on page 156).
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Figure 4-23   OSA/SF Workstation Interface - Open saved configuration

4. OSA/SF displays a Host Configuration List panel containing the names of previously 
saved configuration files that match the feature type (Figure 4-24). 

Note that the Host Configuration List being displayed will vary with the OSA Express2 
feature type selected in Figure 4-22. For example, a request for OSD 1000BaseT Ethernet 
displays the list shown in Figure 4-24.

Figure 4-24   OSA/SF Workstation Interface - Host configuration list (OSD 1000Base T Ethernet)

5. From the list, select the saved configuration name and click Load. Configuration 
information previously saved is now displayed on the OSA configuration panel. Any 
changes that may be needed can be done for this configuration with OSA/SF as shown in 
Figure 4-25.
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Figure 4-25   OSA/SF Workstation Interface - Change Configuration

6. Select Activate → Activate with install to restore the OSA feature configuration 
(Figure 4-26 on page 158). 
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Figure 4-26   OSA/SF Workstation Interface - Install

4.3.2  OSA-ICC, CHPID=OSC
If the 2084 contains any TYPE=OSC CHPIDs, then there is a good chance that the existing 
PCHID will be remapped to a different PCHID when the 2084 processor is replaced with a 
2094. 

Operator Console, TN3270, and Printer definitions are stored and managed on the Support 
Element for that particular CPC, and their definitions only are associated with a PCHID, not a 
CHPID. 

Therefore, if you wish to retain these OSC definitions after the replacement, you need to 
export the definitions to a diskette and import them to the remapped PCHID after the 
processor replacement has been completed.

Exporting the configuration data for OSA-ICC channels
To export the configuration data, follow these steps:

1. Log on using SYSPROG authority to the HMC workstation supplied with the 2094, as 
opposed to a remote Web browser, and select the CPC that contains the OSC CHPIDs 
that you want to export the configuration data for (for example, SCZP101).

2. In the Defined CPCs Work Area, select the CPC that contains the OSC CHPIDs you want 
to export the configuration data for (for example, SCZP101).

3. Under Operational Customization, double-click OSA Advanced Facilities.

4. Select the radio button for the Channel ID card you want to export, then click OK 
(Figure 4-27 on page 159). 
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Figure 4-27   HMC - OSA Advanced Facilities (OSC Channel)

5. Select the radio button Card specific advanced facilities..., then click OK (Figure 4-28). 

Figure 4-28   HMC - OSA Advanced Facilities (Card specific)

6. Select the radio button Manual configuration options..., then click OK (Figure 4-29 on 
page 160).

 

 

 

Chapter 4. Replace a System z9 EC with a z10 EC 159



 

Figure 4-29   HMC - OSA Advanced Facilities (Manual config)

7. Select the radio button Export source file, then click OK (Figure 4-30).

Figure 4-30   HMC - OSA Advanced Facilities (Export source)

8. The HMC prompts you to enter a file name to be written onto the diskette (in the example 
shown in Figure 4-31 on page 161, we used OSC-ICC_0121). Type in the file name, then 
click OK.
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Figure 4-31   HMC - OSA Advanced Facilities (Export file name)

9. The HMC prompts you to insert a diskette into the drive on the HMC that you are logged 
on to (Figure 4-32). Insert the diskette, then click OK.

Figure 4-32   HMC - OSA Advanced Facilities (Export insert diskette)

10.The HMC writes the configuration data for the Channel ID that was selected onto the 
diskette and displays a “command completed” panel when it has finished; see Figure 4-33. 
Click OK. 

Figure 4-33   HMC - OSA Advanced Facilities (Export completed)

11.Remove the diskette from the drive, then click OK (Figure 4-34 on page 162). 
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Figure 4-34   HMC - OSA Advanced Facilities (Remove diskette)

12.Click Cancel to exit all the panels and return to the Defined CPCs Work Area. Figure 4-35 
illustrates a sample of the configuration data in the diskette file. 

Figure 4-35   OSC configuration sample (OSC-0121)

Export the configuration data for OSA-ICC using HMC Ver 2.10.0
To export the configuration data, perform these steps: 

1. Log on using SYSPROG authority to the HMC workstation supplied with the 2094, as 
opposed to a remote Web browser, and select the CPC that contains the OSC CHPIDs 
that you want to export the configuration data for (for example, SCZP101).

<OSC_SERVER>
  HOST_IP= 9.12.4.165
  DEFAULT_GATEWAY= 9.12.4.1
  SUBNET_MASK= 255.255.252.0
  PORT= 3270
  ETHERNET_FRAME= DIX
  MTU= 576
  NAME= OSAF080
</OSC_SERVER>
  
  
<CONFIG_SESSION>
<SESSION1>
  CSS= 00 IID= 07 DEVICE= F080
  GROUP=  "SCZCF080"
  CONSOLE_TYPE= 1    RESPONSE= OFF    READ_TIMEOUT= 60
</SESSION1>

<SESSION2>
  CSS= 01 IID= 07 DEVICE= F081
  GROUP=  "SCZCF081"
  CONSOLE_TYPE= 1    RESPONSE= OFF    READ_TIMEOUT= 60
</SESSION2>
..................................
......................................
<SESSION71>
  CSS= 00 IID= 01 DEVICE= F0BA
  GROUP=  "WTSC74"
  CONSOLE_TYPE= 1    RESPONSE= OFF    READ_TIMEOUT= 0
</SESSION71>

</CONFIG_SESSION>
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2. Under Systems Management, click Servers to expand the list.

a. On the pad to the right you will see listed all servers defined to this HMC. Click the 
radio button for the server you wish to access (in this example SCZP101).

b. Click the small pop-up menu arrow just after the CPC name and use this to expand to 
and select the OSA Advanced Facilities menu (Figure 4-36).

Figure 4-36   HMC - OSA Advanced Facilities (Popup Menu)

3. Alternatively, you can access the OSA options the following way:

a. Under Systems Management, click Servers to expand the list.

b. Under Servers, click the server to select it (in this example SCZP101).

c. On the Tasks pad, click Operational Customization to expand it, and select OSA 
Advanced Facilities (Figure 4-37 on page 164).

Note: A HMC upgraded from Ver 2.9.2 to Ver 2.10.0 may contain a usable floppy disk 
drive. A new HMC installed along with a System z10 EC as Ver 2.10.0 will not contain a 
floppy disk drive.
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Figure 4-37   HMC - OSA Advanced Facilities (Task Menu)

4. Click the radio button for the Channel ID card that you want to export, then click OK 
(Figure 4-38).

Figure 4-38   HMC - OSA Advanced Facilities (OSC Channel)
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5. Select the radio button Card specific advanced facilities... and click OK (Figure 4-39).

Figure 4-39   HMC - OSA Advanced Facilities (Card specific)

6. Select the radio button Manual configuration options..., and click OK (Figure 4-40).

Figure 4-40   HMC - OSA Advanced Facilities (Manual config)
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7. Select the radio button Export source file and click OK (Figure 4-41).

Figure 4-41   HMC - OSA Advanced Facilities (Export source)

8. The task requests a file name to be written onto the installed Media device. In our example 
we entered OSC-ICC_0220 (Figure 4-42). Click OK.

Figure 4-42   HMC - OSA Advanced Facilities (Export filename)

9. The HMC displays panel ACT20430 with the following prompts:

– Please insert the following removable media:
– The removable media to export data to:
– Click Cancel to cancel operation.

10.HMC detects the installed media.

Note: A suitable USB Flash Memory Drive must be inserted into the USB port prior to 
the next step so that it can be detected and be provided as an option for selection.
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11.HMC displays the Select Media Device - SCZP101 panel.

This task supports the following devices:

– USB Flash Memory Drive, Diskette
– Radio Button - USB Flash Memory Drive
– Radio Button - Diskette Drive

12.Click the radio button for USB Flash Memory Drive, then click OK.

13.The HMC task writes the configuration data for the Channel ID that was selected onto the 
media device and displays a message panel when it has completed (Figure 4-43). Click 
OK.

Figure 4-43   HMC - OSA Advanced Facilities (Export completed)

14.You can remove the USB Flash Memory Drive at any time; click OK. Click Cancel to exit 
all OSA Advanced Facilities panels. 

Figure 4-44 shows a sample of the configuration data downloaded on the flash drive.
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Figure 4-44   OSC configuration sample (OSC-0121)

4.4  Validate the 2097 work IODF
In this section we explain the steps needed to validate the 2097 work IODF.

Validate the work IODF
1. Select HCD option 2.12, Build validated work I/O definition file. Review the Message 

List and correct any errors.

2. Press PF3 to continue; the message Requested action successfully processed is 
displayed.

3. Select HCD option 6.4, View I/O Definition File Information and notice that the IODF 
type is now Work - Validated; see Figure 4-45.

<OSC_SERVER>
  HOST_IP= 9.12.4.165
  DEFAULT_GATEWAY= 9.12.4.1
  SUBNET_MASK= 255.255.252.0
  PORT= 3270
  ETHERNET_FRAME= DIX
  MTU= 576
  NAME= OSAF080
</OSC_SERVER>
  
  
<CONFIG_SESSION>
<SESSION1>
  CSS= 00 IID= 07 DEVICE= F080
  GROUP=  "SCZCF080"
  CONSOLE_TYPE= 1    RESPONSE= OFF    READ_TIMEOUT= 60
</SESSION1>

<SESSION2>
  CSS= 01 IID= 07 DEVICE= F081
  GROUP=  "SCZCF081"
  CONSOLE_TYPE= 1    RESPONSE= OFF    READ_TIMEOUT= 60
</SESSION2>
..................................
......................................
<SESSION71>
  CSS= 00 IID= 01 DEVICE= F0BA
  GROUP=  "WTSC74"
  CONSOLE_TYPE= 1    RESPONSE= OFF    READ_TIMEOUT= 0
</SESSION71>

</CONFIG_SESSION>
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Figure 4-45   HCD - View I/O Definition File Information (Validated work IODF)

Creating the IOCP for the CHPID Mapping Tool

1. Select HCD option 2.3, Build IOCP input data set, then press Enter (Figure 4-46).

Figure 4-46   HCD - Activate or Process Configuration Data (Build IOCP for SCZP102)

2. HCD displays the list of available processors to chose from. Select processor SCZP202 by 
typing a forward slash (/), then press Enter (Figure 4-47 on page 170).

---------------- View I/O Definition File Information ------------
                                                                  
                                                                  
 IODF name  . . . . . . : 'SYS6.IODF49.WORK'                    
 IODF type  . . . . . . : Work - Validated                        
 IODF version . . . . . : 5                                       
                                                                  
 Creation date  . . . . : 2007-12-03                              
 Last update  . . . . . : 2007-12-03  15:43                       
                                                                  
 Volume serial number . : BH8ST2                                  
 Allocated space  . . . : 2000    (Number of 4K blocks)           
 Used space . . . . . . : 1582    (Number of 4K blocks)           
    thereof utilized (%)  90                                      
                                                                  
 Activity logging . . . : No                                      
 Backup IODF name . . . :                                         
                                                                  
 Description  . . . . . :                                         

Note: You may prefer to use HCM to create the IOCP statements file and transfer the file to 
your PC. You can then launch the CHPID Mapping Tool, create an updated IOCP 
statements file, and transfer the file back to the host.

 ---- Activate or Process Configuration Data ------  

Select one of the following tasks.               
                                                  
 3_  1.  Build production I/O definition file     
     2.  Build IOCDS                              
     3.  Build IOCP input data set                
     4.  Create JES3 initialization stream data   
     5.  View active configuration                
     6.  Activate or verify configuration         
         dynamically                              
     7.  Activate configuration sysplex-wide      
     8.  Activate switch configuration            
     9.  Save switch configuration                
     10. Build I/O configuration statements       
     11. Build and manage S/390 microprocessor    
         IOCDSs and IPL attributes                
     12. Build validated work I/O definition file 
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Figure 4-47   HCD - Available Processors (select processor for IOCP file)

3. HCD displays a panel on which you enter information regarding the IOCP input data set to 
be created; see Figure 4-48 on page 170. Fill in the following fields:

– Title1.
– IOCP input data set.
– Type Yes in the field Input to Stand-alone IOCP.
– Fill in the Job statement information for the installation.

4. Press Enter. HCD submits a batch job to create the data set.

Figure 4-48   HCD - Build IOCP Input Data Set

5. In TSO, verify that the data set you just created exists and that it contains IOCP 
statements (Figure 4-49 on page 171). 

This data set is used as input into the CHPID Mapping Tool.

----------------------- Available Processors --------------------------- 
Row 1 of 8

Command ===> __________________________________________________________  
                                                                         
Select one.                                                              
                                                                         
  Processor ID  Type     Model    Mode  Description                      
  ISGSYN        2064     1C7      LPAR                                   
  ISGS11        2064     1C7      LPAR                                   
  P000STP1      2084     C24      LPAR                                   
  P000STP2      2094     S08      LPAR                                   
/ SCZP202       2097     E26      LPAR                                   
  SCZP801       2064     1C7      LPAR                                   
  SCZP901       2084     C24      LPAR                                   
**************************** Bottom of data *****************************

 ----------------------- Build IOCP Input Data Set -----------------------

Specify or revise the following values.                                   
                                                                          
IODF name . . . . . . . . . : 'SYS6.IODF49.WORK'                        
Processor ID  . . . . . . . : SCZP202                                     
Title1 . IODF49__________________________________________________________ 
Title2 : SYS6.IODF49.WORK - 2007-12-03 15:43                            
                                                                          
IOCP input data set                                                       
'SYS6.IODF49.IOCPIN.SCZP202'______________________                      
Input to Stand-alone IOCP?  Yes  (Yes or No)                              
                                                                          
Job statement information                                                 
//WIOCDS  JOB (ACCOUNT),'NAME'                                               
//*                                                                          
//*                                                                          

 

 

 

170 IBM System z10 Enterprise Class Configuration Setup



 

Figure 4-49   HCD - IOCP input data set contents (truncated)

Also note that part of the TOK statement has been blanked out with dots (Example 4-1). 

Example 4-1   HCD - IOCP file (TOK statement)

TOK=('SCZP202',00800001991E2094154302750107337F00000000,*
00000000,'07-12-03','15:43:02','........','........') 

This is a safeguard to ensure that this IOCP file cannot be written to a processor and used 
for a power-on reset, because this IOCP file was created from a validated work IODF and 
not a Production IODF – which is something that can be done only for processors that 
contain PCHID definitions.

6. Download this file from TSO to your workstation. Use a workstation file transfer facility 
such as the one in the IBM Personal Communications Workstation Program, or any 
equivalent 3270 emulation program. Be sure to use TEXT as the transfer type. In this 
example, we call this file SCZP202in.iocp.

4.5  CMT - Assign CHPIDs to PCHIDs
In the following steps we take the output from the previous set of HCD steps (IOCP), and the 
output from the 2097 order process (CFReport). Using the CHPID Mapping Tool, we assign 
PCHIDs to each of the CHPIDs for the 2097.

ID    MSG1='IODF49',                                          * 
      MSG2='SYS6.IODF49.WORK - 2007-12-03 15:43',  * 
      SYSTEM=(2097,1),                                        * 
      TOK=('SCZP202',00800001991E2094154302750107337F00000000,* 
      00000000,'07-12-03','15:43:02','........','........')     
RESOURCE PARTITION=((CSS(0),(A0A,A),(A0B,B),(A0C,C),(A0D,D),(A* 
      0E,E),(A0F,F),(A01,1),(A02,2),(A03,3),(A04,4),(A05,5),(A* 
      06,6),(A07,7),(A08,8),(A09,9)),(CSS(1),(A1A,A),(A1B,B),(* 
      A1C,C),(A1D,D),(A1E,E),(A1F,F),(A11,1),(A12,2),(A13,3),(* 
      A14,4),(A15,5),(A16,6),(A17,7),(A18,8),(A19,9)),(CSS(2),* 
      (A2A,A),(A2B,B),(A2C,C),(A2D,D),(A2E,E),(A2F,F),(A21,1),* 
      (A22,2),(A23,3),(A24,4),(A25,5),(A26,6),(A27,7),(A28,8),* 
      (A29,9)),(CSS(3),(*,1),(*,2),(*,3),(*,4),(*,5),(*,6),(*,* 
      7),(*,8),(*,9),(*,A),(*,B),(*,C),(*,D),(*,E),(*,F)))      
CHPID PATH=(CSS(0,1,2),00),SHARED,                            * 
      NOTPART=((CSS(0),(A0B,A0C,A0D,A0E,A0F),(=)),(CSS(1),(A1B* 
      ,A1C,A1D,A1E,A1F),(=)),(CSS(2),(A2B,A2C,A2D,A2E,A2F),(=)* 
      )),PCHID=1B0,TYPE=OSD                                     
CHPID PATH=(CSS(0,1,2),01),SHARED,                            * 
      NOTPART=((CSS(0),(A0B,A0C,A0D,A0E,A0F),(=)),(CSS(1),(A1B* 
      ,A1C,A1D,A1E,A1F),(=)),(CSS(2),(A2B,A2C,A2D,A2E,A2F),(=)* 
      )),PCHID=1A0,TYPE=OSD 

Important: When an IOCP statement file is exported from a Validated Work IODF 
using HCD, it must be imported back to HCD in order for the process to be valid. The 
IOCP file cannot be used directly by the IOCP program.
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For this process, the CHPID Mapping Tool (CMT) must be downloaded. Refer to “CHPID 
Mapping Tool” on page 24 for information about downloading and installing the CMT. If you 
already have CMT installed, then verify that you have the latest updates installed.

Using the CHPID Mapping Tool, follow these steps:

1. Import the IOCP statements file and the CFReport file into the CHPID Mapping Tool. 
Getting the IOCP statements can be performed with HCM.

2. Resolve CHPIDs with a PCHID conflict.

3. Resolve CHPIDs without associated hardware.

4. Resolve Hardware resolution.

5. Set the priority for single-path control units and other control units that would override the 
CHPID Mapping Tool default priorities.

6. Run the CHPID Mapping Tool availability function.

7. Create CHPID Mapping Tool reports.

8. Create an updated IOCP statements file and file transfer back to the host z/OS image. 
This step may be performed with HCM. 

Import the CFReport file into the CHPID Mapping Tool
1. Start the CHPID Mapping Tool on your workstation.

2. Import the CFReport file into the CHPID Mapping Tool. 

3. Click File → Import CFReport file (Figure 4-50). 

 

Figure 4-50   CMT - Import CFReport Order file

4. Select the CFReport file on your workstation to import into the CHPID Mapping Tool and 
click Open (Figure 4-51). 

Note: When upgrading from a 2094 to a 2097, it is mandatory to use the CHPID Mapping 
Tool level that supports the 2097. The internal availability characteristics of the 2097 are 
different from those of the previous System z processors.
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Figure 4-51   CMT - Open CFReport Order file

5. The CHPID Mapping Tool displays the information from the CFReport on the left-hand 
side of the screen (Figure 4-52).

Figure 4-52   CMT - Importing CFReport Order file
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Import 2094 IOCP file into CHPID Mapping Tool
1. Import the IOCP file by clicking Tool → Import IOCP File (Figure 4-53).

Figure 4-53   CMT - Import IOCP files 

2. Select the IOCP file on your workstation to import into the CHPID Mapping Tool and click 
Open. 

In our example, the CHPID Mapping Tool issued the following: 

– Matching CHPID - This window lists all CHPIDs that are assigned with PCHIDs that 
have been moved during MES upgrade. This is for informational purposes only.

– Invalid CHPID - This window lists all the CHPIDs that have been found with Invalid 
PCHID values assigned in the IOCP Input file. PCHID may represent hardware that is 
not compatible with a given CHPID type, or there may be no hardware present at a 
given PCHID.

– HW Resolution - A few CHPIDs support more than one available channel type. Users 
should select the preferred channel type for any given CHPID. CHPIDs are grouped 
and displayed per CHPID type.

– CHPID Reset - Availability considers only CHPIDs that are not assigned with a PCHID. 
CHPIDs that already have PCHIDs assigned can be reset using this panel. 

– Reset CHPIDs assigned by Availability - Checking this option resets all CHPIDs that 
were processed by prior availability runs in this session. 

By default, this option is checked. 

– Reset CHPIDs assigned by Manual Remap - Checking this option resets CHPIDs 
that were assigned a PCHID in the Manual panel. If this option is not checked, then 
availability PCHIDs for these CHPIDs are not reset. 

By default, this option is unchecked. 

– Reset CHPIDs assigned by the CHPID Mapping Tool for config files - The 
CFReport indicates that you are doing a MES/upgrade, and you have channels and/or 
CHPIDs that may have configuration files currently associated with them. The 
MES/upgrade may be moving some of those channel cards. 

Regardless of whether the channels are moving or not, the CHPID Mapping Tool either 
has assigned PCHIDs to the logical CHPID definitions to keep the CHPID definition 
associated with its current configuration file, or has moved the definition to the new 
location where the channel is moving. 
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If you reset the CHPID Mapping Tool assignments, it is your responsibility to have a 
backup of the configuration file data prior to the MES, and to restore that data to the 
new location (the PCHID where the affected CHPIDs are assigned) before you can use 
the CHPIDs. 

By default, this option is unchecked. 

– Reset CHPIDs assigned by IOCP - If some of the CHPIDs were assigned in the IOCP 
Input file, then checking this option resets the CHPIDs. Checking this option may 
require recabling after availability assignments. 

This option should be checked. 

If none of the options is checked, availability only works on CHPIDs that do not have 
PCHIDs assigned.

The CFReport indicates that you are doing a MES/upgrade and you have channels or 
CHPIDs that may have configuration files currently associated with them. The MES/upgrade 
may be moving some of those channel cards. 

Regardless of whether the channels are moving or not, the CHPID Mapping Tool has either 
assigned PCHIDs to the logical CHPID definitions to either keep the CHPID definition 
associated with its current configuration file, or has moved the definition to the new location 
where the channel is moving. 

In order to give the CHPID Mapping Tool the most choices when using the availability option, 
we recommend that you choose Reset all IOCP assigned PCHIDs. 

However, if you choose Reset only the PCHID/hardware mismatch, then review the 
intersects from availability processing carefully to ensure that preserving the prior 
CHPID-to-PCHID relationship is not causing unacceptable availability. 

If you choose to run Availability mapping, this will reset any previously mapped CHPID 
assignments and could result in recabling of the server.

CHPIDs that may have configuration files associated
Figure 4-54 shows CMT listing PCHIDs that could potentially have configuration files 
associated with them. Click OK.

Figure 4-54   CMT - CHPIDs assigned by CMT
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CHPIDs with PCHID conflicts
Now the CMT displays CHPIDs with PCHID conflicts. In our example, we selected Reset only 
the PCHID/hardware conflicts.

Figure 4-55   CMT - CHPIDs with PCHID conflicts

Resolve CHPIDs without associated hardware
The CHPID Mapping Tool now displays messages about any CHPID types that were imported 
from the IOCP input file (IODF) into the CMT that do not have any associated hardware 
support in the CFReport file (Figure 4-56). Click OK.

Figure 4-56   CMT - Required Hardware unavailable

The following message is issued:

CHPIDs with invalid/incompatible hardware found.

We left excessive numbers of CHPID types “FC” in our IODF to show how the CHPID 
Mapping Tool would handle this condition and to give an opportunity to explain how you can 
resolve this situation. Refer to “Over-define channel paths on an XMP processor” on 
page 147.

This is an example of where you can use this option to change the PCHID value to an asterisk 
(*) in the IODF, if you should still want to retain the FC CHPID definitions in the IODF and 
expect to have FC CHPIDs installed in the processor at a later date.
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Alternatively, you could remove the FC CHPID definitions from the IODF.

To continue with this example, follow these steps:

1. Go back into the IODF and change the PCHID values for the FC CHPIDs (or any other 
CHPIDs that have no supporting hardware in the CFReport) and change the value to an 
asterisk (*).

2. Re-validate the IODF; use HCD option 2.12.

3. Recreate the IOCP statements file and file transfer to your PC.

4. Import the IOCP file; click Tool → Import IOCP File.

Now when you click Reset only the PCHID/hardware conflicts, the CHPID Mapping Tool 
asks you to resolve some hardware.

Hardware resolution
The CHPID Mapping Tool may prompt you to resolve issues that may arise from importing the 
IOCP file. In our example, the CHPID Mapping Tool wanted clarification on the TYPE=OSD, 
TYPE=OSE and TYPE=FC channels. 

In each case, we must check off what each of the channels is used for. In Figure 4-57 on 
page 178, the image in the lower right-hand side shows what we had selected for the FC 
channels.

Note: Other CHPID types may also be over-defined by entering an asterisk (*) for the 
PCHID value, with the exception of CIB type CHPID definitions.

Note: If you look at the IOCP statements file now, notice that the FC CHPIDs have 
been omitted from the file, but are still defined in the IODF.
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Figure 4-57   CMT - Hardware resolution after IOCP import

Select one tab at a time. Click the desired box and move to the next tab until all CHPID 
definitions have hardware selected.
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The CHPID Mapping Tool displays all of the information that it currently knows. 

Figure 4-58   CMT - Manual Tab

Process CU Priority
If you are importing an IOCP statements file from a 2094 that had CU Priority values defined, 
you may want to review the CU Priority beforehand. The CHPID Mapping Tool can then 
perform the availability functions appropriately for a 2097. Follow these steps:

1. Under the File menu, click the Availability tab.

2. Click Process CU Priority and a window pops up. 

The Reset CHPID Assignment window allows you to reset previously assigned PCHIDs, 
as follows:

– Reset CHPIDs assigned by Availability
– Reset CHPIDs assigned by Manual Remap
– Reset CHPIDs assigned by IOCP

In our example, we selected Reset CHPIDs assigned by Availability and Reset CHPIDs 
assigned by IOCP; see Figure 4-59 on page 180.
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Figure 4-59   CMT - Reset CHPID Assignments 

The 2097 has different availability rules than the 2094, so all PCHID assignments that 
were still in the input IOCP needed to be removed. 

3. Click Process. After the CHPID Mapping Tool has assigned the CHPIDs, it displays a 
message indicating the results of the process. Click OK (Figure 4-60). 

Figure 4-60   CMT - Process CU Priority completion message

The following list defines the possible intersects:

C Two or more assigned channels use the same channel card.
S Greater than half the assigned channels use the same STI.
M All assigned channels are supported by the same MBA group.
B More than half the assigned channels are supported by the same book.
D Assigned channels are on the same daughter card.

Our example returned the “C” and “B” intersects.

4. Click OK. You can now display the results of the channel mapping. You can also sort the 
report in different ways. For example, to see how the CHPID Mapping Tool ranked the 
control units, select Sorts → By CU Priority.

Note: Intersect messages inform you of a potential availability problem detected by the 
CMT, but do not necessarily indicate an error.
It is your responsibility to evaluate whether the condition should be corrected or not.
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Our example does not contain any CU Priority values, but this illustrates how CU Priority 
values are represented in the IOCP file.

5. You need to check and set values for items such as OSA-ICC CHPIDs and CTC CHPIDs, 
to ensure that the CHPID Mapping Tool allocates these CHPIDs with high PCHID 
availability.

Page through the listing and search through the column CU Number for any control units 
you want to set priority for. In our example, we set the OSC type CU Numbers to priority 
333; see Figure 4-61.

Figure 4-61   CMT Set CU Priority

If there are coupling links used by a CF image, you should group these links.

Each set of CHPIDs going to a different CPC should be grouped with a common priority. 
For example, suppose the CF image has four links (CHPIDs 40, 41, 42, and 43) and that 
40 and 41 go to one CPC, and 42 and 43 go to a different CPC. In this case you should 
give CHPIDs 40 and 41 one priority and CHPIDs 42 and 43 a different priority. The 
concept is the same regardless of the number of connecting CPCs or the number of links 
to each CPC.

Note: The control unit priorities are stored in the IOCP output file created by the CMT 
that gets migrated back into HCD. HCD maintains these priorities and outputs them 
when creating another IOCP deck. 

They are in the form of commented lines at the end of the IOCP deck, as shown here: 

*CMT* VERSION=000
*CMT* CCN=27132026(CFR from ResourceLink)
*CMT* 8000.0=0010,8000.1=0010,8000.2=0010,8100.0=0010,8100.1=0010
*CMT* 8100.2=0010,8200.0=0010,8200.1=0010,8200.2=0010,8300.0=0010
*CMT* 8300.1=0010,8300.2=0010,8400.0=0010,8400.1=0010,8400.2=0010
*CMT* 8500.0=0010,8500.1=0010,8500.2=0010,8600.0=0010,8600.1=0010
*CMT* 8600.2=0010,8700.0=0010,8700.1=0010,8700.2=0010,C400.0=0020
*CMT* C400.1=0020,C400.2=0020,C500.0=0020,C500.1=0020,C500.2=0020
*CMT* C600.0=0020,C600.1=0020,C600.2=0020,C700.0=0020,C700.1=0020
*CMT* C700.2=0020
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6. Under the File menu, click the Availability tab again.

7. Click Process CU Priority and a window pops up. 

The Reset CHPID Assignment window allows you to change the CHPID values:

– Reset CHPIDs assigned by Availability
– Reset CHPIDs assigned by Manual Remap
– Reset CHPIDs assigned by IOCP

In our example, we selected Reset CHPIDs assigned by Availability. 

8. Click Process. Then click Sorts → By CU Priority; notice that the OSC type control units 
with priority of 333 have sorted to the top of the list. 

9. Select the Manual tab; Figure 4-62 shows the results of mapping the CHPIDs.

Figure 4-62   CMT - Manual (CHPIDs assigned)

Note that the CHPID and CHPID Origin columns are no longer blank because the CHPID 
Mapping Tool has assigned CHPIDs to PCHIDs and has placed the value Avail in the CHPID 
Origin column, indicating that the CHPID values were assigned based on availability.

CHPIDs not connected to Control Units
Under the Availability tab, click Sorts → By Control Unit. The CHPID Mapping Tool 
displays at the end of the list all CHPIDs defined in the IOCP input that are not connected to 
control units. All coupling CHPIDs in this list are preceded with an “S” in the CU Number 
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column (not shown in the following figure). All non-coupling CHPIDs are preceded with a “P” 
(Figure 4-63).

Figure 4-63   CMT - Sort by Control Unit

You should review the list because:

� You may have forgotten to add a CHPID to a control unit and may need to update the 
IOCP source before continuing in the CHPID Mapping Tool.

� The unconnected CHPIDs may be extra channels you are ordering in anticipation of new 
control units.

� The unconnected CHPIDs may be coupling links that are being used in coupling facility 
(CF) images (these do not require control units).

If there are extra CHPIDs for anticipated new control units, you may want to group these 
CHPIDs with a common priority. This will allow the availability mapping function to pick 
PCHIDs that will afford your new control unit good availability.

Create CHPID Mapping Tool reports 
The CHPID Mapping Tool offers built-in reports, which are available from the Reports 
pull-down menu. You can also print the information on the Availability or the Manual tab by 
clicking Print. When in the Availability tab, you can enter information in the comments column 
that might be useful at a later date.

For simplicity, we only describe how to print three reports in this example (the CHPID Report, 
the Port Report, Sorted by location, and the CHPID to Control Unit Report). However, all 
built-in reports are printed in the same way, as explained here.

The person who will install the I/O cables during system installation needs one of these 
reports. The Port Report, sorted by location, is recommended. The installer can use this to 
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help with labelling the cables. The labels must include the PCHID or cage/slot/port 
information before system delivery.

CHPID Report
1. Click Reports → CHPID Report (Figure 4-64). 

Figure 4-64   CMT - select CHPID Report

2. Enter the Report File Name (or accept the default name offered by the CMT) and click 
Save (Figure 4-65).

Figure 4-65   CMT - Report File Name

3. The CHPID Mapping Tool opens a browser window with the CHPID report; see 
Figure 4-66 on page 185. You may be prompted to accept active content; accept the active 
content to display the report in your browser.
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Figure 4-66   CMT - CHPID Report

Port Report - Sorted by Location
1. Click Reports → Port Report → Sorted by Location, and then click Save (assuming 

that you accept the CHPID Mapping Tool report name).

The CHPID Mapping Tool opens a browser window with the CHPID to Port Report 
(Figure 4-67 on page 186). 

2. You may be prompted to accept active content. Accept the active content in order to 
display the report in your browser. 
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Figure 4-67   CMT - CHPID to Port Report

Create the CHPID to Control Unit Report
These reports are created in a similar way to the CHPID Report:

1. Click Reports → CHPID to Control Unit Report.

2. Click Save.

3. The CHPID Mapping Tool opens a browser window with the CHPID to Control Unit Report; 
see Figure 4-68 on page 187. You may be prompted to accept active content; accept the 
active content to display the report in your browser. 
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Figure 4-68   CMT - CHPID to CU Report

Create updated IOCP
Create an IOCP statements file for input back into the IODF via HCD. This IOCP statements 
file now has the CHPIDs assigned to PCHIDs. 

1. Click Tool → Create Updated IOCP File (Figure 4-69).

Figure 4-69   CMT - Create Updated IOCP File

2. Enter the File name and location for the IOCP output file, and click Save (Figure 4-70).

Note: This file needs to be uploaded to the z/OS image on which you have the work 
IODF used previously to create the IOCP input data set. 
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Figure 4-70   CMT - Save IOCP output file

3. The CMT displays an informational message, shown in Figure 4-71, regarding what to do 
for the final execution of the tool.

Figure 4-71   CMT - informational message 

4. The CHPID Mapping Tool program can be shut down now. Click File → Exit (Figure 4-72).

Note: If you are an HCM user, you may prefer to use HCM to transfer the updated IOCP 
statements file back to the host.
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Figure 4-72   CMT - Exit program

4.6  HCD - Migrate PCHIDs back into work IODF
After mapping the CHPIDs to PCHIDs using the CHPID Mapping Tool, the information needs 
to be transferred back in HCD, as follows:

1. Upload the IOCP file created by the CMT (sczp202out.iocp, in our example) to the z/OS 
image. Use a file transfer facility such as the one in IBM Personal Communications or an 
equivalent FTP program. Be sure to use TEXT as the transfer type.

Looking at the updated IOCP statements file, you will notice that the CMT has left a 
reference to the CCN. Also notice the CU Priority values added for the OSC control units.

Example 4-2   HCD - Updated IOCP statements file (with CMT statements)

PATH=((CSS(0),D0,D2,DA),(CSS(1),D0,D2,DA)),UNIT=CFP   
         IODEVICE ADDRESS=(FF07,007),CUNUMBR=(FFF6),UNIT=CFP         
         IODEVICE ADDRESS=(FF82,007),CUNUMBR=(FFF6),UNIT=CFP         
         IODEVICE ADDRESS=(FFB3,007),CUNUMBR=(FFF6),UNIT=CFP         
*CMT* VERSION=000                                                    
*CMT* CCN=33442976(CFR)                                              
*CMT* E200.0=0333,E200.1=0333,E200.2=0333,E300.0=0333,E300.1=0333    
*CMT* E300.2=0333,EF00.0=0333,EF00.1=0333,EF00.2=0333,F000.0=0333    
*CMT* F000.1=0333,F000.2=0333,F080.0=0333,F080.1=0333,F080.2=0333 

2. From the HCD main panel shown in Figure 4-73, enter the work IODF name used to 
create the IOCP input data set for the CHPID Mapping Tool. Select option 5, Migrate 
configuration data.

Note: Control unit priorities are stored in the IOCP output file created by the CHPID 
Mapping Tool that gets migrated back into HCD. HCD maintains these priorities and 
outputs them when creating another IOCP deck. They are in the form of commented 
lines at the end of the IOCP deck; see Example 4-2.
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Figure 4-73   HCD - main menu, select Migrate configuration data

3. From the Migrate Configuration Data panel shown in Figure 4-74, select option 1, Migrate 
IOCP/OS data, then press Enter.

Figure 4-74   HCD - Migrate Configuration Data

4. HCD displays the Migrate IOCP Data panel, as shown in Figure 4-75 on page 191. Fill in 
the following fields and then press Enter:

Processor ID Use the same one used to create the IOCP input deck.

OS configuration ID This is the OS configuration associated with the processor.

IOCP only input data set This is the data set name specified when the iocpout.txt file 
was uploaded to TSO (see 4.7, “Build the production 
IODF” on page 192).

Processing mode Select option 2 to save the results of the migration. (Prior to 
using 2, however, try to migrate using option 1, in order to 
validate the operation).

Migrate options Select option 3 for PCHIDS. Only the PCHIDs are to be 
migrated into the work IODF.

  z/OS V1.9 HCD
 Command ===> ________________________________________________________________ 
                                                                               
                            Hardware Configuration                             
                                                                               
 Select one of the following.                                                  
                                                                               
 5_  1.  Define, modify, or view configuration data                            
     2.  Activate or process configuration data                                
     3.  Print or compare configuration data                                   
     4.  Create or view graphical configuration report                         
     5.  Migrate configuration data                                            
     6.  Maintain I/O definition files                                         
     7.  Query supported hardware and installed UIMs                           
     8.  Getting started with this dialog                                      
     9.  What's new in this release                                            
                                                                               
 For options 1 to 5, specify the name of the IODF to be used.                  
                                                                               
 I/O definition file . . . 'SYS6.IODF49.WORK'                                + 

 ----------- Migrate Configuration Data -------------  
                                                       
                                                       
   Select one of the following tasks.                  
                                                       
   1   1.  Migrate IOCP/OS data                        
       2.  Migrate switch configuration data           
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Figure 4-75   HCD - Migrate IOCP / MVSCP / HCPRIO Data

5. HCD displays any errors or warning messages resulting from the migration action. In our 
example, the only message received indicated that the migration was successful; see 
Figure 4-76.

Figure 4-76   HCD - Migration Message List

6. At this point, the work IODF contains both the CHPID definitions and the mapping to 
PCHIDs that was done using the CHPID Mapping Tool. Press PF3 and you should receive 
the message:

IOCP/Operating system deck migration processing complete, return code = 0.

7. Press PF3 again.

-------------------- Migrate IOCP / MVSCP / HCPRIO Data --------------------
                                                                            
                                                                            
 Specify or revise the following values.                                    
                                                                            
 Processor ID . . . . . . . . . . . . SCZP202   +   CSS ID . . . . . . _  + 
 OS configuration ID  . . . . . . . . TEST2097 +                           
                                                                            
 Combined IOCP/MVSCP input data set . _____________________________________ 
 IOCP only input data set . . . . . . 'SYS6.IODF49.IOCPOUT.SCZP202'         
 MVSCP only or HCPRIO input data set  _____________________________________ 
            Associated with processor ________  +                           
                            partition ________  +                           
 Processing mode  . . . . . . . . . . 2   1.  Validate                      
                                          2.  Save                          
                                                                            
 Migrate options  . . . . . . . . . . 3   1.  Complete                      
                                          2.  Incremental                   
                                          3.  PCHIDs                        
 MACLIB used  . . . . . . . 'SYS1.MACLIB'                                   
 Volume serial number . . . ______  + (if not cataloged) 

 ------------------------- Migration Message List ---------------------------
   Query  Help                                                               
 --------------------------------------------------------------------------  
                                                                  Row 1 of 2 
 Command ===> ___________________________________________ Scroll ===> CSR    
                                                                             
 Messages are sorted by severity. Select one or more, then press Enter.      
                                                                             
 / Statement  Orig Sev Message Text                                          
 _                 I   I/O configuration successfully written to the IODF    
 #                     SYS6.IODF49.WORK.
 ***************************** Bottom of data ****************************** 
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4.7  Build the production IODF
In order to make use of the definitions that we updated in HCD, the next step is to create a 
production IODF from the work IODF, as follows:

1. From the HCD main menu, select option 2, Activate or process configuration data 
(Figure 4-77).

Figure 4-77   HCD - main menu, select activate or process configuration data

2. The Activate or Process Configuration Data panel displays (Figure 4-78). Select option 1, 
Build production I/O definition file, and press Enter.

Figure 4-78   HCD - Activate or Process Configuration Data, select Build production IODF

 z/OS V1.9 HCD                                          
 Command ===> ________________________________________________________________ 
                                                                               
                            Hardware Configuration                             
                                                                               
 Select one of the following.                                                  
                                                                               
 2   1.  Define, modify, or view configuration data                            
     2.  Activate or process configuration data                                
     3.  Print or compare configuration data                                   
     4.  Create or view graphical configuration report                         
     5.  Migrate configuration data                                            
     6.  Maintain I/O definition files                                         
     7.  Query supported hardware and installed UIMs                           
     8.  Getting started with this dialog                                      
     9.  What's new in this release                                            
                                                                               
 For options 1 to 5, specify the name of the IODF to be used.                  
                                                                               
 I/O definition file . . . 'SYS6.IODF49.WORK'                                + 

 ----- Activate or Process Configuration Data -------  
                                                       
                                                       
   Select one of the following tasks.                  
                                                       
   1_  1.  Build production I/O definition file        
       2.  Build IOCDS                                 
       3.  Build IOCP input data set                   
       4.  Create JES3 initialization stream data      
       5.  View active configuration                   
       6.  Activate or verify configuration            
           dynamically                                 
       7.  Activate configuration sysplex-wide         
       8.  Activate switch configuration               
       9.  Save switch configuration                   
       10. Build I/O configuration statements          
       11. Build and manage S/390 microprocessor       
           IOCDSs and IPL attributes                   
       12. Build validated work I/O definition file    
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3. The Message List panel displays (Figure 4-79). Verify that you have only Severity W 
warning messages and that they are normal for your configuration. Correct any messages 
that should not occur and try to build the production IODF again. Continue this process 
until you have no messages indicating problems. Press PF3 to continue.

Figure 4-79   HCD - Message List (building Production IODF)

4. The Build Production I/O Definition File panel displays (Figure 4-80). Fill in the fields 
Production IODF name and Volume serial number and press Enter.

Figure 4-80   HCD - Build Production I/O Definition File

5. The Define Descriptor Fields panel displays (Figure 4-81 on page 194). Press Enter to 
accept the descriptor fields selected by HCD, or enter different values and then press 
Enter.

 ------------------------------- Message List -------------------------------- 
    Save  Query  Help                                                          
  --------------------------------------------------------------------------   
                                                                 Row 1 of 139  
                                                                               
  Messages are sorted by severity. Select one or more, then press Enter.       
                                                                               
  / Sev Msg. ID  Message Text                                                  
  _ W   CBDG092I Maximum number of 256 logical paths on link 61.0C to          
  #              control unit 8000 exceeded. Actually defined: 312             
  _ W   CBDG092I Maximum number of 256 logical paths on link 61.10 to          
  #              control unit 8000 exceeded. Actually defined: 424             
  _ W   CBDG092I Maximum number of 256 logical paths on link 61.14 to          
  #              control unit 8000 exceeded. Actually defined: 424             
  _ W   CBDG092I Maximum number of 256 logical paths on link 62.08 to          
  #              control unit 8000 exceeded. Actually defined: 312             
  _ W   CBDG092I Maximum number of 256 logical paths on link 62.0C to          
  #              control unit 8000 exceeded. Actually defined: 312             
  _ W   CBDG092I Maximum number of 256 logical paths on link 62.10 to          
  #              control unit 8000 exceeded. Actually defined: 312             

 -------------- Build Production I/O Definition File ---------------  
                                                                       
                                                                       
   Specify the following values, and choose how to continue.           
                                                                       
   Work IODF name . . . : 'SYS6.IODF49.WORK'                           
                                                                       
   Production IODF name . 'SYS6.IODF49'                                
   Volume serial number . IODFPK  +                                    
                                                                       
   Continue using as current IODF:                                     
   2   1.  The work IODF in use at present                             
       2.  The new production IODF specified above                     
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Figure 4-81   HCD - Define Descriptor Fields

6. HCD displays the following message, indicating that the production IODF was successfully 
created:

Production IODF SYS6.IODF49 created.

Proceed to the steps to implement the configuration on the 2097.

4.8  Implementing the processor configuration on a 2097
At this point there is a production IODF, which is called SYS6.IODF49. Now the IOCDS 
component of the IODF needs to be updated on the replacement CPC that is being installed 
(for example, SCZP202) and activated (POR) using this IOCDS. The final step is to IPL the 
processor using this IODF. (Describing how to IPL the new hardware is beyond the scope of 
this book.)

There are 2 possible ways to load the IOCP Statements onto the 2097 Service Element 
IOCDS:

� HCD, using Option 2.11

� HMC, using Stand-Alone Input/Output Configuration Program

While both ways are valid methods to write the new configuration to the IOCDS, we 
recommend using HCD Option 2.11. However, your 2097 processor and Service Element that 
are replacing the 2094 might not be connected to the system where the configuration was 
generated or cannot be connected to any system where HCD is running. In that case you will 
need to use the Stand-Alone IOCP process.

Firstly we describe using HCD Option 2.11

Updating the IOCDS using HCD Option 2.11
1. From the HCD main menu, select option 2, Activate or process configuration data; see 

Figure 4-82 on page 195. Ensure that the IODF is the production one created in the 
previous step. Press Enter.

 -------------------- Define Descriptor Fields -------------------- 
                                                                     
                                                                     
   Specify or revise the following values.                           
                                                                     
   Production IODF name  . : 'SYS6.IODF49'                           
                                                                     
   Descriptor field 1  . . . SYS6                                    
   Descriptor field 2  . . . IODF49 
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Figure 4-82   HCD - main menu, select Activate or process configuration data

2. The Activate or Process Configuration Data panel is displayed; see Figure 4-83 on 
page 196. Select option 11, Build and manage S/390 microprocessor IOCDSs and IPL 
attributes.

If the new 2097 is not accessible from the HMC LAN, we would need to copy the IOCP 
statements onto a USB Flash Memory Drive and import them onto the 2097 HMC to run a 
stand-alone IOCP. Creating a file on a USB Flash Memory Drive can be done using the 
same process that is used to create an IOCP input file for the CHPID Mapping Tool.

 z/OS V1.9 HCD                              
 Command ===> _____________________________________________________
                                                                   
                            Hardware Configuration                 
                                                                   
 Select one of the following.                                      
                                                                   
 2   1.  Define, modify, or view configuration data                
     2.  Activate or process configuration data                    
     3.  Print or compare configuration data                       
     4.  Create or view graphical configuration report             
     5.  Migrate configuration data                                
     6.  Maintain I/O definition files                             
     7.  Query supported hardware and installed UIMs               
     8.  Getting started with this dialog                          
     9.  What's new in this release                                
                                                                   
 For options 1 to 5, specify the name of the IODF to be used.      
                                                                   
 I/O definition file . . . 'SYS6.IODF49'  +

Note: In this example, we are assuming that the replacement 2097 has been delivered 
and has connectivity to the HMC LAN so we can create an IOCDS from which to 
power-on reset. This may not be the case for all readers.

Tip: The Support Element can now read an IOCP file that has been written to a USB 
Flash Memory Drive.
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Figure 4-83   HCD - Activate or Process Configuration Data, select Build IOCDSs

3. The S/390 Microprocessor Cluster List panel is displayed (Figure 4-84). Use a forward 
slash mark (/) to select the new 2097 from the list in order to update one of its IOCDSs. 
Press Enter.

Figure 4-84   HCD - S/390 Microprocessor Cluster List

4. The Actions on selected CPCs panel is displayed (Figure 4-85). Select option 1, Work 
with IOCDSs, and press Enter.

 z/OS V1.9 HCD                  
----- Activate or Process Configuration Data ------
                                                   
                                                   
 Select one of the following tasks.                
                                                   
 11  1.  Build production I/O definition file      
     2.  Build IOCDS                               
     3.  Build IOCP input data set                 
     4.  Create JES3 initialization stream data    
     5.  View active configuration                 
     6.  Activate or verify configuration          
         dynamically                               
     7.  Activate configuration sysplex-wide       
     8.  Activate switch configuration             
     9.  Save switch configuration                 
     10. Build I/O configuration statements        
     11. Build and manage S/390 microprocessor     
         IOCDSs and IPL attributes                 
     12. Build validated work I/O definition file 

Goto  Query  Help                                                              
 ------------------------------------------------------------------------------ 
                       S/390 Microprocessor Cluster List             Row 1 of 4 
 Command ===> _______________________________________________ Scroll ===> PAGE  
                                                                                
 Select one or more CPCs, then press Enter.                                     
                                                                                
   --------------CPC--------------   IODF                                       
 / SNA Address        Type   Model   Processor ID                               
 / USIBMSC.SCZP202 2097  E26  SCZP202 
 _ USIBMSC.SCZP101 2094  S18  SCZP101                                    
 _ USIBMSC.SCZP801    2064   1C7     SCZP801                                    
 _ USIBMSC.SCZP901    2084   C24     SCZP102                                    
 ******************************* Bottom of data ********************************
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Figure 4-85   HCD - Actions on selected CPCs, Work with IOCDSs

5. The IOCDS List panel is displayed (Figure 4-86). Select the IOCDS that you wish to 
update for the 2097 install by typing a slash (/) and then press Enter.

Figure 4-86   HCD - IOCDS List

6. The Actions on selected IOCDSs panel is displayed (Figure 4-87). Select option 1, 
Update IOCDS and press Enter.

Figure 4-87   HCD - Actions on selected IOCDSs

7. The Build IOCDSs panel is displayed; see Figure 4-88. Verify that all the information is 
correct. 

8. Fill in the field Title1 and then press Enter.

 ----------------- Actions on selected CPCs ------------------ 
                                                                
                                                                
   Select by number or action code and press Enter.             
                                                                
   1_  1.  Work with IOCDSs . . . . . . . . . . (s)             
       2.  Work with IPL attributes . . . . . . (i)             
       3.  Select other processor configuration (p)             

 Goto  Query  Help                                                           
------------------------------------------------------------------------------
                                  IOCDS List          Row 1 of 4 More:       >
Command ===> _______________________________________________ Scroll ===> CSR  
                                                                              
Select one or a group of IOCDSs, then press Enter.                            
                                                                              
                                         -----Token Match----- Write          
/ IOCDS       Name     Type   Status     IOCDS/HSA IOCDS/Proc. Protect        
/ A0.SCZP202  DIAG00  LPAR   Alternate  No        No          No             
_ A1.SCZP202  DIAG01  LPAR   POR        Yes       No          Yes-POR        
_ A2.SCZP202  DIAG02  LPAR   Alternate  No        No          No             
_ A3.SCZP202  DIAG03  LPAR   Alternate  No        No          No 

 ---------------- Actions on selected IOCDSs ----------------- 
                                                                
                                                                
   Select by number or action code and press Enter.             
                                                                
   1_  1.  Update IOCDS . . . . . . . . . . . . (u)             
       2.  Switch IOCDS . . . . . . . . . . . . (s)             
       3.  Enable write protection  . . . . . . (e)             
       4.  Disable write protection . . . . . . (w)             
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Figure 4-88   HCD - Build IOCDSs

9. The Job Statement Information panel is displayed (Figure 4-89). Fill in the job statements 
as required by the installation and press Enter. HCD submits the job to update the IOCDS.

Figure 4-89   HCD - Job Statement Information

10.Verify the job output to ensure that the IOCDS was written without error and to the correct 
IOCDS. You should receive a message like the following:

ICP057I IOCP JOB WIOCDS SUCCESSFUL. LEVEL A0 IOCDS REPLACED.

Now if you return to HCD option 2.11 and view the IOCDS, note that the SNA Address is 
at USIBMSC.SCZP202; see Figure 4-90.

Goto  Query  Help                                                          
------------------------------ Build IOCDSs -------------------------------
                                                                 Row 1 of 1
Command ===> ___________________________________________ Scroll ===> CSR   
                                                                           
Specify or revise the following values.                                    
                                                                           
IODF name . . . . . . . . . : 'SYS6.IODF49'                              
                                                                           
Title1 . TEST49__________________________________________________________  
Title2 : SYS6.IODF49 - 2007-12-03 19:03                                  
                                                                           
                           Write IOCDS in                                  
IOCDS        Switch IOCDS  preparation of upgrade                          
A0.SCZP202 No            No                                              
***************************** Bottom of data ******************************

 ------------------------- Job Statement Information -------------------------- 
                                                                                  
   Specify or revise the job statement information.                             
                                                                                
                                                                                
   Job statement information                                                    
   //WIOCDS  JOB (ACCOUNT),'NAME'                                               
   //*                                                                          
   //*                                                                          
   //*                                                                          

 

 

 

198 IBM System z10 Enterprise Class Configuration Setup



 

Figure 4-90   HCD - IOCDS with replacement IODF

Figure 4-91 shows the updated IOCDS. 

Figure 4-91   HCD - IOCDS showing Alternate Status

Updating the IOCDS using Stand-Alone Input/Output Config Program

Copy the IOCP statements that were generated using HCD option 2.3, Build IOCP input 
data set onto a USB Flash Memory Drive and retain it.

1. Log on using SYSPROG authority to the HMC workstation supplied with the 2097, as 
opposed to a remote Web browser, and select the new 2097, assuming it has been 
defined to the Defined CPCs Work Area.

2. Perform a Power-on Reset using one of the Reset profiles and Starter IOCDSs provided 
on the processor during installation. This is to create an environment on the processor that 
will allow you to run the Stand-Alone IOCP process.

3. When the Power-on Reset is complete, activate one of the logical partitions with at least 
128MB of storage and use this partition to run the I/O Configuration Program.

4. Under Systems Management, click Servers to expand the list.

Goto  Query  Help                                                              
 ------------------------------------------------------------------------------ 
                       S/390 Microprocessor Cluster List             Row 1 of 4 
 Command ===> _______________________________________________ Scroll ===> PAGE  
                                                                                
 Select one or more CPCs, then press Enter.                                     
                                                                                
   --------------CPC--------------   IODF                                       
 / SNA Address        Type   Model   Processor ID                               
 s USIBMSC.SCZP202 2097  E26  SCZP202 
 _ USIBMSC.SCZP101 2094  S18  SCZP101                                    
 _ USIBMSC.SCZP801    2064   1C7     SCZP801                                    
 _ USIBMSC.SCZP901    2084   C24     SCZP102                                    
 ******************************* Bottom of data ********************************

 Goto  Query  Help                                                           
------------------------------------------------------------------------------
                                  IOCDS List          Row 1 of 4 More:       >
Command ===> _______________________________________________ Scroll ===> CSR  
                                                                              
Select one or a group of IOCDSs, then press Enter.                            
                                                                              
                                         -----Token Match----- Write          
/ IOCDS       Name     Type   Status     IOCDS/HSA IOCDS/Proc. Protect        
_ A0.SCZP202  TEST49  LPAR   Alternate  No        Yes  No             
_ A1.SCZP202  DIAG01  LPAR   POR        Yes       No          Yes-POR        
_ A2.SCZP202  DIAG02  LPAR   Alternate  No        No          No             
_ A3.SCZP202  DIAG03  LPAR   Alternate  No        No          No 

Note: Refer to the Stand-Alone Input/Output Configuration Program User’s Guide 
SB10-7152 for detailed information on the following steps.
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5. Under Servers, click the server to select it (in this example SCZP202).

6. On the Tasks pad, click Recovery → Single Object Operations → Yes. 

7. On the Tasks pad, click CPC Configuration → Input/output (I/O) Configuration.

8. Click the radio button for the Data Set you wish to load the IOCDS into.

Figure 4-92   HMC - Select IOCDS for Stand-alone IOCP 

9. Click Options → Import Source File → Hardware Management Console USB Flash 
Memory Drive.

Figure 4-93   HMC - Import source file

10.Select the source file name and click OK.

Figure 4-94   HMC - Select source file
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11.Now that the IOCP statements have been imported, a Build Data Set needs to be 
performed to:

– Process the source file data for the selected I/O configuration.

– Check the syntax and validates the configuration.

– Generate an IOCDS and, if there are no errors, write the IOCDS to the support 
element hard disk.

– Write the I/O configuration source (IOCS) file to the support element hard disk with any 
IOCP messages embedded in the file.

Click OK. 

12.This will now initiate a load of the IOCP code into the targeted LPAR (previously activated) 
and the program will perform the Build Data Set steps.

If the build was successful and there are no caution or warning messages, the resultant 
IOCDS has been written to the support element hard disk. This IOCDS is now ready to be 
selected via a Reset Profile and the 2097 may be activated (Power-on Reset) with the 
production IODF.

4.9  HMC steps for activation profiles

Build the Production Reset Profile and point to required IOCDS
Now that the IODF has been written to an IOCDS, a Reset (Power-on Reset) Profile needs to 
be built to point to that IOCDS. This Reset Profile is used to power-on reset the new 2097 
after it has been handed over from the IBM service representative.

1. Log on using SYSPROG authority to the HMC workstation supplied with the 2097 or use a 
remote Web browser and select the new 2097.

2. Under Systems Management, click Servers to expand the list.

3. Under Servers, click the server to select it (in this example SCZP202).

4. On the Tasks pad, click Operational Customization to expand it, and select 
Customize/Delete Activation Profiles.

5. Select the DEFAULT Reset Profile and click Customize selected profile.

6. Save this DEFAULT profile with a new Profile name to be referred to when the power-on 
reset is required (for example, SCZP202).

7. Select the new Profile and click Customize selected profile.

8. Click the IOCDS that you just updated in the previous step. Message ACTB0PDL is 
displayed; see Figure 4-95.
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Figure 4-95   HMC - Activation Profiles, message ACTB0PDL

Depending on the circumstances, you may wish to answer Yes or No. You may now wish 
to review the Partition Activation List.

STP configuration
STP configuration should be reviewed to ensure that the correct External Time Source has 
been configured and that you are connected to the correct Coordinated Time Network. 

Refer to Chapter 7, “Server Time Protocol setup” on page 305 for details. 

Build Image Profiles
While still in the Reset Profile, you can now review the Image Profile attributes.

Build Load Profiles
Go through and create Load (IPL) Profiles using the “DEFAULTLOAD” Load profile as a 
skeleton for all the logical partitions that you are IPLing on this processor.

Build Load Members in SYS#.IPLPARM
You require Load Members defined in SYS#.IPLPARM when IPLing from the new 2097.

Additionally, if you are going to use the HWNAME parameter to point to the Processor.ID in 
the Load members, then make sure you use the correct name (SCZP202, in our example).

Performing a power-on reset of the 2097
The 2097 is now ready to be Activated (Power-on Reset) using the Production Reset Profile.
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Chapter 5. Install an additional System z10 
EC

In this chapter we describe how to add a new z10 EC into an existing System z environment.

Because a wide variety of different environments exist, your environment may not contain 
exactly the same elements as the configuration described here. Nevertheless, the 
step-by-step process we explain in this chapter should provide enough information for you to 
replicate the approach in your own environment.

This chapter also shows how to define a coupling link connection between a System z9 EC 
and a System z10 EC using CHPID type = CIB

We discuss the following topics:

� Scenario overview

� HCD - Create a 2097 work IODF

� Validate the 2097 work IODF

� CHPID Mapping Tool actions

� Migrate PCHIDs back into the 2097 work IODF

� HCD - build the 2097 production IODF

� Implementing the processor configuration on the 2097

� HMC steps for activation profiles

5
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5.1  Scenario overview
We begin by providing an overall description of this scenario.

5.1.1  The configuration process
Figure 5-1 depicts the general process that we followed in this example. The numbered steps 
are described following the figure.

Figure 5-1   CMT - Overall process flow

1. When you are planning to add a System z10 EC to your environment, the IBM Technical 
Support team can help to define a configuration that meets your needs. The configuration 
then gets passed to the ordering step.

2. The IBM order for the configuration is created and passed to the manufacturing process.

3. The manufacturing process creates a configuration file that is stored on the IBM Resource 
Link Web site. This configuration file describes the hardware being ordered. This data is 
available for download by the client installation team.

4. The existing System z I/O configuration is used as a starting point into HCD. The current 
production IODF is used as input to HCD to create a work IODF that will be the base to 
define the new System z10 configuration. 
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5. When the new System z10 EC configuration has been added and the obsolete hardware 
has been deleted, a validated version of the configuration is saved in a 2097 validated 
work IODF. 

6. From the validated work IODF, create a file containing the z10 EC IOCP statements. This 
file is transferred to the workstation used for the CHPID Mapping Tool. HCM may also be 
used to transfer the IOCP deck to and from the CMT.

7. The configuration file created by the IBM Manufacturing process in step 3 is downloaded 
from Resource Link to the CHPID Mapping Tool workstation.

8. The CHPID Mapping Tool uses the input data from files to map logical channels to 
physical ones on the new System z10 EC hardware. 

You might have to make decisions in response to situations that might arise, such as:

a. Resolving situations in which the limitations on the purchased hardware cause a single 
point of failure (SPoF). You may need to purchase additional hardware in order to 
resolve some SPoF situations.

b. Prioritizing certain hardware items over others. 

After processing by the CHPID Mapping Tool, the IOCP statements contain the physical 
channels assignment to logical channels, based on the actual purchased hardware 
configuration. 

The CHPID Mapping Tool also creates configuration reports to be used by the IBM service 
representative and the installation team. 

9. The file containing the updated IOCP statements created by the CHPID Mapping Tool,   
now containing the physical channels assignment, is transferred to the host system. 

10.Using HCD again, and taking as input the validated work IODF file created in step 5 and 
the IOCP statements updated by the CHPID Mapping Tool (CMT), apply the physical 
channel assignments done by the CMT to the configuration data in the work IODF. 

After the physical channel data has been migrated into the work IODF, a 2097 production 
IODF is created and the final IOCP statements can be generated. 

The IBM installation team uses the configuration data written in step 10 when the final 
power-on reset is done, yielding a System z10 EC with the client I/O configuration that is 
ready to be used.

When installing a new 2097, you may be able to use HCD to write an IOCDS to the 2097 in 
preparation for an upgrade if you have another computer system in another location that 
connects to your new 2097. If you can write an IOCDS to the 2097, do so and let the IBM 
service representative know which IOCDS to use.

If the new 2097 is not connected using a LAN to the CPC where HCD is running, or you are 
not upgrading or cannot write an IOCDS using HCD in preparation for the upgrade, then use 
HCD to produce an IOCP input file and download the input file to a USB Flash Memory Drive. 

The IOCP input file will then need to be loaded into the 2097 Support Element IOCDS using 
the Stand-Alone Input/Output Configuration Program. Refer to Technical Manual SB10-7152 
for details.

Note: Using the HCD option Write IOCDS in preparation of an upgrade is the preferred 
method for writing the initial IOCDS when installing a new 2097. However, you may need 
to use the Stand-Alone Input/Output Configuration Program process.
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5.1.2  Planning considerations
The follow table lists the channel types as described in an IOCDS that are used with the 
System z10 EC.

Table 5-1   Channels, links, and adapters with CHPID type

Keep the following considerations in mind when planning your configuration.

Coupling links
Only the following Coupling Facility CHPIDs are supported:

� CHPID Type=CFP - ISC-3 links in peer mode

� CHPID Type=CBP - ICB-4 links

� CHPID Type=CIB - PSIFB links connecting to an HCA2-O fanout

� CHPID Type=ICP - Internal Coupling links.

HMC
The System z10 EC requires HMC Application Ver 2.10.0 or later and only uses Ethernet for 
its network connection. The HMC and also the Service Elements do not contain a floppy disc 
drive, requiring the use of a USB Flash Memory Drive to input and back up customer 
configuration data.

Channels
CHPID 
Type

May be 
defined as 

Shared

May be 
defined as 
Spanned

ESCON channels:
Connection Channel (ESCON architecture)
Channel to Channel (connects to CNC)

CNC
CTC

yes
ye

no
no

FICON bridge. A FICON channel that attaches to an ESCON Director 
Model 5

FCV yes no

FICON native channels that attach to FICON directors or directly to 
FICON control units

FC yes yes

FICON channels that attach to Fibre channel devices, switches, 
directors, or Fibre-Channel-to-SCSI bridges

FCP yes yes

ISC-3 peer mode channels (connects to another CFP) CFP yes yes

ICB-4 peer channels (connects to another ICB-4) CBP yes yes

IC peer channels (connects to another ICP) ICP yes yes

InfiniBand host channel adapters (HCA) CIB yes yes

HiperSocket (IQDIO) channels IQD yes yes

OSA adapters using QDIO architecture OSD yes yes

OSA adapters using non-QDIO architecture OSE yes yes

OSA 1000Base-T adapters for OSA-ICC OCE yes yes

OSA-Express2 adapters for NCP OSN yes yes

Note: Coupling links can be defined as both Coupling and STP links or STP-only links.
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Software support
HCD V1.9 or HCD V1.7 and later with 2097DEVICE PSP Bucket and PTFs is required to 
define and support some of the new features of the System z10 EC. 

Open Systems Adapter - Integrated Console Controller (OSA-ICC)
You might consider using OSA Express2 1000BaseT CHPIDs defined as TYPE=OSC. These 
OSA cards allow you to set up console function supported by a configuration file defined on 
the Support Element for that processor.

Fibre Channel Protocol (FCP)
When using CHPIDs defined as TYPE=FCP, you may wish to consider NPIV.

CPC name versus Processor ID
HCD allows you to define different Processors (Logical) to the same CPC (Physical). The 
Processor ID needs to be unique within the same IODF, but the CPC name does not. 
Therefore, the CPC name does not need to match the Processor ID. This is useful where you 
may have several Processor/logical partition/control unit setups that share the same physical 
CPC within the same IODF. Furthermore, the Processor ID is what is defined for the 
HWNAME parameter in the LOAD member in SYS1.IPLPARM.

The CPC name is coded in HCD option 1.3 under View Processor Definition in the CPC name 
field under SNA address, along with a Network name. It is the CPC name, and not the 
Processor ID, that appears on the HMC. 

When you view the Network information for a CPC via the HMC, note that the SNA address is 
made up of a Network name and CPC name separated by a dot (for example, 
USIBMSC.SCZP201). These values are defined in the Support Element for the CPC and they 
need to match the values set in the IODF so that HCD option 2.11 can find the CPC to write 
an IOCDS in the S/390 Microprocessor Cluster List.

Local System Name
An additional system name LSYSTEM is used to identify the local system name of a server 
when defining PSIFB type=CIB coupling links.

This data field can be found when changing a CIB-capable processor under HCD Option 1.3

The LSYSTEM field can be set or changed to any 1-8 alphanumeric characters and also can 
begin with either an alpha or numeric character. All characters are upper case.

Here are the rules that will determine whether, and where, HCD will set the LSYSTEM 
keyword automatically or not.

1. If a CIB-capable processor is defined and the CPC name is set but the local system name 
is not set, HCD defaults the local system name to the CPC name. 

2. If a CIB-capable processor that has not yet defined a CPC name will be changed to get a 
CPC name but no local system name, HCD defaults the CPC name to the local system 
name.

3. If a non-CIB capable processor is changed to a support level that is CIB capable, and the 
processor has a CPC name set but no local system name, the local system name is 
defaulted to the CPC name. 

4. If the processor definition is changed such that the local system name is explicitly 
removed, HCD does not do any defaulting.
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5. If a processor has a local system name set (whether it has a CPC name or not), any 
change to the local system name has to be done explicitly. There will be no implicit name 
if the CPC name or the support level is changed.

6. During Build Production IODF it is verified that a local system name has to be set for the 
processor if the processor has a CIB channel path defined. If this verification fails, an error 
message is given and the production IODF is not built.

We do, however, recommend that the local system name be the same as the CPC name.

Additional keywords on the ID statement in an IOCP deck include:

AID: Adapter ID
Port: HCA port
CPATH: Specifies the CCSID and CHPID on the connecting system

5.1.3  Additional 2097 scenario
In this scenario we describe the configuration steps to install a new 2097 processor into an 
existing hardware environment. Key considerations are as follows:

� HCD requires a new Processor ID for the 2097.

� We recommend defining a new CPC name for 2097.

� The 2097 processor connects to new switch ports and new control unit interfaces.

� The control unit interfaces connect to the same switch ports as previously.

� The starting IODF is the current production IODF.

� The target IODF is a new 2097 work IODF.

This example shows an existing System z9 EC (2094-S18) with Processor ID of SCZP101 
and three CSSs (CSS ID=0, CSS ID=1 and CSS ID=2). We will be adding a new System z10 
EC (2097-E26) with Processor.ID SCZP201 and with fours CSSs (CSS ID=0, CSS ID=1, CSS 
ID=2 and CSS ID=3). The CPC name of SCZP201 and serial number of 000201 is used for 
the 2097.

The following CHPID types are defined:

� FC, FCP, CTC, CNC 
� OSD, OSE, OSC, OSN
� CFP, CBP, ICP, CIB
� IQD

The following Hardware/CHPID types are not supported on the 2097:

� PCIXCC and PCICA
� ICB-3 links
� ICB-2 links
� ISC-3 links in compatibility mode (CHPID types CFS and CFR)
� OSA-Express Token Ring
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Table 5-2   Additional 2097 I/O configuration

5.2  HCD - Create a 2097 work IODF
The following steps are used to define a new 2097 server to the existing I/O configuration 
using HCD:

1. Create a 2097 work IODF from a current production IODF.

2. Add the processor.

3. Change required partition names and usage from reserved.

4. Add CHPIDs.

5. Connect FICON and ESCON CHPIDs to existing switches, to available ports. 

6. Create any additional control units unique to this processor and connect CHPIDs.

7. Define all required CF connections to other processors and any Internal CF connections 
required.

8. Create CTCs.

9. Connect to existing control units for DASD, Tape, Printer, Communication devices, directly 
or via switches.

10.Create OSA (OSC, OSD, OSE, OSN).

11.Build a validated work IODF.

New 2097 Additional 2097 to connect to same switch 
ports and control units that existing 
processors connect to (additional new)

Processor ID Require new Processor ID

CPC name Require new CPC name

Channel to switch port connections Additional ports

Control Unit to switch port connections Same ports

Starting IODF Current active production IODF

Target IODF Create a new work IODF

HCD action Add Processor (see below)

CHPID Mapping Tool (CMT) Program Optional, but recommended

CFReport File (CCN) Required

IOCP (import from validated work IODF) Yes

CHPID Mapping Tool Actions (PCHID reset) Yes

CHPID Mapping Tool IOCP Output Yes

CHPID Mapping Tool Reports Yes, CHPID and CHPID to CU Report

Note: As mentioned, it is possible to have a different Processor ID with a CPC name.

However, if you do not need to support multiple processor images, we recommend that the 
Processor ID and CPC name match.
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12.Create an IOCP statements file and file transfer to your CHPID Mapping Tool workstation. 
This step can also be performed with HCM. 

13.Import CFReport and IOCP statements into the CMT.

14.Perform hardware resolution and PCHID/CHPID availability.

15.Create configuration reports for yourself and the IBM service representative.

16.Import IOCP statements updated with PCHIDs back into the validated work IODF.

17.Build Production IODF and remote write the IOCP to an IOCDS on the processor, or if not 
possible, copy the IOCP statements to a USB Memory Flash Drive.

18.Run Stand-Alone Input/Output Configuration Program to load the IOCP statements onto 
the 2097 Service Element IOCDS.

19.Build Reset, Image and Load Profile.

20.Perform Power-on Reset (Activate) of 2097.

Create a work IODF from current Production IODF
Select the current production IODF in HCD that contains the existing hardware environment 
that will be connected to the new 2097 (for example, ‘SYS6.IODF68’).

Add the new 2097 processor 
1. From the HCD main menu, select option 1.3, Processor List (Figure 5-2).

2. Type add or press PF11 (add) to add a new processor, then press Enter.

Figure 5-2   HCD - Processor List (adding processor)

� The Add Processor panel displays (Figure 5-3).

 Goto  Filter  Backup  Query  Help                                            
------------------------------------------------------------------------------ 
                                Processor List        Row 1 of 8 More:       > 
Command ===> add____________________________________________ Scroll ===> CSR   
                                                                               
Select one or more processors, then press Enter. To add, use F11.              
                                                                               
                                                                               
/ Proc. ID Type +   Model +  Mode+ Serial-# + Description                      
_ ISGSYN   2064     1C7      LPAR  __________ ________________________________ 
_ ISGS11   2064     1C7      LPAR  __________ ________________________________ 
_ P000STP1 2084     C24      LPAR  01534A2084 ________________________________ 
_ P000STP2 2094     S08      LPAR  0BAD4E2094 ________________________________ 
_ SCZP101  2094     S18      LPAR  02991E2094 ________________________________ 
_ SCZP801  2064     1C7      LPAR  010ECB2064 ________________________________ 
_ SCZP901  2084     C24      LPAR  026A3A2084 ________________________________ 
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Figure 5-3   HCD - Add Processor (blank values)

3. Specify the appropriate values. In our example, we entered the following values:

Add Processor ID: SCZP201

Add Processor type: 2097

Add Processor model: E26

Number of channel subsystems: Leave blank for the moment

Add Serial number: 0002012097

Add Network name: USIBMSC

Add CPC name: SCZP201

Local System Name: Leave blank for the moment

Figure 5-4 on page 212 shows the values we added.

 ------------------------------ Add Processor --------------------------

 Specify or revise the following values.                                
                                                                        
 Processor ID . . . . . . . . . . ________                              
 Processor type . . . . . . . . . ________  +                           
 Processor model  . . . . . . . . ________  +                           
 Configuration mode . . . . . . . LPAR      +                           
 Number of channel subsystems . . _         +                           
                                                                        
 Serial number  . . . . . . . . . __________                            
 Description  . . . . . . . . . . ________________________________      
                                                                        
 Specify SNA address only if part of an S/390 microprocessor cluster:   
                                                                        
 Network name . . . . . . . . . . ________  +                           
 CPC name . . . . . . . . . . . . ________  +                           
                                                                        
 Local system name  . . . . . . . ________                              
  F1=Help     F2=Split    F3=Exit     F4=Prompt   F5=Reset    F9=Swap   
 F12=Cancel 
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Figure 5-4   HCD - Add Processor (adding values)

4. Press Enter. The Create Work I/O Definition File panel prompts you to enter the data set 
name of the Target IODF (for example, SYS6.IODF69.WORK).

5. Press Enter. You now have an additional 2097 processor named SCZP201; see 
Figure 5-5.

Notice the message displayed at the bottom of the panel indicating that the processor 
definition has been extended to its maximum configuration. This is because part of the 
Central Storage is allocated as a fixed-sized Hardware System Area, which is not 
addressable by application programs. In HCD when you define as new or redefine a 
processor as 2097, HCD automatically defines the maximum configuration of four CSSs 
and 60 logical partitions.

 ------------------------------ Add Processor -----------------------------

 Specify or revise the following values.                                   
                                                                           
 Processor ID . . . . . . . . . . SCZP201_                                 
 Processor type . . . . . . . . . 2097____  +                              
 Processor model  . . . . . . . . E26_____  +                              
 Configuration mode . . . . . . . LPAR      +                              
 Number of channel subsystems . . _         +                              
                                                                           
 Serial number  . . . . . . . . . 0002012097                               
 Description  . . . . . . . . . . ________________________________         
                                                                           
 Specify SNA address only if part of an S/390 microprocessor cluster:      
                                                                           
 Network name . . . . . . . . . . USIBMSC_  +                              
 CPC name . . . . . . . . . . . . SCZP201_  +                              
                                                                           
 Local system name  . . . . . . . ________                                 
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Figure 5-5   HCD - processor List (new process or added)

6. Type s next to the SCZP201 and press Enter. The Channel Subsystem List is displayed. 
Here you can see four Channel Subsystems defined with the default MAXDEV values of 
65280 set by HCD. 

Figure 5-6   HCD - Channel Subsystem List (newly defined CSS)

7. Type p next to any of the CSSs and observe that HCD also defines the maximum number 
of logical partitions, 15 per CSS or a total of 60, as Reserved (*) (Figure 5-7 on page 214).

 Goto  Filter  Backup  Query  Help                                            
 ------------------------------------------------------------------------------ 
                                 Processor List        Row 1 of 8 More:       > 
 Command ===> _______________________________________________ Scroll ===> CSR   
                                                                                
 Select one or more processors, then press Enter. To add, use F11.              
                                                                                
                                                                                
 / Proc. ID Type +   Model +  Mode+ Serial-# + Description                      
 _ ISGSYN   2064     1C7      LPAR  __________ ________________________________ 
 _ ISGS11   2064     1C7      LPAR  __________ ________________________________ 
 _ P000STP1 2084     C24      LPAR  01534A2084 ________________________________ 
 _ P000STP2 2094     S08      LPAR  0BAD4E2094 ________________________________ 
 _ SCZP101  2094     S18      LPAR  02991E2094 ________________________________ 
 _ SCZP201  2097     E26      LPAR  0002012097 ________________________________ 
 _ SCZP801  2064     1C7      LPAR  010ECB2064 ________________________________ 
 _ SCZP901  2084     C24      LPAR  026A3A2084 ________________________________ 
 ******************************* Bottom of data ********************************
                                                                                

                                                                                
                                                                                
+------------------------------------------------------------------+
| Definition of processor SCZP201 has been extended to its maximum |
| configuration.  |
+------------------------------------------------------------------+

 Channel Subsystem List                  Row 1 of 4
Command ===> _______________________________________________ Scroll ===> CSR  
                                                                              
Select one or more channel subsystems, then press Enter.  To add, use F11.    
                                                                              
Processor ID . . . : SCZP201 
                                                                              
  CSS Devices in SS0    Devices in SS1                                        
/ ID  Maximum + Actual  Maximum + Actual  Description                         
_ 0   65280     0       65535     0       ________________________________    
_ 1   65280     0       65535     0       ________________________________    
_ 2   65280     0       65535     0       ________________________________    
_ 3   65280     0       65535     0       ________________________________ 

Note: The MAXDEV values are automatically set when defining a 2097 due to the 
fixed Hardware System Area (HSA) on a 2097 processor. 
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Figure 5-7   HCD - Partition List 

If you scroll down you will see the remaining reserved logical partitions defined for this 
CSS.

8. Define the resources to the new 2097 processor.

9. Define the resources to the new 2097 processor:

– Change Reserved partitions for each desired CSS to required partition name and 
usage. Not all partitions need to be changed at this point but can be modified later via a 
Dynamic IODF Activate.

– Add CHPIDs to each CSS, with no PCHIDs assigned. 
– Define a Partition Access list for these CHPIDs.
– Define a Partition Candidate list for these CHPIDs.

10.Connect FICON and ESCON CHPIDs to available ports on existing switches.

11.Connect FICON and ESCON CHPIDs directly to control units, where applicable.

12.Create any control units unique for this processor and connect CHPIDs.

13.Define all required coupling links to other processors in the hardware environment, and 
also any internal coupling links required.

14.Create CTCs (ESCON or FICON).

15.Define logical paths to existing control units for DASD, tape, printers, communications 
controllers directly or via the FICON or ESCON switches.

16.Create OSA resources (for example, OSC, OSD, OSE, OSN).

----------------------------- Partition List ----------------------------
Row 1 of 15

 Command ===> ________________________________________ Scroll ===> CSR   
                                                                         
 Select one or more partitions, then press Enter. To add, use F11.       
                                                                         
 Processor ID  . . . . : SCZP201 
 Configuration mode  . : LPAR                                            
 Channel Subsystem ID  : 0                                               
                                                                         
 / Partition Name   Number Usage + Description                           
 _ *                1      CF/OS   ________________________________      
 _ *                2      CF/OS   ________________________________      
 _ *                3      CF/OS   ________________________________      
 _ *                4      CF/OS   ________________________________      
 _ *                5      CF/OS   ________________________________      
 _ *                6      CF/OS   ________________________________      
 _ * 7  CF/OS   ________________________________ 

Note: For specific details on defining processors, partitions, switches, control units, 
devices, and so forth, refer to z/OS HCD Users Guide, SC33-7988 and IOCP Users 
Guide, SB10-7037.

Note: We will explain in more detail in the next section on how to define CIB type 
coupling facility links and set up a CIB coupling link between the 2094 and the new 
2097.
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Over-define channel paths
Sometimes you may need to define a channel path that is not physically installed on the 
processor. This may be useful if you are planning to add additional channel cards to the 
processor in the future and want to have the definitions in the IODF before the hardware is 
installed.

HCD allows you to over-define CHPIDs by using an asterisk (*) for the PCHID value. An 
over-defined CHPID must adhere to all validation rules, but it is not taken into account by an 
IOCDS download. Also it is not included in the IOCP statements, in a CONFIGxx member, or 
during dynamic activation.

If a control unit contains only CHPIDs with a PCHID value of an asterisk (*), then the whole 
control unit (including any attached devices) is omitted from the configuration to be activated.

When installing the channel path later, you must edit the CHPID and replace the * with its 
valid PCHID.

The 2097 production IODF can then be activated dynamically and the PCHID/CHPID/control 
unit definitions become available to the operating system.

� Figure 5-8 illustrates what the CHPID/PCHID definitions look like before being defined as 
over-defined. Press PF20 (right) in the Channel Path List.

Figure 5-8   HCD - Channel Path List (Reserving CHPIDs)

Note: This is not the case for CFP and CBP type CHPIDs, where these CHPIDs have 
connections to other CFP and CBP type CHPIDs. 

Therefore, HCD only allows you to define CFP and CBP type CHPIDS as over-defined if 
they are unconnected.

If you define a CIB type CHPID, it must also be defined with an HCA Adapter ID (AID) and 
an HCA Port ID, represented in the AID/P column in the Channel Path List. HCD does not 
allow a CIB type CHPID to be defined as over-defined.

 Channel Path List     Filter Mode. More: <     >
Command ===> _______________________________________________ Scroll ===> CSR  
                                                                              
Select one or more channel paths, then press Enter. To add, use F11.          
                                                                              
Channel Subsystem ID : 0                                                      
1=A01       2=A02       3=A03       4=A04       5=A05                         
6=A06       7=A07       8=A08       9=A09       A=A0A                         
B=A0B       C=A0C       D=A0D       E=A0E       F=A0F                         
                          I/O Cluster  --------- Partitions 0x -----   PCHID  
/ CHPID Type+ Mode+ Mngd  Name +       1 2 3 4 5 6 7 8 9 A B C D E F   AID/P  
_ BE    CFP   SHR   No    ________     _ _ _ _ _ _ _ _ _ _ _ _ a _ _   3D8    
_ BF    CFP   SHR   No    ________     _ _ _ _ _ _ _ _ _ _ _ _ a _ _   3D9    
_ CE    CFP   SPAN  No    ________     _ _ a _ _ _ _ _ _ _ _ _ _ _ _   181    
_ CF    CFP   SPAN  No    ________     _ _ a _ _ _ _ _ _ _ _ _ _ _ _   111    
_ EC    CFP   SPAN  No    ________     _ _ a _ _ _ _ _ _ _ _ _ _ _ _   3C0    
_ EE    CFP   SPAN  No    ________     _ _ a _ _ _ _ _ _ _ _ _ _ _ _   3D0 
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� Figure 5-9 illustrates what the CHPID/PCHID definitions look like after being defined as 
over-defined.

Figure 5-9   HCD - Channel Path List (over-defined CHPIDs)

Add CHPID type=CIB channels and PSIFB links
In this section we define CIB CHPIDs to the 2094 (running as a dedicated coupling 
processor) and the 2097, and define a PSIFB link between the CIB type CHPIDs.

First we briefly go through processor Support Levels and the local system name or LSYSTEM 
keyword introduced for PSIFB link definitions.

1. From the HCD main menu, select option 1.3, Processor List (Figure 5-10).

2. Type c next to SCZP101 (the 2094) and press Enter.

 Channel Path List     Filter Mode. More: <     >
Command ===> _______________________________________________ Scroll ===> CSR  
                                                                              
Select one or more channel paths, then press Enter. To add, use F11.          
                                                                              
Channel Subsystem ID : 0                                                      
1=A01       2=A02       3=A03       4=A04       5=A05                         
6=A06       7=A07       8=A08       9=A09       A=A0A                         
B=A0B       C=A0C       D=A0D       E=A0E       F=A0F                         
                          I/O Cluster  --------- Partitions 0x -----   PCHID  
/ CHPID Type+ Mode+ Mngd  Name +       1 2 3 4 5 6 7 8 9 A B C D E F   AID/P  
_ BE    CFP   SHR   No    ________     _ _ _ _ _ _ _ _ _ _ _ _ a _ _   *      
_ BF    CFP   SHR   No    ________     _ _ _ _ _ _ _ _ _ _ _ _ a _ _   *      
_ CE    CFP   SPAN  No    ________     _ _ a _ _ _ _ _ _ _ _ _ _ _ _   *      
_ CF    CFP   SPAN  No    ________     _ _ a _ _ _ _ _ _ _ _ _ _ _ _   *      
_ EC    CFP   SPAN  No    ________     _ _ a _ _ _ _ _ _ _ _ _ _ _ _   *      
_ EE    CFP   SPAN  No    ________     _ _ a _ _ _ _ _ _ _ _ _ _ _ _   * 

Note: The local system name must be defined if PSIFB links are going to be defined over 
CIB type CHPIDs. We recommend using the CPC name of that server.
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Figure 5-10   HCD - Change Processor Definition (display Support level)

3. Notice that the local system name field is blank for this 2094.

– If a 2094 (CIB-capable) processor is defined and the CPC name is set but the local 
system name is not set, HCD defaults the local system name to the CPC name. 

– If a 2094 (CIB-capable) processor that has not yet defined a CPC name will be 
changed to get a CPC name but no local system name, HCD defaults the CPC name to 
the local system name.

– If a 2094 (non-CIB capable) processor is changed to a support level that is CIB 
capable, and the processor has a CPC name set but no local system name, the local 
system name is defaulted to the CPC name. 

– If the 2094 processor definition is changed such that the local system name is explicitly 
removed, HCD does not do any defaulting.

– If a 2094 processor has a local system name set (whether it has a CPC name or not), 
any change to the local system name has to be done explicitly. There will be no implicit 
name if the CPC name or the support level is changed.

We do, however, recommend that the local system name be the same as the CPC name.

4. In our example in Figure 5-11, we add the local system name before we move on to the 
processor Support Levels.

------------------------ Change Processor Definition -----------------------

 Specify or revise the following values.                                    
                                                                            
 Processor ID . . . . . . . . : SCZP101                                     
 Support level:                                                             
 XMP, Basic 2094 support                                                    
 Processor type . . . . . . . . 2094      +                                 
 Processor model  . . . . . . . S18       +                                 
 Configuration mode . . . . . . LPAR      +                                 
                                                                            
 Serial number  . . . . . . . . 02991E2094  +                               
 Description  . . . . . . . . . ________________________________            
                                                                            
 Specify SNA address only if part of an S/390 microprocessor cluster:       
                                                                            
 Network name . . . . . . . . . USIBMSC   +                                 
 CPC name . . . . . . . . . . . SCZP101   +                                 
                                                                            
 Local system name  . . . . . . ________ 
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Figure 5-11   HCD - Change Processor Definition (display Support level)

Notice the Support Level in Figure 5-11 and see how the 2094 is currently set to XMP, 
Basic 2094 support.

5. Press Enter. HCD will give you the option to change the Support Level to include CIB 
support (Figure 5-12).

Figure 5-12   HCD - Change Processor Definition (changing support level)

6. Type s next to ‘XMP, 2094 support, CIB’ and press Enter.

------------------------ Change Processor Definition -----------------------

 Specify or revise the following values.                                    
                                                                            
 Processor ID . . . . . . . . : SCZP101                                     
 Support level:                                                             
 XMP, Basic 2094 support                                                    
 Processor type . . . . . . . . 2094      +                                 
 Processor model  . . . . . . . S18       +                                 
 Configuration mode . . . . . . LPAR      +                                 
                                                                            
 Serial number  . . . . . . . . 02991E2094  +                               
 Description  . . . . . . . . . ________________________________            
                                                                            
 Specify SNA address only if part of an S/390 microprocessor cluster:       
                                                                            
 Network name . . . . . . . . . USIBMSC   +                                 
 CPC name . . . . . . . . . . . SCZP101   +                                 
                                                                            
 Local system name  . . . . . . SCZP101 

------------------------- Available Support Levels ---------------------
                                                   Row 1 of 3 More:     
 Command ===> __________________________________________________________
                                                                        
 Select the processor support level which provides the processor        
 capabilities you want to use.                                          
                                                                        
                                                                        
   Support Level                                                        
   XMP, Basic 2094 support                                              
 s XMP, 2094 support, CIB                                               
 #                                                                      
 ***************************** Bottom of data **************************
                                                                        
                                                                        
  F1=Help        F2=Split       F3=Exit        F7=Backward    F8=Forward
  F9=Swap       F12=Cancel     F20=Right      F22=Command               
------------------------------------------------------------------------
+----------------------------------------------------------------------+
| A support level selection is required. Press PF1 on the Support Level|
| field for available detail information.                              |
+======================================================================+

 

 

 

218 IBM System z10 Enterprise Class Configuration Setup



 

Now we add some CIB type CHPIDs to the 2094 and 2097 processors and define a PSIFB 
link using the following steps:

1. Review the PCHID report that came with the 2094 and look for the AID. In our example we 
will use AID=0A and AID=1A (HCA1-O).

2. Review the PCHID report that came with the 2097 and do the same. In our example we 
will use AID=0B and AIB=1B (HCA2-O). Refer to Figure 5-13 to see the Adapter IDs for 
the Host Channel Adapter F/C 0163 on the 2097.

Figure 5-13   HCD - 2097 PCHID Report (showing AIDs)

3. In the processor list, type s next to the 2094 and press Enter.

4. Type s next to the CSS where you wish to define the CIB CHPIDs and press Enter.

5. Type add or press PF11 (add) to add new chpids and press Enter (Figure 5-14 on 
page 220).

Note: Currently PSIFB links using CIB type CHPIDs are only supported on a 2094 when 
running as a standalone coupling facility.

IBM has announced a statement of Direction to support PSIFB links on general purpose 
System z9 EC and BC servers. When that support is made available, System z9 servers 
with general purpose processors, IFLs, zAAPs, or zIIPS will be able to utilize 12x IB-SDR 
links. 

Note: Once installed, Adapter IDs can also be found via the HMC/SE panels.

CHPIDSTART
  33442976                      PCHID REPORT                       Nov 30,2007
  Machine: 2097-E26  SN1
  - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - -
  Source           Cage  Slot  F/C    PCHID/Ports or AID              Comment
  06/D6            A25B  D606  0163   AID=0B

15/D6            A25B  D615  0163   AID=1B

06/DA            A25B  DA06  3393   01E/J01 01F/J02

15/DA            A25B  DA15  3393   03E/J01 03F/J02

15/D9/J01        A01B  D101  0218   100/J00

15/D9/J01        A01B  D201  0218   108/J00

06/D9/J01        A01B  D102  0218   110/J00 111/J01

06/D9/J01        A01B  D202  0218   118/J00 119/J01 

 

 

 

Chapter 5. Install an additional System z10 EC 219



 

Figure 5-14   HCD - Channel Path List (adding chpids)

6. Enter the appropriate values. As shown in Figure 5-15, for our example we specified the 
following values:

Channel path ID: B0

Channel path type: CIB

Operational mode: SHR

Figure 5-15   HCD - Add Channel Path (adding chpids)

7. Press Enter. HCD will now display the Specify HCA Attributes panel.

 Channel Path List     Row 1 of 153 More:       >
Command ===> add____________________________________________ Scroll ===> CSR  
                                                                              
Select one or more channel paths, then press Enter. To add use F11.           
                                                                              
Processor ID . . . . : SCZP101                                                
Configuration mode . : LPAR                                                   
Channel Subsystem ID : 0                                                      
                                                                              
                    DynEntry Entry +                                          
/ CHPID Type+ Mode+ Switch + Sw Port Con Mngd Description                     
  00    OSD   SPAN  __       __ __       No   1000BaseT                       
_ 01    OSD   SPAN  __       __ __       No   1000BaseT                       
_ 02    OSD   SPAN  __       __ __       No   1000BaseT                       
_ 03    OSD   SPAN  __       __ __       No   1000BaseT                       
_ 04    OSD   SPAN  __       __ __       No   1000BaseT                       
_ 05    OSD   SPAN  __       __ __       No   1000BaseT                       
_ 06    OSD   SPAN  __       __ __       No   1000BaseT                       
_ 07    OSE   SPAN  __       __ __       No   1000BaseT                       
_ 08    OSE   SPAN  __       __ __       No   1000BaseT 

--------------------------- Add Channel Path ------------------------
                                                                     
Specify or revise the following values.                              
                                                                     
Processor ID . . . . : SCZP101                                       
Configuration mode . : LPAR                                          
Channel Subsystem ID : 0                                             
                                                                     
Channel path ID  . . . . B0    +            PCHID . . . ___          
Number of CHPIDs . . . . 1                                           
Channel path type  . . . CIB   +                                     
Operation mode . . . . . SHR   +                                     
Managed  . . . . . . . . No   (Yes or No)   I/O Cluster ________  +  
Description  . . . . . . ________________________________            
                                                                     
Specify the following values only if connected to a switch:          
Dynamic entry switch ID  __  + (00 - FF)                             
Entry switch ID  . . . . __  +                                       
Entry port . . . . . . . __  + 
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8. Enter the appropriate values. As shown in Figure 5-16, for our example we specified the 
following values:

Adapter ID of the HCA: 0A
Port on the HCA: 1

Figure 5-16   HCD - Specify HCA Attributes for 2094 (defining AID and port)

9. Press Enter. HCD will go through the normal Define Access and Candidate List panels for 
the new CHPID.

10.Follow the same procedure to define a new CIB type CHPID to the 2097. For our example 
we specified the following values:

Channel path ID: 80
Channel path type: CIB
Operational mode: SHR

Figure 5-17   HCM - Create CHPID (type = CIB)

------------------ Specify HCA Attributes ------------------
                                                            
                                                            
 Specify or revise the values below.                        
                                                            
 Adapter ID of the HCA  . . 0A  +                           
 Port on the HCA  . . . . . 1 +                           
                                                            
                                                            
  F1=Help     F2=Split    F3=Exit     F4=Prompt   F5=Reset  
  F9=Swap    F12=Cancel 

Note: Figure 5-17 on page 221 is an example of the HCM panel used to create any 
CHPID. This example shows CHPID 80, type = CIB as SHR.
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Adapter ID of the HCA: 0B
Port on the HCA: 1

Figure 5-18   HCD - Specify HCA Attributes for 2097 (defining AID and port)

Figure 5-19   HCM - Define Host Communications Adapter parameters

11.Define the following CHPIDs and a coupling link between:

– 2094 CHPID B1 as type=CIB using AID/P=0A/2

– 2097 CHPID 90 as type=CIB using AID/P=0B/2

12.In HCD, display the Channel Path List for the 2097 and press PF20 (right). Notice how 
HCD represents a CIB CHPID in the AID/P column as opposed to a PCHID (Figure 5-20).

------------------ Specify HCA Attributes ------------------
                                                            
                                                            
 Specify or revise the values below.                        
                                                            
 Adapter ID of the HCA  . . 0B  +                           
 Port on the HCA  . . . . . 1 +                           
                                                            
                                                            
  F1=Help     F2=Split    F3=Exit     F4=Prompt   F5=Reset  
  F9=Swap    F12=Cancel 

Note: The corresponding HCM panel looks like Figure 5-19.

 

 

 

222 IBM System z10 Enterprise Class Configuration Setup



 

Figure 5-20   HCD - Channel Path List (displaying AID/P)

Figure 5-21   HCM - CHPID summary showing CIB CHPIDs

13.That concludes the CIB CHPID definitions. Now define a coupling link between these two 
sets of CIB CHPIDs as you would with a CFP or CBP type CHPID. Figure 5-22 on 
page 224 shows the end result.

 Channel Path List   Row 100 of 143 More: <     >
Command ===> _______________________________________________ Scroll ===> CSR  
                                                                              
Select one or more channel paths, then press Enter. To add, use F11.          
                                                                              
Channel Subsystem ID : 0                                                      
1=A01       2=A02       3=A03       4=A04       5=A05                         
6=A06       7=A07       8=A08       9=A09       A=A0A                         
B=A0B       C=A0C       D=A0D       E=A0E       F=A0F                         
                          I/O Cluster  --------- Partitions 0x -----   PCHID  
/ CHPID Type+ Mode+ Mngd  Name +       1 2 3 4 5 6 7 8 9 A B C D E F   AID/P  
_ 79    FCP   SPAN  No    ________     a a a a a a a a a a a a _ _ _   1F3    
_ 7A    FCP   SPAN  No    ________     a a a a a a a a a a a a _ _ _   553    
_ 7B    FCP   SPAN  No    ________     a a a a a a a a a a a a _ _ _   1D3    
_ 80    CIB   SHR   No    ________     a _ _ _ _ _ _ _ _ _ _ _ _ _ _   0B/1   
_ 90    CIB   SHR   No    ________     a _ _ _ _ _ _ _ _ _ _ _ _ _ _   0B/2  
_ A0    CFP   SPAN  No    ________     a _ _ _ _ _ _ _ _ _ _ _ _ a _   110    
_ A1    CFP   SPAN  No    ________     _ a _ _ _ _ _ _ _ _ _ _ a _ _   111    
_ A2    CFP   SPAN  No    ________     a _ _ _ _ _ _ _ _ _ _ _ _ a _   118    
_ A3    CFP   SPAN  No    ________     _ a _ _ _ _ _ _ _ _ _ _ a _ _   119 

Note: Figure 5-21 illustrates how HCM represents CIB CHPIDs with the HCA ID and HCA 
Port.
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Figure 5-22   HCD - View CF Control Units and Devices

14.From the HCD main menu, select option 1.3, Processor List, and press PF20 (right) to 
display the SNA Address and Local Name (Figure 5-23).

Figure 5-23   HCD - Processor List (displaying local system name)

-------------------- View CF Control Units and Devices -----

 Peer CF side 1:                                            
 Processor ID . . . . . . : SCZP101                         
 Channel subsystem ID . . : 0                               
 Channel path ID  . . . . : B0                              
 Channel path type  . . . : CIB                             
 Control unit number  . . :                                 
 Device number  . . . . . :                                 
 Number of devices  . . . :                                 
                                                            
 Peer CF side 2:                                            
 Processor ID . . . . . . : SCZP201                         
 Channel subsystem ID . . : 0                               
 Channel path ID  . . . . : 80                              
 Channel path type  . . . : CIB                             
 Control unit number  . . : FFDC                            
 Device number  . . . . . : FD86                            
 Number of devices  . . . : 7                               
                                                            
 ENTER to continue.                                         
  F1=Help     F2=Split    F3=Exit     F9=Swap    F12=Cancel 

 Processor List        Row 1 of 8 More: <     
Command ===> _______________________________________________ Scroll ===> CSR 
                                                                             
Select one or more processors, then press Enter. To add, use F11.            
                                                                             
                                     ----SNA Address + ---- ---Local---      
/ Proc. ID Type +   Model +  Mode +  Network Name  CPC Name System Name      
_ ISGSYN   2064     1C7      LPAR    ________      ________ ________         
_ ISGS11   2064     1C7      LPAR    ________      ________ ________         
_ P000STP1 2084     C24      LPAR    IBM390PS      P000STP1 ________         
_ P000STP2 2094     S08      LPAR    ZZZZZZZZ      P000STP2 ________         
_ SCZP101  2094     S18      LPAR    USIBMSC       SCZP101  SCZP101          
_ SCZP201  2097     E26      LPAR    USIBMSC       SCZP201  SCZP201          
_ SCZP801  2064     1C7      LPAR    USIBMSC       SCZP801  ________         
_ SCZP901  2084     C24      LPAR    USIBMSC       SCZP901  ________ 
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5.3  Validate the 2097 work IODF
1. Select HCD option 2.12, Build validated work I/O definition file.

2. Observe the Message List and review.

3. Press PF3 to continue; you should receive the following message:

Requested action successfully processed

4. Go to HCD option 6.4, View I/O Definition File Information (Figure 5-24). Note that the 
IODF type is now Work - Validated.

Figure 5-24   HCD - View I/O Definition File Information (validated work IODF)

Create the IOCP statements for the CHPID Mapping Tool

1. Select HCD option 2.3, Build IOCP input data set, and press Enter (Figure 5-25 on 
page 226).

Note: As described previously, in most cases the local system name value will default to 
the recommended value of the CPC name, unless during a new processor add the CPC 
name was not specified. In this case, HCD will also leave the local system name 
undefined.

System A (SCZP101) is known to itself as the LSYSTEM or local system, and it sees 
System B (SCZP201) as the CSYSTEM or connecting system.

System B (SCZP201) is known to itself as the LSYSTEM or local system, and it sees 
System A (SCZP101) as the CSYSTEM or connecting system.

CSYSTEM, along with the other keywords associated with CIB type coupling links, can be 
seen in the IOCP deck. Refer to Figure 5-28 on page 227.

 -------------- View I/O Definition File Information -------------

IODF name  . . . . . . : 'SYS6.IODF69.WORK'                     
IODF type  . . . . . . : Work - Validated                         
IODF version . . . . . : 5                                        
                                                                  
Creation date  . . . . : 2007-12-04                               
Last update  . . . . . : 2007-12-04  16:53                        
                                                                  
Volume serial number . : BH8ST2                                   
Allocated space  . . . : 2000    (Number of 4K blocks)            
Used space . . . . . . : 1464    (Number of 4K blocks)            
   thereof utilized (%)  97                                       
                                                                  
Activity logging . . . : No                                       
Backup IODF name . . . :                                          
                                                                  
Description  . . . . . : Description  . . . . . :                                               

Note: You may prefer to use HCM to create the IOCP statements file and transfer the file 
to your PC. You can then launch the CHPID Mapping Tool, create an updated IOCP 
statements file, and transfer the file back to the host.
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Figure 5-25   HCD - Activate or Process Configuration Data (Build IOCP for SCZP201)

2. HCD displays the list of available processors to chose from (Figure 5-26). Select the 
processor SCZP201 by using a forward slash mark (/), and then press Enter.

Figure 5-26   HCD - Available Processors (select processor for IOCP file)\

3. HCD displays a panel on which you enter information regarding the IOCP input data set to 
be created; see Figure 5-27.

Fill in the following fields:

– Title1
– IOCP input data set
– Enter Yes in the field Input to Stand-alone IOCP?
– The Job statement information for the installation

4. Press Enter; HCD submits a batch job to create the data set.

  ----- Activate or Process Configuration Data ------  

   Select one of the following tasks.                  
                                                       
   3_  1.  Build production I/O definition file        
       2.  Build IOCDS                                 
       3.  Build IOCP input data set                   
       4.  Create JES3 initialization stream data      
       5.  View active configuration                   
       6.  Activate or verify configuration            
           dynamically                                 
       7.  Activate configuration sysplex-wide         
       8.  Activate switch configuration               
       9.  Save switch configuration                   
       10. Build I/O configuration statements          
       11. Build and manage S/390 microprocessor       
           IOCDSs and IPL attributes                   
       12. Build validated work I/O definition file   

 ------------------------ Available Processors ---------------------------
                                                               Row 1 of 8 
Command ===> __________________________________________________________   
                                                                          
Select one.                                                               
                                                                          
  Processor ID  Type     Model    Mode  Description                       
  ISGSYN        2064     1C7      LPAR                                    
  ISGS11        2064     1C7      LPAR                                    
  P000STP1      2084     C24      LPAR                                    
  P000STP2      2094     S08      LPAR                                    
  SCZP101       2094     S18      LPAR                                    
/ SCZP201       2097     E26      LPAR                                    
  SCZP801       2064     1C7      LPAR                                    
  SCZP901       2084     C24      LPAR                                    
**************************** Bottom of data ***************************** 
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Figure 5-27   HCD - Build IOCP Input Data Set

5. Verify in TSO that the data set just created exists and that it contains IOCP statements. 
This data set is used as input into the CHPID Mapping Tool; see Figure 5-28 on page 227. 
Also shown here is the LSYSTEM keyword and the CHPID statement showing the CPATH 
and CSYSTEM keywords.

Figure 5-28   HCD - IOCP input data set contents (truncated)

Note that part of the TOK statement has been blanked out with dots; see Example 5-1 on 
page 228.

 ----------------------- Build IOCP Input Data Set -----------------------

Specify or revise the following values.                                   
                                                                          
IODF name . . . . . . . . . : 'SYS6.IODF69.WORK'                        
Processor ID  . . . . . . . : SCZP201                                     
Title1 . IODF69__________________________________________________________ 
Title2 : SYS6.IODF69.WORK - 2007-12-04 16:53                            
                                                                          
IOCP input data set                                                       
'SYS6.IODF69.IOCPIN.SCZP201'__________________________                  
Input to Stand-alone IOCP?  Yes  (Yes or No)                              
                                                                          
Job statement information                                                 
//WIOCP   JOB (ACCOUNT),'NAME'                                               
//*                                                                          
//*                                                                          

ID    MSG1='IODF69',                                          *  
      MSG2='SYS6.IODF69.WORK - 2007-12-04 16:53',  *  
      SYSTEM=(2097,1),LSYSTEM=SCZP201,                        *  
      TOK=('SCZP201',00800001991E2094165352310107338F00000000,*  
      00000000,'07-12-04','16:53:52','........','........')      
RESOURCE PARTITION=((CSS(0),(A0A,A),(A0B,B),(A0C,C),(A0D,D),(A*  
      0E,E),(A0F,F),(A01,1),(A02,2),(A03,3),(A04,4),(A05,5),(A*  
      06,6),(A07,7),(A08,8),(A09,9)),(CSS(1),(A1A,A),(A1B,B),(*  
      A1C,C),(A1D,D),(A1E,E),(A1F,F),(A11,1),(A12,2),(A13,3),(*  
      A14,4),(A15,5),(A16,6),(A17,7),(A18,8),(A19,9)),(CSS(2),*  
      (A21,1),(A22,2),(A23,3),(A24,4),(A25,5),(*,6),(*,7),(*,8*  
      ),(*,9),(*,A),(*,B),(*,C),(*,D),(*,E),(*,F)),(CSS(3),(A3*  
      1,1),(A32,2),(A33,3),(*,4),(*,5),(*,6),(*,7),(*,8),(*,9)*  
      ,(*,A),(*,B),(*,C),(*,D),(*,E),(*,F)))                     
CHPID PATH=(CSS(0,1,2,3),00),SHARED,                          *  
      NOTPART=((CSS(0),(A0D,A0E,A0F),(=)),(CSS(1),(A1D,A1E,A1F*  
      ),(=))),PCHID=120,TYPE=OSD                                 
CHPID PATH=(CSS(0,1,2,3),01),SHARED,                          *  
      NOTPART=((CSS(0),(A0D,A0E,A0F),(=)),(CSS(1),(A1D,A1E,A1F*  
      ),(=))),PCHID=121,TYPE=OSD                                 
...........................................................
CHPID PATH=(CSS(0),80),SHARED,PARTITION=((A01),(=)),          *
      CPATH=(CSS(0),B0),CSYSTEM=SCZP101,AID=0B,PORT=1,TYPE=CIB 
...........................................................
CNTLUNIT CUNUMBR=FFDC,PATH=((CSS(0),80)),UNIT=CFP         
IODEVICE ADDRESS=(FD86,007),CUNUMBR=(FFDC),UNIT=CFP 
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Example 5-1   HCD - IOCP file (TOK statement)

TOK=('SCZP201',00800001991E2094165352310107338F00000000,*
00000000,'07-12-04','16:53:52','........','........') 

This is a safeguard to ensure that this IOCP file cannot be written to a processor and used 
for a power-on reset because this IOCP file was created from a validated work IODF and 
not a Production IODF—which is something that can be done only for processors that 
contain PCHID definitions.

6. Download this file from TSO to your workstation. Use a workstation file transfer facility 
such as the one in IBM Personal Communications Workstation Program, or any 
equivalent 3270 emulation program. Be sure to use TEXT as the transfer type. In this 
example, we call this file SCZP201in.iocp

5.4  CHPID Mapping Tool actions
In the following process, we take the output from the previous set of HCD steps (IOCP), as 
well as the output from the 2097 order process (CFReport). We then use the CHPID Mapping 
Tool to assign PCHIDs to channels in the configuration. 

Download and install the CHPID Mapping Tool. Refer to “CHPID Mapping Tool” on page 24, 
for information about obtaining and installing the CMT. If you already have the CHPID 
Mapping Tool installed, verify that you have the latest updates installed.

Using the CHPID Mapping Tool, follow these steps:

1. Import the IOCP statements file and the new 2097 CFReport file into the CHPID Mapping 
Tool. Getting the IOCP statements can be performed with HCM.

2. Resolve CHPIDs without associated hardware.

3. Resolve Hardware resolution.

4. Set CU Priority for single-path control units and other control units that would override the 
CHPID Mapping Tool default priorities.

5. Run the CHPID Mapping Tool availability function.

6. Create the CHPID Mapping Tool CHPID reports.

7. Create an updated IOCP statements file and file transfer back to the host. This step can 
be performed with HCM.

Import the CFReport order file into the CHPID Mapping Tool
1. Start the CHPID Mapping Tool on your workstation.

2. Import the CFReport order file into the CHPID Mapping Tool by clicking File → Import 
CFReport Order file (Figure 5-29).

Important: When an IOCP statement file is exported from a Validated Work IODF 
using HCD, it must be imported back to HCD for the process to be valid. The IOCP file 
cannot be used directly by the IOCP program.
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Figure 5-29   CMT - Import CFReport Order file

3. Select the CFReport file on your workstation to import into the CHPID Mapping Tool and 
click Open (Figure 5-30). 

Figure 5-30   CMT - Open CFReport Order file

The CHPID Mapping Tool displays the information from the CFReport on the left-hand 
side of the window (Figure 5-31).

Note: This display also shows the Adapter IDs for the two HCAs that have been 
ordered for this processor.
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Figure 5-31   CMT - Importing CFReport Order file

Import IOCP file into the CHPID Mapping Tool
1. Import the IOCP file by clicking Tool → Import IOCP File (Figure 5-32).

Figure 5-32   CMT - Import IOCP files
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2. Select the IOCP file on your workstation to import into the CHPID Mapping Tool and click 
Open.

Hardware resolution
The CHPID Mapping Tool may prompt you to resolve any issues that might arise from 
importing the IOCP file. In our example, the CHPID Mapping Tool requests clarification on the 
TYPE=OSD, TYPE=FCP, and TYPE=FC channels. 

In each case, we must check off what each of the channels is used for. The image on the 
lower right-hand side of Figure 5-33 on page 232 shows what we have selected for the FC 
channels.
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Figure 5-33   CMT - Hardware resolution after IOCP import
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Select one tab at a time. Click the desired box and move to the next tab until all CHPID 
definitions have hardware selected.

The CHPID Mapping Tool displays all of the currently known information. Note that the 
CHPID column and the CHPID Origin column are filled in after the CHPID Mapping Tool 
assigns the CHPIDs to PCHIDs (Figure 5-34).

Figure 5-34   CMT - Manual tab

Set control unit priority manually
1. Under the File menu, click the Availability tab.

2. Click Process CU Priority and a window pops up. 

The Reset CHPID Assignment window allows you to change the CHPID values:

– Reset CHPIDs assigned by Availability
– Reset CHPIDs assigned by Manual Remap
– Reset CHPIDs assigned by IOCP

In our example, we selected Reset CHPIDs assigned by Availability because no 
PCHIDs were defined in the IOCP input and we did not assign any in the manual panel.

3. Click Process; see Figure 5-35 on page 234.
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Figure 5-35   CMT - Reset CHPID Assignments by Availability

4. After the CHPID Mapping Tool has assigned the CHPIDs, a message indicating the 
results of the process is displayed (Figure 5-36).

Figure 5-36   CMT - Process CU Priority completion message

Our example only returned “C” type intersects, which we deliberately defined to show the 
example of defining 2 x PSIFB links on the same HCA (refer to Figure 5-20). 
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The following list defines the possible intersects:

C Two or more assigned channels use the same channel card.

S Greater than half the assigned channels use the same STI.

M All assigned channels are supported by the same MBA group.

B More than half the assigned channels are supported by the same book.

D Assigned channels are on the same daughter card.

5. Click OK. Figure 5-37 shows the “C” intersects under the availability tab.

Figure 5-37   CMT - C type intersects via Availability tab

Note: Intersect messages inform you of a potential availability problem detected by the 
CMT, but do not necessarily indicate an error. It is your responsibility to evaluate 
whether the condition should be corrected or not.
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6. Now click the Manual tab and notice the “C” intersects (Figure 5-38).

Figure 5-38   CMT - C type intersects via Manual tab

The CHPID Mapping Tool can only identify these intersects, go back into HCD and redefine 
the PSIFB connections over different HCAs, run another validate and import the IOCP 
statements into CMT, and run the Process CU function again.

� You can now display the results of the channel mapping. You can also sort the report in 
different ways. For example, to see how the CHPID Mapping Tool ranked the control 
units, click Sorts → By CU Priority.

Our example does not contain any control units set with CU Priority, but we do need to 
check and set values for items such as OSA-ICC CHPIDs and CTC CHPIDs, to ensure 
that the CHPID Mapping Tool allocates these CHPIDs with high PCHID availability.

� Go through the listing and search through the CU Number column for any control units you 
want to set priority for.

In our example we set the OSC type CU Numbers F200 and F280 to priority 333 plus a 
few FCTCs and a 2107 CU; see Figure 5-39.

 

 

 

236 IBM System z10 Enterprise Class Configuration Setup



 

Figure 5-39   CMT Set CU Priority

If they are coupling links used by a CF image, you should group these links.

Each set of CHPIDs going to a different CPC should be grouped with a common priority. For 
example, suppose the CF image has four links (CHPIDs 40, 41, 42, and 43) and that 40 and 
41 go to one CPC, and 42 and 43 go to a different CPC. In this case you should give CHPIDs 
40 and 41 one priority and CHPIDs 42 and 43 a different priority. The concept is the same 
regardless of the number of connecting CPCs or the number of links to each CPC.

1. Under the File menu, click the Availability tab.

2. Click Process CU Priority. The Reset CHPID Assignment window opens to allow you to 
change the CHPID values:

– Reset CHPIDs assigned by Availability
– Reset CHPIDs assigned by Manual Remap
– Reset CHPIDs assigned by IOCP

In our example, we selected Reset CHPIDs assigned by Availability.

3. Click Process.

4. Click Sorts → By CU Priority and you notice that the OSC type control units with priority 
of 333 have sorted to the top of the list.

5. Select the Manual tab to view the results of mapping the CHPIDs (Figure 5-40 on 
page 238).
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Figure 5-40   CMT - Manual (CHPIDs assigned)

Note that the CHPID column and the CHPID Origin column are no longer blank. The CHPID 
Mapping Tool has assigned CHPIDs to PCHIDs, and placed the value “Avail” in the CHPID 
Origin column, indicating that the CHPID values were assigned based on availability.

CHPIDs not connected to Control Units
Under the Availability tab, click Sorts → By Control Unit. The CHPID Mapping Tool 
displays at the end of the list all CHPIDs defined in the IOCP input that are not connected to 
control units. All coupling CHPIDs in this list are preceded with an “S” in the CU Number 
column. All non-coupling CHPIDs are preceded with a “P” (see Figure 5-41).
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Figure 5-41   CMT - Sort by Control Unit

� You should review the list because:

– You may have forgotten to add a CHPID to a control unit and may need to update the 
IOCP source before continuing in the CHPID Mapping Tool.

– The unconnected CHPIDs may be extra channels you are ordering in anticipation of 
new control units.

– The unconnected CHPIDs may be coupling links that are being used in coupling facility 
(CF) images (these do not require control units).

If there are extra CHPIDs for anticipated new control units, you may want to group these 
CHPIDs with a common priority. This will allow the availability mapping function to pick 
PCHIDs that will afford your new control unit good availability.

Create reports for the hardware team
The CHPID Mapping Tool has built-in reports, which are available from the Reports pull-down 
menu.

You can also print the information on the Availability tab or the Manual tab by clicking the 
Print button. When in the Availability tab, you can also enter information in the Comments 
column that might be useful at a later date.

For simplicity, we only describe how to print three reports in this example (the CHPID Report, 
the Port Report sorted by location, and the CHPID to Control Unit Report). However, all 
built-in reports are printed in the same way, as explained here.

The person who will install the I/O cables during system installation needs one of these 
reports. The Port Report, sorted by location, is recommended. The installer can use this to 
help with labelling the cables. The labels must include the PCHID or cage/slot/port 
information before system delivery.
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CHPID Report
1. Click Reports → CHPID Report (Figure 5-42).

Figure 5-42   CMT - select CHPID Report

2. Enter the report File name, or accept the name that the CHPID Mapping Tool enters and 
click Save (Figure 5-43).

Figure 5-43   CMT - Report File Name

The CHPID Mapping Tool opens a browser window with the CHPID report (Figure 5-44 on 
page 241). 
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3. You may be prompted to accept active content. Accept the active content in order to 
display the report in your browser.

Figure 5-44   CMT - CHPID Report
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Port Report sorted by location
1. Click Reports → Port Report → Sorted by Location. Click Save (assuming that you 

accept the CHPID Mapping Tool report name).

The CHPID Mapping Tool opens a browser window with the CHPID to Port Report 
(Figure 5-45 on page 242). 

2. You may be prompted to accept active content. Accept the active content in order to 
display the report in your browser. 

Figure 5-45   CMT - CHPID to Port Report
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CHPID to Control Unit Report
1. Click Reports → CHPID to Control Unit Report. Click Save (assuming that you accept 

the CHPID Mapping Tool report name).

The CHPID Mapping Tool opens a browser window with the CHPID to Control Unit Report 
(Figure 5-46). 

2. You may be prompted to accept active content. Accept the active content in order to 
display the report in your browser. 

Figure 5-46   CMT - CHPID to CU Report

Create the updated IOCP file

Create an IOCP statements file for input back into the IODF via HCD. This IOCP statements 
file now has the CHPIDs assigned to PCHIDs. 

1. Click Tool → Create Updated IOCP File (see Figure 5-47 on page 244).

Note: You may prefer to use HCM to transfer the updated IOCP statements file back to the 
host. Before doing so, however, first perform the following procedure in the CHPID 
Mapping Tool to create the updated IOCP file.
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Figure 5-47   CMT - Create Updated IOCP File

2. Enter File name and location for the IOCP output file, then click Save (Figure 5-48).

Figure 5-48   CMT - Save IOCP output file 

3. The CHPID Mapping Tool displays an informational message, shown in Figure 5-49 on 
page 245, regarding what to do for the final execution of the tool.

Note: The file must be uploaded to the z/OS image on which you have the work IODF 
used previously to create the IOCP input data set. 
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Figure 5-49   CMT - informational message

5.5  Migrate PCHIDs back into the 2097 work IODF
After mapping the CHPIDs to PCHIDs using the CHPID Mapping Tool, this information needs 
to be input back to HCD. This is accomplished by using the updated IOCP statement file (for 
example, sczp201out.iocp), as follows:

1. Upload the sczp201out.txt file to the z/OS image in order to migrate the PCHID 
information into HCD. Use a workstation file transfer facility such as the one in IBM 
Personal Communications Workstation Program, or any equivalent 3270 emulation 
program. Be sure to use TEXT as the transfer type.

In the updated IOCP statements file, notice that the CHPID Mapping Tool has left its mark 
with reference to the CCN. Also notice the CU Priority values added for the OSC control 
units, F200 and F280, and for some other CUs.

Example 5-2   HCD - Updated IOCP statements file (with CMT statements)

IODEVICE ADDRESS=(FFDD,007),CUNUMBR=(FFFE),UNIT=CFP         
         IODEVICE ADDRESS=(FFF9,007),CUNUMBR=(FFFE),UNIT=CFP         
*CMT* VERSION=000                                                    
*CMT* CCN=19756694(CFR)                                              
*CMT* 4B00.0=0100,4B08.0=0110,5B00.0=0120,5B08.0=0130,D000.0=0200    
*CMT* D100.0=0210,D200.0=0220,D300.0=0230,D400.0=0240,D500.0=0250    
*CMT* F200.0=0333,F200.1=0333,F280.0=0333,F280.1=0333 
***************************** Bottom of Data ****************************

Note: Control unit priorities are stored in the IOCP output file created by the CHPID 
Mapping Tool that gets migrated back into HCD. HCD maintains these priorities and 
outputs them when creating another IOCP deck. They are in the form of commented 
lines at the end of the IOCP deck; see Example 5-2.

Important: The CMT comments contained in the IOCP output file should not be edited 
manually. If priorities need to be changed it should always be done within the CHPID 
Mapping Tool.
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2. On the HCD main menu, enter the work IODF name used to create the IOCP input data 
set for the CHPID Mapping Tool on the HCD main menu; see Figure 5-50 on page 246. 
Select option 5, Migrate configuration data.

Figure 5-50   HCD - main menu, select Migrate configuration data

3. The Migrate Configuration Data panel displays; see Figure 5-51. Select option 1, Migrate 
IOCP/OS data, and press Enter.

Figure 5-51   HCD - Migrate Configuration Data

4. HCD displays the Migrate IOCP Data panel; see Figure 5-52 on page 247. Fill in the 
following fields:

Processor ID Use the same one as used to create the IOCP input deck.

OS configuration ID This is the OS configuration associated with the processor.

IOCP only input data set This is the data set name specified when the iocpout.txt file 
was uploaded to TSO (see 5.6, “HCD - build the 2097 
production IODF” on page 248).

Processing mode Use 2 to save the results of the migration. (Prior to using 2, 
however, try to migrate using 1, in order to validate the 
operation.)

Migrate options Use 3 for PCHIDS. Only the PCHIDs are migrated into the 
work IODF.

Then press Enter.

 z/OS V1.9 HCD                               
Command ===> ______________________________________________________
                                                                   
                           Hardware Configuration                  
                                                                   
Select one of the following.                                       
                                                                   
5_  1.  Define, modify, or view configuration data                 
    2.  Activate or process configuration data                     
    3.  Print or compare configuration data                        
    4.  Create or view graphical configuration report              
    5.  Migrate configuration data                                 
    6.  Maintain I/O definition files                              
    7.  Query supported hardware and installed UIMs                
    8.  Getting started with this dialog                           
    9.  What's new in this release                                 
                                                                   
For options 1 to 5, specify the name of the IODF to be used.       
                                                                   
I/O definition file . . . 'SYS6.IODF69.WORK'  + 

 ----------- Migrate Configuration Data -------------  
                                                       
                                                       
   Select one of the following tasks.                  
                                                       
   1   1.  Migrate IOCP/OS data                        
       2.  Migrate switch configuration data           
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Figure 5-52   HCD - Migrate IOCP / MVSCP / HCPRIO Data

5. HCD displays any errors or warning messages as a result of the migration action. In our 
example, we did not receive any messages other than the one indicating that the 
migration was successful; see Figure 5-53.

Figure 5-53   HCD - Migration Message List

This is the message that you should also receive. At this point, the work IODF contains 
both the CHPID definitions and the mapping to PCHIDs that was done using the CHPID 
Mapping Tool.

6. Press PF3; you should receive the following message: 

IOCP/Operating system deck migration processing complete, return code = 0

7. Press PF3 again.

------------------- Migrate IOCP / MVSCP / HCPRIO Data --------------------

Specify or revise the following values.                                    
                                                                           
Processor ID . . . . . . . . . . . . SCZP201_  +   CSS ID . . . . . .    + 
OS configuration ID  . . . . . . . . TEST2097  +                           
                                                                           
Combined IOCP/MVSCP input data set . _____________________________________ 
IOCP only input data set . . . . . . 'SYS6.IODF69.IOCPOUT.SCZP201'       
MVSCP only or HCPRIO input data set  _____________________________________ 
           Associated with processor ________  +                           
                           partition ________  +                           
Processing mode  . . . . . . . . . . 2   1.  Validate                      
                                         2.  Save                          
                                                                           
Migrate options  . . . . . . . . . . 3   1.  Complete                      
                                         2.  Incremental                   
                                         3.  PCHIDs                        
MACLIB used  . . . . . . . 'SYS1.MACLIB'                                   
Volume serial number . . . ______  + (if not cataloged) 

------------------------- Migration Message List -------------------------- 
Query  Help                                                               

--------------------------------------------------------------------------  
                                                                 Row 1 of 2 
Command ===> ___________________________________________ Scroll ===> CSR    
                                                                            
Messages are sorted by severity. Select one or more, then press Enter.      
                                                                            
/ Statement  Orig Sev Message Text                                          
_                 I   I/O configuration successfully written to the IODF    
#                     SYS6.IODF69.WORK. 
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5.6  HCD - build the 2097 production IODF
In order to make use of the definitions that were updated in HCD, a production IODF needs to 
be created from the work IODF. Follow these steps:

1. From the HCD main menu, select option 2, Activate or process configuration data (see 
Figure 5-54).

Figure 5-54   HCD - Main menu, select Activate or process configuration data

2. The Activate or Process Configuration Data panel is displayed (Figure 5-55). Select option 
1, Build production I/O definition file, and press Enter.

Figure 5-55   HCD - Activate or Process Configuration Data, select Build production IODF

3. The Message List panel is displayed (Figure 5-56). Verify that you have only Severity W 
warning messages, and that they are normal for the configuration. Correct any messages 

 z/OS V1.9 HCD                               
Command ===> ______________________________________________________
                                                                   
                           Hardware Configuration                  
                                                                   
Select one of the following.                                       
                                                                   
2   1.  Define, modify, or view configuration data                 
    2.  Activate or process configuration data                     
    3.  Print or compare configuration data                        
    4.  Create or view graphical configuration report              
    5.  Migrate configuration data                                 
    6.  Maintain I/O definition files                              
    7.  Query supported hardware and installed UIMs                
    8.  Getting started with this dialog                           
    9.  What's new in this release                                 
                                                                   
For options 1 to 5, specify the name of the IODF to be used.       
                                                                   
I/O definition file . . . 'SYS6.IODF69.WORK'  + 

 ----- Activate or Process Configuration Data -----
                                                   
                                                   
 Select one of the following tasks.                
                                                   
 1_  1.  Build production I/O definition file      
     2.  Build IOCDS                               
     3.  Build IOCP input data set                 
     4.  Create JES3 initialization stream data    
     5.  View active configuration                 
     6.  Activate or verify configuration          
         dynamically                               
     7.  Activate configuration sysplex-wide       
     8.  Activate switch configuration             
     9.  Save switch configuration                 
     10. Build I/O configuration statements        
     11. Build and manage S/390 microprocessor     
         IOCDSs and IPL attributes                 
     12. Build validated work I/O definition file 
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that should not occur and try to build the production IODF again. Continue this process 
until you have no messages that indicate problems.

Figure 5-56   HCD - Message List (building Production IODF)

4. Press PF3 to continue.

5. The Build Production I/O Definition File panel is displayed (Figure 5-57). Fill in the fields 
Production IODF name and Volume serial number, then press Enter.

Figure 5-57   HCD - Build Production I/O Definition File

6. The Define Descriptor Fields panel is displayed (Figure 5-58). Press Enter to accept the 
descriptor fields selected by HCD, or enter different values and then press Enter.

Figure 5-58   HCD - Define Descriptor Fields

 ------------------------------ Message List --------------------------------
   Save  Query  Help                                                         
 --------------------------------------------------------------------------  
                                                                  Row 1 of 4 
 Command ===> ___________________________________________ Scroll ===> CSR    
                                                                             
 Messages are sorted by severity. Select one or more, then press Enter.      
                                                                             
 / Sev Msg. ID  Message Text                                                 
 _ W   CBDG061I Switch control unit must be defined for switch 61.           
 _ W   CBDG061I Switch control unit must be defined for switch 62.           
 _ W   CBDG061I Switch control unit must be defined for switch 63.           
 _ W   CBDG061I Switch control unit must be defined for switch 64.           
 ***************************** Bottom of data ****************************** 

 ------------- Build Production I/O Definition File ------------
                                                                
                                                                
 Specify the following values, and choose how to continue.      
                                                                
 Work IODF name . . . : 'SYS6.IODF69.WORK'                    
                                                                
 Production IODF name . 'SYS6.IODF69'______________________   
 Volume serial number . BH8ST1  +                               
                                                                
 Continue using as current IODF:                                
 2   1.  The work IODF in use at present                        
     2.  The new production IODF specified above                

 ------------------- Define Descriptor Fields ----------------

 Specify or revise the following values.                      
                                                              
 Production IODF name  . : 'SYS6.IODF39'                    
                                                              
 Descriptor field 1  . . . SYS6 
 Descriptor field 2  . . . IODF39 
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7. HCD displays the following message, indicating that the production IODF was 
successfully created:

Production IODF SYS6.IODF69 created.

Proceed to the steps to implement the configuration on the 2097.

5.7  Implementing the processor configuration on the 2097
At this point there is a production IODF called SYS6.IODF69. Now the IOCDS component of 
the IODF needs to be updated on the new CPC that is being installed (for example, 
SCZP201) and activated (POR) using this IOCDS. The final step would be to POR the 
processor using this IOCDS. 

Describing how to POR the new hardware is beyond the scope of this book.

There are 2 possible ways to load the IOCP Statements onto the 2097 Service Element 
IOCDS

� HCD, using Option 2.11

� HMC, using the Stand-Alone Input/Output Configuration Program

While both are valid methods to write the new configuration to the IOCDS, we recommend 
using HCD Option 2.11. However, your new 2097 processor and Service Element may not be 
connected to the system where the configuration was generated or to any system where HCD 
is running. In that case you will need to use the Stand-Alone IOCP process.

First we will describe using HCD Option 2.11

Updating the IOCDS using HCD Option 2.11
1. From the HCD main menu, select option 2, Activate or process configuration data 

(Figure 5-59). Ensure that the IODF is the production one created in the previous step. 
Press Enter.

Figure 5-59   HCD - Main menu, select Activate or process configuration data

 z/OS V1.9 HCD                              
 Command ===> _____________________________________________________
                                                                   
                            Hardware Configuration                 
                                                                   
 Select one of the following.                                      
                                                                   
 2   1.  Define, modify, or view configuration data                
     2.  Activate or process configuration data                    
     3.  Print or compare configuration data                       
     4.  Create or view graphical configuration report             
     5.  Migrate configuration data                                
     6.  Maintain I/O definition files                             
     7.  Query supported hardware and installed UIMs               
     8.  Getting started with this dialog                          
     9.  What's new in this release                                
                                                                   
 For options 1 to 5, specify the name of the IODF to be used.      
                                                                   
 I/O definition file . . . 'SYS6.IODF69'  +
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2. The Activate or Process Configuration Data panel is displayed (Figure 5-60). Select option 
11, Build and manage S/390 microprocessor IOCDSs and IPL attributes.

Note: In this example, we are assuming that we have connectivity to the new 2097 via the 
HMC LAN in order to create an IOCDS from which we power-on reset. This may not be 
the case for all readers. 

If the new 2097 is not accessible from the HMC LAN, you would need to copy the IOCP 
statements onto a USB Flash Memory Drive and import them to the 2097 HMC to run a 
stand-alone IOCP. Creating a file on a USB Flash Memory Drive can be done using the 
same process that is used to create an IOCP input file for the CHPID Mapping Tool.

Figure 5-60   HCD - Activate or Process Configuration Data, select Build IOCDSs

3. The S/390 Microprocessor Cluster List panel is displayed (Figure 5-61). Use a forward 
slash (/) to select the new 2097 from the list in order to update one of its IOCDSs. Press 
Enter.

Tip: The Support Element can now read an IOCP file that has been written to a USB 
Flash Memory Drive.

 z/OS V1.9 HCD                  
----- Activate or Process Configuration Data ------
                                                   
                                                   
 Select one of the following tasks.                
                                                   
 11  1.  Build production I/O definition file      
     2.  Build IOCDS                               
     3.  Build IOCP input data set                 
     4.  Create JES3 initialization stream data    
     5.  View active configuration                 
     6.  Activate or verify configuration          
         dynamically                               
     7.  Activate configuration sysplex-wide       
     8.  Activate switch configuration             
     9.  Save switch configuration                 
     10. Build I/O configuration statements        
     11. Build and manage S/390 microprocessor     
         IOCDSs and IPL attributes                 
     12. Build validated work I/O definition file 
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Figure 5-61   HCD - S/390 Microprocessor Cluster List

4. The Actions on selected CPCs panel is displayed (Figure 5-62). Select option 1, Work 
with IOCDSs, and press Enter.

Figure 5-62   HCD - Actions on selected CPCs, Work with IOCDSs

5. The IOCDS List panel is displayed (Figure 5-63). Select the IOCDS that you wish to 
update for the 2097 install using the forward slash (/), then press Enter.

Figure 5-63   HCD - IOCDS List

6. The Actions on selected IOCDSs panel is displayed (Figure 5-64). Select option 1, 
Update IOCDS and press Enter.

Goto  Query  Help                                                              
 ------------------------------------------------------------------------------ 
                       S/390 Microprocessor Cluster List             Row 1 of 4 
 Command ===> _______________________________________________ Scroll ===> PAGE  
                                                                                
 Select one or more CPCs, then press Enter.                                     
                                                                                
   --------------CPC--------------   IODF                                       
 / SNA Address        Type   Model   Processor ID                               
 / USIBMSC.SCZP201 2097  E26  SCZP201 
 _ USIBMSC.SCZP101 2094  S18  SCZP101                                    
 _ USIBMSC.SCZP801    2064   1C7     SCZP801                                    
 _ USIBMSC.SCZP901    2084   C24     SCZP102                                    
 ******************************* Bottom of data ********************************

 ----------------- Actions on selected CPCs ------------------- 
                                                                
                                                                
   Select by number or action code and press Enter.             
                                                                
   1_  1.  Work with IOCDSs . . . . . . . . . . (s)             
       2.  Work with IPL attributes . . . . . . (i)             
       3.  Select other processor configuration (p)             

 Goto  Query  Help                                                            
 ------------------------------------------------------------------------------ 
                                   IOCDS List          Row 1 of 4 More:       > 
 Command ===> _______________________________________________ Scroll ===> CSR  
                                                                                
 Select one or a group of IOCDSs, then press Enter.                             
                                                                                
                                          -----Token Match----- Write           
 / IOCDS       Name     Type   Status     IOCDS/HSA IOCDS/Proc. Protect         
 _ A0.SCZP201  DIAG00   LPAR   POR        Yes       No          Yes-POR         
 / A1.SCZP201  LPAR   Alternate  No        No          No              
 _ A2.SCZP201  DIAG02   LPAR   Alternate  No        No          No              
 _ A3.SCZP201  DIAG03   LPAR   Alternate  No        No          No              
 ******************************* Bottom of data ********************************
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Figure 5-64   HCD - Actions on selected IOCDSs

7. The Build IOCDSs panel is displayed; see Figure 5-65. Verify that all the information is 
correct. 

8. Fill in the field Title1 and press Enter.

Figure 5-65   HCD - Build IOCDSs

9. The Job Statement Information panel is displayed (Figure 5-66). Fill in the job statements 
as required by the installation and press Enter. HCD submits the job to update the IOCDS.

Figure 5-66   HCD - Job Statement Information

10.Verify the job output to ensure that the IOCDS was written without error and to the correct 
IOCDS. You should receive a message like the following:

ICP057I IOCP JOB WIOCDS SUCCESSFUL. LEVEL A1 IOCDS REPLACED.

11.Now if you return to HCD option 2.11 and view the IOCDS, note that the SNA Address is 
at USIBMSC.SCZP201; see Figure 5-67 on page 254.

 ---------------- Actions on selected IOCDSs ----------------- 
                                                                
                                                                
   Select by number or action code and press Enter.             
                                                                
   1_  1.  Update IOCDS . . . . . . . . . . . . (u)             
       2.  Switch IOCDS . . . . . . . . . . . . (s)             
       3.  Enable write protection  . . . . . . (e)             
       4.  Disable write protection . . . . . . (w)             

 ------------------------------- Build IOCDSs --------------------------------- 
                                                                    Row 1 of 1  
   Command ===> ___________________________________________ Scroll ===> CSR  
                                                                                
   Specify or revise the following values.                                      
                                                                                
   IODF name . . . . . . . . . : 'SYS6.IODF69' 
                                                                                
   Title1 . IODF69 _________________________________________________________    
   Title2 : SYS6.IODF69 - 2007-11-28 18:49 
                                                                                
                              Write IOCDS in                                    
   IOCDS        Switch IOCDS  preparation of upgrade                            
   A1.SCZP201  No            No                                                
   ***************************** Bottom of data ******************************  

 ------------------------- Job Statement Information -------------------------- 
                                                                                  
   Specify or revise the job statement information.                             
                                                                                
                                                                                
   Job statement information                                                    
   //WIOCDS  JOB (ACCOUNT),'NAME'                                               
   //*                                                                          
   //*                                                                          
   //*                                                                          

 

 

 

Chapter 5. Install an additional System z10 EC 253



 

Figure 5-67   HCD - IOCDS with replacement IODF

12.Figure 5-68 shows the Alternate status.

Figure 5-68   HCD - IOCDS showing Alternate Status

Updating the IOCDS using Stand-Alone Input/Output Config Program

Copy the IOCP statements that were generated using HCD option 2.3, Build IOCP input 
data set, onto a USB Flash Memory Drive and retain.

1. Log on using SYSPROG authority to the HMC workstation supplied with the 2097, as 
opposed to a remote Web browser, and select the new 2097, assuming it has been 
defined to the Defined CPCs Work Area.

2. Perform a Power-on Reset using one of the Reset profiles and Starter IOCDSs provided 
on the processor during installation. This is to create an environment on the processor that 
will allow you to run the Stand-Alone IOCP process.

3. When the Power-on Reset is complete, activate one of the logical partitions with at least 
128MB of storage and use this LPAR to run the I/O Configuration Program.

4. Under Systems Management, click Servers to expand the list; click the server of interest 
to select it. (In this example we selected SCZP201).

Goto  Query  Help                                                              
 ------------------------------------------------------------------------------ 
                       S/390 Microprocessor Cluster List             Row 1 of 4 
 Command ===> _______________________________________________ Scroll ===> PAGE  
                                                                                
 Select one or more CPCs, then press Enter.                                     
                                                                                
   --------------CPC--------------   IODF                                       
 / SNA Address        Type   Model   Processor ID                               
 s USIBMSC.SCZP201 2097  E26  SCZP201 
 _ USIBMSC.SCZP101 2094  S18  SCZP101                                    
 _ USIBMSC.SCZP801    2064   1C7     SCZP801                                    
 _ USIBMSC.SCZP901    2084   C24     SCZP102                                    
 ******************************* Bottom of data ********************************

Goto  Query  Help                                                            
 ------------------------------------------------------------------------------ 
                                   IOCDS List          Row 1 of 4 More:       > 
 Command ===> _______________________________________________ Scroll ===> CSR  
                                                                                
 Select one or a group of IOCDSs, then press Enter.                             
                                                                                
                                          -----Token Match----- Write           
 / IOCDS       Name     Type   Status     IOCDS/HSA IOCDS/Proc. Protect         
 _ A0.SCZP201  DIAG00   LPAR   POR        Yes       No          Yes-POR         
 _ A1.SCZP201  IODF69   LPAR   Alternate  Yes       Yes         No              
 _ A2.SCZP201  DIAG02   LPAR   Alternate  No        No          No              
 _ A3.SCZP201  DIAG03   LPAR   Alternate  No        No          No              
 ******************************* Bottom of data ********************************

Note: Refer to the Stand-Alone Input/Output Configuration Program User’s Guide, 
SB10-7152 for detailed information about the following steps.

 

 

 

254 IBM System z10 Enterprise Class Configuration Setup



 

5. On the Tasks pad, click Recovery to expand it, and select Single Object Operations.

6. Click Yes to confirm connection.

7. On the Tasks pad, find CPC Configuration, and select Input/output (I/O) Configuration.

8. Click the radio button for the Data Set into which you want to load the IOCDS.

Figure 5-69   HMC - Select IOCDS for Stand-alone IOCP 

9. Select Options → Import Source File → Hardware Management Console USB Flash 
Memory Drive.

Figure 5-70   HMC - Import Source File

10.Select the source file name and click OK.

Figure 5-71   HMC - Select Source File
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11.Now that the IOCP statements have been imported, a Build Data Set is performed to:

– Process the source file data for the selected I/O configuration.

– Check the syntax and validate the configuration.

– Generate an IOCDS and, if there are no errors, write the IOCDS to the support element 
hard disk.

– Write the I/O configuration source (IOCS) file to the support element hard disk with any 
IOCP messages embedded in the file.

Click OK. This will initiate a load of the IOCP code into the targeted LPAR (previously 
activated) and the program will perform the Build Data Set steps.

If the build was successful and there are no caution or warning messages, the resultant 
IOCDS has been written to the support element hard disk.

This IOCDS is now ready to be selected via a Reset Profile and the 2097 can be activated 
(Power-on Reset) with the production IODF.

5.8  HMC steps for activation profiles

Build the Production Reset Profile and point to required IOCDS
Now that the IODF has been written to an IOCDS, a Reset (Power-on Reset) Profile must be 
built to point to that IOCDS. This Reset Profile is used to power-on reset the new 2097 after it 
has been handed over from the IBM service representative.

1. Log on using SYSPROG authority to the HMC workstation supplied with the 2097, or use 
a remote Web browser and select the new 2097.

2. Under Systems Management, click Servers to expand the list, then click the server to 
select it (in this example, SCZP201).

3. On the Tasks pad, select Operational Customization → Customize/Delete Activation 
Profiles.

4. Select the DEFAULT Reset Profile and click Customize selected profile.

5. Save this DEFAULT profile with a new Profile name to be referred to when the power-on 
reset is required (for example, SCZP201).

6. Select the new Profile and click Customize selected profile.

7. Click the IOCDS that you just updated in the previous step (A1). 

8. Message ACTB0PDL is displayed; see Figure 5-72.

 

Figure 5-72   HMC - Activation Profiles (received when changing IOCDS)
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9. Depending on the circumstances, you may wish to answer Yes or No. You can now review 
the Partition Activation List, if desired.

Configure STP
STP configuration should be reviewed to ensure that the correct External Time Source has 
been configured and that you are connected to the correct Coordinated Time Network. 

Refer to Chapter 7, “Server Time Protocol setup” on page 305 for details. 

Build Image Profiles
While still in the Reset Profile, you can now review the Image Profile attributes.

Build Load Profiles
Go through and create Load (IPL) Profiles using the DEFAULTLOAD Load profile as a 
skeleton for all the logical partitions that you are IPLing on this processor.

Build Load Members in SYS#.IPLPARM
You require Load Members defined in SYS#.IPLPARM when IPLing from the new 2097.

Additionally, if you are going to use the HWNAME parameter to point to the Processor.ID in 
the Load members, make sure you use the correct name (in our example, SCZP201).

Performing a power-on reset of the 2097
The 2097 is now ready to be Activated (Power-on Reset) using the Production Reset Profile.
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Chapter 6. Install a new System z10 EC

In this chapter we describe how to install a System z10 EC into a new hardware environment.

Because a wide variety of different environments exist, your environment does not contain 
exactly the same elements as the configuration described here. Nevertheless, the 
step-by-step process we explain in this chapter should provide enough information for you to 
replicate the approach in your own environment. 

We discuss the following topics:

� Scenario overview

� HCD - Create a 2097 Work IODF

� Validate the 2097 work IODF

� CHPID Mapping Tool actions

� Migrate PCHIDs back into the 2097 work IODF

� HCD steps to build production IODF

� Implementing the processor configuration on the 2097

� HMC steps for activation profiles

6
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6.1  Scenario overview
We begin by providing an overall description of this scenario.

6.1.1  The configuration process
Figure 6-1 depicts the general process that we followed in this example. The numbered steps 
are described following the figure.

Figure 6-1   CMT - Overall process flow

1. When planning to install a new System z10 EC, the IBM Technical Support team can help 
to define a configuration that meets your needs. The configuration is then passed to the 
ordering step.

2. The IBM order for the configuration is created and passed to the manufacturing process.

3. The manufacturing process creates a configuration file that is stored on the IBM Resource 
Link Web site. The configuration file describes the hardware being ordered. This data is 
available for download by the client installation team.

4. The client starts with a completely new work IODF file created on another System z 
processor in this or another site, or produced on behalf of them by the IBM service 
representative. The client uses this as input into the HCD tool, which is used to create the 
client’s view of the new configuration. 
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5. After all of the new hardware has been added to the HCD definition, a validated 2097 work 
IODF is created.

6. From the validated work IODF, create a file containing the z10 EC IOCP statements. This 
file is transferred to the workstation and used for the CHPID Mapping Tool. HCM may also 
be used here to transfer the IOCP deck to and from the CMT.

7. The configuration file created by IBM Manufacturing in step 3 is downloaded from 
Resource Link to the CHPID Mapping Tool workstation.

8. The CHPID Mapping Tool uses the input data from files to map logical channels to 
physical ones on the new System z10 EC hardware. 

You might have to make decisions in response to situations that might arise, such as:

a. Resolving situations in which the limitations on the ordered hardware causes a single 
point of failure (SPoF). You may need to purchase additional hardware in order to 
resolve some SPoF situations.

b. Prioritizing certain hardware items over others. 

After processing by the CHPID Mapping Tool, the IOCP statements contain the physical 
channels assignment to logical channels, based on the actual purchased hardware 
configuration. 

The CHPID Mapping Tool also creates configuration reports to be used by the IBM service 
representative and the installation team. 

9. The file containing the updated IOCP statements created by the CHPID Mapping Tool,   
now containing the physical channel assignments, is transferred to the host system. 

10.Using HCD, take as input the validated work IODF file created in step 5 and the IOCP 
statements updated by the CHPID Mapping Tool. Apply the physical channel assignments 
done by the CMT to the configuration data in the work IODF. 

After the physical channel data has been migrated into the work IODF, a 2097 production 
IODF is created and the final IOCP statements can be generated.

The IBM hardware team uses the configuration data written in this step when the final 
power-on reset is done, yielding a System z10 EC with the client’s configuration on it and 
ready to be used by the client.

When installing a new 2097, you may be able to use HCD (Option 2.11) to write an IOCDS to 
the 2097 in preparation for an upgrade if you have another computer system in another 
location that connects to your new 2097. If you can write an IOCDS to the 2097, do so and let 
the IBM service representative know which IOCDS to use.

If the new 2097 is not connected using a LAN to the CPC where HCD is running, or you are 
not upgrading or cannot write an IOCDS using HCD in preparation for the upgrade, then use 
HCD to produce an IOCP input file and download the input file to a USB Flash Memory Drive. 
The memory drive is then given to the IBM service representative.

The IOCP input file will be loaded into the 2097 Support Element IOCDS using the 
Stand-Alone Input/Output Configuration Program. Refer to Technical Manual SB10-7152 for 
details.

Normally it is the responsibility of the IBM service representative to hand over a newly 
installed processor in power-on reset complete state, but there is no reason why the 
customer cannot run additional Stand-alone IOCPs after handover, to modify or add 
additional IODFs to the new processor.
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6.1.2  Planning considerations
Table 6-1 lists the channel types as described in an IOCDS that are used with the System z10 
EC.

Table 6-1   Channels, links, and adapters with CHPID type.

Keep the following considerations in mind when planning your configuration.

Coupling links

Only the following Coupling Facility CHPIDs are supported:
� CHPID Type=CFP - ISC-3 links in peer mode

� CHPID Type=CBP - ICB-4 links

� CHPID Type=CIB - PSIFB links connecting to a HCA2-O (Optical) card

� CHPID Type=ICP - Internal Coupling links.

Note: Using HCD option 2.11 (remote IOCDS build) with Write IOCDS in preparation of 
an upgrade=yes is the preferred method for writing the initial IOCDS when installing a 
new 2097. However, in this scenario, the Stand-Alone Input/Output Configuration Program 
process is described. 

Channels
CHPID 
Type

May be 
defined as 

Shared

May be 
defined as 
Spanned

ESCON channels:
Connection Channel (ESCON architecture)
Channel to Channel (connects to CNC)

CNC
CTC

yes
ye

no
no

FICON bridge. A FICON channel that attaches to an ESCON Director 
Model 5

FCV yes no

FICON native channels that attach to FICON directors or directly to 
FICON control units

FC yes yes

FICON channels that attach to Fibre channel devices, switches, 
directors, or Fibre-Channel-to-SCSI bridges

FCP yes yes

ISC-3 peer mode channels (connects to another CFP) CFP yes yes

ICB-4 peer channels (connects to another ICB-4) CBP yes yes

IC peer channels (connects to another ICP) ICP yes yes

InfiniBand host channel adapters (HCA) CIB yes yes

HiperSocket (IQDIO) channels IQD yes yes

OSA adapters using QDIO architecture OSD yes yes

OSA adapters using non-QDIO architecture OSE yes yes

OSA 1000Base-T adapters for OSA-ICC OCE yes yes

OSA-Express2 adapters for NCP OSN yes yes

Note: Coupling links can be defined as both Coupling and STP links or STP only links.
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HMC
The System z10 EC requires HMC Application Ver 2.10.0 or later and only uses Ethernet for 
its network connection. The HMC and also the Service Elements do not contain a floppy disc 
drive, requiring the use of a USB Flash Memory Drive to input and backup customer 
configuration data.

Software support
HCD V1.9 or HCD V1.7 and higher with 2097DEVICE PSP Bucket and PTFs is required to 
define and support some of the new features of the System z10 EC. 

Open Systems Adapter - Integrated Console Controller (OSA-ICC)
You might consider using OSA Express2 1000BaseT CHPIDs defined as TYPE=OSC. These 
OSA cards allow you to set up console function supported by a configuration file defined on 
the Support Element for that processor.

Fibre Channel Protocol (FCP)
When using CHPIDs defined as TYPE=FCP, you may wish to consider NPIV.

CPC name versus Processor ID
HCD allows you to define different Processors (Logical) to the same CPC (Physical). The 
Processor ID must be unique within the same IODF, but the CPC name does not. Therefore, 
the CPC name does not need to match the Processor ID. This is useful where you may have 
several Processor/logical partition/control unit setups that share the same physical CPC 
within the same IODF. Furthermore, the Processor ID is what is defined for the HWNAME 
parameter in the LOAD member in SYS1.IPLPARM.

The CPC name is coded in HCD option 1.3 under View Processor Definition in the CPC name 
field under SNA address, along with a Network name. It is the CPC name, and not the 
Processor ID, that appears on the HMC. 

When you view the Network information for a CPC via the HMC, note that the SNA address is 
made up of a Network name and CPC name separated by a dot (for example, 
USIBMSC.SCZP201). These values are defined in the Support Element for the CPC and they 
need to match the values set in the IODF so that HCD option 2.11 can find the CPC to write 
an IOCDS in the S/390 Microprocessor Cluster List.

Local System Name
An additional system name LSYSTEM is used to identify the local system name of a server 
when defining PSIFB type=CIB coupling links.

This data field can be found when changing a CIB-capable processor under HCD Option 1.3

The LSYSTEM field can be set or changed to any 1-8 alphanumeric character and also can 
begin with either an alpha or numeric character. All characters are upper case.

Here are the rules that will determine whether, and where, HCD will set the LSYSTEM 
keyword automatically:

1. If a CIB-capable processor is defined and the CPC name is set but the local system name 
is not set, HCD defaults the local system name to the CPC name. 

2. If a CIB-capable processor that has not yet defined a CPC name will be changed to get a 
CPC name but no local system name, HCD defaults the CPC name to the local system 
name.
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3. If a non-CIB capable processor is changed to a support level that is CIB capable, and the 
processor has a CPC name set but no local system name, the local system name is 
defaulted to the CPC name. 

4. If the processor definition is changed such that the local system name is explicitly 
removed, HCD does not do any defaulting.

5. If a processor has a local system name set (whether it has a CPC name or not), any 
change to the local system name has to be done explicitly. There will be no implicit name 
if the CPC name or the support level is changed.

6. During Build Production IODF it is verified that a local system name has to be set for the 
processor if the processor has a CIB channel path defined. If this verification fails, an error 
message is given and the production IODF is not built.

We do, however, recommend that the local system name be the same as the CPC name.

Additional keywords on the ID statement in an IOCP deck include:

AID: Adapter ID

Port: HCA port

CPATH: Specifies the CCSID and CHPID on the connecting system

6.1.3  Adding a new 2097 to a new hardware environment
In this scenario we describe the configuration steps for installing a new 2097 processor into a 
new environment. The 2097 is the first processor on the floor and is being connected to new 
switches and control unit interfaces. Key considerations are as follows:

� HCD requires a new Processor ID for the 2097.

� We recommend defining a new CPC name for the 2097.

� The 2097 processor connects to new switch ports and new control unit interfaces.

� The control unit interfaces connect to new switch ports.

� The starting IODF can be an existing production IODF from another data center, or can be 
a new work IODF. 

This example shows a 2097-E26 with Processor.ID of SCZP203 and with four CSSs (CSS 
ID=0, CSS ID=1, CSS ID=2 and CSS ID=3). The CPC name of SCZP203 and serial number 
of 000203 is used for the 2097.

The following CHPID types are defined:

� FC, FCP, CTC, CNC 
� OSD, OSE, OSC, OSN
� CFP, CBP, ICP, CIB
� IQD

The following Hardware/CHPID types are not supported on the 2097:

� PCIXCC and PCICA
� ICB-3 links
� ICB-2 links
� ISC-3 links in compatibility mode (CHPID types CFS and CFR)
� OSA-Express Token Ring
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Table 6-2   New 2097 in a new installation

6.2   HCD - Create a 2097 Work IODF
The following steps explain how to define a new 2097 configuration using HCD:

1. Create a 2097 work IODF, either new or from an existing production IODF.

2. Add the processor.

3. Change required partition names and usage from reserved.

4. Add CHPIDs.

5. Add FICON and ESCON Switches.

6. Add operating system configurations.

7. Create the Eligible Device Table (EDT).

8. Create esoterics for the EDT.

9. Connect FICON and ESCON CHPIDs to new switches, spreading connections over as 
many switches and physical port cards as possible, where appropriate.

10.Create control units unique to this processor.

11.Create devices appropriate to the control units.

New 2097 Additional 2097 to connect to new switch ports 
and control units that do not currently exist

 (new installation)

Processor.id Require new Processor.ID

CPC name Require new CPC name

Channel to switch port connections New ports

Control Unit to switch port connections New ports

Starting IODF Current active production IODF

Target IODF Create a new work IODF

HCD action Add Processor (see below)

CHPID Mapping Tool (CMT) Program 
(needed or not)

Optional, but recommended

CFReport File (CCN) Required

IOCP (import from validated work IODF) Yes

CHPID Mapping Tool Actions (PCHID reset) Yes

CHPID Mapping Tool IOCP Output Yes

CHPID Mapping Tool Reports Yes 
(CHPID and CHPID to CU Report)

Note: As mentioned, you can have different Processor ID and CPC names.

However, if you do not need to support multiple processor images, we recommend that the 
Processor.ID and CPC name match.
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12.Define devices to the operating system configurations and any esoterics, where 
appropriate.

13.Connect control units to CHPIDs or switch ports, then CHPIDs.

14.Define all required coupling connections to other processors and any Internal coupling 
connections required.

15.Create CTCs.

16.Create OSA configuration (OSC, OSD, OSE, OSN).

17.Define Nucleus Initialization Program (NIP) consoles.

18.Build validated Work IODF.

19.Create an IOCP statements file and file transfer to your PC for input into the CMT. This 
step can be performed with HCM.

20.Import CFReport and IOCP statements into the CMT.

21.Perform hardware resolution and PCHID/CHPID availability.

22.Create configuration reports for yourself and the IBM service representative.

23.Import IOCP statements updated with PCHIDs back into validated work IODF.

24.Build Production IODF and remote write the IOCP to an IOCDS on the processor or, if not 
possible, copy the IOCP statements to a USB Memory Flash Drive.

25.Run Stand-Alone Input/Output Configuration Program to load the IOCP statements onto 
the 2097 Service Element IOCDS.

26.Build Reset, Image, and Load Profile.

27.Perform Power-on Reset (Activate) of 2097.

In the following sections, we describe some of these steps in more detail. For specific details 
on defining processors, partitions, switches, control units, devices, and so forth in an IODF 
using HCD, refer to z/OS HCD Users Guide SC33-7988 and IOCP Users Guide SB10-7037.

Create new Work IODF
Create and select a new work IODF where you add the new 2097 processor definition (for 
example, ‘SYS6.IODF39.WORK’).

Add 2097 processor
1. From the HCD main menu, select option 1.3, Processor List (Figure 6-2). Press PF11 (or 

type add on the command line) to add a new processor; press Enter. The Add Processor 
panel is displayed (Figure 6-3 on page 267).

Figure 6-2   HCD - Processor List (adding processor)

 Processor List                               
Command ===> add____________________________________________ Scroll ===> CSR 
                                                                             
Select one or more processors, then press Enter. To add, use F11.            
                                                                             
                                                                             
/ Proc. ID Type +   Model +  Mode+ Serial-# + Description 
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Figure 6-3   HCD - Add Processor (blank values)

2. Enter the appropriate information on the Add Processor panel. For our example we 
specified the following values:

Processor ID: SCZP203
Processor type: 2097
Processor model: E26
Number of channel subsystems: 4

If this field is left blank, then 4 will be defined. If any number below 4 is entered, then 
the following error message will be displayed:
Minimum configuration not defined for processor SCZP203.

Serial number: 0002032097
Network name: USIBMSC
CPC name: SCZP203

Figure 6-4 on page 268 shows the values we added.

------------------------------- Add Processor -----------------------------
                                                                           
                                                                           
 Specify or revise the following values.                                   
                                                                           
 Processor ID . . . . . . . . . . ________                                 
 Processor type . . . . . . . . . ________  +                              
 Processor model  . . . . . . . . ________  +                              
 Configuration mode . . . . . . . LPAR      +                              
 Number of channel subsystems . . _         +                              
                                                                           
 Serial number  . . . . . . . . . __________                               
 Description  . . . . . . . . . . ________________________________         
                                                                           
 Specify SNA address only if part of an S/390 microprocessor cluster:      
                                                                           
 Network name . . . . . . . . . . ________  +                              
 CPC name . . . . . . . . . . . . ________  +                              
                                                                           
 Local system name  . . . . . . . ________                                 
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Figure 6-4   HCD - Add Processor (adding values)

3. Press Enter. The Processor List panel displays, showing the additional 2097 processor 
named SCZP203 (Figure 6-5).

Notice the message displayed at the bottom of the panel indicating that the processor 
definition has been extended to its maximum configuration. This is because part of the 
Central Storage is allocated as a fixed-sized Hardware System Area, which is not 
addressable by application programs. In HCD when you define as new or redefine a 
processor as 2097, HCD automatically defines the maximum configuration of four CSSs 
and 60 logical partitions.

Figure 6-5   HCD - processor List (new process or added)

4. Type s next to the SCZP203 and press Enter (Figure 6-6 on page 269).

 --------------------------- Add Processor -----------------------------

 Specify or revise the following values.                                
                                                                        
 Processor ID . . . . . . . . . . SCZP203_                              
 Processor type . . . . . . . . . 2097____  +                           
 Processor model  . . . . . . . . E26_____  +                           
 Configuration mode . . . . . . . LPAR      +                           
 Number of channel subsystems . . 4         +                           
                                                                        
 Serial number  . . . . . . . . . 0002032097                            
 Description  . . . . . . . . . . ________________________________      
                                                                        
 Specify SNA address only if part of an S/390 microprocessor cluster:   
                                                                        
 Network name . . . . . . . . . . USIBMSC_  +                           
 CPC name . . . . . . . . . . . . SCZP203_  +                           
                                                                        
 Local system name  . . . . . . . ________ 

 Processor List        Row 1 of 1 More:       >
Command ===> _______________________________________________ Scroll ===> CSR  
                                                                              
Select one or more processors, then press Enter. To add, use F11.             
                                                                              
                                                                              
/ Proc. ID Type +   Model +  Mode+ Serial-# + Description                     
_ SCZP203  2097     E26      LPAR  0002032097 ________________________________
******************************* Bottom of data *******************************
                                                                              
+------------------------------------------------------------------+
| Definition of processor SCZP203 has been extended to its maximum |
| configuration.                                                   |
+------------------------------------------------------------------+
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Figure 6-6   HCD - Channel Subsystem List 

Here you can see four (or maximum) Channel Subsystems defined with the default 
MAXDEV value of 65280 set by HCD. 

5. Type p next to any of the CSSs and observe that HCD also defines the maximum number 
of logical partitions, 15 per CSS or a total of 60, as Reserved (*) (Figure 6-7).

Figure 6-7   HCD - Partition List 

Scroll down to see the remaining reserved logical partitions defined for this CSS.

6. Define the resources to the new 2097 processor:

a. Change Reserved partitions for each desired CSS to the required partition name and 
usage. Not all partitions need to be changed at this point; they can be modified later via 
a Dynamic IODF Activate.

b. Add CHPIDs to each CSS, with no PCHIDs assigned. 
c. Define a Partition Access list for these CHPIDs.
d. Define a Partition Candidate list for these CHPIDs.

 Channel Subsystem List                  Row 1 of 4
Command ===> _______________________________________________ Scroll ===> CSR  
                                                                              
Select one or more channel subsystems, then press Enter.  To add, use F11.    
                                                                              
Processor ID . . . : SCZP203                                                  
                                                                              
  CSS Devices in SS0    Devices in SS1                                        
/ ID  Maximum + Actual  Maximum + Actual  Description                         
_ 0   65280     0       65535     0       ________________________________    
_ 1   65280     0       65535     0       ________________________________    
_ 2   65280     0       65535     0       ________________________________    
_ 3   65280     0       65535     0       ________________________________ 

Note: The MAXDEV values are automatically set when defining a 2097 due to the fixed 
Hardware System Area (HSA) on a 2097 processor. 

----------------------------- Partition List ----------------------------
Row 1 of 15

 Command ===> ________________________________________ Scroll ===> CSR   
                                                                         
 Select one or more partitions, then press Enter. To add, use F11.       
                                                                         
 Processor ID  . . . . : SCZP203                                         
 Configuration mode  . : LPAR                                            
 Channel Subsystem ID  : 0                                               
                                                                         
 / Partition Name   Number Usage + Description                           
 _ *                1      CF/OS   ________________________________      
 _ *                2      CF/OS   ________________________________      
 _ *                3      CF/OS   ________________________________      
 _ *                4      CF/OS   ________________________________      
 _ *                5      CF/OS   ________________________________      
 _ *                6      CF/OS   ________________________________      
 _ * 7  CF/OS   ________________________________ 

 

 

 

Chapter 6. Install a new System z10 EC 269



 

� Add FICON and ESCON switches.

� Add operating system configurations: 

a. Create an Eligible Device Table (EDT) for each of these operating system 
configurations.

b. Create esoterics for each of these EDTs.

� Connect FICON and ESCON CHPIDs to the new switches, spreading connections over as 
many switches and physical port cards as possible, where appropriate.

� Create control units:

a. Create devices appropriate to the control units.
b. Define devices to operating system configurations and any esoterics, where 

appropriate.
c. Connect control units direct to FICON or ESCON CHPIDs or to switch ports, then 

CHPIDs.

� Define all required internal coupling links and peer coupling links to any other new 
processors you may be adding to the IODF.

� Create ESCON and FICON CTCs.

� Create OSA control units (OSC, OSD, OSE, OSN).

� Define Nucleus Initialization Program (NIP) consoles.

Over-define channel paths
Sometimes you may need to define a channel path that is not physically installed on the 
processor. This may be useful if you are planning to add additional channel cards to the 
processor in the future and want to have the definitions in the IODF before the hardware is 
installed.

HCD allows you to over-define CHPIDs by using an asterisk (*) for the PCHID value. An 
over-defined CHPID must adhere to all validation rules, but it is not taken into account by an 
IOCDS download. Also it is not included in the IOCP statements, in a CONFIGxx member, or 
during dynamic activation.

If a control unit contains only CHPIDs with a PCHID value of an asterisk (*), then the whole 
control unit (including any attached devices) is omitted from the configuration to be activated.

When installing the channel path later, you must edit the CHPID and replace the * by its valid 
PCHID.

Note: For specific details on defining processors, partitions, switches, control units, 
devices, and so forth, refer to z/OS HCD Users Guide, SC33-7988 and IOCP Users 
Guide, SB10-7037.

Note: This is not the case for CFP and CBP type CHPIDs, where these CHPIDs have 
connections to other CFP and CBP type CHPIDs. 

Therefore, HCD only allows you to define CFP and CBP type CHPIDS as over-defined if 
they are unconnected.

If you define a CIB type CHPID, it must also be defined with an HCA Adapter ID (AID) and 
an HCA Port ID, represented in the AID/P column in the Channel Path List. HCD does not 
allow a CIB type CHPID to be defined as over-defined.
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The 2097 production IODF can then be activated dynamically and the PCHID/CHPID/control 
unit definitions become available to the operating system.

� Figure 6-8 illustrates what the CHPID/PCHID definitions look like before being defined as 
over-defined. Press PF20 (right) in the Channel Path List.

Figure 6-8   HCD - Channel Path List (Reserving CHPIDs)

� Figure 6-9 illustrates what the CHPID/PCHID definitions look like after being defined as 
over-defined.

Figure 6-9   HCD - Channel Path List (over-defined CHPIDs)

 Channel Path List     Filter Mode. More: <     >
Command ===> _______________________________________________ Scroll ===> CSR  
                                                                              
Select one or more channel paths, then press Enter. To add, use F11.          
                                                                              
Channel Subsystem ID : 0                                                      
1=A01       2=A02       3=A03       4=A04       5=A05                         
6=A06       7=A07       8=A08       9=A09       A=A0A                         
B=A0B       C=A0C       D=A0D       E=A0E       F=A0F                         
                          I/O Cluster  --------- Partitions 0x -----   PCHID  
/ CHPID Type+ Mode+ Mngd  Name +       1 2 3 4 5 6 7 8 9 A B C D E F   AID/P  
_ BE    CFP   SHR   No    ________     _ _ _ _ _ _ _ _ _ _ _ _ a _ _   3D8    
_ BF    CFP   SHR   No    ________     _ _ _ _ _ _ _ _ _ _ _ _ a _ _   3D9    
_ CE    CFP   SPAN  No    ________     _ _ a _ _ _ _ _ _ _ _ _ _ _ _   181    
_ CF    CFP   SPAN  No    ________     _ _ a _ _ _ _ _ _ _ _ _ _ _ _   111    
_ EC    CFP   SPAN  No    ________     _ _ a _ _ _ _ _ _ _ _ _ _ _ _   3C0    
_ EE    CFP   SPAN  No    ________     _ _ a _ _ _ _ _ _ _ _ _ _ _ _   3D0 

 Channel Path List     Filter Mode. More: <     >
Command ===> _______________________________________________ Scroll ===> CSR  
                                                                              
Select one or more channel paths, then press Enter. To add, use F11.          
                                                                              
Channel Subsystem ID : 0                                                      
1=A01       2=A02       3=A03       4=A04       5=A05                         
6=A06       7=A07       8=A08       9=A09       A=A0A                         
B=A0B       C=A0C       D=A0D       E=A0E       F=A0F                         
                          I/O Cluster  --------- Partitions 0x -----   PCHID  
/ CHPID Type+ Mode+ Mngd  Name +       1 2 3 4 5 6 7 8 9 A B C D E F   AID/P  
_ BE    CFP   SHR   No    ________     _ _ _ _ _ _ _ _ _ _ _ _ a _ _   *      
_ BF    CFP   SHR   No    ________     _ _ _ _ _ _ _ _ _ _ _ _ a _ _   *      
_ CE    CFP   SPAN  No    ________     _ _ a _ _ _ _ _ _ _ _ _ _ _ _   *      
_ CF    CFP   SPAN  No    ________     _ _ a _ _ _ _ _ _ _ _ _ _ _ _   *      
_ EC    CFP   SPAN  No    ________     _ _ a _ _ _ _ _ _ _ _ _ _ _ _   *      
_ EE    CFP   SPAN  No    ________     _ _ a _ _ _ _ _ _ _ _ _ _ _ _   * 
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6.3  Validate the 2097 work IODF
1. Select HCD option 2.12, Build validated work I/O definition file.

2. Review the Message List.

3. Press PF3 to continue; you should receive the following message:

Requested action successfully processed

4. Go to HCD option 6.4, View I/O Definition File Information (Figure 6-10). Note that the 
IODF type is now Work - Validated.

Figure 6-10   HCD - View I/O Definition File Information (validated work IODF)

 --------------- View I/O Definition File Information ------------ 

                                                                   
 IODF name  . . . . . . : 'SYS6.IODF39.WORK'             
 IODF type  . . . . . . : Work - Validated                         
 IODF version . . . . . : 5                                        
                                                                   
 Creation date  . . . . : 2007-11-28                               
 Last update  . . . . . : 2007-11-28  14:10                        
                                                                   
 Volume serial number . : BH8ST1                                   
 Allocated space  . . . : 2000    (Number of 4K blocks)            
 Used space . . . . . . : 201     (Number of 4K blocks)            
    thereof utilized (%)  86                                       
                                                                   
 Activity logging . . . : No                                       
 Backup IODF name . . . :                                          
                                                                   
 Description  . . . . . :                                          
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Create the IOCP for the CHPID Mapping Tool

1. Select HCD option 2.3, Build IOCP input data set, and press Enter (Figure 6-11).

Figure 6-11   HCD - Activate or Process Configuration Data (Build IOCP for SCZP203)

2. HCD displays the list of available processors to chose from. Select the processor 
SCZP203 by using a forward slash mark (/), and then press Enter (Figure 6-12).

Figure 6-12   HCD - Available Processors (select processor for IOCP file)\

3. HCD presents a panel on which you enter information regarding the IOCP input data set to 
be created (Figure 6-13). Enter the appropriate information. In our exercise, we entered 
the following values:

Title1: IODF39
IOCP input data set: 'SYS6.IODF39.IOCPIN.SCZP203'
Input to Stand-alone IOCP? Yes
Job statement information as shown

4. Press Enter. HCD submits a batch job to create the data set.

Note: You may prefer to use HCM to create the IOCP statements file and transfer the file 
to your PC. You can then launch the CHPID Mapping Tool, create an updated IOCP 
statements file, and transfer the file back to the host.

----- Activate or Process Configuration Data ------  

 Select one of the following tasks.               
                                                  
 3   1.  Build production I/O definition file     
     2.  Build IOCDS                              
     3.  Build IOCP input data set                
     4.  Create JES3 initialization stream data   
     5.  View active configuration                
     6.  Activate or verify configuration         
         dynamically                              
     7.  Activate configuration sysplex-wide      
     8.  Activate switch configuration            
     9.  Save switch configuration                
     10. Build I/O configuration statements       
     11. Build and manage S/390 microprocessor    
         IOCDSs and IPL attributes                
     12. Build validated work I/O definition file 

------------------------- Available Processors --------------------------- 
Row 1 of 1

Command ===> __________________________________________________________  
                                                                         
Select one.                                                              
                                                                         
  Processor ID  Type     Model    Mode  Description                      
/ SCZP203       2097     E26      LPAR
************************* Bottom of data ************************** 
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Figure 6-13   HCD - Build IOCP Input Data Set

5. Verify in TSO that the data set just created exists, and that it contains IOCP statements 
(Figure 6-14). This data set is used as input into the CHPID Mapping Tool.

Figure 6-14   HCD - IOCP input data set contents (truncated)

------------------------- Build IOCP Input Data Set -------------------------- 

 Specify or revise the following values.                                  
                                                                          
 IODF name . . . . . . . . . : 'SYS6.IODF39.WORK'                       
 Processor ID  . . . . . . . : SCZP203                                    
 Title1 . IODF39__________________________________________________________
 Title2 : SYS6.IODF39.WORK - 2007-11-28 14:10                           
                                                                          
 IOCP input data set                                                      
 'SYS6.IODF39.IOCPIN.SCZP203'_________________                          
 Input to Stand-alone IOCP?  Yes  (Yes or No)                             
                                                                          
 Job statement information                                                
 //WIOCP   JOB (ACCOUNT),'NAME'                                           
 //*                                                                      
 //*                                                                      
 //* 

ID    MSG1='IODF39',                                          *  
      MSG2='SYS6.IODF39.WORK - 2007-11-28 14:10',  *  
      SYSTEM=(2097,1),LSYSTEM=SCZP203,                        *  
      TOK=('SCZP203',00800001DE502097141059710107332F00000000,*  
      00000000,'07-11-28','14:10:59','........','........')      
RESOURCE PARTITION=((CSS(0),(A0A,A),(A0B,B),(A0C,C),(A0D,D),(A*  
      0E,E),(A0F,F),(A01,1),(A02,2),(A03,3),(A04,4),(A05,5),(A*  
      06,6),(A07,7),(A08,8),(A09,9)),(CSS(1),(A1A,A),(A1B,B),(*  
      A1C,C),(A1D,D),(A1E,E),(A1F,F),(A11,1),(A12,2),(A13,3),(*  
      A14,4),(A15,5),(A16,6),(A17,7),(A18,8),(A19,9)),(CSS(2),*  
      (A21,1),(A22,2),(A23,3),(A24,4),(A25,5),(*,6),(*,7),(*,8*  
      ),(*,9),(*,A),(*,B),(*,C),(*,D),(*,E),(*,F)),(CSS(3),(A3*  
      1,1),(A32,2),(A33,3),(*,4),(*,5),(*,6),(*,7),(*,8),(*,9)*  
      ,(*,A),(*,B),(*,C),(*,D),(*,E),(*,F)))                     
CHPID PATH=(CSS(0,1,2,3),00),SHARED,                          *  
      NOTPART=((CSS(0),(A0D,A0E,A0F),(=)),(CSS(1),(A1D,A1E,A1F*  
      ),(=))),TYPE=OSD                                           
CHPID PATH=(CSS(0,1,2,3),01),SHARED,                          *  
      NOTPART=((CSS(0),(A0D,A0E,A0F),(=)),(CSS(1),(A1D,A1E,A1F*  
      ),(=))),TYPE=OSD                                           
CHPID PATH=(CSS(0,1,2,3),02),SHARED,                          *  
      NOTPART=((CSS(0),(A0D,A0E,A0F),(=)),(CSS(1),(A1D,A1E,A1F*  
      ),(=))),TYPE=OSD                                           
CHPID PATH=(CSS(0,1,2,3),03),SHARED,                          * 
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Note that part of the TOK statement has been blanked out with dots (Example 6-1).

Example 6-1   HCD - IOCP file (TOK statement)

TOK=('SCZP203',00800001DE502097141059710107332F00000000,*  
      00000000,'07-11-28','14:10:59','........','........')      

This is a safeguard to ensure that this IOCP file cannot be written to a processor and used 
for a power-on reset because this IOCP file was created from a validated work IODF and 
not a Production IODF, which is something that can be done only for processors that 
contain PCHID definitions.

6. Download this file from TSO to your workstation. Use a workstation file transfer facility 
such as the one in IBM Personal Communications Workstation Program, or any 
equivalent 3270 emulation program. Be sure to use TEXT as the transfer type. In this 
example, we call this file SCZP203in.iocp.

6.4  CHPID Mapping Tool actions
In the following steps we take the output from the previous set of HCD steps (IOCP), as well 
as the output from the 2097 order process (CFReport). Using the CHPID Mapping Tool, we 
assign PCHIDs to each of the CHPIDs for the 2097.

Download and install the CHPID Mapping Tool. Refer to “CHPID Mapping Tool” on page 24, 
for information about obtaining and installing the CMT. If you already have the CHPID 
Mapping Tool installed, then verify that you have the latest updates installed.

Using the CHPID Mapping Tool, follow these steps:

1. Import IOCP statements file and “new” CFReport file into the CHPID Mapping Tool. 
Getting the IOCP statements can be performed with HCM.

2. Resolve CHPIDs without associated hardware.

3. Resolve Hardware resolution.

4. Set CU Priority for single-path control units and other control units that would override the 
CHPID Mapping Tool default priorities.

5. Run the CHPID Mapping Tool availability function.

6. Create the CHPID Mapping Tool reports.

7. Create updated IOCP statements file and file transfer back to the host. This step can be 
performed with HCM.

Import the CFReport file into the CHPID Mapping Tool
1. Start the CHPID Mapping Tool on your workstation.

2. Import the CFReport file into the CHPID Mapping Tool by clicking File → Import 
CFReport file (Figure 6-15 on page 276).

Important: When an IOCP statement file is exported from a Validated Work IODF 
using HCD, it must be imported back to HCD for the process to be valid. The IOCP file 
cannot be used directly by the IOCP program.
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Figure 6-15   CMT - Import CFReport file

3. Select the CFReport file on your workstation to import into the CHPID Mapping Tool and 
click Open (Figure 6-16). 

Figure 6-16   CMT - Open CFReport file

The CHPID Mapping Tool displays the information from the CFReport on the left-hand 
side of the window (Figure 6-17 on page 277).
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Figure 6-17   CMT - Importing CFReport file
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Import IOCP file into the CHPID Mapping Tool
1. Import the IOCP file by clicking Tool → Import IOCP File (Figure 6-18). 

Figure 6-18   CMT - Import IOCP files

2. Select the IOCP file on your workstation to import into the CHPID Mapping Tool and click 
Open.

Hardware resolution
The CHPID Mapping Tool may prompt you to resolve any issues that may arise from 
importing the IOCP file. In our example, the CHPID Mapping Tool requests clarification on the 
TYPE=OSD, TYPE=FCP, and TYPE=FC channels. 

In each case, we must check off what each of the channels is used for. The image in the 
lower right-hand side of Figure 6-19 shows what we have selected for the FC channels.
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Figure 6-19   CMT - Hardware resolution after IOCP import
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1. Select one tab at a time. Click the desired box and move to the next tab until all CHPID 
definitions have hardware selected.

2. Click Done.

3. The CHPID Mapping Tool displays all of the currently known information. In Figure 6-20, 
note that the CHPID column and the CHPID Origin columns contain blanks. These are 
filled in after the CHPID Mapping Tool assigns the CHPIDs to PCHIDs.

Figure 6-20   CMT - Manual tab

Set control unit priority manually
1. Under the File menu, click the Availability tab.

2. Click Process CU Priority and a window pops up; see Figure 6-21 on page 281. 

The Reset CHPID Assignment window allows you to change the CHPID values:

– Reset CHPIDs assigned by Availability
– Reset CHPIDs assigned by Manual Remap
– Reset CHPIDs assigned by IOCP

In our example, we selected Reset CHPIDs assigned by Availability because no 
PCHIDs were defined in the IOCP input and we did not assign any in the manual panel.

3. Click Process.
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Figure 6-21   CMT - Reset CHPID Assignments by availability

After the CHPID Mapping Tool has assigned the CHPIDs, it displays a message indicating 
the results of the process (Figure 6-22).

Figure 6-22   CMT - Process CU Priority completion message
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Our example returned a successful message with no intersects.

The possible intersects are as follows:

C Two or more assigned channels use the same channel card.
S More than half the assigned channels use the same STI.
M All assigned channels are supported by the same MBA group.
B More than half the assigned channels are supported by the same book.
D Assigned channels are on the same daughter card.

4. Click OK. 

5. You can now display the result of the channel mapping. You can also sort the report in 
different ways. For example, to see how the CHPID Mapping Tool ranked the control 
units, click Sorts → By CU Priority.

Our example does not contain any control units set with CU Priority, but we need to check 
and set values for items such as OSA-ICC CHPIDs and CTC CHPIDs to ensure that the 
CHPID Mapping Tool allocates these CHPIDs with high PCHID availability.

6. Go through the listing and search through the CU Number column for any control units you 
want to set priority for.

In our example we set the OSC type CU Numbers F200 and F280 to priority 333 plus a 
few FCTCs and a 2107 CU; see Figure 6-23.

Figure 6-23   CMT - Set CU Priority

If there are coupling links used by a CF image, you should group these links.

Each set of CHPIDs going to a different CPC should be grouped with a common priority. 
For example, suppose the CF image has four links (CHPIDs 40, 41, 42, and 43) and that 
40 and 41 go to one CPC, and 42 and 43 go to a different CPC. In this case you should 
give CHPIDs 40 and 41 one priority and CHPIDs 42 and 43 a different priority. The 
concept is the same regardless of the number of connecting CPCs or the number of links 
to each CPC.

7. Under the File menu, click the Availability tab.

Note: Intersect messages inform you of a potential availability problem detected by the 
CMT, but do not necessarily indicate an error.

It is your responsibility to evaluate whether the condition should be corrected or not.
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8. Click Process CU Priority and a window pops up. 

The Reset CHPID Assignment window allows you to change the CHPID values:

– Reset CHPIDs assigned by Availability
– Reset CHPIDs assigned by Manual Remap
– Reset CHPIDs assigned by IOCP

In our example, we selected Reset CHPIDs assigned by Availability.

9. Click Process.

10.Click Sorts → By CU Priority and you notice that the OSC type control units with priority 
of 333 have sorted to the top of the list.

11.Select the Manual tab and view the results of mapping the CHPIDs (Figure 6-24).

Figure 6-24   CMT - Manual (CHPIDs assigned)

Note that the CHPID column and the CHPID Origin columns are no longer blank. The 
CHPID Mapping Tool has assigned CHPIDs to PCHIDs and it has placed the value Avail 
in the CHPID Origin column, indicating that the CHPID values were assigned based on 
availability.
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CHPIDs not connected to Control Units
1. Under the Availability tab, click Sorts → By Control Unit. The CHPID Mapping Tool 

displays at the end of the list all CHPIDs defined in the IOCP input that are not connected 
to control units. All coupling CHPIDs in this list are preceded with an S in the CU Number 
column (not shown in the following figure). All non-coupling CHPIDs are preceded with a P 
(Figure 6-25).

Figure 6-25   CMT - Sort by Control Unit

You should review the list because:

� You may have forgotten to add a CHPID to a control unit and may need to update the 
IOCP source before continuing in the CHPID Mapping Tool.

� The unconnected CHPIDs may be extra channels you are ordering in anticipation of new 
control units.

� The unconnected CHPIDs may be coupling links that are being used in coupling facility 
(CF) images (these do not require control units).

If there are extra CHPIDs for anticipated new control units, you may want to group these 
CHPIDs with a common priority. This will allow the availability mapping function to pick 
PCHIDs that will afford your new control unit good availability.

Create reports for the hardware team
The CHPID Mapping Tool has built-in reports, which are available from the Reports pull-down 
menu.

You can also print the information on the Availability tab or the Manual tab by clicking the 
Print button. When in the Availability tab, you can also enter information in the Comments 
column that might be useful at a later date.
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For simplicity, we only describe how to print three reports in this example (the CHPID Report, 
the Port Report sorted by location, and the CHPID to Control Unit Report). However, all 
built-in reports are printed in the same way.

The person who will install the I/O cables during system installation needs one of these 
reports. The Port Report, sorted by location, is recommended. The installer can use this to 
help with labelling the cables. The labels must include the PCHID or cage/slot/port 
information before system delivery.

CHPID Report
1. Click Reports → CHPID Report (Figure 6-26).

Figure 6-26   CMT - select CHPID Report

2. Enter the report File name (or accept the name that the CHPID Mapping Tool enters) and 
click Save (Figure 6-27).

Figure 6-27   CMT - Report File Name

3. The CHPID Mapping Tool opens a browser window with the CHPID report; see 
Figure 6-28 on page 286. You may be prompted to accept active content. Accept the 
active content in order to display the report in your browser.
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Figure 6-28   CMT - CHPID Report

 

 

 

286 IBM System z10 Enterprise Class Configuration Setup



 

Port Report - Sorted by Location
1. Click Reports → Port Report → Sorted by Location, and then click Save (assuming 

that you accept the CHPID Mapping Tool report name).

2. The CHPID Mapping Tool opens a browser window with the CHPID to Port Report 
(Figure 6-29). You may be prompted to accept active content. Accept the active content in 
order to display the report in your browser. 

Figure 6-29   CMT - CHPID to Port Report

 

 

 

Chapter 6. Install a new System z10 EC 287



 

CHPID to Control Unit Report
1. Click Reports → CHPID to Control Unit Report, and then click Save (assuming that you 

accept the CHPID Mapping Tool report name).

2. The CHPID Mapping Tool opens a browser window with the CHPID to Control Unit Report 
(Figure 6-30). You may be prompted to accept active content. Accept the active content in 
order to display the report in your browser. 

Figure 6-30   CMT - CHPID to CU Report

Create updated IOCP

Create an IOCP statements file for input back into the IODF via HCD. This IOCP statements 
file now has the CHPIDs assigned to PCHIDs. 

1. Click Tool → Create Updated IOCP File (Figure 6-31).

Note: You may prefer to use HCM to transfer the updated IOCP statements file back to the 
host. Before doing so, however, first run the next step in the CHPID Mapping Tool to create 
the updated IOCP file.
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Figure 6-31   CMT - Create Updated IOCP File

2. Enter File name and location for the IOCP output file and click Save (Figure 6-32).

Figure 6-32   CMT - Save IOCP output file 

3. The CHPID Mapping Tool displays an informational message regarding what to do for the 
final execution of the tool (Figure 6-33).

Note: This file must be uploaded to the z/OS image on which you have the work IODF 
used previously to create the IOCP input data set. 

 

 

 

Chapter 6. Install a new System z10 EC 289



 

Figure 6-33   CMT - informational message 

6.5  Migrate PCHIDs back into the 2097 work IODF
Once we have mapped the CHPIDs to PCHIDs using the CHPID Mapping Tool, we need to 
input this information back into HCD. We do this using the updated IOCP statement file (for 
example, sczp203out.iocp).

1. Upload the sczp203out.iocp file to the z/OS image in order to migrate the PCHID 
information into HCD. Use a workstation file transfer facility such as the one in IBM 
Personal Communications Workstation Program, or any equivalent 3270 emulation 
program. Be sure to use TEXT as the transfer type.

In the updated IOCP statements file, notice that the CHPID Mapping Tool has left its mark 
with reference to the CCN. Also notice the CU Priority values added for the OSC control 
units F200 and F280 and also some other CUs.

Example 6-2   HCD - Updated IOCP statements file (with CMT statements)

IODEVICE ADDRESS=(FFDD,007),CUNUMBR=(FFFE),UNIT=CFP         
         IODEVICE ADDRESS=(FFF9,007),CUNUMBR=(FFFE),UNIT=CFP         
*CMT* VERSION=000                                                    
*CMT* CCN=19756694(CFR)                                              
*CMT* 4B00.0=0100,4B08.0=0110,5B00.0=0120,5B08.0=0130,D000.0=0200    
*CMT* D100.0=0210,D200.0=0220,D300.0=0230,D400.0=0240,D500.0=0250    
*CMT* F200.0=0333,F200.1=0333,F280.0=0333,F280.1=0333 
***************************** Bottom of Data ****************************

2. On the HCD main menu, enter the work IODF name that you used to create the IOCP 
input data set for the CHPID Mapping Tool.

Select option 5, Migrate configuration data (Figure 6-34).

Note: Control unit priorities are stored in the IOCP output file created by the CHPID 
Mapping Tool that gets migrated back into HCD. HCD maintains these priorities and 
outputs them when creating another IOCP deck. They are in the form of commented 
lines at the end of the IOCP deck; see Example 6-2.

Important: The CMT comments contained in the IOCP output file should not be edited 
manually. If priorities need to be changed, that task should always be done within the 
CHPID Mapping Tool.
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Figure 6-34   HCD - main menu, select Migrate configuration data

3. The Migrate Configuration Data panel is displayed (Figure 6-35). Select option 1, Migrate 
IOCP/OS data, and press Enter. 

Figure 6-35   HCD - Migrate Configuration Data

4. HCD displays the Migrate IOCP Data panel. Fill in the following fields and then press 
Enter:

Processor ID Use the same one as used to create the IOCP input deck.

OS configuration ID This is the OS configuration associated with the processor.

IOCP only input data set This is the data set name specified when the iocpout.txt file 
was uploaded to TSO (see 6.6, “HCD steps to build 
production IODF” on page 293).

Processing mode Select option 2 to save the results of the migration. (Prior 
to using 2, however, try to migrate using option 1, in order 
to validate the operation.

Migrate options Select option 3 for PCHIDS. Only the PCHIDs are migrated 
into the work IODF.

 z/OS V1.9 HCD                               
Command ===> ______________________________________________________
                                                                   
                           Hardware Configuration                  
                                                                   
Select one of the following.                                       
                                                                   
5   1.  Define, modify, or view configuration data                 
    2.  Activate or process configuration data                     
    3.  Print or compare configuration data                        
    4.  Create or view graphical configuration report              
    5.  Migrate configuration data                                 
    6.  Maintain I/O definition files                              
    7.  Query supported hardware and installed UIMs                
    8.  Getting started with this dialog                           
    9.  What's new in this release                                 
                                                                   
For options 1 to 5, specify the name of the IODF to be used.       
                                                                   
I/O definition file . . . 'SYS6.IODF39.WORK'  + 

 ----------- Migrate Configuration Data ----------

Select one of the following tasks.         

1_  1.  Migrate IOCP/OS data               
2.  Migrate switch configuration data 
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Figure 6-36   HCD - Migrate IOCP / MVSCP / HCPRIO Data

5. HCD displays any errors or warning messages as a result of the migration action. In our 
example, we did not receive any messages other than the one indicating that the 
migration was successful (Figure 6-37).

Figure 6-37   HCD - Migration Message List

This is the message that you should get. At this point, the work IODF contains both the 
CHPID definitions and the mapping to PCHIDs that was done using the CHPID Mapping 
Tool.

6. Press PF3 and you should receive the following message:

IOCP/Operating system deck migration processing complete, return code = 0.

7. Press PF3 again.

------------------- Migrate IOCP / MVSCP / HCPRIO Data --------------------

                                                                           
Specify or revise the following values.                                    
                                                                           
Processor ID . . . . . . . . . . . . SCZP203   +   CSS ID . . . . . . _  + 
OS configuration ID  . . . . . . . . TEST2097  +                           
                                                                           
Combined IOCP/MVSCP input data set . _____________________________________ 
IOCP only input data set . . . . . . 'SYS6.IODF39.IOCPOUT.SCZP203'       
MVSCP only or HCPRIO input data set  _____________________________________ 
           Associated with processor ________  +                           
                           partition ________  +                           
Processing mode  . . . . . . . . . . 2   1.  Validate                      
                                         2.  Save                          
                                                                           
Migrate options  . . . . . . . . . . 3   1.  Complete                      
                                         2.  Incremental                   
                                         3.  PCHIDs                        
MACLIB used  . . . . . . . 'SYS1.MACLIB'                                   
Volume serial number . . . ______  + (if not cataloged) 

 -------------------------- Migration Message List --------------------------- 
    Query  Help                                                                
  --------------------------------------------------------------------------   
                                                                   Row 1 of 2  
  Command ===> ___________________________________________ Scroll ===> CSR 
                                                                               
  Messages are sorted by severity. Select one or more, then press Enter.       
                                                                               
  / Statement  Orig Sev Message Text                                           
  _                 I   I/O configuration successfully written to the IODF     
  #                     SYS6.IODF39.WORK. 
***************************** Bottom of data ******************************  
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6.6  HCD steps to build production IODF
In order to make use of the definitions that were updated in HCD, we must create a production 
IODF from the work IODF. This is done with the following steps:

1. From the HCD main menu, select option 2, Activate or process configuration data 
(Figure 6-38).

Figure 6-38   HCD - Main menu, select Activate or process configuration data

2. The Activate or Process Configuration Data panel is displayed (Figure 6-39). Select option 
1, Build production I/O definition file, and press Enter.

Figure 6-39   HCD - Activate or Process Configuration Data, select Build production IODF

3. The Message List panel is displayed (Figure 6-40). Verify that you have only Severity W 
warning messages, and that they are normal for the configuration. Correct any messages 

 z/OS V1.9 HCD                               
Command ===> ______________________________________________________
                                                                   
                           Hardware Configuration                  
                                                                   
Select one of the following.                                       
                                                                   
2   1.  Define, modify, or view configuration data                 
    2.  Activate or process configuration data                     
    3.  Print or compare configuration data                        
    4.  Create or view graphical configuration report              
    5.  Migrate configuration data                                 
    6.  Maintain I/O definition files                              
    7.  Query supported hardware and installed UIMs                
    8.  Getting started with this dialog                           
    9.  What's new in this release                                 
                                                                   
For options 1 to 5, specify the name of the IODF to be used.       
                                                                   
I/O definition file . . . 'SYS6.IODF39.WORK'  + 

 ----- Activate or Process Configuration Data -----
                                                   
                                                   
 Select one of the following tasks.                
                                                   
 1_  1.  Build production I/O definition file      
     2.  Build IOCDS                               
     3.  Build IOCP input data set                 
     4.  Create JES3 initialization stream data    
     5.  View active configuration                 
     6.  Activate or verify configuration          
         dynamically                               
     7.  Activate configuration sysplex-wide       
     8.  Activate switch configuration             
     9.  Save switch configuration                 
     10. Build I/O configuration statements        
     11. Build and manage S/390 microprocessor     
         IOCDSs and IPL attributes                 
     12. Build validated work I/O definition file 
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that should not occur and try to build the production IODF again. Continue this process 
until you have no messages that indicate problems.

Figure 6-40   HCD - Message List (building Production IODF)

4. Press PF3 to continue.

5. The Build Production I/O Definition File panel is displayed (Figure 6-41). Fill in the fields 
Production IODF name and Volume serial number, and then press Enter.

Figure 6-41   HCD - Build Production I/O Definition File

6. The Define Descriptor Fields panel is displayed (Figure 6-42). Press Enter to accept the 
descriptor fields selected by HCD, or enter different values and then press Enter.

Figure 6-42   HCD - Define Descriptor Fields

 ------------------------------ Message List --------------------------------
   Save  Query  Help                                                         
 --------------------------------------------------------------------------  
                                                                  Row 1 of 4 
 Command ===> ___________________________________________ Scroll ===> CSR    
                                                                             
 Messages are sorted by severity. Select one or more, then press Enter.      
                                                                             
 / Sev Msg. ID  Message Text                                                 
 _ W   CBDG061I Switch control unit must be defined for switch 61.           
 _ W   CBDG061I Switch control unit must be defined for switch 62.           
 _ W   CBDG061I Switch control unit must be defined for switch 63.           
 _ W   CBDG061I Switch control unit must be defined for switch 64.           
 ***************************** Bottom of data ****************************** 

 ------------- Build Production I/O Definition File ------------
                                                                
                                                                
 Specify the following values, and choose how to continue.      
                                                                
 Work IODF name . . . : 'SYS6.IODF39.WORK'                    
                                                                
 Production IODF name . 'SYS6.IODF39'______________________   
 Volume serial number . BH8ST1  +                               
                                                                
 Continue using as current IODF:                                
 2   1.  The work IODF in use at present                        
     2.  The new production IODF specified above                

 ------------------- Define Descriptor Fields ----------------

 Specify or revise the following values.                      
                                                              
 Production IODF name  . : 'SYS6.IODF39'                    
                                                              
 Descriptor field 1  . . . SYS6 
 Descriptor field 2  . . . IODF39 
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7. HCD displays the following message, indicating that the production IODF was 
successfully created:

Production IODF SYS6.IODF39 created.

Proceed to the next section to implement the configuration on the 2097.

6.7  Implementing the processor configuration on the 2097
At this point there is a production IODF, which is called SYS6.IODF39. Now the IOCDS 
component of the IODF needs to be updated on the new CPC that is being installed (for 
example, SCZP203) and activated (POR) using this IOCDS. The final step is to POR the 
processor using this IOCDS. 

Describing how to POR the new hardware is beyond the scope of this book.

There are 2 possible ways to load the IOCP Statements onto the 2097 Service Element 
IOCDS:

� HCD, using Option 2.11

� HMC, using Stand-Alone Input/Output Configuration Program

While both are valid methods to write the new configuration to the IOCDS, we recommend 
using HCD Option 2.11. However, your new 2097 processor and Service Element may not be 
connected to the system where the configuration was generated or cannot be connected to 
any system where HCD is running. In that case you will need to use the Stand-Alone IOCP 
process.

First we describe using HCD Option 2.11.

Updating the IOCDS using HCD Option 2.11
1. From the HCD main menu, select option 2, Activate or process configuration data 

(Figure 6-43 on page 296). Ensure that the IODF is the production one created in the 
previous step. Press Enter.
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Figure 6-43   HCD - main menu, select Activate or process configuration data

2. The Activate or Process Configuration Data panel is displayed (Figure 6-44 on page 297). 
Select option 11, Build and manage S/390 microprocessor IOCDSs and IPL 
attributes.

Note: In this example, we are assuming that we have connectivity to the new 2097 via the 
HMC LAN in order to create an IOCDS from which we power-on reset. This may not be 
the case for all readers. 

If the new 2097 is not accessible from the HMC LAN, we would need to copy the IOCP 
statements onto a USB Flash Memory Drive and import them on to the 2097 HMC to run a 
stand-alone IOCP. Creating a file on a USB Flash Memory Drive can be done using the 
same process that is used to create an IOCP input file for the CHPID Mapping Tool.

 z/OS V1.9 HCD                              
 Command ===> _____________________________________________________
                                                                   
                            Hardware Configuration                 
                                                                   
 Select one of the following.                                      
                                                                   
 2   1.  Define, modify, or view configuration data                
     2.  Activate or process configuration data                    
     3.  Print or compare configuration data                       
     4.  Create or view graphical configuration report             
     5.  Migrate configuration data                                
     6.  Maintain I/O definition files                             
     7.  Query supported hardware and installed UIMs               
     8.  Getting started with this dialog                          
     9.  What's new in this release                                
                                                                   
 For options 1 to 5, specify the name of the IODF to be used.      
                                                                   
 I/O definition file . . . 'SYS6.IODF39'  +

Tip: The Support Element can now read an IOCP file that has been written to a USB 
Flash Memory Drive.
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Figure 6-44   HCD - Activate or Process Configuration Data, select Build IOCDSs

3. The S/390 Microprocessor Cluster List panel is displayed (Figure 6-45). Use a forward 
slash (/) to select the new 2097 from the list in order to update one of its IOCDSs. Press 
Enter.

Figure 6-45   HCD - S/390 Microprocessor Cluster List

4. The Actions on selected CPCs panel is displayed (Figure 6-46). Select option 1, Work 
with IOCDSs, and press Enter.

Figure 6-46   HCD - Actions on selected CPCs, Work with IOCDSs

5. The IOCDS List panel is displayed (Figure 6-47 on page 298). Select the IOCDS that you 
wish to update for the 2097 install by typing a slash (/), then press Enter.

 z/OS V1.9 HCD                  
----- Activate or Process Configuration Data ------
                                                   
                                                   
 Select one of the following tasks.                
                                                   
 11  1.  Build production I/O definition file      
     2.  Build IOCDS                               
     3.  Build IOCP input data set                 
     4.  Create JES3 initialization stream data    
     5.  View active configuration                 
     6.  Activate or verify configuration          
         dynamically                               
     7.  Activate configuration sysplex-wide       
     8.  Activate switch configuration             
     9.  Save switch configuration                 
     10. Build I/O configuration statements        
     11. Build and manage S/390 microprocessor     
         IOCDSs and IPL attributes                 
     12. Build validated work I/O definition file 

Goto  Query  Help                                                              
S/390 Microprocessor Cluster List             Row 1 of 3 

Command ===> _______________________________________________ Scroll ===> CSR   
                                                                               
Select one or more CPCs, then press Enter.                                     
                                                                               
  --------------CPC--------------   IODF                                       
/ SNA Address        Type   Model   Processor ID                               
/ USIBMSC.SCZP203  2097   E26     SCZP203                                    
******************************* Bottom of data ********************************

 ----------------- Actions on selected CPCs ------------------- 
                                                                
                                                                
   Select by number or action code and press Enter.             
                                                                
   1_  1.  Work with IOCDSs . . . . . . . . . . (s)             
       2.  Work with IPL attributes . . . . . . (i)             
       3.  Select other processor configuration (p)             
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Figure 6-47   HCD - IOCDS List

6. The Actions on selected IOCDSs panel is displayed (Figure 6-48). Select option 1, 
Update IOCDS and press Enter.

Figure 6-48   HCD - Actions on selected IOCDSs

7. The Build IOCDSs panel is displayed (Figure 6-49). Verify that all the information is 
correct.

Fill in the field Title1 and press Enter.

Figure 6-49   HCD - Build IOCDSs

 Goto  Query  Help                                                            
 ------------------------------------------------------------------------------ 
                                   IOCDS List          Row 1 of 4 More:       > 
 Command ===> _______________________________________________ Scroll ===> CSR  
                                                                                
 Select one or a group of IOCDSs, then press Enter.                             
                                                                                
                                          -----Token Match----- Write           
 / IOCDS       Name     Type   Status     IOCDS/HSA IOCDS/Proc. Protect         
 _ A0.SCZP203  DIAG00   LPAR   POR        Yes       No          Yes-POR         
 / A1.SCZP203  DIAG01   LPAR   Alternate  No        No          No              
 _ A2.SCZP203  DIAG02   LPAR   Alternate  No        No          No              
 _ A3.SCZP203  DIAG03   LPAR   Alternate  No        No          No              
 ******************************* Bottom of data ********************************

 ---------------- Actions on selected IOCDSs ----------------- 
                                                                
                                                                
   Select by number or action code and press Enter.             
                                                                
   1_  1.  Update IOCDS . . . . . . . . . . . . (u)             
       2.  Switch IOCDS . . . . . . . . . . . . (s)             
       3.  Enable write protection  . . . . . . (e)             
       4.  Disable write protection . . . . . . (w)             

 ------------------------------- Build IOCDSs --------------------------------- 
                                                                    Row 1 of 1  
   Command ===> ___________________________________________ Scroll ===> CSR  
                                                                                
   Specify or revise the following values.                                      
                                                                                
   IODF name . . . . . . . . . : 'SYS6.IODF39' 
                                                                                
   Title1 . IODF39 _________________________________________________________    
   Title2 : SYS6.IODF39 - 2007-11-28 18:49 
                                                                                
                              Write IOCDS in                                    
   IOCDS        Switch IOCDS  preparation of upgrade                            
   A1.SCZP203   No            No                                                
   ***************************** Bottom of data ******************************  
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8. The Job Statement Information panel is displayed (Figure 6-50). Fill in the job statements 
as required by the installation and press Enter. HCD submits the job to update the IOCDS.

Figure 6-50   HCD - Job Statement Information

9. Verify the job output to ensure that the IOCDS was written without error and to the correct 
IOCDS. You should receive a message like the following:

ICP057I IOCP JOB WIOCDS SUCCESSFUL. LEVEL A1 IOCDS REPLACED.

Now if you return to HCD option 2.11 and view the IOCDS, note that the SNA Address is 
at USIBMSC.SCZP203 (Figure 6-51).

Figure 6-51   HCD - IOCDS with replacement IODF

Figure 6-52 shows the Alternate status.

Figure 6-52   HCD - IOCDS showing Alternate Status

 ------------------------- Job Statement Information -------------------------- 
                                                                                  
   Specify or revise the job statement information.                             
                                                                                
                                                                                
   Job statement information                                                    
   //WIOCDS  JOB (ACCOUNT),'NAME'                                               
   //*                                                                          
   //*                                                                          
   //*                                                                          

Goto  Query  Help                                                              
 ------------------------------------------------------------------------------ 
                       S/390 Microprocessor Cluster List             Row 1 of 4 
 Command ===> _______________________________________________ Scroll ===> CSR  
                                                                                
 Select one or more CPCs, then press Enter.                                     
                                                                                
   --------------CPC--------------   IODF                                       
 / SNA Address        Type   Model   Processor ID                               
 s USIBMSC.SCZP203    2097 E26 SCZP203                                    
 ******************************* Bottom of data ********************************

Goto  Query  Help                                                            
 ------------------------------------------------------------------------------ 
                                   IOCDS List          Row 1 of 4 More:       > 
 Command ===> _______________________________________________ Scroll ===> CSR  
                                                                                
 Select one or a group of IOCDSs, then press Enter.                             
                                                                                
                                          -----Token Match----- Write           
 / IOCDS       Name     Type   Status     IOCDS/HSA IOCDS/Proc. Protect         
 _ A0.SCZP203  DIAG00   LPAR   POR        Yes       No          Yes-POR         
 _ A1.SCZP203  IODF39   LPAR   Alternate  Yes       Yes         No              
 _ A2.SCZP203  DIAG02   LPAR   Alternate  No        No          No              
 _ A3.SCZP203  DIAG03   LPAR   Alternate  No        No          No              
 ******************************* Bottom of data ********************************
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Updating the IOCDS using Stand-Alone Input/Output Config Program

Copy the IOCP statements that were generated using HCD option 2.3 onto a USB Flash 
Memory Drive and retain.

1. Log on using SYSPROG authority to the HMC workstation supplied with the 2097, as 
opposed to a remote Web browser, and select the new 2097, assuming it has been 
defined to the Defined CPCs Work Area.

2. Perform a Power-on Reset using one of the Reset profiles and Starter IOCDSs provided 
on the processor during installation. This is done to create an environment on the 
processor that will allow you to run the Stand-Alone IOCP process.

3. When the Power-on Reset is complete, activate one of the logical partitions with at least 
128MB of storage and use this partition to run the I/O Configuration Program.

4. Under Systems Management, click Servers to expand the list; click a server to select it (in 
this example we selected SCZP203).

5. On the Tasks pad, click Recovery to expand it, and select Single Object Operations.

6. Click Yes to confirm connection.

7. On the Tasks pad, find CPC Configuration, and select Input/output (I/O) Configuration.

8. Click the radio button for the Data Set you wish you load the IOCDS into.

Figure 6-53   HMC - Select IOCDS for Stand-alone IOCP 

9. Click Options → Import Source File → Hardware Management Console USB Flash 
Memory Drive.

Note: Refer to the Stand-Alone Input/Output Configuration Program User’s Guide, 
SB10-7152, for detailed information about the following steps.
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Figure 6-54   HMC - Import Source File

10.Select the source file name and click OK.

Figure 6-55   HMC - Select source file

11.Now that the IOCP statements have been imported, perform a Build Data Set to:

– Process the source file data for the selected I/O configuration.

– Check the syntax and validates the configuration.

– Generate an IOCDS and, if there are no errors, writes the IOCDS to the support 
element hard disk.

– Write the I/O configuration source (IOCS) file to the support element hard disk with any 
IOCP messages embedded in the file.

Click OK. This initiates a load of the IOCP code into the targeted LPAR (previously 
activated) and the program will perform the Build Data Set steps.

If the build was successful and there are no caution or warning messages, the resultant 
IOCDS has been written to the support element hard disk.

This IOCDS is now ready to be selected via a Reset Profile and the 2097 may be activated 
(Power-on Reset) with the production IODF.
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6.8  HMC steps for activation profiles

Build the Production Reset Profile and point to required IOCDS
Now that the IODF has been written to an IOCDS, a Reset (Power-on Reset) Profile must be 
built to point to that IOCDS. This Reset Profile is used to power-on reset the new 2097 after it 
has been handed over from the IBM service representative.

1. Log on using SYSPROG authority to the HMC workstation supplied with the 2097 or use a 
remote Web browser and select the new 2097.

2. Under Systems Management, click Servers to expand the list; click the server to select it 
(in this example we selected SCZP203).

3. On the Tasks pad, click Operational Customization to expand it, and select 
Customize/Delete Activation Profiles.

4. Select the DEFAULT Reset Profile and click Customize selected profile.

5. Save this DEFAULT profile with a new Profile name to be referred to when the power-on 
reset is required (for example, SCZP203).

6. Select the new Profile and click Customize selected profile.

7. Click the IOCDS that you just updated in the previous step. 

8. Message ACTB0PDL is displayed (Figure 6-56).

 

Figure 6-56   HMC - Activation Profiles message ACTB0PDL

Depending on the circumstances, you may wish to answer Yes or No. You can now review 
the Partition Activation List if you want to.

STP configuration
STP configuration should be reviewed to ensure that the correct External Time Source has 
been configured and that you are connected to the correct Coordinated Time Network. 

Refer to Chapter 7, “Server Time Protocol setup” on page 305 for details. 

Build Image Profiles
While still in the Reset Profile, you can now review the Image Profile attributes.

Build Load Profiles
Go through and create Load (IPL) Profiles using the DEFAULTLOAD Load profile as a 
skeleton for all the logical partitions that you are IPLing on this processor.
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Build Load Members in SYS#.IPLPARM
You require Load Members defined in SYS#.IPLPARM when IPLing from the new 2097.

Additionally, if you are going to use the HWNAME parameter to point to the Processor.ID in 
the Load members, then make sure you use the correct name (SCZP203, in our example).

Performing a Power-on reset 
The 2097 is now ready to be Activated (Power-on Reset) using the Production Reset Profile.
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Chapter 7. Server Time Protocol setup

This chapter describes the STP setup when a new System z10 EC is installed. It contains the 
following sections:

� External Time Source setup

� Add the System z10 EC to an existing CTN

� Create a new STP-only CTN

7
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7.1  External Time Source setup

To maintain time accuracy, the STP facility supports connectivity to an external time source. 
Using an external time source, regular adjustments can be performed either manually or 
automatically. 

In a Mixed CTN, if the Sysplex Timer has an external time source configured, it will be used 
and time accuracy will be maintained by the Sysplex Timer. The Sysplex Timer ETS 
operation is not discussed in this book.

In an STP-only CTN the Sysplex Timer is no longer used. Therefore, if an external time 
source is to be used to maintain time accuracy, it should be configured before: 

� A migration from a Mixed to STP-only CTN. 

� Configuration of a new STP-only CTN. If the ETS is used to initialize the Coordinated 
Server Time, the ETS must be configured before the time is initialized. 

The ETS can be configured to:

� Dial out to telephone time services.

Using the dial out to telephone time service consists of two steps: 

a. Configure an HMC to dial out to telephone time services. At the Customize Outbound 
Connectivity task on the HMC, select both of the following check boxes: 

• Enable local system as a call-home server

• Allow external time source dialing using the local modem 

This enables the configuration of the external time source. Configuration of the ETS 
should be done on multiple HMCs in order to have an alternate HMC for ETS queries. 

b. Add scheduled operations to the Preferred Time Server (PTS) and the Backup Time 
Server (BTS), if applicable, to access the ETS. The HMC and SE support automatic 
retrieval of the time from a time service and automatic update of CST on a scheduled 
basis. 

Setting up a schedule to dial out to the time service automatically can be done from the 
HMC. One of the following can be requested:

• A single scheduled operation at a specified date and time

• A recurring scheduled operation that occurs at a specified frequency

Scheduled operations that are to be executed by a server that is not the Current Time 
Server are ignored. At the scheduled time the SE requests the HMC to dial out to the 
time service; the HMC sends the difference with the time obtained from the service to 
the STP facility, which will make gradual adjustments by steering the CST to the time 
obtained from the external time source.

� Access an NTP server.

The NTP server must be defined on the SE of the servers that can be assigned as Current 
Time Server. NTP becomes active once a server is configured as the Current Time Server 
within the CTN.

The ETS configuration of the PTS and the BTS can be different. For example, the PTS 
may use NTP, while the BTS is configured for Dial out from the HMC. The actual ETS type 
being used depends on which server is currently the Current Time Server. A CTS change 
may result in using a different ETS.
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7.1.1  ETS dial out configuration 

HMC setup for ETS dial out configuration
The HMC setup can be considered as the first step of ETS dial out configuration. It makes the 
HMC “capable” of dialing up to a time service provider.

To configure the dial out telephone connection:

1. Select the Service Management task on the Hardware Management Console application. 

2. Click the Customize Outbound Connectivity option available in the Work Panel. The 
Customize Outbound Connectivity dialog is displayed (Figure 7-1). Make sure the “Enable 
local system as a call-home server” check box is selected to enable configuration of the 
external time source.

Figure 7-1   Customize Outbound Connectivity - External Time Source 

3. On the External Time Source tab, check “Allow external time source dialing using the local 
modem” to enable configuration of the Protocol. 

Three protocols are available: 

– NIST (National Institute of Standards and Technology) representing the Automated 
Computer Time Service (ACTS), typically used in the USA

– IEN (Instituto Elettrotecnico Nazionale) representing the Telephone Date Code (CTD), 
typically used in Europe

– NRC (National Research Council) representing the Canadian Time Service (CTS), 
typically used in Canada

The countries’ Time Service provider must be contacted to determine which protocol they 
support and what phone number should be used.

Note: Independent of the type of ETS configuration, dial out HMC or NTP, synchronization 
to the ETS is requested by the Support Element of the CTS. 
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4. Click the Modem Configuration button. The Customize Modem Settings dialog allows 
you to specify tone or pulse dialing, Wait for dial tone, Enable speaker, and Dial prefix 
(Figure 7-2). Make the appropriate selections and click OK.

Figure 7-2   Customize Modem Settings panel

5. Enter the appropriate Phone number in the Add External Time Source Phone Number 
dialog (Figure 7-3).

Figure 7-3   Add External Time Source Phone Number panel

6. When the dial-out phone number has been added, the Test button in the Customize 
Outbound Connectivity panel becomes selectable. Click Test to ensure that the correct 
configuration and connectivity to the ETS service provider has been accomplished. See 
Figure 7-4.
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Figure 7-4   Test External Time Source Phone Number 

This completes the first step of the ETS dial out configuration. 

The HMC is now capable of handling ETS requests. We recommend configuring a second 
HMC for ETS dial out capability to have redundancy in case of an HMC failure. This can be 
accomplished by performing the same steps for the second HMC that has all the CTS 
candidates in its Server group.

SE setup for ETS dial out configuration
The second part of the ETS dial out configuration adds scheduled operations to the Support 
Element of those Servers that are CTS candidates (PTS and BTS) and are using the HMC 
ETS dial out function.

1. Select the Server as the target object, then select Operational Customization → 
Customize Operational Customization → Options → New. This opens the Add a 
Scheduled Operation dialog as shown in Figure 7-5 on page 310.
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Figure 7-5   Add a Scheduled Operation

2. Select the “Access external time source” radio button and click OK. The Set up a 
Scheduled Operation dialog opens as shown in Figure 7-6.

Figure 7-6   Set up a Scheduled Operation/Date and Time

3. Enter a Date and Time when the scheduled operation should be performed. The default 
Time Window of 10 minutes should be sufficient in the case this scheduled operation gets 
prevented by any resource constraint. For the ETS query we recommend setting up a 
repeated scheduled operation as a periodic time adjustment to continuously maintain time 
accuracy. The repeat option is shown in Figure 7-7. 

4. Select the “Set up a repeated scheduled operation” radio button. Depending on the time 
accuracy requirement, select one or more days the ETS should be contacted. Selecting 
an interval of one week will have the ETS device contacted once a week on the days 
previously selected. Check the option “Repeat indefinitely” to make sure this scheduled 
operation will never expire.
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Figure 7-7   Set up a Scheduled Operation/Repeat

As previously mentioned, this scheduled operation setup needs to be done for those SEs that 
are using the HMC ETS dial out function, so the same scheduled operation setup may need 
to be done for another SE, if relevant.

7.1.2  Configure NTP as the External Time Source
STP uses time adjustment only from the NTP server configured on the Current Time Server. 
However, in an STP-only CTN where the NTP client function is used, we recommend that the 
NTP function be configured on each server that can be assigned the CTS role. It is typical for 
the CTS to be the Preferred Time Server (PTS). If the PTS has an ETS configured, it is highly 
recommended to also configure the ETS on the Backup Time Server. The NTP time server 
will only be used to adjust the Coordinated Server Time if the server is the Current Time 
Server.

To configure the NTP Time Server, perform the following steps:

1. Click the Server to be set up for NTP on the HMC. 

2. Click the System (Sysplex) Time option available in the Tasks section. Select the ETS 
Configuration tab.

The ETS Configuration tab is displayed for all servers that support NTP to allow an ETS 
configuration for every server that could potentially become the CTS in the future. 

Note: Servers that do not support NTP (z990, z890) will not display the ETS 
Configuration tab, even though these servers can be part of the STP-only CTN.
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Figure 7-8   ETS Configuration

3. Select the Use NTP radio button to display the NTP server information table. When at 
least one Configured check box is selected, it indicates that the IP address or URL 
entered should be used as the NTP server address. The use of a URL requires that the 
SE be customized with Domain Name Services enabled. 

Use the task Customize Network Settings → Name services in the Support Element 
Console Applications.

Refer to the manual System z10 Support Element Operations Guide V2.10.0, SC28-6868 
or System z9 Support Element Operations Guide (Version 2.9.2) SC28-6860 for 
information about how to customize network settings for the Support Element.

4. Click the Query button to test the access and fill in the Stratum, Dispersion, Source, and 
Status table fields for the corresponding NTP server.

5. Click the Apply button to set NTP server configuration as shown in Figure 7-8.

The Dispersion, expressed in microseconds, on the ETS Configuration tab is an indication of 
the accuracy of the time obtained from the NTP server time relative to its source. For 
example, if the NTP server indicates a time of t0 and a dispersion of 100, it means that the 
time retrieved from the NTP server is t0 plus or minus 100 microseconds relative to the NTP 
server’s source. If the NTP server’s time source is an external source, like GPS or WWV, the 
NTP server’s source will be accurate to UTC by the dispersion value. If the NTP server lost 
connection to the external source and is running off of its internal clock, whether calibrated or 
uncalibrated, the accuracy relative to UTC cannot be guaranteed.

The Source field contains a description of the time source for the NTP server provided as 
information by the NTP server. Typically, the source for Stratum 1 servers will be GPS, or 
radio signals such as WWV. A list of examples of known Stratum 1 source values is shown in 
Table 7-1. For NTP servers not at Stratum 1, this field contains the IP address of the higher 
stratum NTP server. This field is blank if the server is not available.
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Table 7-1   NTP Stratum 1 clock sources

When both NTP servers are configured, the NTP client code will select the NTP server with 
the highest Stratum level (Stratum 1 will be selected over Stratum 2). If the Stratum levels are 
the same, the NTP server with the lowest dispersion is selected. Entries with unsuccessful 
status are not considered as potential time sources. The specific NTP server selection occurs 
during each access.

NTP server access is driven from the CTS, once every 10 minutes, with an adjust time 
occurring once an hour. In case of a bad NTP server access, a hardware message is posted 
to alert the customer to take corrective action. 

For servers that are PTS or BTS, but not the CTS, the NTP server access is driven from the 
CTS, once every 10 minutes, with a time adjustment issued every hour. This adjustment is 
ignored by the STP facility if the server is not the CTS. This monitoring is done to detect NTP 
server problems. In the case of NTP server access failures or changes in stratum level or 
source ID, a hardware message is posted. For all other servers, the NTP server is not 
accessed.

NTP source 
ID

Displayed 
source text

Description of source ID

ACTS ACTS NIST telephone modem service

CESM Cesium Calibrated Cesium clock

CHU CHU Ottawa (Canada) Radio 3330, 7335, 14760 kHz

DCF DCF Mainflingen (Germany) Radio 77.5 kHz

GOES GOES Geostationary Orbit Environment Satellite

GPS GPS Global Positioning Service

HBG HBG Prangins, HB 75 kHz

IRIG IRIG Inter-Range Instrumentation Group

JJY JJY Fukushima, JP 40 kHz, Saga, JP 60 kHz

LOCL Local un-calibrated local clock

LORC LORAN-C LORAN-C radio-navigation system

MSF MSF Rugby (UK) Radio 60 kHz

OMEG OMEGA OMEGA radio-navigation system

PPS PPS Calibrated quartz clock or other pulse-per-second source

PTB PTB PTB (Germany) telephone modem service

RBDM Rubidium Calibrated Rubidium clock

TDF TDF Allouis (France) Radio 164 kHz

USNO USNO USNO telephone modem service

WWV WWV Ft. Collins (US) Radio 2.5, 5, 10, 15, 20 MHz

WWVB WWVB Boulder (US) Radio 60 kHz

WWVH WWVH Kaui, Hawaii (US) Radio 2.5, 5, 10, 15 MHz
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The NTP server configuration takes effect when the user clicks the Apply button. The 
information is saved on the Support Element. When the CTS is configured in an STP-only 
CTN, NTP accesses begin using the saved information.

No user message is displayed on the HMC when STP accesses the NTP server. When a time 
adjustment is requested, an entry message is generated in the Support Element Console 
Events log. An example is shown in Table 7-2. 

To view the console log from the HMC application:

1. Select the CTS. 

2. Select Recovery → Single Object Mode to log on to the Support Element. 

3. From the SE workplace, select Service Management → View Console Events. 

Table 7-2    Support Element Console events

This completes the configuration of an external time source. The ETS will be ready for use 
when an STP-only CTN is activated, either as a new STP-only CTN or as a result of a 
migration from a Mixed CTN.

7.2  Add the System z10 EC to an existing CTN

The starting point for this implementation is a Mixed CTN consisting of one or more servers 
and Sysplex Timers. The purpose of this section is to describe how to implement the System 
z10 EC into this existing Mixed CTN. 

The server can be added in two different ways:

� A Mixed CTN, using either ETR or STP timing mode. 

The starting point for this implementation is a Mixed CTN consisting of one or more 
servers and Sysplex Timers. The System z10 EC can join this Mixed CTN in two ways:

– Using ETR timing mode: In this case, the System z10 EC needs ETR connectivity 
established to the existing Sysplex Timers. 

– Using STP timing mode: In this case, Sysplex Timer connectivity is not required. If the 
connection exists, the ETR ports on the System z10 EC must be disabled as part of the 
implementation.

It is assumed that the System z10 EC has coupling link connectivity to the existing CTN. 
For more information about coupling links and STP connectivity refer to Server Time 
Protocol Planning Guide, SG24-7280.

� An STP-only CTN. 

Date Time Console event

09/10/2007 12:18:54.570 This CPC is requesting an adjustment to the Coordinated Server Time 
after contacting an External Time Source via NTP [0.000798 seconds].

09/10/2007 11:18:54.550 This CPC is requesting an adjustment to the Coordinated Server Time 
after contacting an External Time Source via NTP [-0.036087 seconds].

09/10/2007 10:18:54.600 This CPC is requesting an adjustment to the Coordinated Server Time 
after contacting an External Time Source via NTP [-0.157594 seconds].
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7.2.1  Add the System z10 EC to an existing Mixed CTN in ETR timing mode

The starting point for this implementation is a Mixed CTN consisting of one or more servers 
and Sysplex Timers. The purpose of this section is to describe how to implement the System 
z10 EC to this existing Mixed CTN using ETR timing mode:

� Set the CTN ID for the System z10 EC.

� Attach and enable the ETR ports.

In our example the existing Mixed CTN consists of two servers, named SCZP101 and 
SCZP901, using CTN ID [ITSOPOK] - [31]. 

Setting the CTN ID
Because this is a Mixed CTN, both the ETR ID and the STP ID must be defined in order to 
have the System z10 EC join the Mixed CTN. 

1. From the ETR Configuration tab set the state to Enabled for both Port 0 and Port 1, and 
enter the ETR Network ID to match one of the existing Mixed CTNs. Click Apply. The CTN 
ID for the server becomes [ ] - [31], in line with the value already defined in our example 
Mixed CTN. See Figure 7-9. 

Figure 7-9   Define ETR Network ID 

2. From the STP Configuration tab enter the STP ID. The ETR Network ID field is read only. It 
displays the value entered in the previous step. See Figure 7-10.

Figure 7-10   STP Configuration tab: Define STP ID

3. Click Apply. The CTN ID for the server becomes [ITSOPOK] - [31], in line with the value 
defined for the existing Mixed CTN.
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Verification 
The server STP configuration can be verified from the Timing Network tab shown in 
Figure 7-11.

Figure 7-11   Timing Network tab, SCZP201 

The Timing network type now indicates that the server is in a Mixed CTN, and is a member of 
a Coordinated Timing Network with CTN ID = [ITSOPOK] - [31].

The STP Status page shown in Figure 7-12 indicates that the server timing mode is External 
Time Reference (ETR). 

The STP Status tab also reflects the fact that coupling links are initialized for STP since both 
ends of the link are configured. Similar information is now reflected on the STP Status tab at 
the other end of the links, on server SCZP101 and SCZP901. 
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Figure 7-12   STP Status tab, SCZP201

Once a z/OS image has been IPLed on server SCZP201, the response to the Display ETR 
command, message IEA282I, now indicates the CTN ID, as shown in Example 7-1. The 
message also indicates the synchronization mode along with the ETR details. 

Example 7-1   D ETR command and response in ETR mode

D ETR                                                    
IEA282I 10.51.52 TIMING STATUS 512                       
SYNCHRONIZATION MODE = ETR                   
  CPC PORT 0   <== ACTIVE       CPC PORT 1   
  OPERATIONAL                   OPERATIONAL  
  ENABLED                       ENABLED      
  ETR NET ID=31                 ETR NET ID=31
  ETR PORT=00                   ETR PORT=00  
  ETR ID=00                     ETR ID=01 
  THIS SERVER IS PART OF TIMING NETWORK ITSOPOK -31 

This completes the procedure for adding the System z10 EC to an existing CTN using ETR 
timing mode. 

The System z10 EC is now part of the CTN and is using the Sysplex Timer as time source.

7.2.2  Add the System z10 EC to an existing Mixed CTN in STP timing mode

The starting point for this implementation is a Mixed CTN consisting of one or more servers 
and Sysplex Timers. The purpose of this section is to describe how to implement the System 
z10 EC to this existing Mixed CTN using STP timing mode.
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In our configuration we are showing a Mixed CTN consisting of servers SCZP101 and 
SCZP901. Server SCZP201 will be added to this CTN using STP timing mode.

If STP is enabled, the new System z10 EC can be configured to join the CTN. This is always 
done by setting the CTN ID on the new server. Even when the new server is not connected to 
the Sysplex Timer it can be configured to join the Mixed CTN using STP timing mode. The 
System z10 EC to be added needs to have coupling link connectivity to other STP-configured 
servers in the CTN so that STP messages can flow between servers.

The addition of a new server is accomplished by defining its CTN ID to match the CTN ID 
already in use by the Mixed CTN.

From the ETR Configuration tab 
Set both Port 0 and Port 1 states to Disabled and enter the ETR Network ID to match the one 
of the existing Mixed CTN. Click Apply. The CTN ID for the server becomes [ ] - [31], in line 
with the value already defined in our example Mixed CTN. See Figure 7-13.

Figure 7-13   Define ETR Network ID 

From the STP Configuration tab
From the STP Configuration tab enter the STP ID. The ETR Network ID field is read only. It 
displays the value entered in the previous step. See Figure 7-14.

Figure 7-14   STP Configuration tab, define STP ID

Click Apply. The CTN ID for the server becomes [ITSOPOK] - [31], in line with the value 
defined for the Mixed CTN. If the server has coupling link connectivity to other Stratum 1 or 
Stratum 2 servers in the Mixed CTN, STP will automatically join the server to the Mixed CTN. 

Verification
1. The server STP configuration can be verified from the Timing Network tab shown in 

Figure 7-15.
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Figure 7-15   Timing Network tab, SCZP201 

The Timing network type now indicates that the server is in a Mixed CTN, and is a member of 
a Coordinated Timing Network with CTN ID = [ITSOPOK] - [31].

The STP Status page shown in Figure 7-16 indicates that the server timing mode is STP. 

The STP Status tab also reflects the fact that coupling links are initialized for STP since both 
ends of the link are configured. Similar information is now reflected on the STP Status tab at 
the other end of the links, on server SCZP101 and SCZP901. 

Figure 7-16   STP Status tab, SCZP201

Once a z/OS image has been IPLed on Server SCZP201, the response to the Display ETR 
command, message IEA386I, now indicates the CTN ID, as shown in Example 7-2. The 
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message also indicates the synchronization mode along with the number of usable Timing 
links.

Example 7-2   D ETR command and response in ETR mode

D ETR                                                    
IEA386I 10.51.52 TIMING STATUS 512                       
SYNCHRONIZATION MODE = STP 
  THIS SERVER IS A STRATUM 2
  CTN ID = ITSOPOK -31
  NUMBER OF USABLE TIMING LINKS = 2

This completes adding the System z10 EC to an existing CTN using the STP timing mode.

The System z10 EC is now part of the CTN as configured and is using the Sysplex Timer as 
time source. Further reconfigurations, such as migrating to an STP-only CTN, can be done 
following the procedures presented in IBM Server Time Protocol Implementation Guide, 
SG24-7281.

7.2.3  Add the System z10 EC to an existing STP-only CTN

The starting point for this implementation is an STP-only CTN consisting of one or more 
servers. The purpose of this section is to describe how to implement the System z10 EC to 
this existing STP-only CTN.

Setting the CTN ID
In this section we discuss setting the CTN ID. The CTN ID is an identifier that is used to 
indicate whether the server has been configured to be part of a CTN and, if so configured, 
identifies the CTN.

The CTN ID is of the format STP Network ID - ETR Network ID, and is the basis for the 
establishment of the Coordinated Timing Network. 

The format of these fields is CTN ID = “cccccccc - xx”, where “cccccccc” is the STP Network 
ID and “xx” is the ETR Network ID.

� The STP Network ID is case sensitive and is 1 to 8 characters. The valid characters are 
A–Z, a–z, 0–9, ‘-’ and ‘_’.

� The ETR Network ID is always null for an STP-only CTN. 

Setting the STP Network ID
The STP Network ID is entered using the STP Configuration tab, as shown in Figure 7-17. 
The CTN ID must match the one already defined to the existing STP-only CTN. 

Figure 7-17   System (Sysplex) Time - STP Configuration tab
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Message ACT37315 will be posted once the CTN change has been completed as shown in 
Figure 7-18.

Figure 7-18   Message ACT37315

Assigning roles
If the new configuration consists of two or three servers, the second step is to assign other 
roles. The BTS role and optional Arbiter role (recommended for a CTN consisting of three or 
more servers) can be assigned, as shown in Figure 7-19. Because the CTS already exists, 
the Force configuration option is not required, nor recommended, in this step.

Since the existing configuration consists of servers SCZP101 and SCZP901 being assigned 
as PTS and BTS, we are showing the new System z10 EC being configured as the Arbiter. 
Because the assignment of roles does have significant effect on the recovery behavior of the 
CTN it is recommended to have the planning tasks and checklist from Server Time Protocol 
Planning Guide, SG24-7280 reviewed.

The z10 EC can be assigned as either:

� The BTS, if the current configuration consists of only one server.

� The Arbiter, if the current configuration consists of two server.

You also can consider changing the role assignment of any existing server within the CTN. 
This can be done in the same step. However, the recommendations and considerations for 
the roles in an STP-only CTN as explained in the Server Time Protocol Planning Guide, 
SG24-7280 should be reviewed first.

When two or more servers are selected in the System (Sysplex) Time task, it is necessary to 
click the Refresh button to update the displayed configuration information for all servers.

Because assigning or changing roles must be considered a global change to the CTN, any 
change needs to be done from the server that will become the Current Time Server when the 
reconfiguration is complete.

In our example SCZP201 is assigned as Arbiter, as shown in Figure 7-19 on page 322. 
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Figure 7-19   Network Configuration tab, define SCZP201 as Arbiter

The Network Configuration Change Confirmation message ACT37357 is displayed, as shown 
in Figure 7-20.

Figure 7-20   Network Configuration Change Confirmation message ACT37357

Click Yes on the confirmation panel. The Modify Network Configuration successful message 
ACT37341 is displayed, as shown in Figure 7-21.

Figure 7-21   Modify Network Configuration message ACT37341

This completes the CTN configuration. 

Verification 
� For verification from the HMC:

To verify the successful activation of the STP-only CTN, select the STP Status tab 
(shown in Figure 7-22). The STP status indicates the following:

– The Timing state is Synchronized.
– The Timing mode is STP.
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– The Stratum level is 2 because the System z10 EC does have coupling link 
connectivity to the CTS.

– The Local STP Timing links.

Figure 7-22   STP Status tab, Stratum 2

� For verification from z/OS

Once a z/OS image has been IPLed on Server SCZP201, the response to the Display 
ETR command shows also Stratum level and synchronization status. The z/OS command 
Display ETR returns message IEA386I displaying the following information:

– Synchronization mode
– Stratum level
– The node ID of the current Stratum 1 server in the CTN
– The server role, if applicable
– The number of usable timing links (does not apply for the CTS)

Example 7-4 shows the output of the command Display ETR for z/OS system images 
SC80 residing on the Arbiter of this STP-only CTN.

Example 7-3   Display ETR commands and responses 

IEA386I 14.17.17 TIMING STATUS 390                                      
SYNCHRONIZATION MODE = STP                                             
  THIS SERVER IS A STRATUM 2                                           
  CTN ID = ITSOPOK                                                    
  THE STRATUM 1 NODE ID = 002094.S18.IBM.02.00000002991E 
  THIS IS THE ARBITER SERVER                                     
  NUMBER OF USABLE TIMING LINKS =  4 

This completes the System z10 EC configuration to add it to an existing STP-only CTN.
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The System z10 EC is now part of the CTN as configured and is using STP as time source. 
Further reconfigurations such restarting the CTN, reassigning server roles or changing offsets 
can be done by following the IBM Server Time Protocol Implementation Guide, SG24-7281.

7.3  Create a new STP-only CTN

The starting configuration is an STP-enabled server that needs to be configured into an 
STP-only CTN. In this section we are showing a single server that creates a new CTN. Once 
these tasks have been finished, additional servers can join this CTN by using the procedure 
given in “Add the System z10 EC to an existing STP-only CTN” on page 320.

The sequence of steps to configure an STP-only CTN is:

1. Set the CTN ID. In this case it consists of only the STP ID portion.
2. Initialize the time. This includes set time zone, leap seconds, and date and time.
3. Assign CTN role.

If using an ETS, dial out or NTP, access to the external time source must be configured and 
tested before setting up the CTN. If the server is a z990 or z890, it does not support the NTP 
client function. Nevertheless, it can participate in an STP-only CTN where a System z10 or 
System z9 is the CTS and has an ETS configured to NTP. More information about the dial out 
function at the HMC and the required setup for the HMC/SE can be found in “ETS dial out 
configuration” on page 307.

7.3.1  Setting the CTN ID
In this section we discuss setting the CTN ID. The CTN ID is an identifier that is used to 
indicate whether the server has been configured to be part of a CTN and, if so configured, 
identifies the CTN.

The CTN ID is of the format STP Network ID - ETR Network ID, and is the basis for the 
establishment of the Coordinated Timing Network. 

The format of these fields is CTN ID = “cccccccc - xx”, where “cccccccc” is the STP Network 
ID and “xx” is the ETR Network ID.

� The STP Network ID is case sensitive and is 1–8 characters. The valid characters are 
A–Z, a–z, 0–9, ‘-’ and ‘_’.

� The ETR Network ID is always null for an STP-only CTN. 

Setting the STP Network ID
The STP Network ID is entered using the STP Configuration tab, as shown in Figure 7-23. 
The same CTN ID must be entered on every server that will participate in the STP-only CTN. 

Figure 7-23   System (Sysplex) Time - STP Configuration tab
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Message ACT37315 will be posted once the CTN change has been completed, as shown in 
Figure 7-24.

Figure 7-24   Message ACT37315

7.3.2  Initialize the time
The Initialize Time button is only enabled if the CTS and PTS roles have not been assigned 
yet and only after the CTN ID has been defined for the server that will become the CTS and 
PTS.

The Initialize Time button is accessed from the Network Configuration tab shown in 
Figure 7-25. 

Figure 7-25   Initialize Time button

Click Initialize Time to display the Initialize Time panel shown in Figure 7-26 on page 326. 
There are three radio buttons on the panel, each representing a task that must be completed 
before a Network Configuration can be applied for an STP-only CTN.

The three tasks related to initializing the time are: Set leap seconds, Set time zone, and Set 
date and time. As each task is completed, the corresponding box in the Complete column is 
selected. 

Important: Initializing the time must be done on the server that will become the Current 
Time Server for the STP-only CTN.
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Figure 7-26   HMC workplace - Initialize Time

Set leap seconds
Since January 1, 1972, occasional corrections of exactly one second, called a leap second, 
have been inserted into the UTC time scale to keep UTC time within 0.9 second of UT1 at all 
times.

Leap seconds are either hypercritical or completely irrelevant, depending on the applications 
and business requirements:

� If there are specific accuracy requirements to provide UTC or GMT to the very second, at 
any instant, then leap seconds need to be considered.

Some examples of such specific requirements might be legal or contractual requirements 
for time stamps to be within some tolerance of UTC Time, or if time stamps are used for 
time-dependant banking, scientific, or navigational purposes.

To account for leap second corrections, the total accumulated number of leap seconds 
since January 1972 must be entered when setting the time.

� Most sites have little awareness of leap seconds and ongoing leap second adjustments, 
and therefore this setting can probably be ignored. If there are no specific requirements for 
leap seconds, then specify a leap second value of zero.

Figure 7-27 illustrates the initial Adjust Leap Seconds panel. Although the installation may not 
be sensitive to leap seconds, a valid Leap Seconds Offset value must be entered to complete 
the Initialize Time task. If Leap Seconds are not used, enter a value of zero. 

Figure 7-27   Initialize Time - Set leap seconds

Set time zone
The panel shown in Figure 7-28 is used to set initial time zone parameters for the CTN. The 
current time zone must be set by selecting an entry from the Time zone drop-down box. 
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Figure 7-28    Adjust Time Zone Offset, initial view

Click the time zone drop-down arrow to display a list of all the time zones that are supported, 
as shown in Figure 7-29. Each of the supported time zone entries has a defined offset from 
UTC, and might optionally have a time zone algorithm defined, which is used for daylight 
saving time offset adjustment purposes. The time zone algorithm defines:

� Daylight saving offset
� Daylight saving automatic adjustment information (optional):

– Daylight saving date and time start algorithm
– Daylight saving date and time end algorithm

Automatically adjust is selected by default when the time zone selected supports automatic 
adjustment of daylight saving time. Otherwise, this button is disabled.

Even if automatic adjustment is supported, the user still has the option of selecting Set 
standard time or Set daylight saving time. If automatic adjustment for daylight saving time 
is not supported by the selected time zone, the user must decide whether the time zone 
algorithm selected requires a daylight saving time adjustment and select the “Set standard 
time” or “Set daylight saving time” radio buttons accordingly.

Figure 7-29   Time Zone drop down menu

If a time zone entry that meets the user requirements cannot be found, then one of the five 
user-defined time zones (that is, UD1 to UD5) may be used to define the desired time zone. If 
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a user-defined time zone entry is selected, the Define button is enabled. It is used to display 
the Define Time Zone Algorithm panel shown in Figure 7-30.

Figure 7-30   Define Time Zone Algorithm

The Description (maximum 80 characters) and Standard time name fields (maximum four 
characters) must be entered. Otherwise, an error message appears when OK is clicked. The 
standard time name is an abbreviation displayed on various panels to differentiate standard 
time from daylight saving time.

The UTC offset must be entered in +/- hours and minutes and ranges from -14 to +14 hours. 

Also, if the time zone is subject to daylight saving time adjustments, then the daylight saving 
time name and daylight saving offset must be specified. Optionally, algorithms for daylight 
saving time start and daylight saving time end can be defined to support automatic clock 
adjustment by selecting the option Define adjustment of clock for daylight saving time. 
The algorithm is saved when OK is clicked, but it is not sent to the STP facility until OK is 
clicked on the Adjust Time Zone Offset panel.

Set date and time
The final task in the sequence is to initialize the date and time. Three different methods are 
provided. 

1. If the local date and time are to be set to specific values, click the Set date and time 
button. Date and time values can be entered in each field. The value filled in is the current 
time from the Support Element of the server on which the configuration task is being 
performed. An Icon is also available to display an additional calendar dialog box.

2. If an ETS is configured, either through dial out or NTP server, the date and time should be 
initialized by selecting the option Use External Time Source to set date and time. This 
will ensure that the Coordinated Server Time will match the time source. An external time 
source can be used to set the time to within +/- 100 milliseconds of the time provided from 
the external source.

 

 

 

328 IBM System z10 Enterprise Class Configuration Setup



 

Figure 7-31   Set Date and Time via External Time Source

Click the option Use External Time Source to set date and time as shown in 
Figure 7-31. Click OK. 

STP accesses the ETS to calculate the difference between the server TOD clock and the 
time obtained from the external time source, either dial out or NTP server. When access to 
the ETS is successful, the resulting time value is not displayed to the user, but instead is 
passed directly to the STP facility when OK is clicked. 

Message ACT37382 is displayed upon successful completion of the Set Date and Time 
operation (Figure 7-32). Click OK. 

Figure 7-32   Set Date and Time successful, message ACT 37382

The Initialize Time panel shown in Figure 7-34 is displayed again.

In order to verify the date and time set by accessing the external time source, the user can 
optionally select the Set Date and Time radio button a second time and click OK 
(Figure 7-33).

Figure 7-33   Set Date and Time via External Time Source

It is the only way the user can verify the information obtained from the external time 
source. To leave the panel without change, use the Cancel button.

3. A delta value can be specified through selection of the Modify time by delta to set date 
and time button. The value specified is either positive (default) or negative and is entered 
in the +/-hh:mm:ss.mmm format. 

Regardless of the method chosen, STP uses the information to calculate the Coordinated 
Server Time and set the server TOD clock when the OK button is clicked. 

At this point the three tasks on the Initialize Time panel have a check mark in the Complete 
column (see Figure 7-34). Click Cancel to exit the Initialize Time task and return to the 
Network Configuration tab. 
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Figure 7-34   Initialize Time complete

The Coordinated Server Time will be passed to other participating servers in the CTN when 
the server roles and the Current Time Server are assigned, as described in the next section. 

7.3.3  Assigning the PTS role
Now that the Initialize Time task has been completed, the Apply button on the Network 
Configuration page is enabled, as shown in Figure 7-35. The server role can be assigned. 

Figure 7-35    Network Configuration tab, after time initialization

Because this is the first server within this “new” CTN we are going to assign only the PTS 
role. Select the PTS from the drop-down list. The PTS is also going to be the CTS. Additional 
servers can be added to this CTN afterwards, to be configured as BTS and Arbiter. (This is 
covered in section “Add the System z10 EC to an existing STP-only CTN” on page 320.)

To configure a new STP-only CTN, begin by selecting the Force configuration check box. 
Force configuration specifies whether connectivity between the Preferred Time Server and 
other servers with a defined role will be verified when a change in configuration is requested. 
Because this is a new STP-only CTN where there is no CTS configured yet, the Force 
configuration check box must be checked. 

If the force check box is not used the request is rejected and message ACT37346, shown in 
Figure 7-36, is displayed. Click OK to return to the Network Configuration tab. 
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Figure 7-36   Force configuration required, message ACT37346

On the Network Configuration tab (Figure 7-37) the radio button in the Current Time Server 
section is pointing to the PTS. Since the PTS will be the only server assigned, it has to be the 
CTS. Click the Force configuration check box; it must be specified when configuring a new 
STP-only CTN for the first time in order to bypass connectivity verification because a Current 
Time Server does not yet exist. 

Figure 7-37   Network Configuration tab, define the CTS

Now that the Force configuration check box is selected, Network Configuration Change 
Confirmation message ACT37348 is displayed (Figure 7-38). Click Yes to confirm.
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Figure 7-38   Network Configuration Change Confirmation, message ACT37348

Assignment of the CTS globally transitions all servers with the same CTN ID to STP timing 
mode. This is confirmed by message ACT 37341, shown in Figure 7-39.

Figure 7-39   Modify Network Configuration successful, message ACT37341

Verification 
� For verification from the HMC:

To verify the successful activation of the STP-only CTN, select the Timing Network tab 
(shown in Figure 7-40). The Network portion indicates:

– Timing network type is STP-only CTN.

– The CTN Time Source is an NTP server.

– The reference clock for the NTP server is the Global Positioning Service (GPS).

The CTN time source reflects where the Coordinated Server Time is currently being 
steered from. If the NTP server is a stratum 1, the user should expect to see one of the 
clock sources identified in Table 7-1, “NTP Stratum 1 clock sources” on page 313.
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Figure 7-40   System (Sysplex) Time - Timing Network tab

� For verification from z/OS:

Once a z/OS image residing on the server went through an IPL, the Stratum level and 
synchronization status can be verified from the z/OS side as well. The z/OS command 
Display ETR returns message IEA386I displaying the following information:

– Synchronization mode
– Stratum level
– The node ID of the current Stratum 1 server in the CTN
– The server role

Example 7-4 shows the output of the command Display ETR for z/OS system image SC80 
on the PTS.

Example 7-4   Display ETR commands and responses 

SC80 RESPONSES ---------------------------------------------------  
IEA386I 16.37.39 TIMING STATUS 151 
SYNCHRONIZATION MODE = STP                                              
  THIS SERVER IS A STRATUM 1                                            
  CTN ID = ITSOPOK                                                      
  THE STRATUM 1 NODE ID = 002097.E26.IBM.02.00000001DE50 
  THIS IS THE PREFERRED TIME SERVER  
  THIS STP NETWORK HAS NO BACKUP TIME SERVER
  THIS STP NETWORK HAS NO SERVER TO ACT AS ARBITER 

The command Display XCF,SYSPLEX,ALL indicates the timing mode of Sysplex system 
images is STP, as shown in Example 7-5. 
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Example 7-5   Display XCF,S,ALL command and response

D XCF,S,ALL                                                          
IXC335I  16.45.05  DISPLAY XCF 174 
SYSTEM   TYPE SERIAL LPAR STATUS TIME         SYSTEM STATUS 
SC80     2097 DE50   01   11/28/2007 16:45:05 ACTIVE         TM=STP 
SC81     2097 DE50   11   11/28/2007 16:45:03 ACTIVE         TM=STP 

This completes the STP-only CTN configuration. Additional servers can be added to this CTN 
using the procedure documented in “Add the System z10 EC to an existing STP-only CTN” 
on page 320.
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Chapter 8. Crypto Express2 configuration

In this chapter we provide information about Crypto Express2 configuration on a System z10 
EC. We cover cryptographic domains, configuration rules, and points to consider when 
planning for nondisruptive installation of cryptographic features.

Step-by-step definition and configuration of the Crypto Express2 feature to a logical partition 
are explained. 

The following topics are discussed:

� Crypto Express2 configuration overview

– Configuration rules

– Configuration planning

� Cryptographic definition

– HMC/SE session to System z10 EC

– Check CPACF DES/TDES enablement feature installed

– Logical partition cryptographic definition

– Cryptographic configuration using the Support Element

� Activation and deactivation using ICSF

8
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8.1  Crypto Express2 configuration overview

This section provides a brief overview of configuration rules and planning considerations.

8.1.1  Configuration rules

Each cryptographic coprocessor has 16 physical sets of registers or queue registers, each 
set belonging to a domain, as follows:

� A cryptographic domain index, from 0 to 15, is allocated to a logical partition via the 
definition of the partition in its image profile; the same domain must also be allocated to 
the ICSF instance running in the logical partition via the Options Data Set.

� Each ICSF instance accesses only the Master Keys or queue registers corresponding to 
the domain number specified in the logical partition image profile at the Support Element 
and in its Options Data Set. Each ICSF instance is seeing a logical crypto coprocessor 
consisting of the physical cryptographic engine and the unique set of registers (the 
domain) allocated to this logical partition.

The installation of the CP Assist for Cryptographic Functions (CPACF) DES/TDES 
enablement, feature code 3863, is required to enable the use of the Crypto Express2 feature. 
This feature enables the DES and TDES algorithms on the CPACF, which are supported by 
z/OS, z/VM, and Linux on System z. On the other hand, SHA-1, SHA-256, SHA-384, and 
SHA-512 are shipped enabled on all servers and do not require this feature.

� The total number of Crypto Express2 features may not exceed eight per System z10 EC. 
� Each Crypto Express2 feature contains two PCI-X adapters. Each adapter can be 

configured as a cryptographic coprocessor or accelerator. During the feature installation 
both PCI-X adapters are configured by default as coprocessors.

� The Crypto Express2 feature does not use CHPIDs from the channel subsystem pool, but 
each feature is assigned two PCHIDs, one per PCI-X adapter.

Table 8-1 summarizes the Cryptographic feature codes for System z10 EC.

Table 8-1   Cryptographic Feature codes

Feature code Description

3863 CPACF DES/TDES enablement feature
Prerequisite to use the CPACF (except for SHA-1, SHA-256, SHA-384, and 
SHA-512) and Crypto Express2 features.

0863 Crypto Express2 feature
A maximum of eight features can be ordered. Each feature contains two PCI-X 
cryptographic adapters.

0839/0859 Trusted Key Entry (TKE) 5.0 workstation
This workstation is optional and supports only Ethernet adapters to connect to a 
LAN. When the TKE option is chosen for key management of the PCI-X crypto- 
graphic adapters, a TKE workstation with the TKE 5.0 LIC or later is required.

0855 TKE 5.0 LIC (carried forward only)

0856 TKE 5.1 LIC (carried forward only)

0857 TKE 5.2 LIC

0887 TKE Smart Card Reader

0888 TKE Additional Smart Cards
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8.1.2  Configuration planning

The System z10 EC always operates in LPAR mode. The concept of “dedicated coprocessor” 
does not apply to the PCI-X adapter. A PCI-X adapter, whether configured as coprocessor or 
accelerator, is made available to logical partitions as directed by the domain assignment and 
the candidate list, regardless of the shared or dedicated status given to the CPs in the 
partition.

The System z10 EC allows up to 60 logical partitions to be active concurrently. Each PCI-X 
adapter on a Crypto Express2 feature supports 16 domains, whether it is configured as a 
Crypto Express2 accelerator or a Crypto Express2 coprocessor.

When all 60 logical partitions on the System z10 EC are active and require concurrent access 
to cryptographic functions provided by a PCI-X adapter, the configuration must include at 
least two Crypto Express2 features, but should have four for redundancy.

� For availability, assignment of multiple PCI-X adapters of the same type (Crypto Express2 
accelerator or coprocessor) to one logical partition should be spread across multiple 
features.

� The use of retained private keys on a PCI-X adapter configured as a Crypto Express2 
coprocessor creates an application single point of failure, since RSA-retained private keys 
are not copied or backed up.

� There is an intrusion latch within the PCI-X adapter logic that is set any time the feature is 
removed from the system. If the feature is re-installed, and power is applied, the 
coprocessor keys and secrets are zeroized and the intrusion latch is reset.

If a TKE workstation is available, the PCI-X adapter can first be disabled from the TKE 
workstation before removing the feature from the system. In that case, when the feature is 
re-installed, the coprocessor keys and secrets are not zeroized, but the intrusion latch is 
reset and the coprocessor remains in the disabled state. The PCI-X adapter then can be 
enabled from the TKE and normal operations can resume. 

The definition of domain indexes and cryptographic coprocessor numbers in the 
Candidate list for each logical partition should be planned to prepare the cryptographic 
configuration. You can also define or change that cryptographic definition dynamically to 
an active logical partition with a running system. For more information, see “Change LPAR 
Cryptographic Controls” on page 348.

� Crypto Express2 features can be installed concurrently by use of the Nondisruptive 
Hardware Change1 task. To dynamically enable use of a new PCI-X adapter to a partition 
requires that:

– At least one usage domain index be defined to the logical partition.

– The cryptographic coprocessor numbers be defined in the partition Candidate list.

� The same usage domain index can be defined more than once across multiple logical 
partitions. However, the cryptographic coprocessor number coupled with the usage 
domain index specified must be unique across all active logical partitions.

The same cryptographic coprocessor number and usage domain index combination can 
be defined for more than one logical partition. This can be used, for example, to define a 
configuration for backup situations. In this case, only one of the logical partitions can be 
active at any one time.

� Newly installed Crypto Express2 features are assigned coprocessor numbers sequentially 
during the power-on-Reset following the installation.

1  The Nondisruptive Hardware Change is only available when logged on to the Support Element in Service mode.
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However, when a Crypto Express2 feature is installed concurrently using the 
Nondisruptive Hardware Change task, it is possible for the installation to select an 
out-of-sequence coprocessor number from the unused range. In this case, the client 
should communicate the desired cryptographic coprocessor numbers to the IBM 
installation team.

When the task is used to concurrently remove a PCI cryptographic feature, the 
coprocessor number is automatically freed.

If Crypto Express2 features are moved during a push/pull upgrade, the existing 
coprocessor numbers are reset. Numbers are assigned sequentially on the new CPC, as 
they would be for a new installation.

Configuration planning requires that you distribute 16 domains for each PCI-X adapter, 
across 60 logical partitions, for up to 16 PCI-X adapters in a fully populated server.

Table 8-2 is a simplified configuration map. Each row identifies a PCI-X adapter and each 
column identifies a domain index number. Each cell entry indicates the logical partition to be 
assigned the cryptographic coprocessor number coupled with the usage domain index.

Table 8-2   Planning for logical partitions, domains, and PCI-X adapter numbers

This table illustrates, for example:

� Logical partitions LP00 and LP01 use domain 0, but are assigned different PCI-X 
adapters. There is no conflict. They can be concurrently active.

� Logical partition LP02 uses domain 0 on the set of cryptographic adapters already defined 
to LP00 and LP01. Therefore, partition LP02 cannot be active concurrently with either 
LP00 or LP01. However, the definition may be valid for backup situations.

� Logical partitions LP04 and LP05 use different domain numbers for PCI-X cryptographic 
adapter 0, so there is no conflict. The combination, domain number and cryptographic 
coprocessor number, is unique across partitions.

Adapter
Type

Domain
index 0

Domain
index 1

Domain
index 2 .../...

Domain
index 14

Domain
index 15

PCI-X adapter 0 CEX2C/A LP00
LP02

LP05 LP04 LP04

PCI-X adapter 1 CEX2C/A LP01
LP02

PCI-X adapter 2 CEX2C/A LP00

.../...

.../...

PCI-X adapter 13 CEX2C/A

PCI-X adapter 14 CEX2C/A

PCI-X adapter 15 CEX2C/A

Important: Any given cell should contain only one active logical partition since the 
combination of cryptographic coprocessor number and usage domain index must be 
unique across all active logical partitions.
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Each PCI-X adapter provides 16 domains, and up to 60 partitions can be defined and active 
on the System z10 EC. To allow all 60 logical partitions to use cryptographic services, either 
accelerator or coprocessor, requires at a minimum two Crypto Express2 features without 
redundancy, or four Crypto Express2 features if redundancy is required.

For more detailed information regarding the Crypto Express2 feature for System z, check the 
following site;

http://www.ibm.com/systems/z/security/cryptography.html

8.2  Cryptographic definition

This section provides detailed steps for configuring Crypto Express2 for System z.

8.2.1  HMC/SE session to System z10 EC

The System z10 EC also operates only in LPAR mode. For each logical partition that requires 
access to a PCI-X adapter, configured as either an accelerator or coprocessor, you must 
customize the partition image profile. This is done using the System z10 EC Hardware 
Management Console or Support Element workplace.

The System z10 EC requires the HMC Application V2.10.0. This application allows you to 
choose the interface style in which you prefer to work from the following choices:

� Tree style user interface

� Classic style user interface

Keep in mind that it no longer uses an OS/2-based system.

The tree style user interface (tree interface) is the default for Operator, Advanced Operator, 
Access Administrator, and System Programmer user roles, but not for the Service 
Representative user role. You can change the mode by selecting the UI style tab in the User 
Settings menu.

1. Sign on to the HMC using SYSPROG or an identification with equivalent rights. The initial 
HMC Workplace™ after logging in is displayed, as shown in Figure 8-1 on page 340. All 
images captured for this book are in tree mode.
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Figure 8-1   Welcome page after logging in HMC

2. If multiple CPCs are connected to the HMC, select and click the one you want to connect 
to from the Servers menu in the Systems Management group. You can see the Contents 
area (upper right of panel) and Tasks area (lower right of panel) in tree mode, shown in 
Figure 8-2 on page 341.

3. When you use the Support Element, locate and click the Single Object Operations task 
from the Recovery section. You can log in after you respond to the confirmation panel, 
shown in Figure 8-3 on page 341.
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Figure 8-2   Contents and Tasks of CPCs

Figure 8-3   Single Object Operations Task Confirmation

8.2.2  Check CPACF DES/TDES enablement feature installed

The System z10 EC crypto enablement feature (#3863) enables DES and TDES algorithms 
on the CPACF. It is a prerequisite for using the Crypto Express2 feature. You have to verify 
whether the CPACF feature is properly installed on the processor before configuring 
cryptographic functions. This information is displayed in the Support Element (SE).

1. Access the SE Welcome page. Compared with the HMC window (Figure 8-1 on 
page 340), notice the difference in the panel’s title and also the presence of a logo in the 
background of the SE panel.
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Figure 8-4   SE Welcome page

2. From the Systems Management section on the left side of the panel, locate and click CPC. 
The right-hand panel displays Contents and Tasks areas for that CPC (Figure 8-5).

Figure 8-5   SE - Contents and Tasks area of CPC
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3. Click the CPC Details menu at the top of the Tasks area. This opens the CPC details 
panel shown in (Figure 8-6).

Figure 8-6   SE - CPC Details

4. Select the Instance Information tab to verify the CPACF DES/TDES enablement feature.

5. If the panel displays CP Assist for Crypto Functions: Installed, the CPACF 
enablement feature code 3863 is installed.

6. If the panel displays CP Assist for Crypto Functions: Not Installed, then feature code 
3863 is not installed. You can still customize the partition image profiles, but cryptographic 
functions do not operate.

7. Click Cancel to return.

8.2.3  Logical partition cryptographic definition

The next step is to define the following cryptographic resources in the image profile for each 
partition:

� Usage domain index

� Control Domain Index

� PCI Cryptographic Coprocessor Candidate List

� PCI Cryptographic Coprocessor Online List

This is accomplished through the Customize/Delete Activation Profile task. You need to 
modify the cryptographic initial definition from the crypto tab in the image profile, as shown in 
Figure 8-7 on page 344. After this operation, any changes to the image profile require a 
DEACTIVATE and ACTIVATE of the logical partition for the change take effect, so the 
cryptographic definition is disruptive to a running system.

CPACF
FC #3863
CPACF

FC #3863
CPACF

FC #3863
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Figure 8-7   Customize Image Profiles - Crypto

The cryptographic resource definitions have the following meanings:

� Usage domain index

Identifies the cryptographic coprocessor domains assigned to the partition for all 
cryptographic coprocessors that are configured on the partition. 

The numbers selected should match the domain numbers entered in the Options data set 
when starting this partition instance of ICSF.

The same usage domain index can be used by multiple partitions regardless of which 
CSS they are defined to, but the combination PCI-X adapter number and usage domain 
index number must be unique across all active partitions.

� Control domain index

Identifies the cryptographic coprocessor domain indexes that can be administered from 
this logical partition if it is being set up as the TCP/IP host for the TKE.

The control domain index must include the usage domain index specified for the partition. 
If any selected usage domain index is not part of the control domain index selection, the 
update is rejected.

If you are setting up the host TCP/IP in this logical partition to communicate with the TKE, 
the partition is used as a path to other domains’ Master Keys. Indicate all the control 
domains you want to access (including this partition’s own control domain) from this 
partition.

Important: Operational changes can be made using the Change LPAR Cryptographic 
Controls task from the Support Element, which reflects the cryptographic definitions in the 
image profile for the partition, shown in Figure 8-12 on page 350.

With this new function, you can dynamically add and remove the cryptographic feature 
without stopping a running operating system. For details on how to use this function refer 
to “Change LPAR Cryptographic Controls” on page 348.

 

 

 

344 IBM System z10 Enterprise Class Configuration Setup



 

� PCI Cryptographic Coprocessor Candidate list

Identifies the cryptographic coprocessor numbers that are eligible to be accessed by this 
logical partition. From the scrollable list, select the coprocessor numbers, from 0 to 15, 
that identify the PCI-X adapters to be accessed by this partition.

When a cryptographic coprocessor number selected in the partition Candidate list is not 
available to the partition when the partition is activated, either because it is configured off 
or not installed, no error condition is reported. The cryptographic coprocessor number is 
ignored and the activation process continues.

You can also add the cryptographic coprocessor candidate list after activating the logical 
partition non disruptively using the Change LPAR Cryptographic Controls task from the 
SE. For more information, see “Change LPAR Cryptographic Controls” on page 348.

If the cryptographic coprocessor number and usage domain index combination for the 
coprocessor selected in the partition Online list is already in use by another active logical 
partition, activation of the logical partition or change of cryptographic controls task fails; 
see Figure 8-8. In this conflicting case, you have to check cryptographic information for all 
active logical partitions from the Summary tab of the View LPAR Cryptographic 
Controls task, as shown in Figure 8-10 on page 348, and resolve the error based on the 
collected data (assign a unique combination of PCI-X adapter number and usage domain 
index number).

Figure 8-8   SE - Change LPAR Cryptographic Controls, message ACT33676

� PCI Cryptographic Coprocessor Online list

Identifies the cryptographic coprocessor numbers that are automatically brought online 
during logical partition activation. The numbers selected in the Online list must also be 
part of the Candidate list.

After the next partition activation, installed PCI Cryptographic Coprocessors that are in the 
partition’s PCI Cryptographic Candidate list but not on the PCI Cryptographic Online list 
are in a “configured off” state (Standby). They can later be configured online to the 
partition by using the Configure On/Off option from the SE. For more information, see 
“Config On/Off to the logical partition” on page 359.

When the partition is activated, no error condition is reported if a cryptographic 
coprocessor number selected in the partition’s Online list is not installed. The 
cryptographic coprocessor is ignored and the activation process continues.

When a cryptographic coprocessor number selected in the partition’s Online list has been 
previously configured off to the partition, it is automatically configured back on when the 
partition is next activated. The partition’s Online list is always selected from the image 
profile for each logical partition, and these settings cannot be updated dynamically for a 
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running system; see “SE - Change LPAR Cryptographic Controls, message ACT33677” 
on page 350. 

8.2.4  Cryptographic configuration using the Support Element

From the Support Element, you can do the following:

� Display PCI Cryptographic Configuration

� Display LPAR cryptographic controls (domain index and Candidate/Online lists for 
currently activate partitions)

� Reconfigure (the coprocessor from/to accelerator)

� Configure a cryptographic coprocessor and accelerator On/Off to a logical partition

� Change LPAR cryptographic controls to a logical partition 

These tasks require you to work from the Support Element; to get to the appropriate SE task, 
log on to the SE directly or use the Single Object Operations task from the HMC.

Cryptographic management
After selecting the CPCs, locate and click the Cryptographic Management task in the CPC 
Configuration section.

Figure 8-9 on page 347 shows the Cryptographic Management panel. Use this panel to 
release the installed cryptographic configuration (the association of the cryptographic number 
and the card serial number), as follows:

� View installed cryptographic features, with current status and assigned PCHID and 
coprocessor numbers. Each PCI-X adapter is assigned a coprocessor number, in the 
range 0 to 15, as part of the configuration process. The assignment is made when the 
feature is installed. 

� View coprocessor numbers that still retain assignment to removed cryptographic features. 

� Initiate the release of coprocessor numbers. The relationship should be removed only 
when a Crypto Express2 feature is permanently removed from the CPC. 

The release option removes the relationship between a PCI cryptographic feature serial 
number and the assigned coprocessor numbers. Removing the relationship allows the 
coprocessor numbers to be freed, and makes them available to be assigned to a new 
feature serial number. 

Important: The coprocessor numbers are assigned to the feature serial number, not to the 
installed location. If a feature is removed from one location to be reinstalled in another, the 
coprocessor number assignment remains. 
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Figure 8-9   SE - Cryptographic Management

View LPAR cryptographic controls
You can visualize active partition cryptographic definitions from the SE. 

Select the CPCs, locate and click the View LPAR Cryptographic Controls task in CPC 
Configuration section.

The resulting panel displays the definition of Usage and Control domain indexes, and PCI 
Cryptographic Candidate and Online lists. The information is provided only for active logical 
partitions.

This panel is informational only. You can see the definitions, but you cannot change them 
from this panel. To modify the cryptographic coprocessor On/Off status requires the use of 
the Configure On/Off task, which is discussed in “Config On/Off to the logical partition” on 
page 359. 

Note: You can review the PCI Cryptographic Candidate lists and Usage domain indexes 
which are assigned for all active logical partition from the Summary tab shown in 
Figure 8-10 on page 348. 

The Usage Domain Index in combination with the Cryptographic Number selected in the 
Candidate List, must be unique across all partitions defined to the CPC, so this new tab is 
very useful when defining or changing the Usage domain index for a logical partition. 
(Refer to “Change LPAR Cryptographic Controls” on page 348).
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Figure 8-10   SE - View LPAR Cryptographic Controls

Change LPAR Cryptographic Controls
For each logical partition, you have to define:

� Usage domain index

� Control domain index

� Cryptographic Coprocessor Candidate list

� Cryptographic Coprocessor Online list

The Change LPAR Cryptographic Controls function is included in the Support Element for 
System z10 EC. You can perform the following operations using this function:

� Add a crypto to a logical partition for the first time.

� Add a crypto to a logical partition already using crypto. 

� Remove a crypto from a logical partition.

� Zeroize, or clear the cryptographic secure keys for a given usage domain.

You can use this task as a substitute when making cryptographic changes for existing Image 
Profiles from the Customization/Delete Activation Profiles task in HMC or SE. See the manual 
Support Element Operations Guide V2.10.0, SC28-6868 for more information.
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Dynamic assignment of the cryptographic definition to the partition

Figure 8-11   SE - Change LPAR Cryptographic Controls task

1. Select the logical partition, click the Change LPAR Cryptographic Controls task from 
CPC Operational Customization (Figure 8-11).

2. Select Usage and Control domain index and Cryptographic Candidate and Online list 
numbers that you want to assign. After checking each box, click the Change Running 
System button, as shown in Figure 8-12 on page 350.
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Figure 8-12   Change LPAR Cryptographic Controls (Change Running System)

3. Figure 8-13 shows the message indicating that only the Cryptographic Online List cannot 
be changed by this task dynamically, so changes are ignored. The Cryptographic Online 
list definition is always selected from the image profile for each logical partition. Click OK. 

Figure 8-13   SE - Change LPAR Cryptographic Controls, message ACT33677

4. When you add or change the control or usage domain index and cryptographic 
coprocessor number dynamically for a running system, the confirmation message shown 
in Figure 8-14 is displayed. Click Yes.

�

Figure 8-14   SE - Change LPAR Cryptographic Controls, message ACT33683

5. A status panel indicates the result of a dynamic add or change of a cryptographic 
definition to an LPAR, as shown in Figure 8-15 on page 351.
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Figure 8-15   SE - Change LPAR Cryptographic Controls (Success) 

Dynamic removal of the cryptographic definition
You can also remove the cryptographic definition from a logical partition dynamically using 
the Change LPAR Cryptographic Controls task. This section discusses the related issues and 
describes the procedure.

� Before you change the cryptographic settings using the Change LPAR Cryptographic 
Controls task, check that the cryptographic lists you want to remove from a logical 
partition are offline (Standby). If you try to remove the lists dynamically while they are 
online, the change fails and you receive the message shown in Figure 8-16.

Figure 8-16   SE - Change LPAR Cryptographic Controls, message ACT33679

� In addition to adding or changing the cryptographic settings to a logical partition, you can 
remove the Control/Usage domains and Cryptographic Candidate lists for a logical 
partition from the Change LPAR Cryptographic Controls panel; see in Figure 8-12 on 
page 350. After deselecting (unchecking) the definitions for a logical partition, you remove 
a definition dynamically by clicking Change Running System.

� When you only remove the definition of the cryptographic lists, the zeroize panel appears; 
see Figure 8-17 on page 352. Remove the check to zeroize each crypto number, then 
click OK.

Note: You can zeroize a usage domain to clear the coprocessor configuration data and all 
cryptographic keys manually using the Cryptographic Configuration task. 

From the Change LPAR Cryptographic Controls task, since you cannot see at a glance all 
cryptographic information, including the usage domains for other logical partitions, we 
recommend you remove the check for zeroize. For more information about zeroize, see 
“Reconfiguration of the PCI-X Adapter to Coprocessor or Accelerator” on page 353. 
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Figure 8-17   SE - Change LPAR Cryptographic Controls

� Click Yes when the confirmation dialog is displayed to change the cryptographic settings 
dynamically. As the message in Figure 8-18 shows, the task was completed successfully.

Figure 8-18   SE - Change LPAR Cryptographic Controls, message ACT33687

Save the cryptographic definition to the image profile

The operations explained in this section are temporary changes to a running system in the 
logical partition. Remember to save the cryptographic definitions that you defined to the 
current image profile of the changed logical partition by clicking the Save to Profiles option. 
You can also change the image profile for a logical partition using the Customize/Delete 
Activation Profile task from the HMC. 

1. To save the changes to the logical partitions image profile click Save to Profiles, as 
shown in Figure 8-19 on page 353. 
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Figure 8-19   SE - Change Crypto Graphic Controls (Save to Profiles)

2. Click Yes to the confirmation message to implement the image profile change, as shown 
in Figure 8-20.

Figure 8-20   SE - Change LPAR Cryptographic Controls, message ACT33682

The Change LPAR Cryptographic Controls task is used to perform a change  in Crypto 
Express2 configuration without deactivation of the partition. Any other method will require you 
to shut down operating systems running in the logical partition that is the target of 
cryptographic settings updates. For more information about hot plugging crypto features, see 
the manual IBM System z10 Enterprise Class Processor Resource/Systems Manager™ 
Planning Guide, SB10-7153.

Reconfiguration of the PCI-X Adapter to Coprocessor or Accelerator
Each PCI-X Cryptographic adapter on a Crypto Express2 feature can be configured either as 
a coprocessor or as an accelerator. Each Crypto Express2 feature can be configured as:

� Two Crypto Express2 coprocessors
� One Crypto Express2 coprocessor and one accelerator
� Two Crypto Express2 accelerators

Whether it is configured as a coprocessor or an accelerator, each PCI-X Cryptographic 
adapter can be shared among 16 logical partitions.
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Configure from Coprocessor to Accelerator
During installation of a Crypto Express2 feature, both PCI-X Cryptographic adapters are 
configured by default as coprocessors. The reconfiguration is fully supported in Licensed 
Internal Code. Therefore, Crypto Express2 features carried forward from System z9 to 
System z10 EC can take advantage of the reconfiguration capability.

When a PCI-X adapter is configured as a coprocessor, it can still perform accelerator 
functions, albeit much more slowly than when configured as accelerator. When it is 
configured as an accelerator, it cannot perform coprocessor functions. 

To reconfigure the PCI-X Adapter from coprocessor to accelerator, do the following:

1. Select the CPC that has crypto adapters you want to reconfigure and click the 
Cryptographic Configuration task.

2. The reconfiguration is enabled only for PCI-X adapters that are Off, so make sure the 
PCI-X Cryptographic adapter status for that crypto channel is Deconfigured; see 
Figure 8-21.

If necessary, configure the PCI-X Cryptographic adapter Off for all partitions that have it in 
their candidate list. To configure the PCI-X Cryptographic adapter Off, use the procedure 
described in “Config On/Off to the logical partition” on page 359.

3. Select the number of the crypto channel and click the Crypto Type Configuration option.

Figure 8-21   SE - Cryptographic Configuration task (Coprocessor)

4. Change the configuration for the crypto adapter. The selected crypto channel is currently 
configured as a Coprocessor (Figure 8-22 on page 355). Select Accelerator in the panel.

When you select Accelerator, you can zeroize the selected coprocessor by clicking the 
Zeroize the Coprocessor check box on the Crypto Type Configuration panel. Remove the 
check for Zeroize the Coprocessor and click OK.

Caution: Zeroizing one or all cryptographic coprocessors clears their configuration data 
and clears all cryptographic keys. Zeroizing all also erases configuration data from the 
support element hard drive (for example, UDX files). Cryptographic coprocessors should 
be zeroized manually only when absolutely necessary, typically when the cryptographic 
coprocessor configuration data must be erased completely. In normal cases, be sure to 
remove the check for each crypto channel.
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Figure 8-22   SE - Crypto Type Configuration (Coprocessor to Accelerator) 

5. Click Yes when the confirmation dialog shown in Figure 8-23 is displayed.

 

Figure 8-23   SE - Crypto Type Configuration Confirmation, message ACT37837 

6. Check that your request completed successfully (Figure 8-24). Click OK to return to the 
Crypto Type Configuration panel.

Figure 8-24   SE - Crypto Type Configuration Confirmation, message ACT37844

7. Click Cancel on the Crypto Type Configuration panel to return to the Cryptographic 
Configuration task panel. You can confirm that the target crypto channel changed to 
cryptographic accelerator type in the Cryptographic Configuration task panel (Figure 8-25 
on page 356).
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Figure 8-25   SE - Cryptographic Configuration (Accelerator)

8. Click the View Details option for detailed information (Figure 8-26).

9. Finally, click Cancel to return.

Figure 8-26   SE - Cryptographic Details (Accelerator)
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Configure from Accelerator to Coprocessor
Use the following steps to configure from an Accelerator to a Coprocessor: 

1. Select the number of the crypto channel that you want to change (it must be in a 
Deconfigured status), and click the Crypto Type Configuration option (Figure 8-27).

Figure 8-27   Cryptographic Configuration (Accelerator)

2. The selected crypto channel is currently configured as an Accelerator, as shown in 
Figure 8-28. Select Coprocessor and click OK in the panel.

Figure 8-28   Crypto Type Configuration (Accelerator to Coprocessor)

3. Click Yes in the confirmation message dialog displayed (Figure 8-29).

Figure 8-29   Crypto Type Configuration, message ACT37839

4. When your request has completed successfully, the message shown in Figure 8-30 is 
displayed. Click OK.
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Figure 8-30   Crypto Type Configuration, message ACT37843

5. Click Cancel in the Crypto Type Configuration panel; the Crypto Configuration task panel 
is shown again. You can confirm that the crypto channel has been changed to a 
cryptographic accelerator type from the Cryptographic Configuration task panel, as shown 
in Figure 8-31.

Figure 8-31   Cryptographic Configuration (Coprocessor)

6. Click the View Details option for complete details (Figure 8-32 on page 359).
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Figure 8-32   Cryptographic Details (Coprocessor)

Using this task from the Support Element allows you to reconfigure the PCI-X Adapter 
manually.

Config On/Off to the logical partition
After you have defined the cryptographic settings to each logical partition, the next step is to 
change the coprocessor/accelerator lists from offline (Standby) to online dynamically. If you 
can perform a reactivate (DEACTIVATE and ACTIVATE) of the image profiles for the logical 
partitions whose Cryptographic Online Lists have been updated, then the dynamic operation 
is not needed.

To change the lists to online status dynamically, use the following steps:

1. From the SE, select the Systems Management function. Select the target server, click 
Partitions, and then select the target logical partition. Click the Cryptos selection for the 
target logical partition. In the Contents of Cryptos panel, select the Crypto IDs that are to 
be changed. In Figure 8-33 on page 360, one Cryptographic accelerator (06) and one 
coprocessor (07) to LOGICAL PARTITION (A01) are selected.

2. Click the Configure On/Off task under Crypto Service Operations. This task is used to 
control whether a Crypto ID is online or standby (offline - this means only the definition of 
candidate list to that logical partition) in the active configuration.
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Figure 8-33   SE Crypto Service Operations - Standby

3. Select the crypto channel numbers you want, click Toggle to switch from Standby to 
Online in the desired state. If you choose multiple crypto channels at the same time, click 
the Toggle All On option as shown in Figure 8-34 on page 360.

Figure 8-34   SE Crypto Config On/Off (Toggle All On)

4. After confirming the desired state for your requested crypto channels is set to Online, click 
the Apply button (Figure 8-35).

Figure 8-35   SE Crypto Config On/Off (Standby to Online)

5. A progress panel indicates the status of your request. Confirm that your request for 
configure channel path On/Off is completed (Figure 8-36). Press OK.

6. After checking that the Current State of the Crypto channels has been changed to Online, 
click Cancel to return.
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Figure 8-36   SE Crypto Config On/Off (Online completed)

7. Finally, you can view the contents of the Cryptos panel of the logical partition to confirm 
that the target crypto channels are now in an Online and Operating status (Figure 8-37).

Figure 8-37   SE Crypto Service Operations - Online

Change channel into Standby (Offline)
Similarly, the procedure to change to Standby (Offline) uses the following steps:

1.  For a target logical partition select the Crypto IDs to be changed to Standby. For example, 
we select two crypto processors (06 and 07) which are currently in an online state. Click 
Configure On/Off task in Crypto Service Operations.

2. Select all crypto channel numbers you want, click Toggle All off to switch from Online to 
Standby in the desired state (Figure 8-38). 

Figure 8-38   SE Crypto Config On/Off (Toggle All Off)

3. After confirming that the desired state for your requested crypto channel is Standby, click 
the Apply button (Figure 8-39 on page 362).
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Figure 8-39   SE Crypto Config On/Off (Online to Standby)

4. When your request to configure a channel path On/Off is completed, the confirmation 
dialog shown in Figure 8-40 is displayed. Click OK.

Figure 8-40   SE Crypto Config On/Off (Standby Completed)

8.3  Activation and deactivation using ICSF

ICSF provides an ISPF Coprocessor Management panel to display or change the status, 
Active or Deactivate, of cryptographic coprocessors. This only refers to the coprocessor 
status to ICSF and has no effect on the Online/Standby hardware status displayed on the 
System z10 EC Support Element.

From the ICSF main menu, select option 1 to display the ICSF Coprocessor Management 
panel (Figure 8-41 on page 363).

 

 

 

362 IBM System z10 Enterprise Class Configuration Setup



 

Figure 8-41   Integrated Cryptographic Service Facility Main Panel

Cryptographic coprocessors that are currently configured on the partition are displayed on the 
ICSF Coprocessor Management panel (Figure 8-42).

Figure 8-42   ICSF Coprocessor Management

HCR7750  -------------- Integrated Cryptographic Service Facility--------------
 OPTION ===> 1                                                                  
 Enter the number of the desired option.                                        
                                                                                
   1  COPROCESSOR MGMT -  Management of Cryptographic Coprocessors              
   2  MASTER KEY       -  Master key set or change, CKDS/PKDS Processing        
   3  OPSTAT           -  Installation options                                  
   4  ADMINCNTL        -  Administrative Control Functions                      
   5  UTILITY          -  ICSF Utilities                                        
   6  PPINIT           -  Pass Phrase Master Key/CKDS Initialization            
   7  TKE              -  TKE Master and Operational Key processing             
   8  KGUP             -  Key Generator Utility processes                       
   9  UDX MGMT         -  Management of User Defined Extensions                 
                                                                                
                                                                                
      Licensed Materials - Property of IBM                                      
      5694-A01 (C) Copyright IBM Corp. 1989, 2007.  All rights reserved.        
      US Government Users Restricted Rights - Use, duplication or               
      disclosure restricted by GSA ADP Schedule Contract with IBM Corp.         
                                                                                
 Press ENTER to go to the selected option.                                      
 Press END   to exit to the previous menu.                                      

------------------------- ICSF Coprocessor Management -------- Row 1 to 6 of 6 
 COMMAND ===>                                                  SCROLL ===> PAGE 
                                                                                
  Select the coprocessors to be processed and press ENTER.                      
  Action characters are: A, D, E, K, R and S. See the help panel for details.   
                                                                                
     COPROCESSOR      SERIAL NUMBER   STATUS                                    
     -----------      -------------   ------                                    
 .   E00              97007984        ACTIVE                                    
 .   E01              97007985        ACTIVE                                    
 .   E02              97006647        ACTIVE                                    
 .   E03              97006644        ACTIVE                                    
 .   E04              97007866        ACTIVE                                    
 .   E05              97007853        ACTIVE                                    
******************************* Bottom of data ********************************
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When a coprocessor is configured off to the partition from the SE (Standby status), it is 
viewed Offline on the ICSF Coprocessor Management panel (Figure 8-43). 

Figure 8-43   ICSF Coprocessor Management (Candidate only - Standby)

A cryptographic coprocessor becomes visible to ICSF Coprocessor Management when the 
coprocessor number is part of the partition candidate list and the coprocessor is first brought 
online to the partition in either of these ways:

� At the time the partition is activated, if the coprocessor is installed and the coprocessor 
number is part of the partition Online list

� When the coprocessor is first configured online to the partition using the Config On/Off 
task from the SE Workplace.

Figure 8-44   ICSF Coprocessor Management (Online)

 ------------------------- ICSF Coprocessor Management -------- Row 1 to 8 of 8 
 COMMAND ===>                                                  SCROLL ===> PAGE 
                                                                                
  Select the coprocessors to be processed and press ENTER.                      
  Action characters are: A, D, E, K, R and S. See the help panel for details.   
                                                                                
     COPROCESSOR      SERIAL NUMBER   STATUS                                    
     -----------      -------------   ------                                    
 .   E00              97007984        ACTIVE                                    
 .   E01              97007985        ACTIVE                                    
 .   E02              97006647        ACTIVE                                    
 .   E03              97006644        ACTIVE                                    
 .   E04              97007866        ACTIVE                                    
 .   E05              97007853        ACTIVE                                    
 .   E07                              OFFLINE                                   
 .   F06                              OFFLINE                                   
******************************* Bottom of data ********************************

 ------------------------- ICSF Coprocessor Management -------- Row 1 to 8 of 8 
 COMMAND ===>                                                  SCROLL ===> PAGE 
                                                                                
  Select the coprocessors to be processed and press ENTER.                      
  Action characters are: A, D, E, K, R and S. See the help panel for details.   
                                                                                
     COPROCESSOR      SERIAL NUMBER   STATUS                                    
     -----------      -------------   ------                                    
 .   E00              97007984        ACTIVE                                    
 .   E01              97007985        ACTIVE                                    
 .   E02              97006647        ACTIVE                                    
 .   E03              97006644        ACTIVE                                    
 .   E04              97007866        ACTIVE                                    
 .   E05              97007853        ACTIVE                                    
 .   E07              97006564        ACTIVE                                    
 .   F06                              ACTIVE                                    
******************************* Bottom of data ********************************
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In the list shown in Figure 8-44, enter action character A or D to switch a coprocessor status to 
Active or Deactivated. When a coprocessor is deactivated through ICSF, shown in 
Figure 8-45, it cannot be used by applications running in that system image.

We recommend that you deactivate an active coprocessor from the ICSF Coprocessor 
Management panel before it is configured off from the Support Element. If you do not 
deactivate the coprocessor first (before it is configured off from the SE), then some jobs may 
not be rerouted correctly.

Figure 8-45   ICSF Coprocessor Management (Deactivate)

 ------------------------- ICSF Coprocessor Management -------- Row 1 to 8 of 8 
 COMMAND ===>                                                  SCROLL ===> PAGE 
                                                                                
  Select the coprocessors to be processed and press ENTER.                      
  Action characters are: A, D, E, K, R and S. See the help panel for details.   
                                                                                
     COPROCESSOR      SERIAL NUMBER   STATUS                                    
     -----------      -------------   ------                                    
 .   E00              97007984        ACTIVE                                    
 .   E01              97007985        ACTIVE                                    
 .   E02              97006647        ACTIVE                                    
 .   E03              97006644        ACTIVE                                    
 .   E04              97007866        ACTIVE                                    
 .   E05              97007853        ACTIVE                                    
 .   E07              97006564        DEACTIVATED                               
 .   F06                              DEACTIVATED                               
******************************* Bottom of data ********************************
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The Active/Deactivated status viewed from ICSF Coprocessor Management does not change 
the Online/Standby status set from the System z10 EC Support Element (Figure 8-46).

Figure 8-46   ICSF - Coprocessor Hardware Status

---------------------- ICSF - Coprocessor Hardware Status ---------------------
 COMMAND ===>                                                  SCROLL ===>      
                                                              CRYPTO DOMAIN: 1  
                                                                                
 REGISTER STATUS                  COPROCESSOR E07                               
                                                                    More:     + 
  Crypto Serial Number          : 97006564                                      
  Status                        : ACTIVE                                        
  Symmetric-Keys Master Key                                                     
    New Master Key register     : EMPTY                                         
      Verification pattern      :                                               
      Hash pattern              :                                               
                                :                                               
    Old Master Key register     : EMPTY                                         
      Verification pattern      :                                               
      Hash pattern              :                                               
                                :                                               
    Current Master Key register : VALID                                         
      Verification pattern      : 5B8EAE2289D07CF7                              
      Hash pattern              : EB74EC9A1FDBE39A                              
                                : D0518360AB317815                              
  Asymmetric-Keys Master Key                                                    
    New Master Key register     : EMPTY                                         
      Hash pattern              :                                               
                                :                                               
    Old Master Key register     : EMPTY                                         
      Hash pattern              :                                               
                                :                                               
    Current Master Key register : VALID                                         
      Hash pattern              : 82F0E5C8849F2ECA                              
                                : 4C13B323C769691F                              
                                                                                
 Press ENTER to refresh the hardware status display. 
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Help information from ICSF Coprocessor Management, shown in Figure 8-47, describes valid 
actions and status information for each type of cryptographic coprocessor. 

Figure 8-47   ICSF Help for Coprocessor Management

----------------------- Help for Coprocessor Management -----------------------
 COMMAND ===>                                                                   
 Press enter to page through this help.                                         
                                                                    More:     + 
 The Coprocessor Management panel displays the status of all cryptographic      
 coprocessors installed.  Select the coprocessors to be processed.              
                                                                                
 Prefix     Type of cryptographic coprocessor        Valid action characters    
 ------     ---------------------------------        -----------------------    
   A         PCI Cryptographic Accelerator            a, d                      
   E         Crypto Express2 Coprocessor              a, d, e, k, r, s          
   F         Crypto Express2 Accelerator              a, d,                     
   X         PCI X Cryptographic Coprocessor          a, d, e, k, r, s          
                                                                                
 Action characters:  (entered on the left of the coprocessor number)            
  'a'      Makes available a coprocessor previously deactivated by a 'd'.       
  'd'      Makes a coprocessor unavailable.                                     
  'e'      Selects the PCIXCC/CEX2C for clear master key entry.                 
  'k'      Selects the PCIXCC/CEX2C for DES operational key load                
  'r'      Causes the PCIXCC/CEX2C default role to be displayed.                
  's'      Causes complete hardware status to be displayed for an PCIXCC/CEX2C. 
 The action character 'e' can not be combined with any other action characters. 
 The action character 'k' may be specified on only one coprocessor.             
                                                                                
 Cryptographic Accelerator:                                                     
   - ACTIVE:        The accelerator is available for work.                      
   - OFFLINE:       The accelerator is installed but not available to ICSF.     
   - DEACTIVATED:   The accelerator has been deactivated (see action 
characters)
   - QUIESCING:     The accelerator is being deactivated.                       
   - TEMP UNAVAILABLE:  The accelerator is temporarily busy.                    
   - HARDWARE ERROR:    The accelerator has been stopped.                       
                                                                                
 Cryptographic Coprocessor:                                                     
   - ACTIVE:    The symmetric-keys master key is valid.                         
   - ONLINE:    The symmetric-keys master key is not valid.                     
   - OFFLINE:   The coprocessor is installed but not available to ICSF.         
   - DISABLED:  The coprocessor has been removed from service by a TKE work     
                station.                                                        
   - DEACTIVATED: The coprocessor has been deactivated (see action characters). 
   - QUIESCING:   The coprocessor is being deactivated.                         
   - TEMP UNAVAILABLE:  The coprocessor is temporarily busy.                    
   - HARDWARE ERROR:    The coprocessor has been stopped.                       
   - UNKNOWN: CODE =  cccc/ssss  The coprocessor has returned a return/reason   
                                 code combination unrecognized by ICSF. 
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Chapter 9. Reserved logical partitions

In this chapter we explain how to implement and use reserved logical partitions on the 
System z10 EC.

We cover the following topics in this chapter:

� Introduction to reserved logical partitions

� Name and activate a reserved logical partition

� Un-name a reserved logical partition

� Rename a reserved logical partition

9
 

 

 

© Copyright IBM Corp. 2008. All rights reserved. 369



 

9.1  Introduction to reserved logical partitions

A logical partition can be named, given resources, and activated when needed. A logical 
partition can also be deactivated and unnamed, meaning it becomes a reserved logical 
partition. In addition to this, a logical partition can have its name changed. This can all be 
done without the need for a Power-On Reset (POR).

There are various reasons why a client may want to use reserved logical partitions. As the 
capacity of one server increases, there is an associated tendency for the number of logical 
partitions on the server to correspondingly increase. In this case there may be the need, for 
example, for the addition of a new z/OS image, the removal of redundant z/OS images, or 
even the consolidation of logical partitions from multiple servers. All of this can be done 
without disrupting the operating logical partitions. The use of reserved logical partitions also 
includes logical partitions to be used as Coupling Facility images or Linux partitions.

The use of reserved logical partitions, in conjunction with concurrent Book, memory, and 
channel upgrades, means that the need for a power-on reset of the System z10 EC is kept to 
a minimum. This in turn means that the unnecessary downtime on active logical partitions is 
also reduced.

During the initial configuration setup of a processor, you have to plan for several hardware 
configuration definitions, including the logical partitions, channels, channel subsystems (CSS) 
and Subchannel Sets (SS). These definitions influence the Hardware System Area storage 
size which a processor requires. The reserved logical partitions also require extra space in 
the HSA. However, it is no longer a requirement to plan for HSA growth due to additional 
definitions while planning for the System z10 EC.

The ability to use reserved logical partitions depends on certain prerequisite hardware and 
software requirements being in place before this function can be used. In addition, any 
Independent Software Vender (ISV) software that relies on the logical partition MIF ID might 
need to be updated.

Important: On System z10 EC, a fixed amount (16 GB) is reserved for HSA storage size 
and is fenced off from customer purchased memory. When defining a z10 EC in HCD the 
maximum numbers of logical partitions, channel subsystems, and subchannel sets are 
defined, and when the associated IOCDS is activated, HSA space is allocated for this 
configuration. This relieves the user of planning considerations to reserve space for future 
partitions in the Input/Output Configuration Data Set (IOCDS) or to do a Power-On-Reset 
(POR) even if a new logical partition is needed.
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9.2  Name and activate a reserved logical partition

To activate a reserved logical partition, an HCD configuration change is required in order to 
assign a name to the logical partition. In addition, the Activation Profile for the new logical 
partition must be updated. 

It is assumed that the System z10 EC has sufficient resources for the new logical partition, 
which includes memory, channels and CPs. The following steps are required to name and 
activate a reserved logical partition:

� Name a reserved logical partition.

� Activate the configuration on the System z10 EC.

� Customize the Activation Profile.

We discuss these tasks in more detail in the following sections.

9.2.1  Name a reserved logical partition

To name the reserved logical partition, follow these steps using HCD:

1. From the HCD primary menu select option 1. Define, modify, or view configuration 
data, then select option 3. Processors to display the processor list. Select the processor 
that has the reserved logical partition you want to name and select the CSS from the 
Channel subsystem list that contains the reserved logical partition that you want to name. 
This will display the partition list for the selected CSS.

2. From the partition list, name the target reserved logical partition by using the Change (c) 
option. The example in Figure 9-1 shows logical partition number “6” in CSS ID 2 is 
reserved, its name displayed as “*”. 

Figure 9-1   HCD - Changing a reserved logical partition

--------------------------sss Partition List --------------------------ss
   Goto  Backup  Query  Help                                             
 ----------------------------------------------------------------------- 
                                                              Row 1 of 15
 Command ===> ________________________________________ Scroll ===> CSR   
                                                                         
 Select one or more partitions, then press Enter. To add, use F11.       
                                                                         
 Processor ID  . . . . : SCZP201                                         
 Configuration mode  . : LPAR                                            
 Channel Subsystem ID  : 2                                               
                                                                         
 / Partition Name   Number Usage + Description                           
 _ A21              1      OS      ________________________________      
 _ A22              2      OS      ________________________________      
 _ A23              3      OS      ________________________________      
 _ A24              4      OS      ________________________________      
 _ A25              5      OS      ________________________________      
 c *                6      CF/OS   New Named LPAR                        
 _ *                7      CF/OS   Reserved LPAR 
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Figure 9-2 shows that logical partition is given the new name A26. Remember that this 
name is in the IPL load member; we recommend using a name that conforms to your 
standard. Also remember that the partition number (MIF image ID) cannot change from 
what it was set to in the initial partition definition when this partition was created. This 
value already has been set during the power-on reset.

3. Change Partition usage, if necessary.

Figure 9-2   HCD - naming to a reserved logical partition

4. Assign all channels required by the logical partition to access the devices it needs using 
the Include in access list (a) options (Figure 9-3 on page 373). All devices on the 
selected CHPIDs are available to the newly named logical partition.

These channels depend on what works on that newly named logical partition; you might 
need to define devices such as CTC and Coupling links, including InfiniBand (CIB). An 
operating system configuration may have to be created if using a different one from those 
already defined. Remember to ensure that devices like disk subsystems have sufficient 
logical channel connections to support the new logical partition I/O activity. 

5. If you have channels that you do not want to connect to the newly named logical partition, 
those channels must have their candidate lists updated to exclude the newly named 
logical partition using the Include in candidate list (c) option. If some devices already 
have candidate lists, the new logical partition is not included in that candidate list.

-------------- Change Partition Definition ----------

 Specify or revise the following values.            
                                                    
 Partition name . . . A26                           
 Partition number . . 6      (same as MIF image ID) 
 Partition usage  . . OS     +                      
                                                    
 Description  . . . . New Named LPAR 
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Figure 9-3   HCD - Update CHPID to new named logical partition

6. Your partition is now named and has all its necessary resources defined from an HCD 
perspective (Figure 9-4). At this point, a production IODF can be built.

Figure 9-4   HCD - Partition List with new named logical partition

------------- Update CHPID Access and Candidate Lists -------------
                                                      Row 1 of 104 
 Command ===> _________________________________ Scroll ===> CSR    
                                                                   
 Select channel paths to include or exclude, then press Enter.     
                                                                   
 Partition name . . : A26       New Named LPAR                     
                                                                   
                        ---Partition Included In---                
 / CHPID  Type   Mode   Access List  Candidate List                
 _ 00     OSD    SPAN   Yes          No                            
 _ 01     OSD    SPAN   Yes          No                            
 _ 02     OSD    SPAN   Yes          No                            
 _ 03     OSD    SPAN   Yes          No                            
 _ 04     OSD    SPAN   No           No                            
 _ 05     OSD    SPAN   No           No                            
 _ 06     OSD    SPAN   No           No                            
 _ 07     OSD    SPAN   No           No                            
 _ 08     OSD    SPAN   No           No                            
 _ 09     OSD    SPAN   No           No                            
 _ 0A     OSD    SPAN   No           No 

--------------------------sss Partition List --------------------------sss
   Goto  Backup  Query  Help                                              
 -----------------------------------------------------------------------  
                                                              Row 1 of 15 
 Command ===> ________________________________________ Scroll ===> CSR    
                                                                          
 Select one or more partitions, then press Enter. To add, use F11.        
                                                                          
 Processor ID  . . . . : SCZP201                                          
 Configuration mode  . : LPAR                                             
 Channel Subsystem ID  : 2                                                
                                                                          
 / Partition Name   Number Usage + Description                            
 _ A21              1      OS      ________________________________       
 _ A22              2      OS      ________________________________       
 _ A23              3      OS      ________________________________       
 _ A24              4      OS      ________________________________       
 _ A25              5      OS      ________________________________       
 _ A26              6      OS      New Named LPAR                         
 _ *                7      CF/OS   Reserved LPAR 
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9.2.2  Activate the configuration on the System z10 EC

This section explains how to dynamically activate the production IODF to the processor and 
the systems running on it. For more information, see the Hardware Configuration Definition 
User’s Guide (SC33-7988).

Check the definition for IODF dynamic change 
1. Before dynamically activating the production IODF that contains the definition of the newly 

named logical partition, you have to verify that the processor is enabled for dynamic 
activation. From the Dynamic section in the activation profile of the CPC on the HMC 
application, verify that the Allow dynamic I/O changes to the channel subsystem I/O 
definition option is checked. This option must have already been enabled before the last 
power-on reset of the System z10 EC (Figure 9-5). If this isn’t the case, a power-on reset 
is needed to change the reserved logical partition to a named logical partition.

Figure 9-5   HMC - Dynamic section in reset profile

2. Check that the z/OS system supports the command to activate the new configuration 
dynamically. This command is issued through HCD or as a z/OS activate command. This 
function is supported in z/OS V1R6, so when that command is issued in the system 
running on System z10 EC for which z/OS V1R7 or above is required, the software 
requirement should be already satisfied.

3. Before issuing the activate command, be sure to verify that full Software and Hardware 
Activates can be done. From a system console issue d ios,config(all). You should see 
a display similar to the one in Figure 9-6 on page 375. This display shows that the source 
IODF and the active IODF are the same (SYS6.IODF41); therefore, a full Activate can be 
done.
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Figure 9-6   Display IOS,CONFIG output

4. You can also use the HCD Activate or process configuration data → View active 
configuration option to verify that a full ACTIVATE can be performed (Figure 9-7). This 
option gives you the message CBDA781I as shown in Figure 9-8 on page 376.

Figure 9-7   HCD - View Active Configuration

D IOS,CONFIG(ALL)                                       
IOS506I 12.26.18 I/O CONFIG DATA 529                    
ACTIVE IODF DATA SET = SYS6.IODF41                      
CONFIGURATION ID = TEST2097 EDT ID = 01 
TOKEN:  PROCESSOR DATE     TIME     DESCRIPTION         
 SOURCE: SCZP201  07-12-04 11:59:35 SYS6     IODF41     
ACTIVE CSS:  0    SUBCHANNEL SETS CONFIGURED: 0, 1      
CHANNEL MEASUREMENT BLOCK FACILITY IS ACTIVE            
HARDWARE SYSTEM AREA AVAILABLE FOR CONFIGURATION CHANGES
PHYSICAL CONTROL UNITS               8133               
CSS  0 - LOGICAL CONTROL UNITS       4039               
 SS  0   SUBCHANNELS                63608               
 SS  1   SUBCHANNELS                62365               
CSS  1 - LOGICAL CONTROL UNITS       4035               
 SS  0   SUBCHANNELS                63592               
 SS  1   SUBCHANNELS                62365               
CSS  2 - LOGICAL CONTROL UNITS       4088               
 SS  0   SUBCHANNELS                65280               
 SS  1   SUBCHANNELS                65535               
CSS  3 - LOGICAL CONTROL UNITS       4088               
 SS  0   SUBCHANNELS                65280               
 SS  1   SUBCHANNELS                65535               
ELIGIBLE DEVICE TABLE LATCH COUNTS                      
        0 OUTSTANDING BINDS ON PRIMARY EDT 

------------------------- View Active Configuration -------------------------
                                                                             
 Currently active IODF  . . : SYS6.IODF41                                    
    Creation date . . . . . : 07-12-04                                       
    Volume serial number  . : IODFPK                                         
                                                                             
 Configuration ID . . . . . : TEST2097 Sysplex systems 
 EDT ID . . . . . . . . . . : 01                                             
                                                                             
 HSA token  . . . . . . . . : SCZP201  07-12-04 11:59:35 SYS6     IODF41     
                                                                             
 Activation scope:                                                           
 Hardware changes allowed . : Yes                                            
 Software changes allowed . : Yes                                            
                                                                             
 ENTER to view details on the activation scope. 
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Figure 9-8   HCD - display message for View Active Configuration

Activate a new IODF
After verification of the current definition, the new configuration can be activated dynamically. 
Watch for error messages and correct any that occur. The dynamic activate can be done 
either by using the z/OS activate command, or via HCD.

1. In HCD, select option 2. Activate or process configuration data, then select option 6, 
Activate or verify configuration dynamically. Next, select option 1, Activate new 
hardware and software configuration, which allows you to do a full dynamic activation 
(Figure 9-9).

Figure 9-9   HCD - Activate or Verify Configuration panel

2. Test to verify that the new production IODF can be successfully activated. You can 
accomplish this by setting the Test only option to Yes in HCD or using the z/OS activate 
iodf=xx,test command.

3. To activate the configuration change the Test only option to No, so the new hardware and 
software configuration is activated at the same time (Figure 9-10 on page 377).

 +----s Activate or Process Configuration Data ------+ _____________________ 

------------------------------ Message List ------------------------------
   Save  Query  Help                                                         
 --------------------------------------------------------------------------  
                                                                  Row 1 of 2 
 Command ===> ___________________________________________ Scroll ===> PAGE   
                                                                             
 Messages are sorted by severity. Select one or more, then press Enter.      
                                                                             
 / Sev Msg. ID  Message Text                                                 
 _ I   CBDA781I Your system configuration provides full dynamic              
 #              reconfiguration capability.                                  
 ***************************** Bottom of data ****************************** 

---------------- Activate or Verify Configuration ----------------

 The currently active IODF matches the hardware I/O               
 configuration.  Both hardware and software definitions may be    
 changed. Select one of the following tasks.                      
                                                                  
 1_  1.  Activate new hardware and software configuration.        
     2.  Activate software configuration only. Validate           
         hardware changes. Process changes to Coupling            
         Facility elements.                                       
     3.  Activate software configuration only.                    
     4.  Verify active configuration against system.              
     5.  Verify target configuration against system.              
     6.  Build CONFIGxx member. 
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Figure 9-10   HCD - Activate new IODF

4. Check all messages in the resulting panel, as shown in Figure 9-11, and verify that the 
dynamic activate completed successfully. Notice that the action performed by this HCD 
panel is the same as issuing the z/OS activate iodf=xx command.

5. Confirm the current active IODF by using the View active configuration option in HCD or 
the z/OS d ios,config command. Now you can view the newly defined logical partition 
name in the contents of the CPC when you log into the HMC.

Figure 9-11   HCD - Activate new IODF, message

6. Install a new IOCDS to the System z10 EC and make it the active IOCDS on the server for 
the next POR. From HCD, select option 2. Activate or process configuration data, then 
select option 11. Build and manage S/390 microprocessor IOCDSs and IPL attributes 
to update the new IOCDS into the HSA token slot and switch the active IOCDS. This 

------------- Activate New Hardware and Software Configuration -------------

 Specify or revise the values for IODF activation.                          
                                                                            
 Currently active IODF . : SYS6.IODF41                                      
    Processor ID . . . . : SCZP201                                          
    Configuration ID . . : TEST2097 Sysplex systems 
    EDT ID . . . . . . . : 01                                               
                                                                            
 IODF to be activated  . : SYS6.IODF4F                                      
    Processor ID . . . . . SCZP201   +                                      
    Configuration ID . . . TEST2097 +     EDT ID . . . 01  +               
                                                                            
 Test only  . . . . . . . . . . . . . . . . . . . . . NO   (Yes or No)      
 Allow hardware deletes (FORCE, FORCE=DEVICE) . . . . No   (Yes or No)      
 Delete partition access to CHPIDs unconditionally                          
 (FORCE=CANDIDATE)  . . . . . . . . . . . . . . . . . No   (Yes or No)      
 Write IOCDS  . . . . . . . . . . . . . . . . . . . . No   (Yes or No)      
 Switch IOCDS for next POR  . . . . . . . . . . . . . No   (Yes or No) 

 ------ Activate or Process Configuration Data -----------------------------

------------------------------ Message List -------------------------------
   Save  Query  Help                                                         
 --------------------------------------------------------------------------  
                                                                  Row 1 of 5 
 Command ===> ___________________________________________ Scroll ===> PAGE   
                                                                             
 Messages are sorted by severity. Select one or more, then press Enter.      
                                                                             
 / Sev Msg. ID  Message Text                                                 
 _ I   IOS500I  ACTIVATE RESULTS                                             
 #              ACTIVATE COMPLETED SUCCESSFULLY                              
 _ I   CBDA899I Following partitions are to be added to processor            
 #              SCZP201: 2.A26                                               
 _ I   CBDA126I ACTIVATE IODF=4F command was accepted.                       
 ***************************** Bottom of data ****************************** 
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operation enables you to use the new IOCDS, which contains the newly named logical 
partition, for the next POR.

9.2.3  Customize the Activation Profile

Customize the Activation Profile for the new named logical partition.

From the HMC, select the Customize/Delete Activation Profile for the server that contains 
the newly named logical partition. Select the desired reset profile and click Customize 
(Figure 9-12).

After you are in the reset profile, select the new IOCDS that was written to the server in the 
General page. A pop-up window will display, asking if you want to maintain the logical 
partition activation order in the Partitions page. Remember to verify the activation order of the 
Coupling Facility partitions on the server if you do update the activation order. Failure to do so 
may cause Coupling Facility partitions to activate after partitions running in other modes. This 
could lead to operating systems entering a disabled wait state.

Figure 9-12   HMC - Customize/Delete Activation Profile

Define the image profile to the new logical partition
You are now ready to define all the necessary resources to the new logical partition. After 
activating the production IODF which contained a newly named logical partition, you can view 
that logical partition from HMC. You now have to build the image profile for that partition. For 
more information about the definitions in the image profile, see Processor Resource/Systems 
Manager Planning Guide (SB10-7153).

To create the image profile for a new logical partition, click the Customize/Delete Activation 
Profiles task in the Operational Customization menu from HMC. Click Customize selected 
profile after selecting an existing image profile, or click the Image profile wizard. Define the 
values for the new logical partition.

Details about the definition values, organized by page, are in the following sections.
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General page
� Partition identifier

Assign a partition identifier to the new logical partition. This is defined by a hex value 
representing a maximum 60 (decimal) logical partitions; valid identifiers for LPs are X'00' 
through X'3F'. The LP identifier must be unique for each active LP. Remember to use an 
unassigned value that is not in use by any other partition. If the new logical partition is to 
be used as a Coupling Facility, the partition ID is important when defining or updating the 
CFRM policy.

� Operation mode 

You can define how this partition is to be used. The mode of an LP, depending on the 
model, can be ESA/390, ESA/390 TPF, Linux-Only, z/VM, or Coupling Facility. The mode 
of an LP must support the mode of the control program loaded into it. ESA/390 LPs 
support ESA/390 control programs, Coupling Facility LPs support the coupling facility 
control code, z/VM LPs support z/VM, and Linux-Only LPs support Linux, or z/VM.

� Clock type assignment

The clock value allows you to use an External Time Reference (ETR) such as a Sysplex 
Timer and Server Time Protocol (STP), or an internal TOD clock if this is a standalone 
server. You can also set an offset value to the STP or ETR clock here if you wish by 
selecting the Logical partition time offset. 

When this option is selected, another option (Time Offset) is added to the logical partition 
activation profile. You can set the logical partition time either ahead of or behind your ETR 
time by selecting the appropriate option.

Figure 9-13   HMC - General page in Image Profile

Processor page
The Processor page in the image profile is where you specify the new logical partition CP 
assignment. The items that are selectable on this page change depending on the mode of the 
LP selected on the General page. 

Note: zAAPs and zIIPs can be defined to ESA/390 or z/VM mode image. However, 
zAAPs and zIIPs are supported only by z/OS. Other operating systems cannot use 
zAAPs or zIIPs, even if they are defined to the logical partition. z/VM V5.3 can provide 
zAAPs or zIIPs to a guest z/OS.
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� Logical Processor Assignments

Figure 9-14 shows a sample page for an ESA/390 mode logical partition. You must set the 
initial and reserved number of CPs, zAAPs, and zIIPs. Initial refers to how many 
processors come online when the logical partition is IPLed; Reserved refers to how many 
processors can be configured online while the system is running. This value also allows 
for future upgrades and can be set to more than what is physically available in the server. 
That way, when extra processors are enabled, they can be configured online and used 
immediately.

� Not Dedicated Processor Details

If you operate this logical partition with shared processors (the box next to Dedicated 
processors in the Logical Processor Assignments section is not checked), then you need 
to set the processing weight and, if needed, the initial capping value and the Workload 
Manager values. Then, consider the impact for the systems working in other logical 
partitions on the same processor. The effective capacity for a processor might decrease 
because the cost to manage logical partitions becomes larger for PR/SM. We recommend 
that you estimate the capacity using the zPCR tool before defining processor resources, 
including the weight value. You can obtain this tool from IBM. For more details see 
TechDocs: Getting Started with zPCR (IBM Processor Capacity Reference), 
Doc:PRS689.

Figure 9-14   HMC Processor page in image profile

Security page
The Security settings determine the level of interlogical partition action that takes place. 
These values are unique to each client, but generally the first two options are always 
selected, namely Global performance data control and Input/Output configuration 
control.

For greater partition isolation, the other two options, Cross partition authority and Logical 
partition isolation, may be selected.

Storage page
Depending on the hardware model, the System z10 EC can support a minimum of 16 GB to a 
maximum of 1.5 TB of memory, with 384 GB per book, for customer use. Before activating 
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the new logical partition, you have to confirm the size of available storage to assign to the 
new logical partition. Use the Storage Information task in CPC Operational Customization 
from the Support Element (SE) to determine the available memory (Figure 9-15). This also 
shows that Hardware System Area (HSA) size is a fixed value (16384 MB/16 GB). The sum of 
central and expanded storage that you define in the image profile must be set to a value 
smaller than the amount of available storage, as shown in the Storage Information panel.

Figure 9-15   SE - Storage Information

Storage options are set from the Storage page in the image profile (Figure 9-16 on page 382). 
On the System z10 EC, memory can be assigned as a combination of Central Storage and 
Expanded Storage, supporting up to 60 logical partitions. Enter the value (in megabytes) of 
each storage space.

Initial storage is the amount of storage to be allocated to the LP at activation; reserved 
storage is the amount of additional storage requested for the LP. Reserved storage is storage 
that can be dynamically brought online to the LP at some point after LP activation. Entering 0 
for reserved storage limits storage to the initial amount for the duration of the LP activation.

Granularity of Central Storage for a logical partition is dependent on the largest Central 
Storage amount defined for either initial or reserved Central Storage, as shown in Table 9-1. 
The granularity applies across all Central Storage defined, both initial and reserved. For 
example, for an LP with an initial storage amount of 60 GB and a reserved storage amount of 
160 GB, the Central Storage granularity of both initial and reserved Central Storage is 
512 MB. Expanded Storage granularity is fixed at 256 MB. Expanded Storage granularity 
applies across the expanded storage input fields.

Table 9-1   Central Storage granularity

Remember that either a z/Architecture (64-bit) mode or an ESA/390 (31-bit) architecture 
mode operating system can run in an ESA/390 image on a System z10 EC. Any ESA/390 
image can be defined with more than 2 GB of Central Storage and can have Expanded 

LP Central Storage amount Logical partition storage granularity

Central storage amount <= 128 GB 256 MB

128 GB < central storage amount <= 256 GB 512 MB

256 GB < central storage amount <= 512 GB 1 GB

512 GB < central storage amount <= 1 TB 2 GB
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Storage. These options allow you to configure more storage resources than the operating 
system is capable of addressing.

Figure 9-16   HMC - Storage page in image profile

Cryptographic options
If the newly named logical partition is using cryptographic services, you must enable these 
options in the Crypto page of the image profile. Make sure that the Control Domain Index and 
Usage Domain Index are correct and do not conflict with any other logical partitions on the 
System z10 EC. If you duplicate definition values across logical partitions, you are not able to 
save the logical partition activation profiles until you correct the Cryptographic definitions.

These values can also be defined using the Change LPAR Cryptographic Controls task from 
the Support Element after activating the logical partition using the new image profile. This 
topic is covered in 8.2.4, “Cryptographic configuration using the Support Element” on 
page 346. 

Activate a reserved logical partition
After all the values have been updated and saved, the logical partition can be activated and 
IPLed. This operation is done from HMC.

1. Select the logical partition from the HMC Contents of CPC that you want to activate. Click 
the Activate task from the Daily group menu.

2. After confirming that the activation profile is correct, click Yes in the Activate Task 
Confirmation window (Figure 9-17).

Figure 9-17   HMC - Activate Task Confirmation
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3. Check that the activation task completed successfully. The status should have changed 
from Not Activating to Not Operating in the detail information of the target logical partition 
(Figure 9-18).

Figure 9-18   HMC - Details after activating a new logical partition

Finally, you can IPL an operating system in the newly named logical partition.

9.3  Un-name a reserved logical partition

This section explains the steps to change an active logical partition into a reserved partition 
whose name is removed (Un-name).

Deactivate logical partition
First, this requires the deactivation of the target logical partition. Deactivating a logical 
partition is a straightforward process. Once the image has been reset, the logical partition can 
be deactivated from the Deactivate task in the HMC. This frees up all the partition’s 
resources, such as memory, CPs, and channels.

HCD definition changes
After deactivation is complete, make changes via HCD or HCM to revert the logical partition 
back to a reserved logical partition. In HCD, the process of changing a named logical partition 
to a reserved logical partition is the reverse process of naming a logical partition. Before 
making any changes in HCD for the logical partition that will be changed to reserved status, 
we recommend that you verify which channels and devices are defined to the Candidate Lists 
for this logical partition.

Some devices may generate errors if they have been included in the candidate lists for the 
logical partition that is changed to reserved status. 

1. In the HCD panel, select the CSS ID containing the partition you want to change to a 
reserved logical partition. A sample partition list is shown in Figure 9-1 on page 371.

Note: First remove all the assigned CHPIDs for this logical partition. Failure to do this 
before attempting to change the logical partition name to an asterisk (*) results in HCD 
generating errors.
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2. Select the Change logical partition option and proceed to the Update CHPID Access 
and Candidate Lists panel, shown in Figure 9-3 on page 373. Change all the CHPID 
Access and Candidate Lists to No. This removes all channels from the logical partition. 

3. After this is completed, proceed to renaming the partition. When renaming is completed, 
note that the reserved partition is now at the end of the partition list and has an asterisk (*) 
in the name field. You are now ready to activate the new configuration.

Dynamic activation of configuration
For dynamic activation of the production IODF, perform the following steps:

1. Use option 1, Activate new hardware and software configuration, as shown in 
Figure 9-9 on page 376. When a new configuration that has a reserved logical partition 
(un-named) is activated, you must add the force option. If the force option is not added, the 
activation fails with an IOS500I message as shown in Figure 9-19.

Figure 9-19   HCD - Activate new IODF remove logical partition, message (bad case)

2. Set the Allow hardware deletes option to Yes (Figure 9-20 on page 385).

3. Check all messages in the result panel (Figure 9-21 on page 385), and verify that the 
dynamic activate completed successfully. The activate action performed by HCD can also 
be accomplished by issuing the z/OS activate iodf=xx,force=device command.

 ----- Activate or Process Configuration Data ------- _____________________ 

------------------------------ Message List ------------------------------
   Save  Query  Help                                                         
 --------------------------------------------------------------------------  
                                                                  Row 1 of 8 
 Command ===> ___________________________________________ Scroll ===> PAGE   
                                                                             
 Messages are sorted by severity. Select one or more, then press Enter.      
                                                                             
 / Sev Msg. ID  Message Text                                                 
 _ E   IOS500I  ACTIVATE RESULTS                                             
 #              ACTIVATE FAILED - ERROR MESSAGE(S) ISSUED                    
 _ E            REASON=0150,REQUEST CONTAINS DELETE(S), BUT FORCE OPTION     
 #              NOT SPECIFIED                                                
 #               COMPID=SC1C3                                                
 _ I   CBDA878I Following partitions are to be deleted from processor        
 #              SCZP201: 2.A26                                               
 _ I   CBDA126I ACTIVATE IODF=41 command was accepted.                       
 ***************************** Bottom of data ****************************** 
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Figure 9-20   Activate New Hardware and Software Configuration

Figure 9-21   HCD - Activate new IODF remove logical partition, message

Removing resources from the activation profiles
When the new configuration has been activated and the logical partition removed, you can 
remove the resources defined to the logical partition from the Activation Profile on the HMC. 
The important resource is storage; you may want to add this to another partition. 

After all the resources have been removed, write a new IOCDS to the Support Element (SE) 
on the server and make it active. Afterwards, update the Activation profiles to point to the new 
IOCDS. The partition that was changed to reserved status no longer exists in the partition list.

------------- Activate New Hardware and Software Configuration -------------
                                                                            
                                                                            
 Specify or revise the values for IODF activation.                          
                                                                            
 Currently active IODF . : SYS6.IODF4F                                      
    Processor ID . . . . : SCZP201                                          
    Configuration ID . . : TEST2097 Sysplex systems 
    EDT ID . . . . . . . : 01                                               
                                                                            
 IODF to be activated  . : SYS6.IODF41                                      
    Processor ID . . . . . SCZP201   +                                      
    Configuration ID . . . TEST2097  +     EDT ID . . . 01  +               
                                                                            
 Test only  . . . . . . . . . . . . . . . . . . . . . No   (Yes or No)      
 Allow hardware deletes (FORCE, FORCE=DEVICE) . . . . Yes  (Yes or No)      
 Delete partition access to CHPIDs unconditionally                          
 (FORCE=CANDIDATE)  . . . . . . . . . . . . . . . . . No   (Yes or No)      
 Write IOCDS  . . . . . . . . . . . . . . . . . . . . No   (Yes or No)      
 Switch IOCDS for next POR  . . . . . . . . . . . . . No   (Yes or No) 

 -----s Activate or Process Configuration Data ----- _____________________ 

------------------------------ Message List -------------------------------
   Save  Query  Help                                                         
 --------------------------------------------------------------------------  
                                                                  Row 1 of 5 
 Command ===> ___________________________________________ Scroll ===> PAGE   
                                                                             
 Messages are sorted by severity. Select one or more, then press Enter.      
                                                                             
 / Sev Msg. ID  Message Text                                                 
 _ I   IOS500I  ACTIVATE RESULTS                                             
 #              ACTIVATE COMPLETED SUCCESSFULLY                              
 _ I   CBDA878I Following partitions are to be deleted from processor        
 #              SCZP201: 2.A26                                               
 _ I   CBDA126I ACTIVATE IODF=41,FORCE=DEVICE command was accepted.          
 ***************************** Bottom of data ****************************** 
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9.4  Rename a reserved logical partition

Changing a reserved logical partition name from one name to another name cannot be done 
directly. It is a two-step process that combines the following tasks: 

� Deactivate and un-name a named logical partition, making it reserved. 

� Name, assign resources, and activate the reserved logical partition. 

There are special considerations when using this approach. You must remember that it is a 
two-phased approach. 

1. The configuration has to be changed to remove all assigned channels and devices, and 
then the new configuration has to be activated. 

2. The configuration has to be changed again and the reserved logical partition has to be 
given a new name (and, if need be, a new operating mode); all the channels and devices 
it requires must be assigned. 

The configuration is then activated and the newly named logical partition is ready for use.

We discuss how to un-name and deactivate a logical partition in “Un-name a reserved logical 
partition” on page 383, and how to name a reserved logical partition in “Name a reserved 
logical partition” on page 371. Here, we concentrate on changing the name and operating 
mode of a logical partition. We use the example of changing a z/OS partition to a Linux 
partition. 

Any of the following combinations is possible:

� z/OS partition to CF partition, or to a Linux partition, or to a different z/OS partition
� CF partition to z/OS partition, or to a Linux partition, or to a different CF partition
� Linux partition to a z/OS partition, or to a CF partition, or to a different Linux partition

Renaming a z/OS logical partition to a Linux logical partition
Changing a named z/OS partition to a Linux partition consists of six steps. It is assumed that 
all the resources needed for the Linux partition are available (including storage, channels and 
IFLs or CPs). 

To accomplish this change, perform the following steps:

1. In the IODF, remove all assigned channels and, optionally, any devices that may be in the 
candidate list for the logical partition that will have its name and usage changed.

2. Change the partition name value to an asterisk (*); this makes the logical partition a 
reserved logical partition. Build the new IODF. Make sure the logical partition that is 
renamed has been reset and deactivated on the HMC application.

3. Dynamically Activate the new configuration, either by using the activate command from 
an active z/OS logical partition on the System z10 EC where the logical partition is being 
renamed, or via the HCD panels. 

Note: Remember to save the Reset activation profile in case a recovery action needs to be 
performed against the server.

If the old IOCDS is still in the Reset profile and a recovery action is performed against the 
server, the old partition is defined to the server again and attempts to allocate all its 
resources.
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4. Using the work version of the IODF activated in step 3, name the reserved logical partition. 
Assign a partition name and usage. (In this example the usage can be CF/OS, but OS is 
also allowed.) Keep in mind that the partition MIF ID cannot be changed. 

.

5. Assign the channel paths and devices needed for the Linux logical partition. This can 
include channel types FC, FCP, FCV, OSD, OSE, OSN, OSC, IQD, and CNC/CTC.

6. You can now build a new production IODF for dynamic activation. The Dynamic Activate 
can be done once again via the z/OS activate command, or via the HCD panels. 

After the activate has completed successfully, you should write a new IOCDS to the SE. 
The current IOCDS in the Activation Profile for the System z10 EC still reflects the old 
name of the logical partition. While this activation profile for the re-named logical partition 
could be updated and used, the name may not match the new name you have assigned. 
Change the activation profile to point to the new IOCDS and pay attention to the activation 
order of all the logical partitions.

Note: If you are renaming a partition on a z10 EC that already has a Coupling Facility 
with peer mode Coupling links defined, you should change the Partition usage value to 
OS only because Coupling links in peer mode can only be connected to one Coupling 
Facility on a server. 

By using CF/OS, HCD does not allow you to connect any Coupling link that is already 
connected to another Coupling Facility to the reserved partition you are renaming, even 
if you are using this logical partition as an operating system.

Note: OSC is the channel type for the OSA-Express Integrated Console Controller 
(OSA-ICC). This channel type can be used by z/Linux systems.
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Related publications

The publications listed in this section are considered particularly suitable for a more detailed 
discussion of the topics covered in this book.

IBM Redbooks

For information about ordering these publications, see “How to get Redbooks” on page 390. 
Note that some of the documents referenced here may be available in softcopy only. 

� IBM System z10 Enterprise Class Technical Introduction, SG24-7515

� IBM System z10 Enterprise Class Technical Guide, SG24-7516

� IBM System z Connectivity Handbook, SG24-5444

� Getting Started with InfiniBand on System z10 and System z9, SG24-7539

� Server Time Protocol Planning Guide, SG24-7280

� Server Time Protocol Implementation Guide, SG24-7281
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These publications are also relevant as further information sources:

� Hardware Management Console Operations Guide Version 2.10.0, SC28-6867

� Support Element Operations Guide V2.10.0, SC28-6868

� Hardware Configuration Definition User’s Guide, SC33-7988

� IOCP User’s Guide, SB10-7037

� Stand-Alone Input/Output Configuration Program User’s Guide, SB10-7152

� Planning for Fiber Optic Links, GA23-0367

� CHPID Mapping Tool User’s Guide, GC28-6825

� Common Information Model (CIM) Management Interfaces, SB10-7154

� IBM System z10 Enterprise Class Installation Manual, GC28-6865

� IBM System z10 Enterprise Class  Installation Manual for Physical Planning, GC28-6864

� IBM System z10 Enterprise Class  Processor Resource/Systems Manager Planning 
Guide, SB10-7153

� IBM System z10 Enterprise Class  System Overview, SA22-1084

� IBM System z10 Enterprise Class  Capacity on Demand User’s Guide, SC28-6871

� IBM System z Functional Matrix, ZSW0-1335

� z/Architecture Principles of Operation, SA22-7832

� z/OS Cryptographic Services Integrated Cryptographic Service Facility Administrator’s 
Guide, SA22-7521.

� z/OS Cryptographic Services Integrated Cryptographic Service Facility Application 
Programmer’s Guide, SA22-7522
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� z/OS Cryptographic Services Integrated Cryptographic Service Facility Messages, 
SA22-7523 

� z/OS Cryptographic Services Integrated Cryptographic Service Facility Overview, 
SA22-7519

� z/OS Cryptographic Services Integrated Cryptographic Service Facility System 
Programmer’s Guide, SA22-7520

Online resources

These Web sites are also relevant as further information sources:

� IBM Resource Link:

http://www.ibm.com/servers/resourcelink/

� Server Time protocol Web page:

http://www-03.ibm.com/servers/eserver/zseries/pso/stp.html

How to get Redbooks

You can search for, view, or download Redbooks, Redpapers, Technotes, draft publications 
and Additional materials, as well as order hardcopy Redbooks, at this Web site: 

ibm.com/redbooks

Help from IBM

IBM Support and downloads

ibm.com/support

IBM Global Services

ibm.com/services
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Glossary

American National Standards Institute (ANSI). An 
organization consisting of producers, consumers, and 
general interest groups that establishes the procedures by 
which accredited organizations create and maintain 
voluntary industry standards in the United States.

ANSI. See American National Standards Institute.

APAR. See authorized program analysis report.

Attached Server (AS). From the perspective of a server, 
a server to which one or more STP paths have been 
established as specified by the Establish Path Procedure.

authorized program analysis report (APAR). A report of 
a problem caused by a suspected defect in a current, 
unaltered release of a program.

basic mode. A S/390 central processing mode that does 
not use logical partitioning. Contrast with logically 
partitioned (LPAR) mode. Basic mode is not available on 
System z9, z990, or z890 servers.

Branch History Table (BHT). 

Branch Target Buffer (BTB). 

bus. (1) A facility for transferring data between several 
devices located between two end points, only one device 
being able to transmit at a given moment. (2) A network 
configuration in which nodes are interconnected through 
a bidirectional transmission medium. (3) One or more 
conductors used for transmitting signals or power. 

CBP. Integrated cluster bus coupling facility peer link. 

CCC. Channel control check. 

CDC. Channel data check. 

central processor complex. A physical collection of 
hardware that consists of main storage, one or more 
central processors, timers, and channels.

central processor. A processor that contains the 
sequencing and processing facilities for instruction 
execution, interruption action, timing functions, initial 
program loading, and other machine-related functions. 

CFCC. Coupling Facility Control Code.

channel control check. A category of I/O errors affecting 
channel controls and sensed by the channel to which a 
device is attached. See also channel data check.
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channel data check. A category of I/O errors indicating a 
machine error in transferring data to or from storage and 
sensed by the channel to which a device is attached. See 
also channel control check. 

channel Licensed Internal Code. That part of the 
channel subsystem Licensed Internal Code used to start, 
maintain, and end all operations on the I/O interface. See 
also IOP Licensed Internal Code.

channel path (CHP). A single interface between a central 
processor and one or more control units along which 
signals and data can be sent to perform I/O requests.

channel path configuration. In an ESCON or FICON 
environment, the connection between a channel and a 
control unit or between a channel, an ESCON Director, 
and one or more control units. See also point-to-point 
channel path configuration and switched point-to-point 
channel path configuration.

channel path identifier (CHPID). In a Channel 
Subsystem, a value assigned to each installed channel 
path of the system that uniquely identifies that path to the 
system. 

Channel Subsystem (CSS). Relieves the processor of 
direct I/O communication tasks, and performs path 
management functions. Uses a collection of subchannels 
to direct a channel to control the flow of information 
between I/O devices and main storage.

channel. (1) A processor system element that controls 
one channel path, whose mode of operation depends on 
the type of hardware to which it is attached. In a Channel 
Subsystem, each channel controls an I/O interface 
between the channel control element and the logically 
attached control units. (2) In the ESA/390 and 
z/Architecture, the part of a Channel Subsystem that 
manages a single I/O interface between a Channel 
Subsystem and a set of controllers (control units).

channel-attached. (1) Pertaining to attachment of 
devices directly by data channels (I/O channels) to a 
computer. (2) Pertaining to devices attached to a 
controlling unit by cables rather than by 
telecommunication lines.

channel-to-channel adapter (CTCA). An input/output 
device that is used by a program in one system to 
communicate with a program in another system.

check stop. The state that occurs when an error makes it 
impossible or undesirable to continue the operation in 
progress.
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CHPID. Channel path identifier. 

CMAS. CICS® SM address space.

CMOS. Complementary metal-oxide semiconductor.

CMT. CHPID Mapping Tool.

CNC. Mnemonic for an ESCON channel used to 
communicate to an ESCON-capable device.

Communication Error. A communication error has been 
recognized for the attached server indicating that the 
attached server has not communicated with this server for
a period greater than the freewheel period.

concurrent maintenance. Hardware maintenance 
actions performed by a service representative while 
normal operations continue without interruption. See also 
nondisruptive installation and nondisruptive removal.

Configuration Error. A configuration error has been 
recognized for the attached server indicating the attached 
server has provided a mismatched CTN ID on one of the 
paths to the attached server.

control unit. A hardware unit that controls the reading, 
writing, or displaying of data at one or more input/output 
units. 

Coordinated Server Time (CST). The time maintained at 
each Stratum 1 server in a CTN; it is the reference time for 
the CTN. CST may be provided to a server via the 
Hardware Management Console or by a Sysplex Timer. 

Coordinated Timing Network (CTN). A collection of 
servers, each of which exchanges STP timekeeping 
messages with attached servers so that all servers in the 
CTN may synchronize to Coordinated Server Time (CST). 
The servers that make up a CTN are all configured with a 
common identifier, referred to as a CTN ID.

Coordinated Timing Network ID. Specifies the ID for the 
Coordinated Timing Network (CTN) that the server is 
participating in. The form is STP ID-ETR ID. 
� If the server is not a member of any timing network, 

there will be no values in the fields. 
� If it is participating in an ETR network, you will see 

‘-xx’, where xx is a value from 0-31. 
� If it is participating in a Mixed CTN, you will see 

‘cccccccc - xx’, where ccccccc is 1-8 characters and 
xx is a value from 0-31. The valid characters for the 
STP ID are A-Z, a-z, 0-9, ‘-’, and ‘_’.

Changes made to the Coordinated Timing Network ID are 
applied to the entire timing network. If a valid STP ID 
exists, changing the ID results in all CPCs in the STP 
timing network becoming members of a different CTN. If 
the ETR ID is specified when in an STP network, the 
STP-only network will transition back to a Mixed network.

coupler. In an ESCON environment, link hardware used 
to join optical fiber connectors of the same type. Contrast 
with adapter.

coupling facility control code. The Licensed Internal 
Code (LIC) that runs in a coupling facility logical partition 
to provide shared storage management functions for a 
Sysplex.

coupling facility. A special logical partition that provides 
high-speed caching, list processing, and locking functions 
in a Sysplex.

CP. Central Processor.

CPC. Central Processor Complex

CPU Timer. The CPU timer provides a means for 
measuring elapsed CPU time and for causing an 
interruption when a specified amount of time has elapsed.
In a configuration with more than one CPU, each CPU has 
a separate CPU timer.

CPU. Central Processing Unit. 

CST. Coordinated Server Time

CTC. (1) Channel-to-channel. (2) Mnemonic for an 
ESCON channel attached to another ESCON channel. 

CTCA. see channel-to-channel adapter.

CU. Control unit. 

CUA®. Control unit address. 

CUADD. Control unit logical address. 

CULA. Control unit logical address.

Current Time Server. Specifies if the Preferred Time 
Server or Backup Time Server is the Current Time Server. 
The Current Time Server identifies where the time 
reference is currently coming from. The Current Time 
Server cannot be the Backup Time Server unless there is 
a Preferred/Backup (dual) or Preferred/Backup/Arbiter 
(triad) configuration.

CVC. Mnemonic for an ESCON channel attached to an 
IBM 9034 convertor. The 9034 converts from ESCON 
CVC signals to parallel channel interface (OEMI) 
communication operating in block multiplex mode (Bus 
and Tag). Contrast with CBY.

data sharing. The ability of concurrent subsystems (such 
as DB2® or IMS™ DB) or application programs to directly 
access and change the same data while maintaining data 
integrity.

default. Pertaining to an attribute, value, or option that is 
assumed when none is explicitly specified.
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device number. (1) In the ESA/390 architecture and the 
z/Architecture, a four-hexidecimal-character identifier, for 
example 19A0, that you associate with a device to 
facilitate communication between the program and the 
host operator. (2) The device number that you associate 
with a subchannel that uniquely identifies an I/O device.

device. A mechanical, electrical, or electronic contrivance 
with a specific purpose. 

direct access storage device (DASD). A mass storage 
medium on which a computer stores data.

Dispersion. A value that contains the CST dispersion 
reported by the attached server. The value represents the 
dispersion of the TOD clock at the attached server relative 
to the Preferred Time Server in the synchronization path 
selected by the attached server.

dual. A term sometimes used to describe a 
Preferred/Backup server configuration.

Dual-Inn Memory Module (DIMM). A series of random 
access memory integrated circuits.

duplex. Pertaining to communication in which data or 
control information can be sent and received at the same 
time. Contrast with half duplex.

dynamic connection. In an ESCON Director, a 
connection between two ports, established or removed by 
the ESCD and that, when active, appears as one 
continuous link. The duration of the connection depends 
on the protocol defined for the frames transmitted through 
the ports and on the state of the ports. Contrast with 
dedicated connection.

dynamic I/O Reconfiguration. A S/390 function that 
allows I/O configuration changes to be made 
non-disruptively to the current operating I/O configuration.

EAF. See ETR Attachment Facility

ECC. error checking and correction. 

EEPROM. electrically erasable programmable read only 
memory. 

EIA. Electronics Industries Association. One EIA unit is 
1.75 inches or 44.45 mm. 

EMIF. See ESCON Multiple Image Facility.

Enterprise System Connection (ESCON). (1) An 
ESA/390 computer peripheral interface. The I/O interface 
uses ESA/390 logical protocols over a serial interface that 
configures attached units to a communication fabric. (2) A 
set of IBM products and services that provide a 
dynamically connected environment within an enterprise. 

Enterprise Systems Architecture/390 (ESA/390). An 
IBM architecture for mainframe computers and 
peripherals. Processors that follow this architecture 
include the S/390 Server family of processors.

environmental error record editing and printing 
program (EREP). The program that makes the data 
contained in the system recorder file available for further 
analysis.

EPO. Emergency power off.

ESA/390. See Enterprise Systems Architecture/390.

ESCD. Enterprise Systems Connection (ESCON) 
Director.

ESCM. Enterprise Systems Connection Manager.

ESCON channel. A channel having an Enterprise 
Systems Connection channel-to-control-unit I/O interface 
that uses optical cables as a transmission medium. May 
operate in CBY, CNC, CTC, or CVC mode. Contrast with 
parallel channel. 

ESCON Director. An I/O interface switch that provides the 
interconnection capability of multiple ESCON interfaces 
(or FICON FCV (9032-5) in a distributed-star topology.

ESCON Multiple Image Facility (MIF). A function that 
allows logical partitions to share an ESCON channel path 
(and other channel types) by providing each logical 
partition with its own channel-subsystem image.

ESCON. See Enterprise System Connection.

ETR Attachment Facility (EAF). A feature on a server 
where a Sysplex Timer is attached. For example, FC6155, 
FC6150, or FC6152 are EAF feature codes. Sometimes 
these features or facilities are standard with no feature 
code and sometimes they must be specifically ordered, 
depending on the server and the specific configuration.

ETR ID. Identifies the Sysplex Timer that sends ETR 
signals.

ETR Network ID. Identifies the network ID of the Sysplex 
Timer that the ETR Attachment Facility ports are 
connected to.

ETR port number. Identifies the port number of the 
Sysplex Timer output port which is sends ETR signals.

ETR Timing Mode. When the configuration is in 
ETR-timing mode, the TOD clock has been initialized to 
the ETR and is being stepped by stepping signals from 
ETR. To be in ETR-timing mode, the configuration must be 
part of an ETR network.

ETR. External time reference.

 

 

 

 Glossary 393



 

FC-AL. Fibre Channel Arbitrated Loop.

FCS. See Fibre Channel standard.

FCTC. FICON Channel-to-Channel 

fiber optic cable. See optical cable. 

fiber optics. The branch of optical technology concerned 
with the transmission of radiant power through fibers 
made of transparent materials, such as glass, fused silica, 
and plastic.
Note: Telecommunication applications of fiber optics use 
optical fibers. Either a single discrete fiber or a 
non-spatially aligned fiber bundle can be used for each 
information channel. Such fibers are often called optical 
fibers to differentiate them from fibers used in 
non-communication applications. 

fiber. See optical fiber.

Fibre Channel standard. An ANSI standard for a 
computer peripheral interface. The I/O interface defines a 
protocol for communication over a serial interface that 
configures attached units to a communication fabric. The 
protocol has four layers. The lower of the four layers 
defines the physical media and interface, the upper of the 
four layers defines one or more logical protocols (for 
example, FCP for SCSI command protocols and FC-SB-2 
for FICON for ESA/390). Refer to ANSI X3.230.1999x.

FICON channel. A channel having a Fibre Channel 
channel-to-control-unit I/O interface that uses optical 
cables as a transmission medium. The FICON channel 
may operate in (1) FC mode (FICON native mode - 
FC-SB-2/3), (2) FCV mode (FICON conversion mode to a 
IBM 9032-5), or (3) FCP mode (FICON channel operating 
in “open mode”, which is FC-FCP).

FICON. (1) An ESA/390 and z/Architecture computer 
peripheral interface. The I/O interface uses ESA/390 and 
z/Architecture logical protocols over a FICON serial 
interface that configures attached units to a FICON 
communication fabric. (2) An FC4 adopted standard that 
defines an effective mechanism for the export of the 
SBCON command protocol via Fibre Channels.

field replaceable unit (FRU). An assembly that is 
replaced in its entirety when any one of its required 
components fails.

Freewheel Mode. A secondary server enters freewheel 
mode when the attached server it has selected as its clock 
source stops providing timekeeping data. The server 
remains in freewheel mode until the server selects 
another attached server as its clock source or the server 
enters the no-usable-clock-source state. A server that is in 
freewheel mode is said to be “freewheeling”.

FRU. Field-replaceable unit.

Gb. Gigabit.

GB. Gigabyte. 

GbE. Gigabit Ethernet. 

gigabit (Gb). A unit of measure for storage size. One 
gigabit equals one billion bits. 

Gigabit (Gb). Usually used to refer to a data rate, the 
number of gigabits being transferred in one second.

Gigabit Ethernet. An OSA channel (type OSD)

gigabyte (GB). (1) A unit of measure for storage size. One 
gigabyte equals 1,073,741,824 bytes. (2) Loosely, one 
billion bytes.

half duplex. In data communication, pertaining to 
transmission in only one direction at a time. Contrast with 
duplex. 

hard disk drive. (1) A storage media within a storage 
server used to maintain information that the storage 
server requires. (2) A mass storage medium for 
computers that is typically available as a fixed disk or a 
removable cartridge.

Hardware Management Console. A console used to 
monitor and control the Central Processing Complex.

hardware system area (HSA). A logical area of central 
storage, not addressable by application programs, used to 
store Licensed Internal Code and control information. 

HCD. hardware configuration definition.

HDD. See hard disk drive.

head and disk assembly. The portion of an HDD 
associated with the medium and the read/write head.

HMCA. Hardware Management Console Application.

Host Channel Adapter (HCA). Provides connection 
between the book and an I/O cage (HCA2-C), as well as 
between the book and an external coupling link 
(HCA2-O).

I/O configuration. The collection of channel paths, 
control units, and I/O devices that attaches to the 
processor. This may also include channel switches (for 
example, an ESCON Director).

I/O. See input/output.

IC. Internal Coupling link 

ICB. Integrated Cluster Bus link

ICF. Internal coupling facility
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ICMF. Integrated Coupling Migration Facility.

ICP. Internal coupling facility peer channel.

ID. See identifier.

Identifier. A unique name or address that identifies things 
such as programs, devices, or systems.

IFA. Integrated Facility for Applications.

IFCC. interface control check.

IFL. Integrated Facility for Linux 

IML. Initial machine load. A procedure that prepares
a device for use

InfiniBand  An industry-standard specification that 
defines an input/output architecture used to 
interconnect servers, communications infrastructure 
equipment, storage and embedded systems

initial machine load (IML). A procedure that prepares a 
device for use. 

initial program load (IPL). (1) The initialization 
procedure that causes an operating system to commence 
operation. (2) The process by which a configuration image 
is loaded into storage at the beginning of a work day or 
after a system malfunction. (3) The process of loading 
system programs and preparing a system to run jobs.

initial program load (IPL). (1) The initialization 
procedure that causes an operating system to commence 
operation. (2) The process by which a configuration image 
is loaded into storage at the beginning of a work day or 
after a system malfunction. (3) The process of loading 
system programs and preparing a system to run jobs.

input/output (I/O). (1) Pertaining to a device whose parts 
can perform an input process and an output process at the 
same time. (2) Pertaining to a functional unit or channel 
involved in an input process, output process, or both, 
concurrently or not, and to the data involved in such a 
process. (3) Pertaining to input, output, or both. 

input/output configuration data set (IOCDS). The data 
set in the processor (in the support element) that contains 
an I/O configuration definition built by the input/output 
configuration program (IOCP).

input/output configuration program (IOCP). A program 
that defines the channels, I/O devices, paths to the I/O 
devices, and the addresses of the I/O devices to a system. 
The output is written to an IOCDS. 

Integrated Facility for Applications (IFA). A general 
purpose assist processor for running specific types of 
applications. See Application Assist Processor (AAP).

interface. (1) A shared boundary between two functional 
units, defined by functional characteristics, signal 
characteristics, or other characteristics as appropriate. 
The concept includes the specification of the connection 
of two devices having different functions. (2) Hardware, 
software, or both, that links systems, programs, or 
devices. 

IOCDS. See Input/Output configuration data set.

IOCP. See Input/Output configuration control program.

IODF. The data set that contains the S/390 I/O 
configuration definition file produced during the defining of 
the S/390 I/O configuration by HCD. Used as a source for 
IPL, IOCP, and Dynamic I/O Reconfiguration.

IPL. See initial program load.

IRD. Intelligent Resource Director. 

ISC-3. Inter System Channel-3 

ITR. Internal throughput rate

ITRR. Internal thoughput rate ratio

jumper cable. In an ESCON and FICON environment, an 
optical cable having two conductors that provides physical 
attachment between a channel and a distribution panel or 
an ESCON Director port or a control unit/devices, or 
between an ESCON Director port and a distribution panel 
or a control unit/device, or between a control unit/device 
and a distribution panel. Contrast with trunk cable.

LAN. See local area network.

laser. A device that produces optical radiation using a 
population inversion to provide light amplification by 
stimulated emission of radiation and (generally) an optical 
resonant cavity to provide positive feedback. Laser 
radiation can be highly coherent temporally, or spatially, or 
both.

LC connector. An optical fibre cable duplex connector 
that terminates both jumper cable fibres into one 
housing and provides physical keying for attachment to 
an LC duplex receptacle. For technical details, see the 
NCITS - American National Standard for Information 
Technology - Fibre Channel Standards document FC-PI.

LCU. See Logical Control Unit.

LED. Light-emitting diode. 

LIC. see Licensed Internal Code. 

LIC-CC. Licensed Internal Code Configuration Control
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Licensed Internal Code (LIC). Software provided for use 
on specific IBM machines and licensed to customers 
under the terms of IBM Customer Agreement. Microcode 
can be Licensed Internal Code and licensed as such. 

light-emitting diode (LED). A semiconductor chip that 
gives off visible or infrared light when activated. Contrast 
Laser.

link address. On an ESCON or a FICON interface, the 
portion of a source or destination address in a frame that 
ESCON or FICON uses to route a frame through an 
ESCON or FICON director. ESCON and FICON 
associates the link address with a specific switch port that 
is on the ESCON or FICON director. Note: For ESCON, 
there is a one-byte link address. For FICON, there can be 
a one-byte or two-byte link address specified. One-byte 
link address for a FICON non-cascade topology and 
two-byte link address supports a FICON cascade switch 
topology. See also port address. 

local area network (LAN). A computer network located in 
a user’s premises within a limited geographic area.

Local Timing Mode. When the configuration is in local 
timing mode, the TOD clock has been initialized to a local 
time and is being stepped at the rate of the local hardware 
oscillator. The configuration is not part of a synchronized 
timing network.

logical control unit (LCU). A separately addressable 
control unit function within a physical control unit. Usually 
a physical control unit that supports several LCUs. For 
ESCON, the maximum number of LCUs that can be in a 
control unit (and addressed from the same ESCON fiber 
link) is 16; they are addressed from x’0’ to x’F’.

logical partition. A set of functions that create a 
programming environment that is defined by the ESA/390 
and z/Architecture. A logical partition is conceptually 
similar to a virtual machine environment, except that 
LPAR is a function of the processor and does not depend 
on an operating system to create the virtual machine 
environment.

logical processor. In LPAR mode, a central processor in 
a logical partition.

logically partitioned (LPAR) mode. A central processor 
mode, available on the Configuration frame when using 
the PR/SM facility, that allows an operator to allocate 
processor hardware resources among logical partitions. 
Contrast with basic mode.

machine check. An error condition that is caused by an 
equipment malfunction.

maintenance change level (MCL). A change to correct a 
single licensed internal code design defect. Higher quality 
than a patch, and intended for broad distribution. 
Considered functionally equivalent to a software PTF. 

MAS. CICS managed application system

MAU. multistation access unit. 

Mb. Megabit 

MB. Megabyte. 

MBA. memory bus adapter. 

MCL. see maintenance change level. 

MCM. Multi-chip Module. Electronic package where 
multiple integrated circuits, semiconductor dies, or other 
modules are packaged in such a way as to facilitate their 
use as a single integrated circuit.

MDA. Motor Drive Assembly. 

megabit (Mb). A unit of measure for storage size. One 
megabit equals 1,000,000 bits.

megabyte (MB). (1) A unit of measure for storage size. 
One megabyte equals 1,048,576 bytes. (2) Loosely, one 
million bytes. 

Message Time Ordering (MTO). The capability on a I/O 
data path to ensure that information about the path is not 
delivered to a system that represents an event in the 
future relative to the TOD clock at the receiving system.

Message Time Ordering Facility (MTOF). A server that 
has MTOF is capable of exploiting MTO.

MIF. multiple image facility

Mixed CTN. Timing network that contains a collection of 
servers, and has at least one STP-configured server 
stepping to timing signals provided by the Sysplex Timer. 
STP-configured servers in the Mixed CTN not stepping to 
the Sysplex Timer achieve synchronization by exchanging 
STP messages.

MRU. Modular Refrigeration Unit.

MTRJ. An optical fibre cable duplex connector that 
terminates both jumper cable fibres into one housing 
and provides physical keying for attachment to an 
MT-RJ duplex receptacle. For technical details, see the 
NCITS - American National Standard for Information 
Technology - Fibre Channel Standards document FC-PI. 

multi-mode optical fiber. A graded-index or step-index 
optical fiber that allows more than one bound mode to 
propagate. Contrast with single-mode optical fiber. 
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Multiple Image Facility (MIF). In the ESA/390 
architecture and z/Architecture, a function that allows 
logical partitions to share a channel path by providing 
each logical partition with its own set of subchannels for 
accessing a common device.

National Committee for Information Technology 
Standards. NCITS develops national standards and its 
technical experts participate on behalf of the United 
States in the international standards activities of ISO/IEC 
JTC 1, information technology.

NCITS. See National Committee for Information 
Technology Standards.

Node Descriptor. A node descriptor is an unique set of 
data describing the element such as a device, a Server or 
a coupling facility. It contains information such as: 
Type/Model, manufacturer, plant, and serial number that 
makes the element unique.

OEMI. See original equipment manufacturers information.

open system. A system whose characteristics comply 
with standards made available throughout the industry 
and that therefore can be connected to other systems 
complying with the same standards.

optical cable assembly. An optical cable that is 
connector-terminated. Generally, an optical cable that has 
been terminated by a manufacturer and is ready for 
installation. See also jumper cable and optical cable. 

optical cable. A fiber, multiple fibers, or a fiber bundle in 
a structure built to meet optical, mechanical, and 
environmental specifications. See also jumper cable, 
optical cable assembly, and trunk cable. 

optical fiber connector. A hardware component that 
transfers optical power between two optical fibers or 
bundles and is designed to be repeatedly connected and 
disconnected. 

optical fiber. Any filament made of dialectic materials that 
guides light, regardless of its ability to send signals. See 
also fiber optics and optical waveguide. 

optical waveguide. (1) A structure capable of guiding 
optical power. (2) In optical communications, generally a 
fiber designed to transmit optical signals. See optical fiber. 

original equipment manufacturers information 
(OEMI). A reference to an IBM guideline for a computer 
peripheral interface. More specifically, refers to IBM 
S/360™ and S/370™ Channel to Control Unit Original 
Equipment Manufacture’s Information. The interfaces use 
ESA/390 and z/Architecture logical protocols over an I/O 
interface that configures attached units in a multi-drop bus 
environment.

OSA. Open System Adapter

parallel channel. A channel having a System/360™ and 
System/370™ channel-to-control-unit I/O interface that 
uses bus and tag cables as a transmission medium. 
Contrast with ESCON channel.

Parallel Sysplex InfiniBand (PSIFB) link. Parallel 
Sysplex coupling links between servers and coupling 
facilities using InfiniBand technology

path group. The ESA/390 and z/Architecture term for a 
set of channel paths that are defined to a controller as 
being associated with a single S/390 image. The channel 
paths are in a group state and are online to the host.

path. In a channel or communication network, any route 
between any two nodes. For ESCON or FICON, this 
would be the route between the channel and the control 
unit/device, or sometimes from the operating system 
control block for the device and the device itself.

path-group identifier. The ESA/390 and z/Architecture 
term for the identifier that uniquely identifies a given 
logical partition. The path-group identifier is used in 
communication between the system image and a device. 
The identifier associates the path-group with one or more 
channel paths, thereby defining these paths to the control 
unit as being associated with the same system image.

Pattern History Table (PHT). 

PCHID. Physical channel identifier.

physical channel identifier (PCHID). A value assigned 
to each physically installed and enabled channel in the 
CPC that uniquely identifies that channel to the system. 
For the System z9 109, the assigned PCHID values are 
between 000 and 6FF.

Physical TOD Clock. The physical-TOD clock is the 
hardware clock at a server that is stepped by a hardware 
oscillator or, when a Sysplex Timer port is enabled, that is 
stepped by synchronizabtion signals from the Sysplex 
Timer.

POR. Power-on reset.

port. (1) An access point for data entry or exit. (2) A 
receptacle on a device to which a cable for another device 
is attached. See also duplex receptacle. 

power-on reset state. The condition after a machine 
power-on sequence and before an IPL of the control 
program. 

power-on reset. A function that re-initializes all the 
hardware in the system and loads the internal code that 
enables the machine to load and run an operating system. 
This function is intended as a recovery function. 
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PR/SM. Processor Resource/Systems Manager. 

Preferred Time Server. The server assigned as the most 
likely choice as the Current Time Server (active 
stratum-1).

processor complex. A system configuration that consists 
of all the machines required for operation, for example, a 
Processor Unit, a processor controller, a system display, a 
service support display, and a power and coolant 
distribution unit. 

program status word (PSW). An area in storage used to 
indicate the sequence in which instructions are executed, 
and to hold and indicate the status of the computer 
system.

program temporary fix (PTF). A temporary solution or 
bypass of a problem diagnosed by IBM in a current 
unaltered release of a program. 

protocol. (1) A set of semantic and syntactic rules that 
determines the behavior of functional units in achieving 
communication. (2) In SNA, the meanings of and the 
sequencing rules for requests and responses used for 
managing the network, transferring data, and 
synchronizing the states of network components. (3) A 
specification for the format and relative timing of 
information exchanged between communicating parties. 

PSP. preventive service planning. 

PTF. See program temporary fix.

RAS. reliability, availability, serviceability.

remote service facility (RSF). (1) A control program plus 
associated communication equipment that allows local 
personnel to connect to an IBM service center, and allows 
remote personnel to operate the remote system or send 
new internal code fixes to it, if properly authorized. (2) A 
system facility invoked by Licensed Internal Code that 
provides procedures for problem determination and error 
detection.

RETAIN. Remote Technical Assistance and Information 
Network.

RMF™. Resource Measurement Facility.

SC Connector. An optical fibre cable duplex connector 
that terminates both jumper cable fibres into one 
housing and provides physical keying for attachment to 
an LC duplex receptacle. For technical details, see the 
NCITS - American National Standard for Information 
Technology - Fibre Channel Standards document FC-PI. 

SCP. System control program.

SE. see Support Element.

SEC. System Engineering Change.

Self-Timed Interconnect (STI). An interconnect path 
cable that has one or more conductors that transit 
information serially between two interconnected units 
without requiring any clock signals to recover that data. 
The interface performs clock recovery independently on 
each serial data stream and uses information in the data 
stream to determine character boundaries and 
inter-conductor synchronization.

Serial Electrically Erasable Programable Read Only 
Memory (SEEPROM). A chip that uses a serial interface 
to the circuit board

Server Timing Mode. The timing mode specifies the 
method by which the TOD clock is maintained for 
purposes of synchronization within a timing network. A 
TOD clock operates in one of the following timing modes: 
Local Timing Mode, ETR Timing Mode or STP timing 
Mode. To be in STP timing mode, the server must be part 
of an STP network.

Skew Rate: The maximum oscillator skew rate difference 
is equal to the maximum possible difference in oscillator 
skew rates between any two servers in the CTN according 
the skew rate tolerances specified for the oscillators. For 
example, if all oscillators in the CTN are operating with a 
skew rate tolerance of +/- 2 ppm, the maximum oscillator 
skew rate difference is equal to 4 ppm representing the 
worst case oscillator skew rate difference between any 
two oscillators in the CTN.

spanning channels. MIF spanning channels have the 
ability to be configured to multiple Channel SubSystems, 
and be transparently shared by any or all of the configured 
logical partitions without regard to the channel subsystem 
to which the logical partition is configured. 

STI. see Self-Timed Interconnect. 

Stopped State. When a configuration is in the stopped 
state, the TOD clock is either in the stopped state or 
TOD-clock recovery is in progress. After TOD-clock 
recovery completes, the TOD clock enters either the 
synchronized or unsynchronized state.

STP Link. A physical connection between two servers 
that is capable of supporting STP message transmission 
and reception. An STP link may include DWDMs and 
repeaters as part of the link.

STP Path. The combination of an STP link and STP 
facility resources required to perform STP message 
functions.
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STP timing mode. When the server is in STP-timing 
mode, the TOD clock has been initialized to coordinated 
server time (CST) and is being stepped at the rate of the 
local hardware oscillator. In STP timing mode, the TOD 
clock is steered so as to maintain, or attain, 
synchronization with CST. To be in STP-timing mode, the 
server must be part of an STP network.

STP. Server Time Protocol. A time synchronization 
feature designed to enable multliple servers to maintain 
time synchronization with each other.

Stratum Level. In a timing network based on STP, 
Stratum is used as a mean to define the hierarchy of a 
server in the timing network. A stratum level of n is 
associated with each server and indicates the server is 
n-1 hops away from the Current Time Server. A Stratum 1 
server is the highest level in the hierarchy in the CTN. A 
stratum level of zero is used to indicate that the stratum 
level is undefined.

Stratum-1 Configuration. Is defined for STP-only CTNs 
and specifies the server that is to act as the active 
stratum-1 server. The configuration may also define an 
alternate and Arbiter server. All servers are identified by 
node descriptors.

subchannel. The facility that provides all of the 
information necessary to start, control, and complete an 
I/O operation. subchannel number. A system-unique 
16-bit value used to address a subchannel. 

subsystem. (1) A secondary or subordinate system, or 
programming support, usually capable of operating 
independently of or asynchronously with a controlling 
system.

Superscalar processor. A processor where multiple 
instructions can be executed at each cycle

Support Element (SE). (1) an internal control element of 
a server that assists in many of the server operational 
functions. (2) A hardware unit that provides 
communications, monitoring, and diagnostic functions to 
a central processor complex (CPC).

switched point-to-point channel path configuration. In 
an ESCON or FICON I/O interface, a configuration that 
consists of a link between a channel and an ESCON 
Director and one or more links from the ESCD, each of 
which attaches to a control unit. This configuration 
depends on the capabilities of the ESCD for establishing 
and removing connections between channels and control 
units. Contrast with point-to-point channel path 
configuration. 

switched point-to-point topology. A network topology 
that uses switching facilities to provide multiple 
communication paths between channels and contro units. 
See also multidrop topology.

Synchronization Threshold. The amount of time that 
TOD clocks in a CTN are allowed to differ from CST and 
still be considered synchronized. The value is set so that 
it is less than one half of the best-case communication 
time between two servers over communication paths that 
do not support message-time ordering (MTO).

Synchronized State. When a server is in the 
synchronized timing state, the TOD clock is in 
synchronization with the timing-network reference time as 
defined below:
� If the configuration is in ETR-timing mode, the server 

is synchronized with the ETR.
� If the server is in STP timing mode, the server is 

synchronized with coordinated server time (CST).
A server that is in the local-timing or uninitialized-timing 
mode is never in the synchronized state.

Synchronized. A timing state that indicates that the TOD 
clock for a server is within the synchronization threshold 
value relative to CST.

Sysplex Timer. An IBM table-top unit that synchronizes 
the time-of-day (TOD) clocks in as many as 16 processors 
or processor sides. 

Sysplex. A set of systems communicating and 
cooperating with each other through certain multisystem 
hardware components and software services to process 
customer workloads. 

system reset. To reinitialize the execution of a program by 
repeating the load operation.

System TOD Clock. The system-TOD clock at a server is 
formed by adding the TOD-clock offset to the 
physical-TOD clock.

Time server. A computing system that has the STP 
facility installed and enabled.

Time zone. (1) Any of the 24 longitudinal divisions of 
Earth's surface in which a standard time is kept, the 
primary division being that bisected by the Greenwich 
meridian. Each zone is 15° of longitude in width, with local 
variations, and observes a clock time one hour earlier 
than the zone immediately to the east. (2) In some 
countries, standard time zones are not an integral number 
of hours different from UTC. STP supports time-zone 
offsets in integral number of minutes.

time-of-day (TOD) clock. A system hardware feature that 
is nominally incremented once every microsecond in bit 
position 51 and provides a consistent measure of elapsed 
time suitable for indicating date and time. The TOD clock 
runs regardless of whether the processor is in a running, 
wait, or stopped state.
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TOD clock state. The following states are distinguished 
for the TOD clock: set, not set, stopped, error, and not 
operational. 
The state determines the condition code set by execution 
of STORE CLOCK, STORE CLOCK EXTENDED, and 
STORE CLOCK FAST. The clock is incremented, and is 
said to be running, when it is in either the set state or the 
not-set state

TOD Error State. The clock enters the error state when a
malfunction is detected that is likely to have affected the 
validity of the clock value. It depends on the model 
whether the clock can be placed in this state. A 
timing-facility-damage machine-check-interruption 
condition is generated on each CPU in the configuration 
whenever the clock enters the error state. When the 
TOD-clock-steering facility is installed, the TOD clock is 
never reported to be in the error state. Errors in the TOD 
clock cause a system check stop.

TOD Not-Operational State. The clock is in the 
not-operational state when its power is off or when it is 
disabled for maintenance. It depends on the model 
whether the clock can be placed in this state. Whenever 
the clock enters the not-operational state, a timing- 
facility-damage machine-check-interruption condition is 
generated on each CPU in the configuration. When the 
TOD-clock-steering facility is installed, the TOD clock is 
never reported to be in the not-operational state.

TOD Not-Set State. When the power for the clock is 
turned on, the clock is set to zero, and the clock enters the 
not-set state. The clock is incremented when in the not-set 
state. When the TOD-clock-steering facility is installed, 
the TOD clock is never reported to be in the not-set state, 
as the TOD clock is placed in the set state as part of the 
initialmachine-loading (IML) process.

TOD Programmable Register. Each CPU has a TOD 
programmable register. Bits 16-31 of the register contain 
the programmable field that is appended on the right to 
the TOD-clock value by STORE CLOCK EXTENDED. The 
register is loaded by SET CLOCK PROGRAMMABLE 
FIELD. The contents of the register are reset to a value of 
all zeros by initial CPU reset.

TOD Set State. The clock enters the set state only from 
the stopped state. The change of state is under control of 
the TOD-clock-sync-control bit, bit 34 of control register 0, 
of the CPU which most recently caused the clock to enter 
the stopped state. If the bit is zero, the clock enters the set 
state at the completion of execution of SET CLOCK. If the 
bit is one, the clock remains in the stopped state until the 
bit is set to zero on that CPU or until another CPU 
executes a SET CLOCK instruction affecting the clock. If 
an external time reference (ETR) is installed, a signal from 
the ETR may be used to set the set state from the stopped 
state. Incrementing of the clock begins with the first 
stepping pulse after the clock enters the set state.

TOD Stopped State. The clock enters the stopped state
when SET CLOCK is executed and the execution results 
in the clock being set. This occurs when SET CLOCK is 
executed without encountering any exceptions and either 
any manual TOD-clock control in the configuration is set 
to the enable-set position or the 
TOD-clock-control-override control, bit 42 of control 
register 14, is one. The clock can be placed in the stopped 
state from the set, not-set, and error states. The clock is 
not incremented while in the stopped state.

TOD Timing State. The timing state indicates the 
synchronization state of the TOD clock with respect to the 
timing network reference time.

TOD. see Time of day.

TOD-Clock Offset. The TOD-clock offset is a value that 
when added to the physical-TOD clock produces the 
system-TOD clock. The TOD-clock-offset may be 
gradually steered or stepped to keep the system-TOD 
clock synchronized to CST.

TOD-clock steering. Provides a means to change the 
apparent stepping rate of the TOD clock without changing 
the physical hardware oscillator which steps the physical 
clock. This is accomplished by means of a TOD-offset 
register which is added to the physical clock to produce a 
logical-TOD-clock value.

TPF. see Transaction processing facility. 

Transaction Processing Facility. Transaction 
Processing Facility is a specialized high availability 
operating system designed to provide quick response 
times to very high volumes of messages from large 
networks of terminals and workstations. 

triad. A term sometimes used to describe a 
Preferred/Backup/Arbiter server configuration.

trunk cable. In an ESCON environment, a cable 
consisting of multiple fiber pairs that do not directly attach 
to an active device. This cable usually exists between 
distribution panels and can be located within, or external 
to, a building. Contrast with jumper cable. 

TSO. Time sharing option.

UCW. unit control word. 

unit address. The ESA/390 and z/Architecture term for 
the address associated with a device on a given controller. 
On ESCON or FICON interfaces, the unit address is the 
same as the device address. On OEMI interfaces, the unit 
address specifies a controller and device pair on the 
interface.
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Unsynchronized State. When a server is in the 
unsynchronized timing state, the TOD clock is not in 
synchronization with the timing network reference time as 
defined below:
� If the server is in ETR-timing mode, the server has 

lost synchronization with the ETR.
� If the server is in STP timing mode, the server has 

lost or has not been able to attain synchronization 
with coordinated server time (CST). The server is out 
of synchronization with CST when the TOD clock 
differs from CST by an amount that exceeds a model 
dependent STP-sync-check-threshold value.

UPS. uninterruptible power supply. 

VLAN. Virtual Local Area Network.

z/Architecture. An IBM architecture for mainframe 
computers and peripherals. 
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